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Trademark Notice
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FOREWORD

This document is an NTCIP Device Data Dictionary Standard. Device Data Dictionary Standards provide
formal definitions of data elements for use within NTCIP systems. The data is defined using the format
specified in NTCIP 8004, which is based on the formats defined in RFC 2578. This data is typically
exchanged using the Simple Network Management Protocol (SNMP) as defined in NTCIP 2301.

This document identifies and defines how a management station may wish to interface with a field device
to control and monitor environmental sensor stations (ESS). This document defines requirements that are
applicable to all NTCIP ESS and it also contains optional and conditional sections that are applicable to
specific environments for which they are intended.

Approvals

NTCIP Data Dictionary Standards are separately balloted and approved by AASHTO, ITE, and NEMA
after recommendation by the Joint Committee on the NTCIP. Each organization has approved this
document as the following standard type:

AASHTO—Standard Specification;
ITE—Software Standard;
NEMA—Standard;

For more information about NTCIP standards, visit the NTCIP Web Site at www.ntcip.org .
User Comment Instructions

The term “User Comment” includes any type of written inquiry, comment, question, or proposed revision,
from an individual person or organization, about any part of this standards publication’s content. A
“Request for Interpretation” is also classified as a User Comment. User Comments are solicited at any
time. In preparation of this NTCIP standards publication, input of users and other interested parties was
sought and evaluated.

All User Comments will be referred to the committee responsible for developing and/or maintaining the
standards publication. The committee chairperson, or their designee, may contact the submitter for
clarification of the User Comment. When the committee chairperson or designee reports the committee’s
consensus opinion related to the User Comment, that opinion is forwarded to the submitter. The
committee chairperson may report that action on the User Comment may be deferred to a future
committee meeting and/or a future revision of the standards publication. Previous User Comments and
their disposition may be available for reference and information at www.ntcip.org.

A User Comment should be submitted to this address:

NTCIP Coordinator

National Electrical Manufacturers Association
1300 North 17th Street, Suite 1752

Rosslyn, Virginia 22209-3801

e-mail: ntcip@nema.org

A User Comment should be submitted in the following form:

Standard Publication number and version:
Page:

Section, Paragraph, or Clause:

Comment:

Editorial or Substantive?:

Suggested Alternative Language:
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Please include your name, organization, and address in your correspondence.

History

Version Date Description (latest on top)

V05 TBD Updated to SMIv2 with related security updates, added
support for multiple languages (e.g., DisplayString changed to
SnmpAdminString), revised RTM to reference 1SO 26048-1 for
global objects, and revised test procedures to reflect changes.

v04 April 2022 Updated to reflect additional lessons learned and to support
new user needs (e.g., adding support for sensor tables for
most sensors rather than just a single instance).

v03 October Added Annex C (test procedures) along with minor corrections

2009 and clarifications

v02 July 2005 Developed to reflect additional lessons learned, to incorporate
better documentation (e.g., Sections 2-4, which provide the
concept of operations, requirements, and dialogs) and to add
new features requested by the ITS community (e.g., the
control of automated de-icing equipment).

vO1lA November | Technical corrections for objects

2001

v01l September | Original version

(a.k.a. 1998

NEMA

TS 3.7)
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INTRODUCTION

This document provides definitions of data elements for environmental sensor data, including weather
data, pavement condition data, water level data, and air quality data. The data is defined using the
Structure of Management Information version 2 (SMIv2) object-type format as defined in RFC 2578 and
would typically be exchanged using SNMPv3 per the rules of NTCIP 2301. This document also relies
upon the use of SFTP for the exchange of snapshot images captured by the ESS.

This document contains four normative and four informative annexes.

The following keywords apply to this document: AASHTO, ITE, NEMA, NTCIP, ESS, data, data
dictionary, object, environmental sensor.

This document uses only metric units.
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Section 1
General [Informative]

1.1 Scope

This document specifies the logical interface between environmental sensor stations (ESS) and the host
systems that control them (commonly referred to as “central” systems). This document describes the
supported ESS functionality in terms of user needs and requirements; however, the nature of the
interface is determined in part by the operational nature of the devices being controlled, and therefore this
document touches on such operational issues on occasion.

ESS include a wide array of sensors, including those that monitor weather, roadway surface, water level,
and air quality conditions. These sensors are typically connected to a nearby microprocessor termed a
remote processor unit (RPU). An ESS consists of the RPU plus its suite of sensors.

Typically, this equipment is fixed or permanently located at a site along a travel corridor. In some cases,
the "stations" may be transportable, or even mobile. For the purposes of this document, all three types of
stations are called ESS. In the transportation community, these devices are frequently used to improve
roadway maintenance and traffic operations.

Environmental sensors are also frequently co-located with pavement treatment systems (PTS) and, in
fact, may use the same controller. Thus, for the purpose of this document, the term ESS may also include
a PTS.

Note—The PTS portion of this document may be placed in a separate standard in the future.

Prior to standardizing the interface for ESS and their management stations, each manufacturer developed
its own protocol to meet its own particular needs. This approach resulted in systems that were not
interchangeable or interoperable. If an agency wished to use either a management station or additional
ESS from a different vendor, the agency encountered significant systems integration challenges, requiring
additional resources to address. These additional resource requirements inhibited information sharing
within and between various potential users of the data and prevented vendor independence. Without
manufacturer independence, resource requirements further increase because of a lack of a competitive
market.

These problems were not limited to weather and environmental monitoring. Many other devices needed
to exchange information. In surface transportation, examples included traffic signal controllers, dynamic
message signs, bus priority sensors, etc. The NTCIP family of open standards for communications
between field devices and management stations was developed to address these issues. This effort was
later incorporated into ISO standards for some devices.

This document is part of that larger family and is designed to define an interoperable and interchangeable
interface between a management station and an ESS, while still allowing for extensions beyond this
document to allow for new functions as needed. This approach has proven to support the deployment of
ESS from one or more vendors in a consistent and resource-efficient way.

This document only addresses a subset of the requirements needed for procurement. It does not address
requirements related to the performance of the sensors (e.g., accuracy, the supported detection range,
the time it takes to detect conditions, etc.), hardware components, mounting details, etc.

This document standardizes the communications interface by identifying the various operational needs of

the users (Section 2) and subsequently identifying the necessary requirements (Section 3) that support
each need. This document then defines the NTCIP standardized communications interface used to fulfill
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these requirements by identifying the dialogs (Section 4) and related data concepts (Section 5) that
support each requirement.

Traceability among the various sections is defined by the Protocol Requirements List (Section 3.3.3) and
the Requirements Traceability Matrix (Annex A). Conformance requirements for this document are
provided in Section 3.3.2.1.

An implementation of this document requires lower level services to structure, encode, and exchange the
data concepts that it defines. This document assumes that the data concepts are exchanged by SNMPv3
per the rules defined in NTCIP 2301.

1.2 References

The following documents are referenced by this document. At the time of publication, the editions
indicated were valid.

1.2.1 Normative References

Normative references contain provisions that, through reference in this text, constitute provisions of this
document. All standards are subject to revision, and parties to agreements based on this document are
encouraged to investigate the possibility of applying the most recent editions of the standards listed.

Identifier Title

AASHTO / ITE / NEMA Structure and Identification of Management Information (SMI)

NTCIP 8004 v03 published

Glossary of Meteorology | Glossary of Meteorology; American Meteorological Society, 2022,
https://glossary.ametsoc.org/, accessed 20 July 2023.

ISO/TS 26048-1.: - Intelligent transport systems — Field equipment SNMP data interface — Part
1: Global objects (under ballot)

ISO/IEC/IEEE Systems and software engineering — Vocabulary, 2017, available at

24765:2017 https://standards.iso.org/ittf/PubliclyAvailableStandards/index.html

ITU-T X.696 (a.k.a., Information technology — ASN.1 encoding rules: Specification of Octet

ISO/IEC 8825-7) Encoding Rules (OER), published August 2015

RFC 854 Telnet Protocol Specifications

RFC 2578 Structure of Management Information Version 2 (SMIv2), April 1999

RFC 2579 Textual Conventions for SMIv2, April 1999

RFC 2580 Conformance Statements for SMIv2, April 1999

RFC 3411 An Architecture for Describing Simple Network Management Protocol
(SNMP) Management Frameworks, December 2002

RFC 4250 The Secure Shell (SSH) Protocol Assigned Numbers, January 2006

RFC 4251 The Secure Shell (SSH) Protocol Architecture, January 2006

RFC 4252 The Secure Shell (SSH) Authentication Protocol, January 2006

RFC 4253 The Secure Shell (SSH) Transport Layer Protocol, January 2006

RFC 4254 The Secure Shell (SSH) Connection Protocol, January 2006

RFC 4255 Using DNS to Securely Publish Secure Shell (SSH) Key Fingerprints,
January 2006

RFC 4256 Generic Message Exchange Authentication for the Secure Shell Protocol
(SSH), January 2006

RFC 6933 Entity MIB (Version 4)

RFC 9110 HTTP Semantics, June 2022

SFTP v3 SSH File Transfer Protocol, October 2001. Available at
https://datatracker.ietf.org/doc/html/draft-ietf-secsh-filexfer-02
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WMO No. 306; 2019 Technical Regulations; Manual on Codes, International Codes, Volume 1.2,
Annex Il, (Part B - Binary Codes, FM 94 BUFR), 2019 edition, updated in
2022. https://library.wmo.int/doc_num.php?explnum_id=11283, accessed 20

July 2023

1.2.2 Other References

Other references are included to provide a more complete understanding of this document and its

relationship to other documents.

Identifier

Title

AASHTO / ITE / NEMA
NTCIP 2202 v02

Internet (TCP/IP and UDP/IP) Transport Profile, published

AASHTO /ITE / NEMA
NTCIP 2301 v03

Simple Transportation Management Framework (STMF) Application
Profile (AP) (AP-STMF), published

AASHTO / ITE / NEMA
NTCIP 8007 v02

Testing and Conformity Assessment Documentation within NTCIP
Standards Publications, published

AASHTO / ITE /| NEMA
NTCIP 9001 v04

The NTCIP Guide
published July 2009

Architecture Reference for | National ITS Architecture, FHWA, 2023; available at https://www.arc-it.net
Cooperative and Intelligent
Transportation (ARC-IT),

Version 9.2

EN 15518-3:2023 Winter maintenance equipment - Road weather information systems - Part
3:Requirements on measured values of stationary equipment, European

Standard, 2023

ISO 15784-2:2024 Intelligent transport systems — Data exchange involving roadside
equipment communication — Part 2: Centre to field device

communications using SNMP

RFC 5935 (IAB) Expressing SNMP SMI Datatypes in XML Schema Definition Language,

M. Rose, K. McCloghrie, August 2010

OMG Unified Modeling OMG Unified Modeling Language Specification, Object Management

Language Specification, Group, 2003

Version 1.5

SAE J1939 Serial Control and Communications Heavy Duty Vehicle Network — Top
Level Document, J1939 202306, published June 2023

SAE 1979 E/E Diagnostic Test Modes, J1979 201702, published February 2017

TMDD Traffic Management Data Dictionary (TMDD) Standard v3.1 for the Center

to Center Communications, v3.1, AASHTO / ITE
published January 13, 2020

Weather-Responsive
Traffic Management

Weather-Responsive Traffic Management — Concept of Operations.
FHWA, 2003
ops.fhwa.dot.gov/weather/best practices/WeatherConOps0103.pdf

1.2.3 Contact Information
1.2.3.1 AASHTO /ITE Traffic Management Data Dictionary (TMDD) Documents

The Traffic Management Data Dictionary (TMDD) documents can be downloaded at:

https://www.ite.org/technical-resources/standards/tmdd/
1.2.3.2 American Meteorological Society

The Glossary of Meteorology is available from:

https://glossary.ametsoc.org/
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1.2.3.3 CEN (EN) Documents

Documents from the European Committee for Standardization (CEN and EN) are available at:

https://www.cencenelec.eu/

1.2.3.4 |1AB and IETF (RFC) Documents
For Internet Architecture Board (IAB) and Internet Engineering Task Force documents, contact:

Internet Architecture Board (IAB)

www.rfc-editor.org

1.2.3.5 1ISO
ISO documents are available from:

https://www.iso.org/standards.html
Electronic files that support ISO documents are available for free from:

https://standards.iso.org

1.2.3.6 ISO/IEC/IEEE
ISO/IEC/IEEE 24765:2017 can be downloaded for free from:

https://standards.iso.org/ittf/PubliclyAvailableStandards/index.html
1.2.3.7 ITU-T

ITU-T recommendations can be downloaded for free from:

https://lwww.itu.int/rec/T-REC-X/en
1.2.3.8 National ITS Architecture
The National ITS Architecture, also known as the Architecture Reference for Coopoerative and Intelligent
Transportation (ARC-IT), may be viewed on-line at:
https://www.arc-it.net
1.2.3.9 NTCIP Standards
Copies of NTCIP standards may be obtained from:
NTCIP Coordinator
National Electrical Manufacturers Association
1300 N.17th Street, Suite 900
Rosslyn, Virginia 22209-3801

www.ntcip.org
e-mail: ntcip@nema.org

Draft amendments, which are under discussion by the relevant NTCIP Working Group, and amendments
recommended by the NTCIP Joint Committee are available.

1.2.3.10 Object Management Group Documents

Copies of OMG standards may be obtained electronically from the Object Management Group at:

https://www.omg.org/
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1.2.3.11 Office of the Federal Coordinator for Metrology (OFCM) Documents

Copies of OFCM documents may be obtained from:

Office of the Federal Coordinator for Meteorology
8455 Colesville Rd., Suite 1500
Silver Spring, MD 20910
(301) 427-2002
https://www.ofcm.gov/

1.2.3.12 SAE International Documents

Copies of SAE International documents may be obtained from:

SAE Customer Serrice
400 Commonwealth Drive
Warrendale, PA 15096-0001
(877) 606-7323
store.sae.org

1.2.3.13 World Meteorological Organization (WMO) Documents

WMO documents are available from:

https://public.wmo.int/en/resources/standards-technical-regulations
1.3 General Statements
1.3.1 SNMPv3

The information defined in this document can theoretically be exchanged over any communications stack,
but is designed to be exchanged using SNMPv3. Within the context of this document SNMPv3 refers to a
complete communications stack, as described in NTCIP 2301 v03 and ISO 15784-2:2024, which (among
other requirements) require support for Transport Layer Security (TLS) version 1.3 and the TLS Transport
Model (TLSTM). TLSTM defines how the SNMP engine uses the TLS certificate to manage SNMP data
access

1.3.2 Compatibility with Versions Prior to NTCIP 1204 v05

Prior to v05, NTCIP 1204 was intended for use with SNMPv1, which has known security vulnerabilities.
Starting with v05, NTCIP 1204 is intended for use with SNMPv3, which addresses the known security
vulnerabilities with SNMPv1 with minimal redesign but is not directly compatible with prior
implementations using SNMPv1.

Because the migration to SNMPv3 broke direct backward compatibility, the NTCIP community agreed to
address a number of other known technical issues with NTCIP data to further address security, ambiguity,
code reusability, longevity and other issues. Most of these issues were related with NTCIP 1201 and
NTCIP 1103, which prior versions of this document normatively referenced. These references have been
replaced with references to ISO 26048-1. In addition, v04 deprecated and replaced some objects from
prior versions of NTCIP 1204.

This document does not define rules for exchanging any data that was deprecated in NTCIP 1204 v05 or
earlier. Implementations that need to interoperate with equipment that conforms to versions of this
document prior to NTCIP 1204 v05, should refer to those prior versions for specific requirements,
especially in relation to data from NTCIP 1103 and NTCIP 1201.

Most of the objects directly defined in prior versions of NTCIP 1204 were upgraded without significant
compatibility issues. Deprecated objects are retained within the MIB in order to provide an unambiguous
definition of how they should be presented if they are exchanged using SNMPv3 (e.g., this might be done
when communicating to a proxy agent that provides an SNMPv3 interface for a native SNMPv1 device).
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1.3.3 Use of SMiIv2

SNMPv3 is designed to exchange data defined using the Structure of Management Information (SMI)
Version 2 (v2) as defined in RFC 2578. Versions of this document prior to NTCIP 1203 v04 defined data
using SMIv1, as defined in RFC 1212. The data definitions also conform with NTCIP 8004, which defines
additional rules (e.g., the subclauses used within the DESCRIPTION clause. This document updates the
MIB to conform to SMIv2 and the current version of NTCIP 8004 while retaining the object identifiers of
previously declared object types. In some cases, minor revisions have been made to objects; when these
have any technical impact, the issue is identified in the Informative subclause of the object type
description and in the object refinement table in Annex A, when necessary.

1.3.4 Superseding and Supplanting Objects

Many of the object types defined in this document identify superseding or supplanting object types by
using a "<Superseded by>" or "<Supplanted by>" clause. Supplanting object type(s) provide similar
functionality while superseding objects provide a new interface for the same device capability.

For example, eventConfigMode (defined in NTCIP 1103 v03) is supplanted with fdCondTriggerMode
(defined in ISO 26048-1). Although both objects provide similar functionality (i.e., identifying a type of
condition to trigger an event), setting an instance of eventConfigMode does not affect any instance of
fdCondTriggerMode in an implementation that supports both objects because the associated event logs
are defined separately.

By contrast, globalTime (defined in NTCIP 1201 v03) is superseded by fdClockUtcDate and
fdClockUtcTime. In other words, if a device supports both globalTime and fdClockUtcTime, setting
globalTime will affect the time reported by fdClockUtcTime. The core device capability is the same (e.g.,
keeping time), but there is a new interface that provides greater range and resolution.

1.4 Terms

For the purposes of this document, the following terms, definitions, acronyms, and abbreviations apply.
Meteorological terms not defined in this section are in accordance with their definitions in the Glossary of
Meteorology. Systems and software engineering terms not defined here are used in accordance with their
definitions in ISO/IEC/IEEE 24765. NTCIP terms not defined in one of these sources are in accordance
with their definitions in NTCIP 8004. English words not defined in one of these sources are used in
accordance with their definitions in Webster's New Collegiate Dictionary.

Term Definition
Binary Universal Form for the The name of the WMO standard binary code for the exchange and
Representation of storage of non-gridded meteorological data.

Meteorological Data (BUFR)

Consistent The ability of two or more systems or components to exchange
information and use the supported information that has been
exchanged and gracefully reject any unsupported information
according to defined rules.

Controller A host computing platform that is used to manage the collection and
reporting of sensor data and/or to manage the treatment of
pavement for icing conditions.

Note: Within the ESS community, sometimes called a remote
processor unit or “RPU”.

Environmental Monitoring The component within a management subsystem which performs
Equipment Package advanced processing of the collected environmental data. This
would include the analysis, forecasting and packaging of weather
and road condition information for resource management.
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Term

Definition

Environmental Sensor Station
(ESS)

A location that includes a remote processor unit (RPU) connected to
one or more sensors for the collection of environmental or
meteorological data. It may also include a pavement treatment
system (PTS).

Note: The acronym ESS may also be used as a plural.

Feature A behavior of the device.

Mobile In the context of an ESS, the ESS, including environmental sensors
and pavement treatment devices, is able to operate while in motion.

Operator The person who interfaces with the management station software,

typically located at a control center.

Permanent (Fixed)

In the context of an ESS, an ESS not designed to be relocated,
hence fixed.

Remote Processor Unit (RPU)

A field processor that collects data from sensors and can
communicate the collected data to other computers; the processor
may also process the collected data and/or control equipment.

Return

When discussing device requirements for providing data when an
external system requests it, the term “return” is understood to mean
that the data is sent to the requester.

Road Weather Data Collection
Market Package

A set of components that perform all operations related to sensing,
collecting, processing, and exchanging environmental related
information, including the exchange of data among the dispersedly
located equipment.

Road/Weather Information
System

The collection of RPUs and sensors connected to a central system
for analysis and use by maintenance personnel and transportation
system managers.

Sensor

A device that is capable of detecting a condition and reporting the
result to an RPU.

Specification

A document that references a standard either to define the
capabilities of a component (e.g., a specification sheet) or to define
the required capabilities of a component being procured (e.g., a
procurement specification).

Sub-Feature

A specialization of a more generic feature.

Transportable

In the context of an ESS, an ESS capable of being relocated, but its
environmental sensors and pavement treatment devices do not
operate while moving.

Upload

To transfer information from the referenced device to the central
computer or an attached portable computer.

1.5 Abbreviations

The abbreviations and acronyms used in this document are defined as follows:

AASHTO
AQMC

American Association of State Highway and Transporation Officials

Air Quality Management Center
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ARC-IT
ASN.1
CEN
CPU
CcVv
DMS
EN
ESS
FFMC
FR
FTRT
IAB
IEC
IEEE
IETF

IRE
ISO
ITE
ITS
ITU-T

MCMC
MCV
METR
MIB
NA
NEMA
NTFT
OBE
OFCM
OMG
PDF
PICS
PRL

Architecture Reference for Cooperative and Intelligent Transportation
Abstract Syntax Notation One

Comité Européen de Normalisation (European Committee for Standardization)
Central Processing Unit

Connected Vehicle

Dynamic Message Sign

Europaische Norm (European Standard)

Environmental Sensor Station

Fleet and Freight Management Center

Functional Requirement

Feature To Requirement Table

Internet Architecture Board

International Electrotechnical Commission

Institute of Electrical and Electronic Engineers

Internet Engineering Task Force

Internet Protocol

ITS Roadway Equipment

International Organization for Standardization

Institute of Transporation Engineers

Intelligent Transportation Systems

International Telecommunication Union Telecommunication Standardization
Sector

Maintenance and Construction Management Center
Maintenance and Construction Vehicle
Management of Electronic Traffic Regulations
Management Information Base

Not Applicable

National Electrical Manufacturers Association
Needs To Feature Table

On-Board Equipment

Office of Federal Coordinator for Meteorology
Object Management Group

Portable Document Format

Protocol Implementation Conformance Statement

Profile Requirements List
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PTS Pavement Treatment System (or Systems)
RFC Request for Comments
RPU Remote Processor Unit
RSE Roadside Equipment
RTM Requirments Traceability Matrix
SAE Society of Automotive Engineers
SFTP Secure File Transfer Protocol
SNMP (v1 or v3) Simple Network Management Protocol (version 1 or 3)
STMF Simple Transportation Management Framework
STWS Surface Transportation Weather Service
TCP Transmission Control Protocol
TIC Transportation Information Center
T™MC Traffic Management Center
TMDD Traffic Management Data Dictionary
UDP User Datagram Protocol
WG Working Group
WMO World Meteorological Organization
WSS Weather Service System
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Section 2
Concept of Operations [Normative]

This section defines user needs that this document addresses in subsequent sections. Accepted system
engineering processes detail that requirements should only be developed to fulfill well-defined user
needs. The first stage in this process is to identify the ways in which the system is likely to be used. For
this document, this entails identifying the various ways in which transportation operations personnel may
use ESS information to fulfill their duties.

This concept of operations provides the reader with:

a) a detailed description of the scope of this standard,;

b) an explanation of how an ESS is expected to fit into the larger context of an intelligent transportation
system (ITS) network;

¢) a starting point in the agency procurement process; and

d) an understanding of the perspective of the designers of this document.

Section 2 is intended for all readers of this document, including:

a) transportation operations managers
b) transportation operations personnel
C) transportation engineers

d) system integrators

e) device manufacturers

For the first three categories of readers, this section provides a useful understanding of how ESS
equipment can be used in their system. For this audience, Section 2 serves as the starting point in the
procurement process. Readers can become familiar with each feature and determine whether that feature
is appropriate for their agency-specific implementation. If it is, then the agency procurement specification
should require support for the feature and all of the mandatory requirements related to that feature.

For the last two categories of readers, this section is useful to gain a more thorough understanding as to
why more detailed requirements exist later in this document.

21 Tutorial [Informative]

A ConOps describes a proposed system from the users' perspective. Typically, a ConOps is used on a
project to ensure that the system developers understand users' needs. Within NTCIP standards, it is used
to document the intent of each feature that the NTCIP standard supports. It also serves as the starting
point for users to select which features may be appropriate for their project.

The ConOps starts with a discussion of the current situation and issues that have led to the need to
deploy systems covered by the scope of this document and to the development of this document itself.
This discussion is presented in lay terms such that both the potential users of the system and system
developers can understand and appreciate the situation.

The ConOps then documents key aspects about the proposed system, including:

a) Reference Physical Architecture - The reference physical architecture defines the overall context of
the proposed system and defines the specific interface addressed. The reference physical
architecture may be supplemented with one or more samples that describe how the reference
physical architecture may be realized in an actual deployment.

b) Architectural Needs - The architectural needs discuss issues and needs relative to the system
architecture that have a direct impact on this document.
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c) Features - The features identify and describe the various functions that users may want components
of an ESS system to perform. These features are derived from the high level user needs identified in
the problem statement but are refined and organized into a more manageable structure that forms the
basis of the Protocol Requirements List (PRL) and Requirements Traceability Matrix (RTM) contained
in Section 3.3.3 and Annex A, respectively.

Architectural needs and features are collectively called user needs. In Section 3, user needs provide a
basis to analyze the system and define the various functional requirements of an ESS. Each user need is
required to trace to one or more functional requirements, and each functional requirement is required to
be derived from at least one user need. This traceability is shown in the PRL as provided in Section 3.3.3.

This document is intended for use in a broad range of deployments and not every feature is required for
every deployment. To accommodate this diversity, the PRL identifies each user need and requirement as
being mandatory, optional, or conditional. The only items marked mandatory are those that relate to the
most basic functionality of the device. To obtain a device that meets specific needs, the user identifies the
optional and conditional needs appropriate for the specific project.

Each requirement is also presented in the RTM in Annex A, which defines how the requirement is fulfilled
through the standardized dialogs and data element definitions provided in Section 4 and Section 5,
respectively.

A conformant device may support other user needs, as long as they are conformant with the
requirements of this document and its normative references (e.g., ISO 26048-1, NTCIP 8004). For
example, a device may support data that has not been defined by this document; however, when
exchanged via NTCIP 2301, the data shall be properly registered with a valid OBJECT IDENTIFIER
under the Global ISO Naming Tree.

Note: Off-the-shelf interoperability and interchangeability can only be obtained by using well-
documented user needs, along with their corresponding requirements and design, that are
broadly supported by the industry as a whole. Designing a system that uses environments or
features not defined in a standard or not typically deployed in combination with one another
inhibits the goals of interoperability and interchangeability, especially if the documentation of
these user needs is not available for distribution to system integrators. this document allows
implementations to support additional user needs to support innovation, which is constantly
needed within the industry, but users should be aware of the risks involved with using such
environments or features.

The ConOps concludes by describing security needs and by providing a description of how this document
relates to the National ITS Architecture.

2.2 Current Situation and Problem Statement [Informative]

Transportation system managers use ESS in a variety of ways to improve transportation system
operations. The primary uses of ESS data support the following:

a) sharing data with the broader weather community contributes to better weather forecasts

b) improved highway maintenance operations through supporting timely, accurate, and relevant weather
forecasting and knowledge of existing road weather conditions

€) more accurate traveler information, which can result in better route planning by travelers and more
effective, safer transportation system use

d) improved management of facilities maintenance resources, leading to more timely facilities clearance
and improved traveler safety

e) more effective use of advisory and regulatory mechanisms to ensure public safety

f) enhanced monitoring of potentially hazardous conditions, to improve transportation system security
and traveler safety

g) Facilitate sharing of air quality information collected by sensors in field devices and on mobile
platforms
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Additional information about how this data can be used is provided in Weather-Responsive Traffic
Management-Concept of Operations. One of the most common ESS deployed by transportation system
managers is the road/weather ESS. These ESS are used to collect information about road and weather
conditions, such as precipitation and air and surface temperatures. With the data returned by these ESS,
transportation system managers can determine when there are incipient hazardous travel conditions
because of precipitation, fog, high winds, snow, ice, and/or flooding. When travel is becoming hazardous
because of snow and/or ice, transportation system managers can dispatch road maintenance crews to
treat the roads and remove snow and ice if possible.

Transportation system managers can also use ESS in conjunction with other ITS devices, such as
Dynamic Message Signs (DMS), to advise travelers of poor travel conditions or to notify travelers of travel
policy changes because of bad weather. For example, foggy conditions could trigger a DMS to display a
lowered speed limit in a high-speed area. Snow and ice conditions could trigger a DMS to display a
requirement for travelers to use chains on their tires. Icy conditions on bridges or roadways can also lead
to the triggering of a spraying device that sprays anti-icing or de-icing chemicals on bridge or roadway
surfaces to improve driving conditions. High water or high wind conditions could trigger a DMS to display
a message either recommending that travelers choose a different route or that they reduce their speed to
protect themselves against the potential hazard.

Although transportation system managers are the normal users of ESS, the data from these ESS are
sometimes used by emergency management personnel. For example, when flood conditions occur,
regardless of their extent, emergency management personnel use data on the depth of water in areas
covered by ESS to determine how and when to respond to flooding. Emergency management personnel
re-route travelers from flooded areas, in some cases by deploying (in conjunction with transportation
system personnel) signs indicating that sections of road are closed because of flooding.

A transportation system manager may also be interested in using an ESS to measure air quality. This
data can be used to monitor concentrations of certain chemicals to ensure that they do not exceed toxic
levels. For example, tunnel systems frequently use sensors to ensure that carbon monoxide levels stay
within safe levels. The data can also provide a valuable resource to air quality management systems to
determine the accuracy of predictions. Finally, some research has suggested that air quality hot spots
could be monitored to encourage traffic to avoid these areas during problematic periods.

An ESS is typically deployed along the roadside as part of a network of sensors that report their findings
to a central management system. The ESS data received at the central system is processed to provide
the transportation system manager with intelligence about road weather conditions that can trigger
operator action. For example, high wind conditions might trigger a warning to travelers; if the high wind
conditions are severe or in an area where they constitute a high risk, they might trigger the closing of a
bridge or a section of roadway. Likewise, a network of ESS may also be used to provide the transit
system operator information about conditions that affect the health or safety of transit riders. The
processing logic could be rather simple (e.g., monitoring high winds) or very complex (e.g., predictions of
weather conditions on or near the road). In the latter case, the ESS data would likely serve as one of
many inputs; others might include data from the national weather service and other sources.

However, ESS can also be deployed on a vehicle or a transportable platform (such as on a trailer).
Usually, these ESS are atmospheric sensors or pavement sensors, gathering information about snow and
ice conditions, pavement conditions, and similar data designed to provide the transportation system
manager with information about conditions along a particular section of roadway. The data from mobile
ESS are used to complement those from stationary ESS also deployed along the transportation network.

If the ESS data is shared with other agencies, that agency may be interested in the metadata about the
sensor used to report the data. Such metadata might include the make, model, and version of the device
components, the technology used, and, on a mobile station, the placement of the sensor relative to the
mobile platform. The metadata is needed to indicate how the sensor readings can be used. For example,
the snow depth on the roadway, before and after a snow plow passes, indicates two very different things.
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23

In order to ensure a consistent understanding of the terminology used by this document and the intended
deployment environment, this document defines a reference architecture. The reference architecture is
presented according to the rules defined within the Architecture Reference for Cooperative and Intelligent
Transportation (ARC-IT) and defines the overall context of a deployment.

Reference Physical Architecture [Informative]

While the definition of this reference architecture follows ARC-IT conventions, the content is generally
more detailed and uses terminology that is more consistent with the ESS industry. Section 2.8 provides a
mapping between the reference architecture defined in this section and the elements contained in ARC-
IT.

2.31

The physical view of the reference architecture is depicted in Figure 1 and includes:

Physical View of the Reference Architecture

a) Functional objects that identify high-level functions that are required within the system

b) Physical objects that identify where functions typically reside, and

c) Information flows that provide a very high-level indication of the information that needs to be
exchanged between specific physical objects

Sections 2.3.2 through 2.3.6 provide sample physical architectures that are supported by this reference
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Figure 1: Physical View of Reference Architecture for ESS
2.3.1.1  Functional Objects
2.3.1.11 Management Station

A management station is a functional object that is responsible for allowing the end user (e.g., field
technician, traffic engineer) to configure and manage one or more field devices, including the ESS. The
management station can be located in a center (e.qg., traffic management center, maintenance and
construction management center), ITS roadway equipment (e.qg., traffic signal controller), field
maintenance equipment (e.g., technician’s laptop), or an authorized vehicle (e.g., maintenance and
construction vehicle).

The primary functions of the NTCIP Manager are to allow an end user to perform the following:

a) manage the ESS configuration,
b) control the ESS, and
c) monitor the status of the ESS.

Several management stations may communicate with the same ESS. The user should ensure that only
one management station at a time controls the ESS (e.g., when to activate the pavement treatment
system). Further, all control operations should be carefully coordinated with the management of the
configuration to ensure the intended operation. All management stations may monitor the status
simultaneously.

2.3.1.1.2 ESS Agent

The ESS agent is a functional object that is responsible for continuously monitoring weather, roadway,
surface, water level and air quality conditions. When the ESS agent receives a request from a
management station, it shall immediately respond with its most recent reading for that data. A system
operator should be aware that the nature of some information may require significant time to collect (e.g.,
average wind speed), or may be dated (e.g., information stored in a log); thus, the information contained
in the response may have been collected some time prior to the request being sent. The ESS agent is
often deployed in a device dedicated to ESS functionality, but it can also be deployed as a module in an
advanced transportation controller.

The primary functions of the ESS agent are to perform the following:

a) convert NTCIP data into the appropriate commands to control its components (e.g., pavement
treatment system),

b) manage the ESS to ensure that it operates according to the configuration,

c) manage the resulting NTCIP data (e.g., maintaining logs per configuration), and

d) providing NTCIP data in response to authorized requests.

2.3.1.1.3 Actuator

An actuator converts electrical signals to produce changes in a physical characteristic. Within the context
of this document, the actuator converts electrical signal to control a sprayer of the pavement treatment
equipment.

2.3.1.1.4 Sensor
A sensor can observe one or more physical properties and convert those properties into electrical signals.
2.3.1.2 Physical Objects

ESS deployments typically include a traffic management center (TMC), a remote processing unit (RPU),
and sensors. The deployments are in an environment where the sensors are able to detect properties of
interest to users. Deployments can also include pavement treatment equipment (e.g., chemical tanks,
sprayers, and actuators), other centers, other ITS roadway equipment (e.g., traffic signal controllers,
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weather stations, parking equipment), field maintenance equipment, and/or authorized vehicles. The
following paragraphs describe the primary functions of the physical objects.

2.3.1.21 Camera

A camera is a device that is able to capture still images or video and provide them to the RPU. The
camera is controlled by commands received from the RPU.

2.3.1.2.2 Center

A center is an entity that provides application, management, administrative, and support functions from a
fixed location not in proximity to the road network. Within the ESS community, a central system is
sometimes called a central processing unit or "CPU".

2.3.1.2.3 Remote Processing Unit
The remote processing unit (RPU) is the controller used to host the ESS agent and thereby manage the
collection and reporting of sensor data and/or to manage the treatment of pavement for icing conditions.

The RPU along with its cabinet, sensors, actuators and associated equipment are jointly called the "ESS".
Within Figure 1, these physical objects are depicted as orange (representing field equipment), as this is
the most typical deployment scenario. However, the ESS objects can also be implemented as a part of a
vehicle, in which case, they would more accurately be depicted in a blue shade (indicating vehicle-based
equipment).

2.3.1.2.4 ITS Roadway Equipment

Within the scope of this document, ITS Roadway Equipment is another installation of ITS equipment
along the roadway that interacts with the RPU. The ITS Roadway Equipment could be another ESS, but it
is typically another device that has a need to obtain trustworthy environmental sensor information. For
example, a field-based application might monitor pavement sensors attached to the ESS and command
an associated DMS to display an ice warning when ice is detected.

2.3.1.2.5 Field Maintenance Equipment

Field Maintenance Equipment includes any portable equipment used by field personnel to locally
troubleshoot, initialize, reprogram, and test infrastructure equipment.

2.3.1.2.6 Authorized Vehicles

An authorized vehicle is any specialized service vehicle or equipment that has been explicitly granted
access permissions to the RPU.

2.3.1.2.7 Sensor

A sensor represents any attached device that responds to an environmental physical stimulus and
transmits a resulting impulse.

2.3.1.2.8 Actuator
An actuator represents any attached physical unit that activates a sprayer.
2.3.1.2.9 Pavement Treatment Tank and Sprayers

A system to perform maintenance on a roadway pavement. This may include a snowplow, a device to
dispense materials on the roadway pavement, or a device that stores the materials to be dispensed.

2.3.1.2.10 Environment

The environment represents the environmental conditions of and immediately surrounding the roadway,
including the physical condition of the road surface.
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2.3.1.3 Information Flows

The ESS reference architecture includes the first four information flows that are addressed by this
document; the reference architecture also references seven additional information flows that provide a
broader context.

2.3.1.3.1 camera commands
Information that activates or changes the way in which the camera operates.
2.3.1.3.2 configure ESS

Information that manages the internal operation of the ESS controller and decisions that it makes. For
example, this includes the configuration of user access, configuration of event logging, etc.

2.3.1.3.3 control pavement treatment

Information that manages the operation of the pavement treatment system. For example, this includes the
mixture of chemicals to disperse and the rate of dispersal.

2.3.1.3.4 environmental data

Raw data as obtained from the sensors. For example, the data can be presented as analog readings that
are converted to digital readings by the RPU.

2.3.1.3.5 environmental conditions

Current physical conditions that are being monitored.
2.3.1.3.6 images

The images (still or video) captured by the camera.
2.3.1.3.7 monitor ESS

Information that allows a manager to monitor the status of the ESS as whole. For example, this includes
the status of cabinet doors, the health of the RPU, etc.

2.3.1.3.8 monitor sensors

Information that allows a manager to monitor the status of the sensors connected to the ESS. For
example, this includes the current ambient temperature, current pavement temperature, indications of the
presence of ice, etc.

2.3.1.3.9 pavement sprayer control

Information that activates or changes the way in which the pavement treatment system operates. For
example, this includes commands to control the devices (e.g., valves) that manage the current mixture of
chemicals.

2.3.1.3.10 road network environmental conditions

Environmental information that has been collected, likely from multiple ESS, and processed by a center
and is ready for sharing with other centers that might have interest in the information.

2.3.1.3.11 sprayer control
The activation and deactivation of the sprayer.
2.3.2 Remote Weather Station

Figure 2 depicts a wind sensor that is connected by a low-speed wireless radio link because of its remote
location.

Management Station Wind Sensor
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Figure 2 Remote Weather Station
2.3.3 Air Quality Station

Figure 3 depicts an air quality sensor that is connected by a fiber optic network.

R o]

Management Station Air Quality Sensor

Figure 3 Air Quality Station
2.3.4 Mobile Weather Station

Figure 4 depicts a non-invasive pavement sensor mounted on a maintenance vehicle that is connected by
a cellular data modem because of its mobile characteristics.

Management Station Pavement

Sensor

Maintenance Vehicle
Figure 4 Mobile Weather Station

2.3.5 Sprayer Combined with a Pavement Sensor

Figure 5 depicts an ESS consisting of a RPU, a pavement sensor, and a sprayer. The RPU is connected
to the management station through a separate connection, perhaps a dial-up link.
Pa[nent

Sensor

Management Station

Figure 5 Sprayer Combined with a Pavement Sensor
2.3.6 Pavement Treatment Station

Figure 6 depicts a transportable ESS that only consists of sprayers for pavement treatment.
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Management Station

Figure 6 Transportable Pavement Treatment Station
2.3.7 ESS Characteristics

Some features defined within this document are not applicable to all ESS - some features are dependent
on whether an ESS is permanent, transportable, or mobile.

a) Permanent: The ESS is not designed to be relocated.

b) Transportable: The ESS is capable of being relocated, but its environmental sensors and pavement
treatment devices do not operate while moving.

c) Mobile: The ESS, including environmental sensors and pavement treatment devices, is able to
operate while in motion.

Thus, the user categorizes the ESS according to whether it is permanent, transportable, or mobile prior to
determining which requirements are mandatory for a particular project or ESS.

Note: An agency (procurement) specification may include one to all of these types.
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24 Architectural Needs
2.41 1S0O 26048-1 Needs Included in PRL

All the architectural needs are defined within the user needs of ISO 26048-1. Commonly used
architectural needs within the scope of a ESS are listed in the PRL with references to the relevant ISO
26048-1 clauses and include the following:

a) Authenticate users: allows users to ensure that all communications with the device are with
authenticated users.

b) Control access to data: allows administrators to configure the detailed access privileges that are
granted to each authenticated user.

¢) Monitor failed access to the field device: allows administrators to discover when unauthorized
attempts are made to access the device.

d) Manage the field device: allows a user to remotely reset the controller and configure and
monitor basic information about the field device, such as its:

a. lIdentity,

b. Location,

c. Power source,

d. Default language,

e. Capabilities (e.g., which objects are supported, maximum message size),
f. Status, and

g. Configuration identifier.

e) Receive notification of triggers firing: allows a user to define trigger conditions (e.g., an object
value exceeding a defined value) and to automatically receive an SNMP notification when the
trigger condition occurs.

f) Manage device-specific notifications: allows the user to configure all supported notifications to
use notification channels, which prevent notifications from flooding the communications channel.

g) Log system events: allows the device to record information about internal events that can be of
interest during forensic analysis, e.g., for debugging purposes.

h) Log user-defined data snapshots: allows a user to define trigger conditions (e.g., an object
value exceeding a defined value) and to automatically log information when the trigger condition
occurs.

i) Issuetrigger-based commands: allows a user to define trigger conditions (e.g., an object value
exceeding a defined value) and to automatically send another device an SNMP set request when
the trigger condition occurs. For example, when ice is detected by a pavement sensor, command
an attached gate to close (however, this example is discouraged as a gate closure should include
verification mechanisms not offered by this feature to ensure safe operations).

2.4.2 1SO 26048-1 Needs Omitted Due to Duplication

ISO 26048-1 also defines the following user needs that duplicates user needs that previous versions of
this document had already defined with its own design. These user needs are not included in the PRL to
avoid their inadvertent selection, but they are not prohibited:
a) Monitor ambient air temperature: The body of this document provides a more robust way to
monitor ambient air temperature (2.5.2.1.3) that predates the design contained in ISO 26048-1.
b) Monitor ambient relative humidity: The body of this document provides a more robust way to
monitor ambient relative humidity (2.5.2.1.4) that predates the design contained in ISO 26048-1.

2.4.3 1S0O 26048-1 Needs Not Envisioned for ESS

ISO 26048-1 also defines the following user needs that are not envisioned to be needed for most ESS
deployments. These user needs are not included in the PRL to avoid their inadvertent selection, but they
are not prohibited:
a) Monitor ambient light: allows the device to measure ambient light levels (e.g., from the sun).
b) Record a series of data snapshots: allows a user to define trigger conditions (e.g., an object
value exceeding a defined value) and to automatically log a series of snapshots based on the
trigger condition occurring. For example, when the cabinet door opens, record the cabinet
temperature once a second for 60 seconds.
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¢) Configure a complex device: allows a user to buffer changes to a large number of inter-related
configuration parameters so that the proposed changes can be validated as a whole prior to
ensure a safe configuration prior to implementation.

d) Efficient exchange of data: allows a management station to define dynamic objects that can be
used for frequent requests to reduce communications overhead. For example, rather than
monitoring 15 discreet status objects, the 15 objects can be placed into a dynamic object and
retrieved as a single entity. This can be useful when a management station frequently exchanges
a large number of integer values with the device.

2.4.4 Responsive Device

A transportation system operator needs the device to be responsive to conditions without causing
unnecessary communication delays.

2.5 Features

Section 2.4.4 identifies and describes the various features that may be offered by the ESS. It is divided
into the following:

a) ESS Manager Features
b) Sensor Manager Features
c) Pavement Treatment System Manager Features

2.51 ESS Manager Features

Section 2.5.1 identifies and describes the various features that may be offered by the ESS Manager,
which is the part of the RPU that performs the functionality that may apply to both a Sensor Manager and
a PTS Manager. It consists of the following features:

a) Monitor Mobile Station Data
b) Determine ESS Type

2.5.1.1 Reserved

NOTE—This header was previously used by the "Generic Features" user need, which has been replaced
by the user needs defined in ISO 26048-1. The heading number has been preserved so that all
subsequent user needs have the same heading number as used in previous versions of this document.
NTCIP reserves the right to reassign the meaning of this heading in future versions of this document.

2.5.1.2 Reserved

NOTE—This header was previously used by the "Monitor Door Status" user need, which has been
superseded by the "Monitor cabinet doors" user need defined in ISO 26048-1. The heading number has
been preserved so that all subsequent user needs have the same heading number as used in previous
versions of this document. NTCIP reserves the right to reassign the meaning of this heading in future
versions of this document.

2.5.1.3 Reserved

NOTE—This header was previously used by the "Monitor Power " user need, which has been superseded
by the "Monitor cabinet <mains, battery, generator, solar, and wind> power" user need defined in ISO
26048-1. The heading number has been preserved so that all subsequent user needs have the same
heading number as used in previous versions of this document. NTCIP reserves the right to reassign the
meaning of this heading in future versions of this document.

2.5.1.4 Monitor Mobile Station Data

A transportation system operator may need to monitor the movements of a mobile ESS. This feature
allows the transportation system operator to determine the location where sensor readings are collected.

2.51.5 Determine ESS Type

A transportation system operator needs to be able to determine whether the ESS is staffed or automated
to understand the type of information that is likely to be available from the ESS.
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2.5.1.6 Reserved

NOTE—This header was previously used by the "Monitor the Status of the ESS " user need, which has
been superseded by the "Monitor controller operational status " requirement defined in ISO 26048-1. The
heading number has been preserved so that all subsequent user needs have the same heading number
as used in previous versions of this document. NTCIP reserves the right to reassign the meaning of this
heading in future versions of this document.

2.5.2 Sensor Manager Features

Section 2.5.2 identifies and describes the various features that may be offered by the Sensor Manager:

a) monitor weather conditions

b) monitor pavement

¢) monitor subsurface conditions

d) monitor human readings

€) monitor water levels

f) monitor air quality and biohazards
g) monitor mobile weather profile

2.5.2.1 Monitor Ambient Weather Conditions

This feature focuses on ambient weather conditions that can directly or indirectly affect the transportation
system. It includes the following sub-features.

2.5.21.1 Monitor Atmospheric Pressure

A transportation system operator may need to monitor the atmospheric pressure in the vicinity of the ESS
and to configure and retrieve the metadata for the atmospheric pressure measurements. This feature
allows the operator to monitor changing weather conditions.

2.5.2.1.2 Monitor Winds

A transportation system operator may need to monitor the current wind conditions in the vicinity of the
ESS and to configure and retrieve the metadata for the wind measurements. This feature allows an
operator to determine if vehicle restrictions on a given roadway or bridge span should be issued or to
restrict roadway maintenance (e.g., fire alerts).

2.5.2.1.3 Monitor Air Temperature

A transportation system operator may need to monitor the air temperature at the ESS location and to
configure and retrieve the metadata for the temperature measurement. This feature allows an operator to
dispatch maintenance vehicles to treat roadway pavement or to determine if restrictions or warnings to
travelers should be issued.

2.5.2.1.4 Monitor Relative Humidity

A transportation system operator may need to monitor the relative humidity at the ESS location and to
configure and retrieve the metadata for the humidity measurement. This feature allows an operator to
schedule roadway maintenance activities, such as painting.

2.5.2.1.5 Monitor Precipitation

A transportation system operator may need to monitor the amount, intensity, and type of precipitation in
the vicinity of the ESS and to configure and retrieve the metadata for the precipitation measurements.
This feature allows an operator to determine if restrictions or warnings, such as flood warnings, should be
issued to travelers.

2.5.2.1.6 Monitor Solar Radiation

A transportation system operator may need to monitor the amount of solar radiation in the vicinity of the
ESS and to configure and retrieve the metadata for the solar radiation measurements. This feature allows
an operator to schedule maintenance activities (e.g., based on pavement temperatures) or restrict
roadway usage.
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2.5.2.1.7 Monitor Visibility

A transportation system operator may need to monitor the visibility in the vicinity of the ESS and to
configure and retrieve the metadata for the visibility measurement. This feature allows an operator to
determine if restrictions or warnings are needed, such as lowering vehicle speed limits.

2.5.2.1.8 View Environmental Image

A transportation system operator may need to visually inspect weather or pavement conditions and/or
verify the reported weather or pavement conditions.

2.5.2.1.9 Monitor Dewpoint Temperature

A transportation system operator may need to monitor the dew point temperature. The dew point
temperature can be calculated or measured, and is used to determine the temperature when
condensation (dew, frost) occurs.

2.5.2.2 Monitor Pavement

This feature focuses on monitoring road conditions that may adversely affect transportation operations
immediately or in the near future. It supports the transportation system operator's ability to dispatch
equipment to address the condition or to provide appropriate warnings. It includes the following sub-
features.

2.5.2.2.1 Monitor Pavement Surface Condition

A transportation system operator may need to monitor the pavement surface temperature, the moisture
condition (e.g., dry, wet, snowy, icy, chemical concentration, etc.) on and around the roadway pavement,
and to configure and retrieve the metadata for the roadway pavement sensors. This feature allows an
operator to monitor for readings that could lead to hazardous conditions on the roadway based on
moisture or low roadway friction, and allows maintenance managers to determine, in combination with
other data, if they need to treat the road.

2.5.2.2.2 Monitor Icing Conditions

A transportation system operator may need to monitor whether pavement conditions are likely for ice
formation on the pavement. This includes the ability to monitor pavement temperature (i.e., as opposed to
surface temperature), the depth of any water film on the surface, and the predicted freeze point of the
surface. This feature focuses on the conditions on the roadway pavement surface that can directly or
indirectly lead to icing that affects the transportation system. A transportation system operator may also
need to monitor and configure the RPU parameters. The operator needs to be able to change the
parameters based on the treatment that is being applied on the pavement so accurate readings are
measured by the pavement sensors.

2.5.2.2.3 View Pavement Image

A transportation system operator may need to visually inspect pavement conditions and/or verify the
reported pavement conditions.

2.5.2.3 Monitor Subsurface Conditions

A transportation system operator may need to retrieve the conditions below the road surface and to
retrieve the metadata for the subsurface measurements. The operator may monitor for readings that
could lead to road damage and/or affect the onset of icing conditions (e.g., water level table). It supports
the transportation system operator's ability to dispatch equipment to address the condition or to provide
appropriate warnings.

2.5.2.4 Monitor Human Readings

A transportation system operator may need to retrieve data that was manually observed and entered by
field personnel, such as a snow plow operator. This feature allows an operator to verify measured sensor
readings.
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2.5.2.5 Monitor Water Level

A transportation system operator may need to monitor the depth of water at one or more locations (e.g.,
over a roadway, in a stream, of a reservoir, etc.). This feature allows an operator to issue flood warnings
to travelers, public safety agencies, and maintenance crews, if necessary.

2.5.2.6 Monitor Air Quality and Biohazards

A transportation system operator may need to monitor the current air quality in the vicinity of the ESS and
to retrieve the metadata for the air quality measurements. The operator may monitor these measurements
to determine whether there are airborne biohazards in the vicinity of the ESS. These measurements are
also used to issue ozone alert warnings to the public.

2.5.2.7 Monitor Mobile Weather Profile

A transportation system operator may need to monitor information that is specific to a mobile ESS such
as its position and data collected. This feature allows an operator to log the route of the mobile ESS and
develop an environmental profile that can be used as an input for weather forecast models or
maintenance decision support systems. This may also include odometer readings for verification
purposes.

2.5.3 Pavement Treatment System Manager Features

The following identify and describe the various features that may be offered by a Pavement Treatment
System Manager. It consists of the following features:

a) manage stationary spray system

b) manage mobile spray system

2.5.3.1 Manage Stationary Spray System

A transportation system operator may need to manage the application of anti-icing or de-icing chemicals
through the use of a sprayer connected to a permanent or transportable ESS (e.g., a bridge sprayer).
This feature includes the configuration, monitoring, and activation of a permanent or transportable spray
system. This feature allows pre-treatment of the roadway pavement, either manually or programmatically,
before hazardous conditions occur, or to remedy a hazardous condition.

2.5.3.2 Manage Mobile Spray System

A transportation system operator may need to manage the application of anti-icing or de-icing materials
from a mobile pavement treatment system (e.g., a salt truck). This feature allows an operator to monitor
and change the rate anti-icing or de-icing materials are applied.

2.5.3.3 Monitor Mobile Spray System Profile

A transportation system operator may need to monitor the operation of a mobile pavement treatment
system along a path, by collecting its position and information about the anti-icing or de-icing material
distributed. This feature allows an operator to log the route of the mobile pavement treatment system to
improve road-condition forecasts. This may also include odometer readings for verification purposes.

2.54 Backward Compatibility Needs

SNMPv3 is not backwards compatible with SNMPv1 without the use of a proxy agent. Implementations
that need to exchange data with implementations conforming to NTCIP 1204 versions prior to vO5 should
reference the requirements and design elements of the specific version of NTCIP 1204 to be used.

2.6 Security

A management station needs to have confidence that communications with its devices are always secure
and trustworthy. This requires confidentiality, integrity, and availability.

© 2022 AASHTO / ITE / NEMA Do Not Copy Without Written Permission



NTCIP 1204 v04.26
Page 24

2.6.1 Addressing Vulnerabilities

This document standardizes the objects that can be used by a remote entity to monitor and/or control a
device. Allowing remote operations without providing sufficient information security can have a negative
effect on the communications network and/or the transportation system. In particular, the mis-
configuration of "read-write" and/or "read-create" objects can result in the activation of unauthorized
features or unauthorized changes to the device configuration; these changes can result in potentially
hazardous situations.

Further, even failing to secure exchanges of "read-only" objects can have harmful effects. Providing
unauthorized access to read-only objects can reveal information about the device that can be useful in
conducting a cyber-attack against the device itself, other devices, and potentially the central system.
Likewise, failing to authenticate the source of the read-only data allows a cyber threat actor to potentially
impersonate the device and provide false information to a traffic management center.

The object types defined by this document are intended to be transmitted over SNMPv3. SNMP versions

prior to SNMPv3 do not include adequate security. Prior SNMP versions do not provide any control as to

who on the network is allowed to access and read/change/create/delete objects, even if the network itself
is secure.

2.6.2 Conformant Security Environment

The conformant security environment is highly recommended as it does not allow the device to support
any unsecured protocol.

2.6.3 Consistent Security Environment

It is recognized that during a transition to a secure environment, agencies might need to procure
equipment that conforms to their current unsecured environment while still wanting something that can be
reconfigured to support their future secure environment. This is allowed as long as the device is able to
disable the unsecured protocols. Nonetheless, the fact that consistent devices support unsecured
protocols mean that the unsecured protocols can be enabled and the device is inherently less secure
than a conformant device.

2.7 Operational Policies and Constraints

To provide adequate information security, deployments should:
a) Disable any SNMP versions prior to SNMPv3 as soon as possible,
b) Use the communications stack defined in NTCIP 2301,
¢) Ensure that implementations are properly configured to only give read and/or, write access to
objects based on the legitimate needs of each principal (i.e., user), and
d) Update security keys at intervals that inhibit brute-force attacks from being successful.

2.8 Relationship to the ITS National Architecture [Informative]

This document addresses the following information flows that are defined by the Architecture Reference
for Cooperative and Intelligent Transportation (ARC-IT).

a) air quality sensor control: Data used to configure and control area pollution and air quality sensors.

b) air quality sensor data: Measured air quality data, including measured levels of atmospheric
pollutants including ozone, particulate matter, carbon monoxide, and nitrogen oxides, and operational
status of the sensors.

c) environmental sensors control: Data used to configure and control environmental sensors.

d) environmental sensor coordination: The direct flow of information between field equipment. This
includes configuration and control of environmental sensors and the current road conditions (e.g.,
surface temperature, subsurface temperature, moisture, icing, treatment status) and surface weather
conditions (e.g., air temperature, wind speed, precipitation, visibility) as measured and reported by
fixed and/or mobile environmental sensors. Operational status of the sensors is also included.

e) environmental sensor data: Current road conditions (e.g., surface temperature, subsurface
temperature, moisture, icing, treatment status) and surface weather conditions (e.g., air temperature,
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wind speed, precipitation, visibility) as measured and reported by fixed and/or mobile environmental
sensors. Operational status of the sensors is also included.

field equipment commands: System-level control commands issued to field equipment such as
reset and remote diagnostics.

field equipment configuration settings: Control settings and parameters that are used to configure
field equipment.

field equipment status: Reports from field equipment (sensors, signals, signs, controllers, etc.)
which indicate current operational status.

field equipment status for METR: This flow provides reports from field equipment (sensors, signals,
signs, controllers, etc.) indicating current operational status. Certain METR rules and corresponding
physical rules will rely on the supporting data provided by field equipment. For example, a roadside
sensor can be used to detect precipitation, which might be defined to activate a rule for a lower speed
limit. This infrastructure-sourced supporting data can be provided to a CV RSE and then transmitted
to METR user systems so that they can become aware of current status of rules.

maint and constr vehicle operational data: Data that describes the maintenance and construction
activity performed by the vehicle. Operational data includes materials usage (amount stored and
current application rate), operational state of the maintenance equipment (e.g., blade up/down,
spreader pattern), vehicle safety status, and other measures associated with the operation of a
maintenance, construction, or other special purpose vehicle. Operational data may include basic
operational status of the vehicle equipment or a more precise record of the work performed (e.qg.,
application of crack sealant with precise locations and application characteristics).

maint and constr vehicle system control: Configure and control data that supports remote control
of on-board maintenance and construction vehicle systems and field equipment that is remotely
controlled by the vehicle. For example, the data can be used to adjust material application rates and
spread patterns.

roadway treatment coordination: The direct flow of information between field equipment. This
includes control data for remotely located, automated devices, that treat the road surface (e.g., de-
icing applications) and the current operational status of automated roadway treatment devices.
roadway treatment system control: Control data for remotely located, automated devices that treat
the road surface (e.g. de-icing applications).

roadway treatment system status: Current operational status of automated roadway treatment
devices (e.g., anti-icing systems).

This document is applicable to interfaces defined for the physical objects identified in Table 1 and defined
by ARC-IT:

Table 1 ESS Relevant Physical Objects in ARC-IT

Acronym Physical Object

AQMC Emissions Management Center

CV OBE Commercial Vehicle OBE

FFMC Fleet and Freight Management Center

IRE ITS Roadway Equipment

MCMC Maintenance and Construction Management Center

MCV OBE Maintenance and Construction Vehicle Onboard
Equipment

CV RSE Connected Vehicle Roadside Equipment

STWS Surface Transportation Weather Service

TMC Traffic Management Center

WSS Weather Service System

Other IRE Other ITS Roadside Equipment

Other Vehicles | Other Vehicles

TIC Transportation Information Center

Vehicle Vehicle
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Specifically, this document provides a viable communication solution for the ARC-IT information transfers
(i.e., an information flow from a source to a destination) identified in Table 2

Table 2 ARC-IT Information Transfers Related to This Document

ESS Information Flow | Source | ARC-IT Architecture Flow Destination
configure ESS AQMC | air quality sensor control IRE
monitor sensors IRE air quality sensor data AQMC
configure ESS MCMC | environmental sensors control | IRE
configure ESS MCMC | environmental sensors control | MCV OBE
configure ESS MCV environmental sensors control | IRE

OBE
configure ESS STWS | environmental sensors control | IRE
configure ESS TMC environmental sensors control | IRE
monitor sensors/ IRE environmental sensor Other IRE
monitor ESS coordination
monitor sensors/ Other environmental sensor IRE
monitor ESS IRE coordination
monitor sensors/ IRE environmental sensor data CV RSE
monitor ESS
monitor sensors/ IRE environmental sensor data MCMC
monitor ESS
monitor sensors/ IRE environmental sensor data MCV OBE
monitor ESS
monitor sensors/ IRE environmental sensor data STWS
monitor ESS
monitor sensors/ IRE environmental sensor data T™MC
monitor ESS
monitor sensors/ IRE environmental sensor data WSS
monitor ESS
monitor sensors/ MCV environmental sensor data IRE
monitor ESS OBE
monitor sensors/ MCV environmental sensor data MCMC
monitor ESS OBE
monitor sensors/ MCV maint and constr vehicle MCMC
monitor ESS OBE operational data
configure ESS MCMC | maint and constr vehicle systen MCV OBE

control

control pavement IRE roadway treatment coordination] Other IRE
treatment
control pavement Other roadway treatment coordinatior] IRE
treatment IRE
control pavement MCMC | roadway treatment system cont IRE
treatment
monitor ESS IRE roadway treatment system staty{ MCMC

In addition, this document could theoretically provide a viable communication solution for a portion of the
"vehicle environmental data" information transfer (i.e., from a vehicle to a center, another vehicle, or an
CV RSE). However, this standard is not known to be widely used for this interface and SAE J2945/3 is
more typically used for this interface rather than exchanging the data via SNMP.
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The main user need groups (features), as identified in Section 2, are related to the ARC-IT information
flows as shown in Table 3.

Table 3 User Need Groups and ARC-IT Information Flows

Sectio | User Need Group Information Flow(s)

n

25.1 ESS Manager Features environmental sensors control
air quality sensor control

2.5.2.1 | Monitor weather conditions environmental sensor data

2.5.2.2 | Monitor pavement environmental sensor data

2.5.2.3 | Monitor subsurface conditions environmental sensor data

2.5.2.4 | Monitor human readings environmental sensor data

2.5.2.5 | Monitor water level environmental sensor data

2.5.2.6 | Monitor air quality and biohazards air quality sensor data

2.5.2.7 | Monitor mobile weather profile maint and constr vehicle operational data

2.5.3 Pavement treatment system manager maint and constr vehicle system control
roadway treatment coordination
roadway treatment system control
roadway treatment system status

In addition, the data elements defined by this standard are referenced by SAE J2735 to address portions

of additional information flows in defined in ARC-IT.

a) vehicle environmental data: Data from vehicle safety and convenience systems that can be used to
estimate environmental and infrastructure conditions, including measured air temperature, exterior
light status, wiper status, sun sensor status, rain sensor status, traction control status, anti-lock brake
status, vertical acceleration, and other collected vehicle system status and sensor information. The
collected data is reported along with the location, heading, and time that the data was collected. Both
current data and snapshots of recent events (e.g., traction control or anti-lock brake system
activations) may be reported.
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Section 3
Functional Requirements [Normative]

This section defines the Functional Requirements based on the user needs identified in the Concept of
Operations, as defined in Section 2.This section is intended for all readers, including:

a) transportation operations managers
b) transportation operations personnel
c) transportation engineers

d) system integrators

e) device manufacturers

For the first three categories of readers, Section 3 provides a useful understanding of the details of what
this document requires of an ESS. Section 3.3 may be particularly useful to these readers in preparing
procurement specifications and mapping various rows of this table to the more detailed text contained
elsewhere.

For the last two categories of readers, Section 3 provides a useful understanding of what is required of
equipment conforming to this document. For these readers, Section 3.3 provides a table to document the
capabilities of their implementations.

3.1 Tutorial [Informative]

Section 3 defines the requirements that are intended to fulfill the user needs identified in Section 2. This is
achieved through the development of a Protocol Requirements List (PRL) that traces each user need to
one or more requirements. The details of each requirement are then presented following the PRL. The
requirements are presented in three broad categories as follows:

a) Architectural Requirements: These requirements define the required behavior of the system in
exchanging data across the communications interface, including any restrictions to general
architectural requirements, based upon the architectural needs identified in Section 2.

b) Data Exchange Requirements: These requirements define the required behavior of the system in
exchanging data across the communications interface based on the features identified in Section 2.

c) Supplemental Requirements: These requirements define additional requirements of the system that
are derived from the architectural and/or data exchange requirements, but are not themselves
architectural or data exchange requirements. A given supplemental requirement may relate to
multiple architectural and/or data exchange requirements.

3.2 Scope of the Interface [Informative]

Section 3.2 does not apply in the context of this document.

3.3 Protocol Requirements List (PRL)

The PRL, provided in a table in Section 3.3.3, maps the user needs defined in Section 2 to the
requirements defined in Section 3. The PRL can be used by:

a) a user or specification writer to indicate which requirements are to be implemented in a project-
specific implementation

b) the protocol implementer, as a checklist to reduce the risk of failure to conform to the standard
through oversight

c) the supplier and user, as a detailed indication of the capabilities of the implementation

d) the user, as a basis for initially checking the potential interoperability with another implementation

3.3.1 Notation [Informative]

The following notations and symbols are used to indicate status and conditional status in the PRL within
all NTCIP standards. Not all of these notations and symbols may be used within this document.
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3.3.1.1 Conformance Symbols
The symbols in Table 4 are used to indicate status in the PRL table (Section 3.3.3).

Table 4 Conformance Symbols

Symbol Status
M Mandatory
M.# Support of every item of the group labeled by the same
numeral # required, but only one is active at time
O Optional

O.# (range) Part of an option group. Support of the number of items
indicated by the ‘(range)’ is required from all options
labeled with the same numeral #

C Conditional

N/A Not applicable (i.e., logically impossible in the this
document scope)

X Excluded or prohibited

The O.# (range) notation is used to show a set of selectable options (e.g., 0.2 (1..*) would indicate that
one or more of the option group 2 options is required to be implemented). Two-character combinations
are used for dynamic requirements. In this case, the first character refers to the static (implementation)
status, and the second refers to the dynamic (use); thus "MO" means "mandatory to be implemented,
optional to be used."

3.3.1.2 Conditional Status Notation
The predicate notations in
Table 5 may be used.

Table 5 Conditional Status Notation

Predicate Notation
<predicate>: | This notation introduces a single item that is
conditional on the <predicate>.
<predicate>:: | This notation introduces a table or a group of
tables, all of which are conditional on the
<predicate>.
(predicate) This notation introduces the first occurrence of the
predicate. The feature associated with this
notation is the base feature for all options that
have this predicate in their conformance column.

The <predicate>: notation means that the status following it applies only when the PRL states that the
feature or features identified by the predicate are supported. In the simplest case, <predicate> is the
identifying tag of a single PRL item. The <predicate>:: notation may precede a table or group of tables in
a section. When the group predicate is true then the associated section shall be completed. The symbol
<predicate> also may be a Boolean expression composed of several indices. "AND", "OR", and "NOT"
shall be used to indicate the Boolean logical operations.

The predicates used in this document map to the sections indicated in Table 6.

Table 6 Predicate Mapping to this document Section
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Predicate Traceability (PT) Table
Predicate Reference
ISO 26048-1, 8.4
ISO 26048-1, 8.4.4.1.1
ISO 26048-1, 8.6
ISO 26048-1, 8.4.4.1.2

ISO 26048-1, 8.18.3.1
ISO 26048-1, 8.18.3.3

ISO 26048-1, 8.4.4.1.3

ISO 26048-1, 8.18.3.2
ISO 26048-1, 8.18.3.3

ISO 26048-1, 8.14

ISO 26048-1, 8.7.3.5
ISO 26048-1, 8.2.1.3.1.1
ISO 26048-1, 8.7.3.6

ISO 26048-1, 8.7.3.5
ISO 26048-1, 8.7.3.6

ISO 26048-1, 8.19.3.1
ISO 26048-1, 8.19.3.3
ISO 26048-1, 8.11.4
ISO 26048-1, 8.8.2.2.3
ISO 26048-1, 6.6

ISO 26048-1, 8.18.3.4

3.3.1.3 Support Column Symbols

The support column can be used in a procurement specification to identify the required features for the
given procurement or by an implementer to identify which features have been implemented. In either
case, the user circles the appropriate answer (Yes, No, or N/A) in the support column. See Table 7.

Table 7 Support Column Entries

Entry Identifier

Yes Supported by the implementation.

No Not supported by the implementation.
NA Not applicable for the implementation.

3.3.2 Instructions for Completing the PRL [Informative]

In the Support column, each response shall be selected either from the indicated set of responses (for
example: Yes / No / N/A), or it shall reference additional items that are to be attached.

If a conditional requirement is inapplicable, use the Not Applicable (N/A) choice. If a mandatory
requirement is not satisfied, exception information shall be supplied by entering a reference Xi, where i is
a unique identifier, to an accompanying rationale for the non-conformance. When the status is expressed
as a two-character combination, the response shall address each element of the requirement; e.g., for the
requirement "mo," the possible compliant responses are "yy" or "yn."

Note: An agency specification can allow for flexibility in a deliverable by leaving the selection in
the 'Support’ column blank for a given row. For example, an agency specification could allow for
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either passive or active icing detectors by selecting ‘Yes’ on PRL line 2.5.2.2.2, and leaving PRL
lines 3.5.2.3.3.2 and 3.5.2.3.3.3 blank.

3.3.2.1 Conformance Definition

To claim "Conformance" to this document, the vendor shall minimally fulfill the mandatory requirements
as identified in the PRL table (see Section 3.3.3). In addition, a conformant device may offer additional
(optional) features, as long as they are conformant with the requirements of this document and the
standards it references.

Note: The reader and user of this document is advised that 'conformance’ to this document
should not be confused with ‘compliance’ to a specification. this document is as broad as possible
to allow a very simple ESS implementation to be ‘conformant’ to this document. An agency
specification needs to identify the requirements of a particular project and needs to require the
support of those requirements. A specification writer is advised to match the requirements of a
project with the corresponding standardized requirements defined in this document to achieve
interoperability. This means that functions and requirements defined as 'optional’ in this document
might need to be selected in a specification (in effect made 'mandatory’ for the project-specific
specification).

A conformant device may offer additional (optional) features, as long as they are conformant with the
requirements of this document and the standards it references (e.g., NTCIP 2301). For example a device
may also support data that has not been defined by this document; however, when exchanged via NTCIP
2301, the data shall be properly registered with a valid OBJECT IDENTIFIER under the Global ISO
Naming Tree.

Note: Off-the-shelf interoperability and interchangeability can only be obtained through well
documented features broadly supported by the industry as a whole. Designing a system that uses
features not defined in a standard or not typically deployed in combination with one another
inhibits the goals of interoperability and interchangeability, especially if the documentation of
these features is not available for distribution to system integrators. Standards allow the use of
additional features to support innovation, which is constantly needed within the industry; but users
should be aware of the risks involved with using such features.

3.3.3 Protocol Requirements List (PRL) Table

In addition to the Conformance column and the Support column, which were discussed in Section 3.3.1,
the additional columns in the PRL table are the User Need ID and User Need columns, FR ID and
Functional Requirement columns and the Additional Specifications column.

a) User Need ID - the number assigned to the user need statement. The user needs are defined within
Section 2 and the PRL is based upon the user need sections within that Section.

b) User Need — a short descriptive title identifying the user need.

c) FRID —the number assigned to the functional requirement statement. The requirements are defined
within Section 3 and the PRL references the traces from user needs to these requirements.

d) Functional Requirement — a short descriptive title identifying the functional requirement.

e) Conformance — Indicates if the implementation is mandatory or optional.

f)  Support — user selectable to indicate yes or no to the requirement.

g) Additional Specifications - identifies other requirements that are required tobe satisfied, including user
selectable range values. The "Additional Specifications" column may (and should) be used by a
procurement specification to provide additional notes and requirements for the product to be procured
or may be used by an implementer to provide any additional details about the implementation. In
some cases, default text already exists in this field, which the user should complete to fully specify the
equipment. However, additional text can be added to this field as needed to fully specify a feature.
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Table 8 Protocol Requirements List
User Need . . Support /
Section ﬁ::crj Fﬁusrigtgr’n RZUE?::&?:;,[ Conformance Project Additional Project Requirements
Number q Requirement

2.3.7. a) Permanent 0.1(1) Yes / No
2.3.7. b) Transportable 0.1(1) Yes / No
2.3.7. ¢) Mobile 0.1(1) Yes / No

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

See I1SO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)
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User Need . . Support /
Section ﬁ::crj FEIJS:]%%?" RIZU ﬁ?:;?:;t Conformance Project Additional Project Requirements
Number q Requirement

| |seels026048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)
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User Need . . Support /
Section ﬁ::crj Fﬁusrigtgr’n RIZU ?J(i:::a?:r!t Conformance Project Additional Project Requirements
Number q Requirement

| |seels026048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

_- See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)

See ISO 26048-1 NTFT and FTRT tables (available at https://standards.iso.org/iso/ts/26048/-1/ed-1/en/)
2.4.4 Responsive Device M Yes
Maximum
§3.6.29 Response Time for |M Yes
Requests
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User Need : : Support /
Section ksl PR GEEier Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Maximum
§83.6.30 Transmission Start |Natifications:M Yes / NA
Time
2.5 Features M Yes
2.5.1 ESS Manager Features M Yes
2.5.1.4 Monitor Mobile Station Data Mobile:M Yes / NA
Retrieve Mobile
83.5.1.2 ESS Movement M ves
2.5.1.5 Determine ESS Type M Yes
Retrieve ESS Type
§35.1.1 of Station M Yes
2.5.2 Sensor Manager Features 0.3 (1..%) Yes / No
2.5.2.1 Monitor Ambient Weather Conditions 0.4 (1..%) Yes / No
2.5.2.1.1 Monitor Atmospheric Pressure 0.5(1..% Yes/No
Determine Number
83.5.2.1.1 of Atmospheric M Yes
Pressure Sensors
Retrieve
83.5.2.15 Atmospheric M Yes
Pressure
Required Number of The ESS shall support at least
83.6.1 Atmospheric M Yes (1..255:Default =1) atmospheric
Pressure Sensors pressure sensors.
Retrieve
83.5.2.1.2 Atmospheric
(PressLoc) Pressure Sensor ves/No
Location
Retrieve
§3.5.2.1.3 Atmospheric o Yes / No
Pressure Sensor
Identity
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User Need : : Support /
Section B AR SEELI Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Configure
§3.5.2.1.4 Atmospheric PressLoc:O Yes/No / NA
Pressure Sensor
Location
2.5.2.1.2 Monitor Winds 0.5 (1..% Yes / No
Determine Number
§3.5.2.2.1 of Wind Sensors M Yes
83.5.2.2.5 Retrieve Wind Data (M Yes
Required Number of The ESS shall support at least
83.6.2 Wind Sensors M Yes (1..255:Default=1) wind sensors.
83.5.2.2.2 Retrieve Wind
(windLoc) Sensor Location o Yes/No
Retrieve Wind
83.5.2.2.3 Sensor Identity @) Yes / No
§3.5.2.2.4 Configure Wind =1, o) 6c:0 Yes / No / NA
Sensor Location
2.5.2.1.3 Monitor Air Temperature 0.5 (1..% Yes / No
Determine Number
83.5.2.3.1 of Temperature M Yes
Sensors
§3.5.2.3.5 Retrieve Alr M Yes
Temperature
Retrieve Daily
§3.5.2.3.6 Minimum and M Yes
Maximum
Temperature
Required Number of The ESS shall support at least
83.6.3 Temperature M Yes (1..255:Default=1) temperature
Sensors Sensors.
Retrieve
83.5.2.3.2
(TempLoc) Temperature @) Yes / No

Sensor Location
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User Need : : Support /
Section e AR SEiE? Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Retrieve
§3.5.2.3.3 Temperature ) Yes / No
Sensor Identity
Configure
8§3.5.2.34 Temperature TempLoc:O Yes/No/NA
Sensor Location
2.5.2.1.4 Monitor Relative Humidity 0.5(1..% Yes / No
Determine Number
83.5.24.1 of Humidity Sensors ves
Configure Humidity
83.5.2.4.5 Sensor M Yes
Temperature
Retrieve Relative
83.5.2.4.6 Humidity M Yes
§3.6.4 Required Number of M Yes The ESS shall support at least
o Humidity Sensors (1..255:Default=1) humidity sensors.
83.5.2.4.2 Retrieve Humidity
(HumidityLoc) Sensor Location o ves/No
Retrieve Humidity
§3.5.2.4.3 Sensor Identity O Yes / No
§3.5.244 gonﬂgure H“.”"“d'ty HumidityLoc:O Yes/No/NA
ensor Location
2.5.2.1.5 Monitor Precipitation 0.5 (1..% Yes / No
Determine Number
§3.5.25.1 of Precipitation M Yes
Sensors
Retrieve
83.5.2.5.6 Precipitation M Yes
Presence
Required Number of The ESS shall support at least
83.6.5 Precipitation M Yes (1..255:Default=1) precipitation
Sensors Sensors.
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User Need : : Support /
Section e AR SEiE? Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement

Retrieve

§3'5'2'5'2 Precipitation Sensor|O Yes / No

(PrecipLoc) ;
Location
Retrieve

83.5.2.5.3 Precipitation Sensor|O Yes / No
Identity

83.5.2.5.7 Retrieve

(precipRates) Precipitation Rates o Yes/No
Retrieve

83.52.5.8 Precipitation Totals ves/No
Retrieve

(§P3rlgc?.%2rio d) Precipitation Totals |O Yes / No

P - User Specified

Retrieve

83.5.2.5.10 Precipitation Type @) Yes / No
Retrieve

83.5.2.12.2 Precipitation @] Yes / No
Situation
Configure

8§3.5.254 Precipitation Sensor |PrecipLoc:O Yes/No/NA
Location
Configure
Precipitation Total . .

83.5.2.5.5 User-Specified PrecipPeriod:M Yes / NA
Period

ISO 26048-1, UTC clock precipRates:M Yes / NA

88.2.1

2.5.2.1.6 Monitor Solar Radiation 0.5 (1..% Yes / No

Determine Number

83.5.2.6.1 of Solar Radiation |M Yes
Sensors
Retrieve Solar

83.5.2.6.5 Radiation M Yes
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User Need : : Support /
Section e AR SEiE? Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Required Number of The ESS shall support at least
83.6.6 Solar Radiation M Yes (1..255:Default=1) solar radiation
Sensors Sensors.
Retrieve Solar
83.5.2.6.2 Radiation Sensor |O Yes / No
(radLoc) .
Location
Retrieve Solar
83.5.2.6.3 Radiation Sensor |0 Yes / No
Identity
Configure Solar
83.5.2.6.4 Radiation Sensor  [radLoc:O Yes/No/NA
Location
2.5.2.1.7 Monitor Visibility 0.5(1..% Yes/No
Determine Number
835271 of Visibility Sensors ves
83.5.2.7.5 Retrieve Visibility (M Yes
§3.6.7 Required Number of M Yes The ESS shall support at least
o Visibility Sensors (1..255:Default=1) visibility sensors.
§3.5.2.7.2 (VisLoc)| REUieve Visibility Yes / No
Sensor Location
Retrieve Visibility
83.5.2.7.3 Sensor Identity @) Yes / No
§3.5.2.12.3 aeneve Visibility | Yes / No
ituation
§3.5.2.12.4 Retrieve Cloud Yes / No
Situation
§3.5.2.7.4 Configure Visibility |, ;) 0.0 Yes / No / NA
Sensor Location
2.5.2.1.8 View Environmental Image @) Yes / No
Determine Number
§3.5.2.13.1 of Snapshot M Yes
Cameras
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ey NEE User FR Section Functional SIEON:
Section ; Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Retrieve Snapshot
§3.5.2.13.2 Camera Identity M Yes
Determine
§3.5.2.13.3 Supported Image M Yes
Storage Formats
§3.5.2.13.4 Configure Snapshot|, Yes
Camera
Retrieve Snapshot
83.5.2.13.5 Camera M Yes
Configuration
§3.5.2.13.6 Capture Snapshot |, Yes
Image
§3.5.2.13.7 Retrieve Snapshot (M Yes
§3.5.2.13.8 Delete Snapshot (M Yes
§3.6.23 Required Number of M Yes The ES.S shall fupport at least
Snapshot Cameras (1..255:Default=1) snapshot cameras.
Support Camera
§3.6.24 Number in Filename © ves/No
Support Sequence
83.6.25 Number in Filename ves/No
§3.6.26 Support Datein |, Yes / No
Filename
§3.6.27 Support Timein | Yes / No
Filename
§3.6.28 Support Long o Yes / No
Filenames
2.5.2.1.9 Monitor Dewpoint Temperature 0.5 (1..% Yes / No
Configure Humidity
83.5.2.4.5 Sensor M Yes
Temperature
Retrieve Relative
83.5.2.4.6 Humidity M Yes
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User Need : : Support /
Section User ER Section Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
2.5.2.2 Monitor Pavement 0.4 (1..%) Yes / No
2.5.2.2.1 Monitor Pavement Surface Condition M Yes
Determine Number
83.5.2.8.1 of Pavement M Yes
Sensors
Retrieve Pavement
83.5.2.8.10 Surface M Yes
Temperature
§3.6.8 Required Number of M Yes The ESS shall support at least
e Pavement Sensors (1..255:Default=1) pavement sensors.
83.5.2.8.2 Retrieve Pavement
(PavelLoc) Sensor Location o Yes/No
Retrieve Pavement
83.5.2.8.3 Sensor Identity O Yes / No
83.5.2.8.5 Retrieve Pavement
(PaveSensor) Sensor Metadata o Yes/No
Retrieve Pavement
§3.5.2.8.11 Surface Condition Yes/No
Retrieve Forecasted
83.5.2.8.12 Pavement Surface |O Yes / No
Condition
Retrieve Roadway
§35.28.13 Friction Coefficient o Yes/No
Retrieve Adjacent
83.5.2.8.15 Snow Depth @] Yes / No
Retrieve Roadway
§3.5.2.8.16 Snow Depth O Yes / No
§3.5.2.8.17 Retrieve Roadway | Yes / No
Ice Thickness
Configure
83.5.2.8.6 Pavement Sensor |PaveSensor:O Yes / No / NA
Metadata
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Usenieed FR Section Functional Support/
Section - Conformance Project Additional Project Requirements
Number Requirement :
Number Requirement
Configure
83.5.2.8.4 Pavement Sensor |PavelLoc:O Yes / No / NA
Location
2.5.2.2.2 Monitor Icing Conditions O Yes / No
Determine Number
83.5.2.8.1 of Pavement M Yes
Sensors
83.5.2.8.2 Retrieve Pavement
(PaveLoc) Sensor Location o ves/No
Retrieve Pavement
83.5.2.8.3 Sensor Identity O Yes / No
83.5.2.8.5 Retrieve Pavement
(PaveSensor) Sensor Metadata o ves/No
§3.5.2.8.14 Retrieve Ice 0 Yes / No
Percentage
§3.6.9 Active Pavement
(ActivelceDetect) |Treatment Sensors 0.7 ves/No
83.6.10 Passive Pavement
(PassivelceDetect)|Treatment Sensors 0.7 Yes/No
Configure
83.5.2.8.6 Pavement Sensor |PaveSensor:O Yes/ No/NA
Metadata
Configure
83.5.2.8.4 Pavement Sensor |PavelLoc:O Yes / No/ NA
Location
83.5.2.8.7 Configure _Passwg PassivelceDetect:M |Yes / NA
Ice Detection Logic
Retrieve Conditions
83.5.2.8.9 for Fr_eezmg PassivelceDetect:M |Yes / NA
Algorithms -
Passive
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User Need : : Support /
Section e AR SEiE? Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Retrieve Conditions
§3.5.2.8.8 for Freezing ActivelceDetect:M  |Yes / NA
Algorithms - Active
2.5.2.2.3 View Pavement Image O Yes / No
Determine Number
8§3.5.2.13.1 of Snapshot M Yes
Cameras
Retrieve Snapshot
§3.5.2.13.2 Camera Identity M Yes
Determine
§3.5.2.13.3 Supported Image  |M Yes
Storage Formats
§3.5.2.13.4 Configure Snapshot M Yes
Camera
Retrieve Snapshot
83.5.2.13.5 Camera M Yes
Configuration
§3.5.2.13.6 Capture Snapshot |, Yes
Image
83.5.2.13.7 Retrieve Snapshot (M Yes
§3.5.2.13.8 Delete Snapshot (M Yes
Required Number of The ESS shall support at least
83.6.23 Snapshot Cameras M Yes (1..255:Default=1) snapshot cameras.
Support Camera
§3.6.24 Number in Filename o Yes/No
§3.6.25 Support Seqpence o] Yes / No
Number in Filename
§3.6.26 SupportDatein | Yes / No
Filename
§3.6.27 Support Timein | Yes /No
Filename
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User Need : : Support /
Section User AR ST Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
§3.6.28 Support Long 0 Yes / No
Filenames
2.5.2.3 Monitor Subsurface Conditions 0.4 (1.% Yes / No
Determine Number
83.5.2.9.1 of Subsurface M Yes
Sensors
Retrieve
83.5.2.9.7 Subsurface M Yes
Temperature
. The ESS shall support at least
§3.6.11 Required Number of Yes (1..255:Default=1) subsurface
Subsurface Sensors
Sensors.
Retrieve
§3.5.2.9.2 Subsurface Sensor [O Yes / No
(SubSurfLoc) X
Location
Retrieve
83.5.2.9.3 Subsurface Sensor |O Yes / No
Identity
Retrieve
§3.5.2.9.5 Subsurface Sensor [O Yes / No
(SubSurface)
Metadata
Retrieve
83.5.2.9.8 Subsurface 0] Yes / No
Moisture
Configure
83.5.2.9.6 Subsurface Sensor [SubSurface:O Yes / No/NA
Metadata
Configure
83.5.2.9.4 Subsurface Sensor |SubSurfLoc:O Yes / No/ NA
Location
2.5.2.4 Monitor Human Readings 0.4 (1.% Yes / No
Retrieve Wind
83.5.2.12.1 Situation M Yes
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User Need : : Support /
Section User AR ST Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Retrieve
§3.5.2.12.2 Precipitation M Yes
Situation
§3.5.2.12.3 Retrieve Visibility |y, Yes
Situation
Retrieve Cloud
8§3.5.2.12.4 Situation M Yes
§3.5.2.12.5 Retrieve Ground | Yes / No
State
§3.5.2.12.6 Retrieve Pavement |, Yes /No
State
2.5.2.5 Monitor Water Level 0.4 (1.% Yes / No
Determine Number
83.5.2.11.1 of Water Level M Yes
Sensors
§3.5.2.11.7 Retrieve Water |y Yes
Level
Required Number of The ESS shall support at least
§3.6.22 Water Level M Yes (1..255:Default=1) water level
Sensors Sensors.
Retrieve Water
§3.5.2.11.2 Level Sensor O Yes / No
(WaterLoc) L .
ocation
Retrieve Water
83.5.2.11.3 Level Sensor 0] Yes / No
Identity
Retrieve Water
§3.5.2.11.4 Level Sensor O Yes / No
(WaterWarn) .
Warning Level
Configure Water
83.5.2.11.5 Level Sensor WaterLoc:O Yes / No/ NA
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DEED e User FR Section Functional SIEON:
Section ; Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Configure Water
§3.5.2.11.6 Level Sensor WaterWarn:O Yes/No/NA
Warning Level
2.5.2.6 Monitor Air Quality and Biohazards 0.4 (1.% Yes / No
Determine Number
§3.5.2.10.1 of Air Quality M Yes
Sensors
§3.5.2.10.2 Retrieve Air Quality
(AQLoc) Sensor Location o ves/No
§3.5.2.10.3 Retrieve Air Quality |, Yes /No
Sensor ldentity
Retrieve Carbon
§3.5.2.10.5 (CO) Monoxide Reading 0.8 Yes / No
Retrieve Nitrogen
§3.5.2.10.6 (NO2) Dioxide Reading 0.8 Yes / No
Retrieve Sulfur
83.5.2.10.7 (S0O2) Dioxide Reading 0.8 Yes / No
Retrieve Small
83.5.2.10.8 Particulate Matter |O.8 Yes / No
(PM10) .
Reading
83.5.2.10.9 Retrieve Particulate
(PM2.5) Matter 2.5 Reading 08 ves/No
§3.5.2.10.10 Retrieve Particulate
(PM1.0) Matter 1.0 Reading |O-8 ves/No
§3.5.2.10.11 Retrieve Carbon
(CO2) Dioxide Reading  |[©8 ves/No
Retrieve Nitric
§3.5.2.10.12 (NO) Oxide Reading 0.8 Yes / No
§3.5.2.10.13 (03) |Relieve Ozone |4 g Yes / No
Reading
Configure Air
§3.5.2.10.4 Quality Sensor AQLoc:O Yes / No/NA
Location
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User Need : : Support /
Section e AR SEiE? Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Required Number of The ESS shall support at least
§3.6.13 Carbon Monoxide |CO:M Yes / NA (Default=1) carbon monoxide
Sensors Sensors.
Required Number of
L ) The ESS shall support at least
§3.6.14 Carbon Dioxide coz2:M Yes / NA (Default=1) carbon dioxide sensors.
Sensors
Required Number of
N . ) The ESS shall support at least
§3.6.15 glltnc Oxide NO:M Yes/NA (Default=1) nitric oxide sensors.
ensors
Required Number of
) L ) The ESS shall support at least
83.6.16 Nitrogen Dioxide NO2:M Yes / NA (Default=1) nitrogen dioxide sensors.
Sensors
Required Number of
s . The ESS shall support at least
83.6.17 Sulfur Dioxide SO2:M Yes / NA (Default=1) sulfur dioxide sensors,
Sensors
§3.6.18 Required Number of 03'M ves / NA The ESS shall support at least
o Ozone Sensors ' (Default=1) ozone sensors.
g;%?llra%)'\lumber of The ESS shall support at least
83.6.19 . PM10:M Yes/ NA (Default=1) small particulate matter
Particulate Matter
Sensors.
Sensors
gr(?gljllr(ezdsl;lumber of The ESS shall support at least
§3.6.20 Particulate Matter PM2.5:M Yes / NA (Default=1) particulate matter (2.5)
Sensors.
Sensors
Required Number of
Small (1.0) )
83.6.21 Particulate Matter PM1.0:M Yes / NA
Sensors
2.5.2.7 Monitor Mobile Weather Profile O Yes/ No
ISO 26048-1, §8.1 |Action feature M Yes
ISO 26048-1,
§8.2.1 UTC clock Yes
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User Need : : Support /
Section B AR SEELI Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
ISO 26048-1, §8.4 |C0nditional trigger |y, Yes
feature
ISO 26048-1, §8.7 [PYnamic object Yes
feature
ISO 26048-1, .
§8.10 Logging feature M Yes
Retrieve Mobile
83.5.1.2 ESS Movement M ves
2.5.3 Pavement Treatment System Manager Features |0.3 (1..%) Yes / No
2.5.3.1 Manage Stationary Spray System Mobile:X; O Yes / NA
Retrieve Stationary
Pavement
83.5.3.1.4 Treatment M Yes
Configuration
Configure
§3.5.3.1.5 Stationary M Yes
Pavement
Treatment System
Retrieve Pavement
83.53.21 Treatment Status M ves
Retrieve PTS
83.5.3.2.2 Operational Mode M Yes
Set PTS
83.53.4.1 Operational Mode M Yes
Manually Activate
83.5.3.4.2 PTS Sprayer M Yes
Required Number of The ESS shall support at least
83.6.12 Pavement M Yes pavement treatment products
Treatment Products (1..255).
Retrieve Pavement
8§3.5.3.1.1
(PtsLoc) Treatment System |O Yes / No

Location
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User Need : : Support /
Section B AR SEELI Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
Retrieve Pavement
§3.5.3.1.2 Treatment System [O Yes / No
Identity
Configure
Pavement .
83.5.3.1.3 Treatment System PtsLoc:O Yes/No/NA
Location
2.5.3.2 Manage Mobile Spray System Mobile:O Yes /No/NA
Retrieve Pavement
83.53.21 Treatment Status M ves
Retrieve Pavement
§3.5.3.1.1 Treatment System |O Yes / No
(PtsLoc) )
Location
Retrieve Pavement
83.5.3.1.2 Treatment System |O Yes / No
Identity
Configure Mobile
83.5.3.1.6 Pavement @] Yes / No
Treatment System
Retrieve Mobile
§3.5.3.1.7 Pavement o Yes / No
Treatment
Configuration
Retrieve PTS
83.5.3.2.2 Operational Mode o] Yes / No
Set PTS
§3.5.3.4.1 Operational Mode @) Yes / No
Manually Activate
83.5.3.4.2 PTS Sprayer o] Yes / No
Configure
§3.5.3.1.3 Pavement PtsLoc:O Yes / No/ NA
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User Need : : Support /
Section B AR SEELI Fun(;t|onal Conformance Project Additional Project Requirements
Need Number Requirement :
Number Requirement
2.5.3.3 Monitor Mobile Spray System Profile @) Yes / No
ISO 26048-1, §8.1 |Action feature M Yes
ISO 26048-1,
§8.2.1 UTC clock M Yes
ISO 26048-1, §8.4 |COnditional trigger |, Yes
feature
ISO 26048-1, §8.7 [PYnamic object ) Yes
feature
ISO 26048-1, .
§8.10 Logging feature M Yes
Retrieve Mobile
83.5.1.2 ESS Movement M Yes
2.6 Security M Yes
2.6.2 Conformant Security Environment 0.6 (1..%) Yes/No
Conformant
83.7.1 Security M Yes
2.6.3 Consistent Security Environment 0.6 (1..%) Yes / No
|§3.7.2 Consistent Security |M Yes

NOTE—The user needs for "Monitor ambient air temperature” and , "Monitor ambient relative humidity" as defined in ISO 26048-1, 6.5.1.1 and
6.5.1.2 are duplicative of "Monitor Air Temperature" and "Monitor Relative Humidity" as defined in 2.5.2.1.3 and 2.5.2.1.4 of this document and are
therefore omitted from the PRL, but support for these user needs is not prohibited. They are omitted from the PRL to reduce the risk of
procurements inadvertently selecting features that are expected to be uncommon and which could significantly increase procurement costs by
specifying an unnecessary feature that is not widely used.

NOTE—The user needs for "Monitor ambient light", "Record a series of data snapshots"”, "Configure a complex device", and "Efficient exchange of
data", as defined in ISO 26048-1, 6.5.1.3, 6.10, 6.12 and 6.13, are not envisioned to be needed for ESS deployments, but support for these user
needs is not prohibited. They are omitted from the PRL to reduce the risk of procurements inadvertently selecting features that are expected to be
uncommon and which could significantly increase procurement costs by specifying an unnecessary feature that is not widely used.
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34 Common Requirements

Requirements that are common to many NTCIP device types are provided in ISO 26048-1.
3.5 Data Exchange and Operational Environment Requirements

Data exchange requirements for ESS follow.

3.5.1 ESS Manager Requirements

Requirements for managing an ESS Manager follow.

3.5.1.1 Retrieve ESS Type of Station

Upon request, the ESS shall indicate whether the sensor data is collected automatically (e.g.,
electronically or mechanically) or manually (e.g., human readings). If the ESS is a hybrid station (i.e., data
is collected electronically/mechanically and by humans), the field device should include two SNMP
contexts, one to report automatic readings and the other to report human readings;

3.5.1.2 Retrieve Mobile ESS Movement

Upon request, the ESS shall return the following information about the mobile platform:
a) the location of the mobile platform;

b) the speed of the mobile platform;

c) the bearing (direction of travel) of the mobile platform; and

d) the distance traveled.

3.5.2 Sensor Manager Requirements

Requirements for managing a Sensor Manager follow.

3.5.2.1 Manage Atmospheric Pressure Sensors

Requirements for managing atmospheric pressure sensors follow.

3.5.2.1.1 Determine Number of Atmospheric Pressure Sensors

Upon request, the ESS shall return the number of atmospheric pressure sensors connected to the ESS.
3.5.2.1.2 Retrieve Atmospheric Pressure Sensor Location

Upon request, the ESS shall return the following information for the specified atmospheric pressure
Sensor:

a) atextual description of the sensor location;

b) the relative height of the sensor from the reference height of the ESS; and

c) the location of the sensor.

3.5.2.1.3 Retrieve Atmospheric Pressure Sensor Ildentity

Upon request, the ESS shall return the entity identifier of the specified atmospheric pressure sensor so
that the management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.1.4 Configure Atmospheric Pressure Sensor Location

Upon request, the ESS shall store the following information for a specified atmospheric pressure sensor:
a) a textual description of the sensor location;

b) relative height of the sensor from the reference height of the ESS; and

c) the location of the sensor.

3.5.2.1.5 Retrieve Atmospheric Pressure

Upon request, the ESS shall return the current atmospheric pressure reported by the specified
atmospheric pressure sensor.
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3.5.2.2 Manage Wind Sensors

Requirements for managing wind sensors follow.

3.5.2.21 Determine Number of Wind Sensors

Upon request, the ESS shall return the number of wind sensors connected to the ESS.
3.5.2.2.2 Retrieve Wind Sensor Location

Upon request, the ESS shall return the following information for the specified wind sensor:
a) a textual description of the sensor location;

b) the relative height of the sensor from the reference height of the ESS; and

c) the location of the sensor.

3.5.2.2.3 Retrieve Wind Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified wind sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.2.4 Configure Wind Sensor Location

Upon request, the ESS shall store the following information for a specified wind sensor:
a) atextual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.2.5 Retrieve Wind Data

Upon request, the ESS shall return the following information reported by the specified wind sensor:

a) the average wind speed recorded during the 2 minutes preceding the observation;

b) the average direction the wind is blowing from, as recorded during the 2 minutes preceding the
observation;

¢) the current wind speed;

d) the current direction the wind is blowing from;

e) the maximum wind gust recorded during the 10 minutes preceding the observation;

f) the direction of the maximum wind gust recorded during the 10 minutes preceding the observation;
and

g) the assessment of the wind situation as defined by the Beaufort Wind Scale in the Glossary of
Meteorology. Valid values are: other, unknown, calm, light breeze, moderate breeze, strong breeze,
gale, moderate gale, strong gale, storm winds, hurricane force winds, and gusty winds.

3.5.2.3 Manage Temperature Sensors

Requirements for managing temperature sensors follow.

3.5.2.3.1 Determine Number of Temperature Sensors

Upon request, the ESS shall return the number of air temperature sensors connected to the ESS.
3.5.2.3.2 Retrieve Temperature Sensor Location

Upon request, the ESS shall return the following information for the specified air temperature sensor:
a) atextual description of the air temperature sensor location;

b) the relative height of the air temperature sensor to the reference height of the ESS; and

c) the location of the air temperature sensor.

3.5.2.3.3 Retrieve Temperature Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified temperature sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.3.4 Configure Temperature Sensor Location

Upon request, the ESS shall store the following information for a specified air temperature sensor:
a) a textual description of the sensor location;
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b) the relative height of the sensor to the reference height of the ESS; and
c) the location of the sensor.
3.56.2.3.5 Retrieve Air Temperature

Upon request, the ESS shall return the current ambient air temperature reported by the specified air
temperature sensor.

3.5.2.3.6 Retrieve Daily Minimum and Maximum Temperature

Upon request, the ESS shall return the minimum and maximum ambient air temperatures that have been
recorded within the previous 24 hours.

3.5.2.4 Manage Humidity Sensors

Requirements for managing humidity sensors follow.

3.5.2.41 Determine Number of Humidity Sensors

Upon request, the ESS shall return the number of humidity sensors connected to the ESS.
3.5.2.4.2 Retrieve Humidity Sensor Location

Upon request, the ESS shall return the following information for the specified humidity sensor:
a) atextual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.4.3 Retrieve Humidity Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified humidity sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.44 Configure Humidity Sensor Location

Upon request, the ESS shall store following information for a specified humidity sensor:
a) a textual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.4.5 Configure Humidity Sensor Temperature

Upon request, the ESS shall store the index of the temperature sensor that is associated with the
specified humidity sensor.

3.5.2.4.6 Retrieve Relative Humidity

Upon request, the ESS shall return the following information reported by the specified humidity sensor:
a) the current humidity;

b) the temperature sensor associated with this humidity sensor;

c) the derived ambient dewpoint temperature; and

d) the derived ambient wet-bulb temperature.

3.5.2.5 Manage Precipitation Sensors

Requirements for managing precipitation sensors follow.

3.5.2.5.1 Determine Number of Precipitation Sensors

Upon request, the ESS shall return the number of precipitation sensors connected to the ESS.
3.56.2.5.2 Retrieve Precipitation Sensor Location

Upon request, the ESS shall the following information for the specified precipitation sensor:
a) a textual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.
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3.5.2.5.3 Retrieve Precipitation Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified precipitation sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.5.4 Configure Precipitation Sensor Location

Upon request, the ESS shall store the following information for a specified precipitation sensor:
a) a textual description of the sensor location;

b) relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.5.5 Configure Precipitation Total User-Specified Period

Upon request, the ESS shall store the user-specified collection period for measuring the precipitation
recorded for a specified precipitation sensor.

3.56.2.5.6 Retrieve Precipitation Presence

Upon request, the ESS shall return an indication of whether precipitation is currently being reported by
the specified precipitation sensor. Precipitation is detected if 0.01 inches of liquid water equivalent is
detected.

3.56.2.5.7 Retrieve Precipitation Rates

Upon request, the ESS shall return the the following information reported by the specified precipitation

Sensor:

a) the current water-equivalent rate of precipitation;

b) the rate that snow is accumulating; and

c) the start and stop times of the latest recorded precipitation event. The precipitation event can be
rainfall or snowfall.

3.56.2.5.8 Retrieve Precipitation Totals

Upon request, the ESS shall return the total amount of precipitation recorded over the last one hour, three
hour, six hour, twelve hour, and twenty-four hour rolling periods, reported by the specified precipitation
sensor.

3.56.2.5.9 Retrieve Precipitation Totals - User Specified

Upon request, the ESS shall return the total amount of precipitation recorded over a user specified, rolling
time period for the specified precipitation sensor.

3.5.2.5.10 Retrieve Precipitation Type

Upon request, the ESS shall return the assessment of the type and intensity of the current precipitation
situation. The precipitation intensity shall be defined as follows: slight < 2 mm/hour water equivalent,
moderate is = 2 and < 8 mm/hour equivalent, and heavy is = 8 mm/hour water equivalent.

3.5.2.6 Manage Solar Radiation Sensors

Requirements for managing solar radiation sensors follow.

3.5.2.6.1 Determine Number of Solar Radiation Sensors

Upon request, the ESS shall return the number of solar radiation sensors connected to the ESS.
3.5.2.6.2 Retrieve Solar Radiation Sensor Location

Upon request, the ESS shall return the following information for the specified solar radiation sensor:
a) a textual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.
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3.5.2.6.3 Retrieve Solar Radiation Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified solar radiation sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.6.4 Configure Solar Radiation Sensor Location

Upon request, the ESS shall store the following information for a specified solar radiation sensor:
a) a textual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.6.5 Retrieve Solar Radiation

Upon request, the ESS shall return the solar radiation data reported by each solar radiation sensor. The

types of measured solar radiation data that the ESS shall provide are:

a) the total minutes of sunshine measured over the preceding 24-hour period, as defined by WMO Code
Form FM 94 BUFR Table B item 0 14 031;

b) the instantaneous infrared radiation measured, in watts per square meter, as defined by WMO Code
Form FM 94 BUFR Table B item 0 14 017;

c) the instantaneous ultraviolet, visible and near-infrared radiation measured, in watts per square meter,
as defined by WMO Code Form FM 94 BUFR Table B item 0 14 018; and

d) the average total radiation measured, in watts per square meter, as defined by WMO Code Form FM
94 BUFR Table B item 0 14 025, over a user defined rolling period, measured in seconds.

3.5.2.7 Manage Visibility Sensor

Requirements for managing visibility sensors follow.

3.5.2.7.1 Determine Number of Visibility Sensors

Upon request, the ESS shall return the number of visibility sensors connected to the ESS.
3.5.2.7.2 Retrieve Visibility Sensor Location

Upon request, the ESS shall return the following information for a visibility sensor:
a) atextual description of the sensor location;

b) the direction that the sensor uses to measure distance

c) the relative height of the sensor to the reference height of the ESS; and

d) the location of the sensor.

3.5.2.7.3 Retrieve Visibility Sensor Identity

Upon request, the ESS shall return the entity identifier of the visibility sensor so that the management
station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.7.4 Configure Visibility Sensor Location

Upon request, the ESS shall store the following information for a visibility sensor:
a) atextual description of the sensor location;

b) the direction that the sensor uses to measure distance;

c) the relative height of the sensor to the reference height of the ESS; and

d) the location of the sensor.

3.5.2.7.5 Retrieve Visibility

Upon request, the ESS shall return the current visibility distance.
3.5.2.8 Manage Pavement Sensors

Requirements for managing pavement sensors follow.

3.5.2.8.1 Determine Number of Pavement Sensors

Upon request, the ESS shall return the number of pavement sensors connected to the ESS.
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3.5.2.8.2 Retrieve Pavement Sensor Location

Upon request, the ESS shall return the following information for the specified pavement sensor:

a) atextual description of the sensor location and the location of the area the sensor is monitoring;
b) the relative height of the pavement surface to the reference height of the ESS;

c) the location of the sensor; and

d) the location of the geometric center of the surface area that the sensor is monitoring.

3.5.2.8.3 Retrieve Pavement Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified pavement sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.8.4 Configure Pavement Sensor Location

Upon request, the ESS shall store the following information for the specified pavement sensor:

a) a textual description of the sensor location and the location of the area the sensor is monitoring;
b) the relative height of the pavement surface to the reference height of the ESS.

¢) the location of the sensor; and

d) the location of the geometric center of the pavement surface area that the sensor is monitoring.

3.5.2.8.5 Retrieve Pavement Sensor Metadata

Upon request, the ESS shall return the following information for the specified pavement sensor:

a) atextual description of the location that the pavement sensor is monitoring;

b) the type of pavement the sensor is monitoring;

c) an indication of the skyview factor to which the monitored pavement is subjected. A value of 100
(percent) indicates a fully visible sky; and

d) an indication of the sensor technology used.

3.5.2.8.6 Configure Pavement Sensor Metadata

Upon request, the ESS shall store configuration information for a specified pavement sensor. The
configuration information includes:

a) atextual description of the location that the pavement sensor is monitoring;

b) the type of pavement the sensor is monitoring; and

¢) anindication of the skyview factor to which the monitored pavement is subjected.

3.5.2.8.7 Configure Passive Ice Detection Logic

Upon request, the ESS shall store information regarding the pavement treatments being applied so that
the ESS may more accurately estimate icing conditions using passive logic. The information includes:
a) the number of different pavement treatments types;

b) the type of each pavement treatment;

c) the form of each pavement treatment type; and

d) the percentage of each pavement treatment type and form by total application weight.

Different pavement treatments may be the same pavement treatment type but in different forms and in
different percentages (by weight).

Note: There are now combinations of pavement treatments that are used, and they may impact
the calibration of the algorithms used.

3.5.2.8.8 Retrieve Conditions for Freezing Algorithms - Active

There are two methods to determine ice and moisture conditions on the pavement surface — active and
passive. Active pavement sensors determine the freeze point on the pavement surface by actively
freezing a portion of the roadway surface. For an active pavement sensor, upon request, the ESS shall
return:

a) the pavement surface temperature;

b) the pavement temperature;

c) the depth below the pavement surface that the pavement temperature is measured;
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d) the freeze point on the pavement surface at which the existing solution on the roadway freezes;
e) whether black ice is currently detected on the pavement surface;

f) the depth of any water/solution film or ice on the pavement surface; and

g) an indication of whether any of this data might be in error.

3.5.2.8.9 Retrieve Conditions for Freezing Algorithms - Passive

There are two methods to determine ice and moisture conditions on the pavement surface - active and

passive. Passive pavement sensors determine the freeze point on the pavement surface using algorithms

without freezing the chemical mixture on the roadway surface. For a passive pavement sensor, upon

request, the ESS shall return the following:

a) the pavement surface temperature;

b) the pavement temperature;

c) the depth below the pavement surface that the pavement temperature is measured;

d) the freeze point on the pavement surface at which the existing solution on the roadway freezes;

e) whether black ice is currently detected on the pavement surface;

f) the depth of any water/solution film or ice on the pavement surface;

g) the salinity of the water/solution film on the pavement surface;

h) the conductivity of the water/solution film on the pavement surface, as detected by the pavement
surface sensor;

i) anindication of whether any of this data might be in error;

j) the pavement treatment type used for algorithm;

k) the form of each pavement treatment type; and

[) the percentage of the total application weight that is of the pavement treatment type.

3.5.2.8.10 Retrieve Pavement Surface Temperature

Upon request, the ESS shall return the following information reported by the specified pavement sensor:
a) the current pavement surface temperature; and
b) the validity of the data reported.

3.5.2.8.11 Retrieve Pavement Surface Condition

Upon request, the ESS shall return the following information reported by the specified pavement sensor:
a) any presence of moisture and the type of moisture on the surface; and
b) the validity of the data reported.

3.5.2.8.12 Retrieve Forecasted Pavement Surface Condition

Upon request, the ESS shall return the forecasted pavement surface condition for the specified pavement
sensor. The forecast is derived based on the current pavement surface condition and other weather
observations.

3.5.2.8.13 Retrieve Roadway Friction Coefficient

Upon request, the ESS shall return the estimated friction coefficient of the roadway pavement for the
specified pavement sensor. The actual coefficient of friction is dependent on many variables, including
characteristics of the tire traveling on the pavement; thus it is recognized that it is impossible to provide a
on a single mathematically precise value. However, the reported friction coefficient shall be based on an
empirical model that has a strong correlation with actual measured friction coefficients using a standard
test method and test apparatus, such as a decelerometer or a surface friction tester.

3.5.2.8.14 Retrieve Ice Percentage

Upon request, the ESS shall return the percentage of ice in the mixture on the surface of the pavement
for the specified pavement sensor.
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3.5.2.8.15 Retrieve Adjacent Snow Depth

Upon request, the ESS shall return the current depth of snow adjacent to the traveled way (e.g.,
shoulders) for the specified sensor. The depth shall be representative of the snow depth in the area,
exclusive of plowed areas and snow drifts.

3.5.2.8.16 Retrieve Roadway Snow Depth

Upon request, the ESS shall return the current depth of packed and unpacked snow on the roadway
pavement (i.e., roadway, rail line, etc.) for the specified sensor.

3.5.2.8.17 Retrieve Roadway Ice Thickness

Upon request, the ESS shall return the current thickness of ice on the roadway pavement reported by the
specified pavement sensor.

3.5.2.9 Manage Subsurface Sensors

Requirements for managing subsurface sensors follow.

3.5.2.9.1 Determine Number of Subsurface Sensors

Upon request, the ESS shall return the number of subsurface sensors connected to the ESS.
3.5.2.9.2 Retrieve Subsurface Sensor Location

Upon request, the ESS shall return the following information for the specified subsurface sensor:
a) atextual description of the sensor location; and
b) the location of the geometric center of the sensor.

3.5.2.9.3 Retrieve Subsurface Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified subsurface sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.9.4 Configure Subsurface Sensor Location

Upon request, the ESS shall store the following information for a specified subsurface sensor:
a) a textual description of the sensor location; and
b) the location of the geometric center of the sensor.

3.5.2.9.5 Retrieve Subsurface Sensor Metadata

Upon request, the ESS shall return the following information for the specified subsurface sensor:
a) atextual description of the location that the sensor is monitoring;

b) the type of subsurface the sensor is monitoring; and

c) the depth of the sensor location below the pavement surface.

3.5.2.9.6 Configure Subsurface Sensor Metadata

Upon request, the ESS shall store configuration information for a specified subsurface sensor. The
configuration information includes:

a) atextual description of the location that the sensor is monitoring;

b) the type of subsurface the sensor is monitoring; and

c) the depth of the sensor location below the pavement surface.

3.5.2.9.7 Retrieve Subsurface Temperature

Upon request, the ESS shall return the current subsurface temperature reported by the specified
subsurface sensor. The ESS shall also return an indication of whether this data might be in error.

3.5.2.9.8 Retrieve Subsurface Moisture

Upon request, the ESS shall return the amount of moisture currently reported by the specified subsurface
sensor. A value of 0% indicates that the subsurface is dry, while a value of 100% indicates the subsurface
is saturated.
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3.5.2.10 Manage Air Quality Sensors
Requirements for managing air quality sensors follow.
3.5.2.10.1 Determine Number of Air Quality Sensors
Upon request, the ESS shall return the number of air quality sensors connected to the ESS.
3.5.2.10.2 Retrieve Air Quality Sensor Location

Upon request, the ESS shall return the following information for the specified air quality sensor:
a) a textual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.10.3 Retrieve Air Quality Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified air quality sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.10.4 Configure Air Quality Sensor Location

Upon request, the ESS shall store the following information for a specified air quality sensor:
a) atextual description of the sensor location;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.10.5 Retrieve Carbon Monoxide Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of carbon monoxide.

3.5.2.10.6 Retrieve Nitrogen Dioxide Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of nitrogen dioxide.

3.5.2.10.7 Retrieve Sulfur Dioxide Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of sulfur dioxide.

3.5.2.10.8 Retrieve Small Particulate Matter Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of small particulate matter of 10 micrometers or less in diameter.

3.5.2.10.9 Retrieve Particulate Matter 2.5 Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of small particulate matter of 2.5 micrometers or less in diameter.

3.5.2.10.10Retrieve Particulate Matter 1.0 Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of small particulate matter of 1.0 micrometers or less in diameter.

3.5.2.10.11Retrieve Carbon Dioxide Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of carbon dioxide.

3.5.2.10.12Retrieve Nitric Oxide Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of nitric oxide.
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3.5.2.10.13Retrieve Ozone Reading

Upon request, the ESS shall return the current concentration detected by the specified air quality sensor
of ozone.

3.5.2.11 Manage Water Level Sensors

Requirements for managing water level sensors follow.

3.5.2.11.1 Determine Number of Water Level Sensors

Upon request, the ESS shall return the number of water level sensors connected to the ESS.
3.5.2.11.2 Retrieve Water Level Sensor Location

Upon request, the ESS shall return the following information for the specified water level sensor:

a) atextual description of the sensor location, including a description of the reference point that the
water depth is measured against;

b) the relative height of the sensor to the reference height of the ESS; and

¢) the location of the sensor.

3.5.2.11.3 Retrieve Water Level Sensor Identity

Upon request, the ESS shall return the entity identifier of the specified water level sensor so that the
management station is able to properly interpret the accuracy, resolution and limits of the data.

3.5.2.11.4 Retrieve Water Level Sensor Warning Level

Upon request, the ESS shall return the water level depth that is a cause of concern for the specified water
level sensor. This water level depth may be the depth when the water levels may overflow onto the
roadway pavement, or may damage electronic roadside equipment in a cabinet.

3.5.2.11.5 Configure Water Level Sensor Location

Upon request, the ESS shall store the following information for a specified water level sensor:

a) a textual description of the sensor location, including a description of the reference point that the
water depth is measured against;

b) the relative height of the sensor to the reference height of the ESS; and

c) the location of the sensor.

3.5.2.11.6 Configure Water Level Sensor Warning Level

Upon request, the ESS shall store the water level depth that is a cause of concern for the specified water
level sensor.

3.5.2.11.7 Retrieve Water Level

Upon request, the ESS shall return the current depth of water from a user defined point for the specified
water level sensor. The current depth of water can be over a body of water, such as a stream or a
reservoir, or the current depth of water on a roadway pavement, such as an underpass. This requirement
is concerned with the water depth in bodies of water or the pavement surface for flooding concerns, as
opposed to requirements 3.5.2.8.8.f or 3.5.2.8.9., water film depth, which are concerned about icing or
hydroplaning on the pavement surface.

3.5.2.12 Monitor Situation Assessments
Requirements for monitoring situation assessments follow.
3.5.2.12.1 Retrieve Wind Situation

Upon request, the ESS shall return the assessment of the wind situation from a staffed station as defined
by the Beaufort Wind Scale in the Glossary of Meteorology.
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3.5.2.12.2 Retrieve Precipitation Situation

Upon request, the ESS shall return the assessment of the type and intensity of the current precipitation
situation. The assessment may be made through automated processes, or if it is a staffed station,
manually.

3.5.2.12.3 Retrieve Visibility Situation

Upon request, the ESS shall return the assessment of the visibility situation. The assessment may be
made through automated processes, or if it is a staffed station, manually.

3.5.2.12.4 Retrieve Cloud Situation

Upon request, the ESS shall return the amount of cloud cover in the sky, measured in oktas, as defined in
WMO code table 2700. The assessment may be made through automated processes, or if it is a staffed
station, manually.

3.5.2.12.5 Retrieve Ground State

Upon request, the ESS shall return the assessment of the ground state next to the roadway (the roadside,
and not the roadway pavement or shoulders). The assessment is made from a staffed station.

3.5.2.12.6 Retrieve Pavement State

Upon request, the ESS shall return the assessment of the pavement surface. The assessment is made
from a staffed station.

3.5.2.13 Manage Snapshot Cameras

Requirements for managing snapshot cameras follow.

3.5.2.13.1 Determine Number of Snapshot Cameras

Upon request, the ESS shall return the number of snapshot cameras connected to the ESS.

3.5.2.13.2 Retrieve Snapshot Camera Identity

Upon request, the ESS shall return the entity identifier of the specified snapshot camera so that the
management station is able to properly understand its capabilities.

3.5.2.13.3 Determine Supported Image Storage Formats

Upon request, the ESS shall return the image storage formats that are supported by the specified
shapshot camera.

3.5.2.13.4 Configure Snapshot Camera

Upon request, the ESS shall store a textual description of the location and direction to which the specified
camera points along with the filename and file format to be used when storing new snapshots from the
specified camera.

3.5.2.13.5 Retrieve Snapshot Camera Configuration

Upon request, the ESS shall return the following information for the specified snapshot camera:
a) the textual description of the location to which the camera points;

b) the file path where new snapshots are stored;

c) the filename to be used when storing new snapshots; and

d) the file format to be used when storing new snapshots.

3.5.2.13.6 Capture Snapshot Image

Upon request, the ESS shall capture the current image (snapshot) from the specified attached camera
and store it per the configured storage path, filename, and format. The ESS shall report any errors in
performing this task.
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3.5.2.13.7 Retrieve Snapshot

Upon request, the ESS shall return a copy of the specified snapshot image.
3.5.2.13.8 Delete Snapshot

Upon request, the ESS shall delete the specified snapshot image.

3.5.3 PTS Manager Requirements

Requirements for managing a PTS manager follow.

3.5.3.1 PTS Configuration Requirements

Requirements for configuring a PTS manager follow.

3.5.3.1.1 Retrieve Pavement Treatment System Location

Upon request, the ESS shall return the following information for the pavement treatment system:
a) a textual description of the pavement treatment system location; and
b) the location of the pavement treatment system.

3.5.3.1.2 Retrieve Pavement Treatment System Identity

Upon request, the ESS shall return the entity identifier of the pavement treatment system so that the
management station is able to properly interpret the capabilities of the pavement treatment system.

3.5.3.1.3 Configure Pavement Treatment System Location

Upon request, the ESS shall store the following information for a pavement treatment system:
a) atextual description of the pavement treatment system location; and
b) the location of the pavement treatment system.

3.5.3.1.4 Retrieve Stationary Pavement Treatment Configuration

Upon request, the PTS shall return the configuration data for a stationary pavement treatment system

identifying:

a) the pavement sensors that the PTS monitors to determine when to trigger the sprayers;

b) the duration required for a signal to activate the sprayer;

c) the number of pavement treatment products that the PTS has been programmed for; and

d) for each pavement treatment product, the pavement treatment product type, pavement treatment
form and the percentage mix (by weight).

A pavement treatment product is a chemical that can be applied to the roadway to de-ice or prevent icing
of the pavement. This requirement allows a transportation system operator to determine what pavement
treatments may be applied by the PTS.

3.5.3.1.5 Configure Stationary Pavement Treatment System

Upon request, the PTS shall change the configuration for a stationary pavement treatment system

identifying:

a) the pavement sensors that the PTS monitors to determine when to trigger the sprayers;

b) the duration required for a signal to activate the sprayer;

c) the number of pavement treatment products that the PTS has been programmed for; and

d) for each pavement treatment product, the pavement treatment type, pavement treatment form and
the percentage mix (by weight).

3.5.3.1.6 Configure Mobile Pavement Treatment System

Upon request, the PTS shall change the configuration for a mobile pavement treatment system

identifying:

a) the quantity of treatment being applied;

b) the width of the spread of treatment;

c) the minimum amount of time the sprayer needs to detect a signal to activate and the duration to stay
active; and
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d) for each pavement treatment product that the PTS has been programmed for, the pavement
treatment type, pavement treatment form and the percentage mix (by weight).

3.5.3.1.7 Retrieve Mobile Pavement Treatment Configuration

Upon request, the PTS shall return the configuration data for a mobile pavement treatment system

identifying:

a) the quantity of pavement treatment being applied;

b) the width of the spread of treatment; and

c) for each pavement treatment product that the PTS has been programmed for, the pavement
treatment type, pavement treatment form and the percentage mix (by weight).

A pavement treatment product is a chemical that can be applied to the roadway to de-ice or prevent icing
of the pavement. This requirement allows a transportation system operator to determine what pavement
treatments may be applied by the PTS.

3.5.3.2 PTS Status Monitoring Requirements
Requirements for monitoring the status of a PTS manager follow.
3.5.3.21 Retrieve Pavement Treatment Status

Upon request, the PTS shall return the current status of the sprayer and the number of spray events that
have occurred on a pavement treatment system. The status consists of:

a) whether the sprayer is currently active (spraying);

b) a counter indicating the number of signal events that have occurred;
¢) the date and time the sprayer last received a signal event;

d) a counter indicating the number of active events that have occurred;
e) a counter indicating the number of inactive events that have occurred;
f) the date and time the sprayer of the last active event;

g) the date and time the sprayer of the last inactive event; and

h) the state of readiness of the sprayer.

3.56.3.2.2 Retrieve PTS Operational Mode
Upon request, the stationary PTS shall return its current operational mode.

3.5.3.3 PTS Data Retrieval Requirements

There are no requirements for retrieving data from a PTS manager.
3.5.3.4 PTS Control Requirements

Requirements for controlling a PTS manager follow.

3.5.3.41 Set PTS Operational Mode

Upon request, the stationary PTS shall change its operational mode to that requested. Valid operational

modes are:

a) Off, which shall prevent any operation of the sprayer;

b) Manual, which shall allow manual activation of the sprayer; and

c) Automatic, which shall allow either manual activation or activation based on internal logic per the
configuration parameters.

3.5.3.4.2 Manually Activate PTS Sprayer

Upon request, the stationary PTS shall trigger the sprayer to spray its pavement treatment solution. The
trigger shall be activated for the configured duration period.
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3.6 Supplemental Non-Communications Requirements

Supplemental requirements for ESS follow. These requirements do not directly involve communications
between the management station and the ESS, but, if the supplemental requirement is selected in the
PRL, the ESS shall fulfill the stated requirement to claim conformance to this document.

3.6.1 Required Number of Atmospheric Pressure Sensors

The ESS shall support the number of atmospheric pressure sensors as defined by the agency
specification. If the agency specification does not define the number of atmospheric pressure sensors, the
number of atmospheric pressure sensors supported by the ESS is one (1).

3.6.2 Required Number of Wind Sensors

The ESS shall support the number of wind sensors as defined by the agency specification. If the agency
specification does not define the number of wind sensors, the number of wind sensors supported by the
ESS is one (1).

3.6.3 Required Number of Temperature Sensors

The ESS shall support the number of temperature sensors as defined by the agency specification. If the
agency specification does not define the number of temperature sensors, the number of temperature
sensors supported by the ESS is one (1).

3.6.4 Required Number of Humidity Sensors

The ESS shall support the number of humidity sensors as defined by the agency specification. If the
agency specification does not define the number of humidity sensors, the number of humidity sensors
supported by the ESS is one (1).

3.6.5 Required Number of Precipitation Sensors

The ESS shall support the number of precipitation sensors as defined by the agency specification. If the
agency specification does not define the number of precipitation sensors, the number of precipitation
sensors supported by the ESS is one (1).

3.6.6 Required Number of Solar Radiation Sensors

The communications interface only allows the ESS to return a single set of values for the solar radiation;
however, these values may be derived from multiple sensors. The ESS shall support the number of solar
radiation sensors as defined by the agency specification. If the agency specification does not define the
number of solar radiation sensors, the number of solar radiation sensors supported by the ESS is one (1).

3.6.7 Required Number of Visibility Sensors

The communications interface only allows the ESS to return a single value for the visibility; however, this
value may be derived from multiple sensors. The ESS shall support the number of visibility sensors as
defined by the agency specification. If the agency specification does not define the number of visibility
sensors, the number of visibility sensors supported by the ESS is one (1).

3.6.8 Required Number of Pavement Sensors

The ESS shall support the number of pavement sensors as defined by the agency specification. If the
agency specification does not define the number of pavement sensors, the number of pavement sensors
supported by the ESS is one (1).

3.6.9 Active Pavement Treatment Sensors

The ESS shall determine the predicted freeze-point of the pavement by actively freezing a portion of the
mixture on the roadway surface.

3.6.10 Passive Pavement Treatment Sensors

The ESS shall determine the freeze point of the pavement through an algorithm that does not require the
freezing of the chemical mixture on the roadway surface.
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Note: Different makes and models of equipment may use different algorithms for a variety of
reasons. To overcome problems that may result from this variation, this document links each
pavement sensor with a row of the module table so that a system can identify the make and

model of the specific pavement sensor.

3.6.11 Required Number of Subsurface Sensors

The ESS shall support the number of subsurface sensors as defined by the agency specification. If the
agency specification does not define the number of subsurface sensors, the number of subsurface
sensors supported by the ESS is one (1).

3.6.12 Required Number of Pavement Treatment Products

The ESS shall support the number of pavement treatment products as defined by the agency
specification. If the agency specification does not define the number of pavement treatment products, the
number of pavement treatment products supported by the ESS is one (1).

3.6.13 Required Number of Carbon Monoxide Sensors

The communications interface only allows the ESS to return a single value for carbon monoxide;
however, this value may be derived from multiple sensors. The ESS shall support the number of carbon
monoxide sensors as defined by the agency specification. If the agency specification does not define the
number of carbon monoxide sensors, the number of carbon monoxide sensors supported by the ESS is
one (1).

3.6.14 Required Number of Carbon Dioxide Sensors

The communications interface only allows the ESS to return a single value for carbon dioxide; however,
this value may be derived from multiple sensors. The ESS shall support the number of carbon dioxide
sensors as defined by the agency specification. If the agency specification does not define the number of
carbon dioxide sensors, the number of carbon dioxide sensors supported by the ESS is one (1).

3.6.15 Required Number of Nitric Oxide Sensors

The communications interface only allows the ESS to return a single value for nitric oxide; however, this
value may be derived from multiple sensors. The ESS shall support the number of nitric oxide sensors as
defined by the agency specification. If the agency specification does not define the number of nitric oxide
sensors, the number of nitric oxide sensors supported by the ESS is one (1).

3.6.16 Required Number of Nitrogen Dioxide Sensors

The communications interface only allows the ESS to return a single value for nitrogen dioxide; however,
this value may be derived from multiple sensors. The ESS shall support the number of nitrogen dioxide
sensors as defined by the agency specification. If the agency specification does not define the number of
nitrogen dioxide sensors, the number of nitrogen dioxide sensors supported by the ESS is one (1).

3.6.17 Required Number of Sulfur Dioxide Sensors

The communications interface only allows the ESS to return a single value for sulfur dioxide; however,
this value may be derived from multiple sensors. The ESS shall support the number of sulfur dioxide
sensors as defined by the agency specification. If the agency specification does not define the number of
sulfur dioxide sensors, the number of sulfur dioxide sensors supported by the ESS is one (1).

3.6.18 Required Number of Ozone Sensors

The communications interface only allows the ESS to return a single value for ozone; however, this value
may be derived from multiple sensors. The ESS shall support the number of ozone sensors as defined by
the agency specification. If the agency specification does not define the number of ozone sensors, the
number of ozone sensors supported by the ESS is one (1).

3.6.19 Required Number of Small (10) Particulate Matter Sensors

The communications interface only allows the ESS to return a single value for small particulate matter;
however, this value may be derived from multiple sensors. The ESS shall support the number of small
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particulate matter sensors as defined by the agency specification. If the agency specification does not
define the number of small particulate matter sensors, the number of small particulate matter sensors
supported by the ESS is one (1).

3.6.20 Required Number of Small (2.5) Particulate Matter Sensors

The communications interface only allows the ESS to return a single value for small particulate matter 2.5
microns or less in diameter; however, this value may be derived from multiple sensors. The ESS shall
support the number of small particulate matter (< 2.5 microns diameter) sensors as defined by the agency
specification. If the agency specification does not define the number of small particulate matter (< 2.5
microns diameter) sensors, the number of small particulate matter (2.5) sensors supported by the ESS is
one (1).

3.6.21 Required Number of Small (1.0) Particulate Matter Sensors

The communications interface only allows the ESS to return a single value for small particulate matter 1.0
microns or less in diameter; however, this value may be derived from multiple sensors. The ESS shall
support the number of small particulate matter (< 1.0 microns diameter) sensors as defined by the agency
specification. If the agency specification does not define the number of small particulate matter (< 1.0

microns diameter) sensors, the number of small particulate matter (1.0) sensors supported by the ESS is
one (1).

3.6.22 Required Number of Water Level Sensors

The ESS shall support the number of water level sensors as defined by the agency specification. If the
agency specification does not define the number of water level sensors, the number of water level
sensors supported by the ESS is one (1).

3.6.23 Required Number of Snapshot Cameras

The ESS shall support the number of snapshot cameras as defined by the agency specification. If the
agency specification does not define the number of snapshot cameras, the number of snapshot cameras
supported by the ESS is one (1).

3.6.24 Support Camera Number in Filename

The ESS shall support the ability to specify a field in the filename parameter that is replaced by the
camera number when a shapshot is saved. This is the '<camera>' field as defined in Section Error!
Reference source not found..

3.6.25 Support Sequence Number in Filename

The ESS shall support the ability to specify a field in the filename parameter that is replaced by the
current sequence number when a snapshot is saved. This is the '<sequence>' field as defined in Section
Error! Reference source not found..

3.6.26 Support Date in Filename

The ESS shall support the ability to specify a field in the filename parameter that is replaced by the
current UTC date when a snapshot is saved. This is the '<date>' field as defined in Section Error!
Reference source not found..

3.6.27 Support Time in Filename

The ESS shall support the ability to specify a field in the filename parameter that is replaced by the
current UTC time when a snapshot is saved. This is the '<time>' field as defined in Section Error!
Reference source not found..

3.6.28 Support Long Filenames

The ESS shall support the ability to specify filenames up to 255 characters in length minus the length of
the filename extension minus 1.
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3.6.29 Maximum Response Time for Requests

The ESS shall process each received request in accordance with all of the rules of the relevant base
standards (e.g., NTCIP 2301 v03), including updating the value the RPU is storing internally and
producing the response PDU within the maximum response time. If the agency specification does not
indicate the maximum response time, the maximum response time for any standardized request shall be
100 ms.
The maximum response time for any non-standard request shall be calculated as follows:

a) ldentify the minimum number of standardized request messages that contain all the objects

included in the request for which the calculation is being made.

b) The maximum response time for a non-standard request shall be the product of the maximum
response time specified for a standardized request multiplied by the number of standardized
requests identified in Step a.

3.6.30 Maximum Transmission Start Time

Upon satisfying a condition that triggers a transmission (exception-based reporting), the device shall
generate the notification PDU for that specified condition within the defined maximum transmission start
time. Unless the agency specification indicates otherwise, the maximum transmission start time shall be
100 milliseconds.

3.7 Security Requirements
3.7.1 Conformant Security

To claim "conformance" with this document, an ESS shall only support protocols providing equivalent
security to SNMPvV3 per the rules of NTCIP 2301 v03. Implementations should support the
communications stack defined in NTCIP 2301 v03 for the exchanged of data defined by this document.

NOTE—This excludes support for less secure protocols, such as SNMP versions prior to SNMPV3. In
other words, conformant devices do not have the installed code to activate prior versions of SNMP.

3.7.2 Consistent Security

To claim "consistency" with this document, an ESS shall:
a) Support protocols providing equivalent security to SNMPv3 per the rules of NTCIP 2301 v03,

b) Support less secure protocols (e.qg., prior versions of SNMP), and
c) Allow users to disable all protocols that are less secure than SNMPv3 according to NTCIP 2301
v03.

Implementations should support the communications stack defined in NTCIP 2301 v03 for the exchanged
of data defined by this document.

NOTE—Consistent devices are defined to allow agencies to start procuring and deploying SNMPv3-ready
devices immediately, before their management station has been updated to support SNMPv3.
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Section 4
Dialogs [Normative]

Section 4 defines the dialogs (i.e., sequence of data exchanges) that fulfill various Data Exchange
requirements defined in Section 3.5. As SNMP communications are largely driven by the management
station, most of the requirements define how the device shall respond to the various possible actions a
management station might take.

The NTCIP standards effort is based on SNMP. This protocol offers a high degree of flexibility as to how
the management station structures its requests. For example, with SNMP, the management station can
do any of the following:

a) Send only those requests that are critical at the current time, whereas a standardized dialog typically
sends requests relating to all associated data, regardless of whether it is critical for current purposes

b) Combine a number of requests in a single packet, whereas a standardized dialog dictates the exact
contents of each packet

c) Separate a group of requests into multiple packets, whereas a standardized dialog dictates the exact
contents of each packet

d) Interweave requests from multiple dialogs, whereas a standardized dialog dictates the exact ordering
of messages, which are not interrupted with other messages

This flexibility can be a powerful tool allowing a management station to optimize the use of
communication facilities, which is the primary reason that SNMP was chosen as the core NTCIP protocol.
However, the flexibility also means that there are numerous allowable variations in the management
process that a management station may choose to use and that an agent shall support to conform to
NTCIP 1204.

Unfortunately, this flexibility presents a challenge to ensuring interoperability.

To overcome this complication, Section 4 defines a lowest common denominator approach to
communications between a management station and a device. It defines the standardized dialog for each
Data Exchange Requirement. Management stations may support other dialogs to fulfill these same
requirements, as long as these dialogs are consistent with the rules defined in this document. Such a
management station is termed a “consistent management station.” A consistent management station
interoperates with any “conformant” device.

A “conformant management station” is required to offer a mode in which it only uses the standardized
dialogs as defined in Section 4. With this limited definition, there is relatively little variability in what
constitutes a conformant management station. Thus, fully testing a management station for conformance
is a relatively straight forward process that can be done within the practical constraints faced by most
procuring agencies. Thus, a conformant management station provides an agency with a much greater
chance of achieving interoperability with off-the-shelf devices that have been tested against NTCIP 2104
v03, and the designation of such a system is intended to provide a guaranteed base level of
interoperability.

The rules for the standardized dialogs follow:

a) The dialogs are defined by a sequence of GET or SET requests. These requests shall equate to the
GET and SET operations defined by SNMPv3 (specifically in RFC 3416) and shall be transmitted as
a single message.

b) The contents of each request are identified by an object name. Each object name consists of an
object type and an instance identifier. Definitions of each object type are provided in Section 5 and
NTCIP 1201 v03. The meaning of the instance identifier is provided by these same definitions
coupled with standard SNMP rules (see RFC 1212).
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¢) Each message shall contain all of the objects as shown, unless otherwise indicated

d) A message shall not contain any other objects

e) The contents of each message sent by the management station may appear in any order
Note: Ideally, the order of objects should match the order as shown in this document to provide the
highest probability of interoperability. However, it is recognized that many implementations may use
off-the-shelf software, which may prevent the designation of an exact ordering of objects and as a
result, this ordering is not a requirement of this document.

f) After sending a message, the management station shall not transmit any other data across the
communications channel until the earlier of:
1) The management station receiving a response from the device; or
2) The expiration of the maximum response time.

g) If the response indicates an error occurred in the operation, the management station shall exit the
process, unless specific error-handling rules are specified by the dialog.

h) Dialogs containing a sequence of only GET requests may request objects in any order.

However, since consistent management stations can alter the order of requests, this standard defines
rules for when certain data exchanges are allowed. Unless otherwise indicated, a conformant device shall
allow an object to be retrieved (through a GET request) or altered (through a SET request, if the object is
writable) at any time. However, the access to some data is associated with a state machine, and Section
4.3 defines the various rules that apply to these state machines.

Finally, Section 4.4 presents an overview of all of the data defined by this standard, prior to presenting the
complete definition for each piece of data in Section 5.

41 Tutorial [Informative]

The Requirements Traceability Matrix (RTM) in Annex A identifies the standardized dialog that can be
used to achieve each of the data exchange requirements defined in Section 3.5. Simple data exchange
requirements reference one of the generic SNMP dialogs along with a list of data elements. These equate
to a single message being sent (e.g., a GET request) containing the referenced data elements followed
by the appropriate response per the generic dialog specification.

Section 4 defines the standardized dialogs for the more complicated data exchange requirements. Each
of these dialogs is defined by a number of steps. Many of the steps reference data elements that are
defined in Section 5. These data elements are also shown in the corresponding row of the RTM along
with their precise section number.

The dialogs may also be accompanied by an informative figure that provides a graphical depiction of the
normative text. The figures conform to the Unified Modeling Language and depict the management
station as an outside actor sending a series of messages to the device and the device returning
responses. If there is any conflict between the figure and the text, the text takes precedence.

4.2 Specified Dialogs
4.21 Capture Snapshot Image

The standardized dialog for a management station to capture a snapshot image shall be:

a) The management station shall SET essSnapshotCameraCommand.x to the value of
captureSnapshot (2).

b) The ESS shall take the picture with camera x.

c) The ESS shall store the captured picture to the directory essSnapshotCameraStoragePath.x and to
the file essSnapshotCameraFilename.x.

d) The management station shall repeatedly GET essSnapshotCameraCommand.x until it equals ready
(1).

e) The management station shall GET essSnapshotCameraError.x to verify the picture was successful.

f) The ESS shall respond with the indicated value.
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This process is depicted in the UML diagram in Figure 7.
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: Management
Station

Set()
essSnapshotCameraCommand.x = captureSnapshot™
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= 1 image with camera x and save the
. image to the directory
~Get() essSnapshotCameraStoragePath
essSnapshotCameraCommand.x - with the )
essSnapshotCameraFilename.
Response( )
Get()

essSnapshotCameraError.x

Response( )

Figure 7 Dialog for Capture Snapshot Image
4.2.2 Retrieve Snapshot

The standardized dialog for a management station to retrieve a snapshot image shall conform to SFTP v3
as specified in https://datatracker.ietf.org/doc/html/draft-ietf-secsh-filexfer-02 over SSH as specified in
RFC 4250-4256.

The device shall adhere to the following rules:

a) The login directory is the root directory and a user cannot traverse to any parent directories.
b) Subdirectories may be used.
c) Zero or one SFTP login session with the specification username shall exist at any given time.

Implementations of this document may also support the retrieval of files using HTTPS, as defined in RFC
9110.

NOTE—It is expected that future NTCIP documents will detail precise requirements for using SFTP and
HTTPS.
4.2.3 Delete Snapshot

The standardized dialog for a management station to delete a snapshot image shall conform to SFTP v3
as specified in https://datatracker.ietf.org/doc/html/draft-ietf-secsh-filexfer-02 over SSH as specified in
RFC 4250-4256. The device shall adhere to the additional rules defined in Section 4.2.2.

4.2.4 Retrieve Stationary Pavement Treatment Configuration

The standardized dialog for a management station to retrieve the pavement treatment configuration for a
stationary ESS shall be as follows:
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a) The management station shall GET numEssTreatments.0.
b) For each treatment from 1 to the number of treatments, the management station shall GET the
following objects:
1) essPaveTreatProductType.x
2) essPaveTreatProductForm.x
3) essPercentProductMix.x
c) The management station shall GET the following objects:
1) ptsSignalDuration
2) ptsMonitoringDetectors

Where,
X = the index of the treatment

4.2.5 Retrieve Icing Conditions—Passive

The standardized dialog for a management station to retrieve the current and predicted icing conditions
from a passive sensor shall be as follows:

a) (Precondition) The management station is aware of the sensor from which data is desired.
b) The management station shall GET the following objects:
1) essSurfaceTemperature.x
2) essPavementTemperature.x
3) essSurfaceSalinity.x
4) essSurfaceFreezePoint.x
5) essSurfaceBlacklceSignal.x
6) essPavementSensorError.x
c) The management station shall GET the following objects:
1) essSurfacelceOrWaterDepth.x
2) essSurfaceConductivityV2.x
3) pavementSensorTemperatureDepth.x
Note: These are NTCIP 1204 v02 objects that may result in a noSuchName error.
d) The management station shall GET humEssTreatments.0.
e) For each treatment from 1 to the number of treatments, the management station shall GET the
following objects:
1) essPaveTreatProductType.y
2) essPaveTreatProductForm.y
3) essPercentProductMix.y

Where,
X = the sensor index,
y = the index of the treatment

4.2.6 Configure Stationary Pavement Treatment System

The standardized dialog for a management station to configure a stationary pavement treatment system
shall be as follows:

a) The management station shall GET nhumEssTreatments.0.

b) For each treatment from 1 to the number of treatments, the management station shall SET the
following objects to the desired values:
1) essPaveTreatProductType.x
2) essPaveTreatProductForm.x

¢) The management station shall SET every instance of essPercentProductMix.x to the desired values
such that the total of all instances shall equal 100.

d) The management station shall SET the following objects to their desired values:
1) ptsSignalDuration.0
2) ptsMonitoringDetectors.0
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Where,
x = the index of the treatment

4.2.7 Configure Passive Ice Detection Logic

The standardized dialog for a management station to configure the passive ice detection logic shall be as
follows:

a) The management station shall GET numEssTreatments.0.
b) For each treatment from 1 to the number of treatments, the management station shall SET the
following objects to the desired values:
1) essPaveTreatProductType.x
2) essPaveTreatProductForm.x
3) essPercentProductMix.x
The management station shall set every instance of essPercentProductMix.x to the desired value such
that the total of all instances shall equal 100.

Where,
x = the index of the treatment

4.2.8 Configure Mobile Pavement Treatment System

The standardized dialog for a management station to configure a mobile pavement treatment system
shall be as follows:

a) The management station shall GET numEssTreatments.0.
b) For each treatment from 1 to the number of treatments, the management station shall SET the
following objects to the desired values:
1) essPaveTreatProductType.x
2) essPaveTreatProductForm.x
¢) The management station shall SET every instance of essPercentProductMix.x to the desired values
such that the total of all instances shall equal 100.
d) The management station shall SET the following objects to their desired values:
1) essPaveTreatmentAmount.O
2) essPaveTreatmentWidth.0
3) ptsSignalDuration.0

Where,
X = the index of the treatment

4.2.9 Retrieve Solar Radiation

The standardized dialog for a management station to retrieve solar radiation shall be as follows:

a) The management station shall GET radiationSensorTableNumSensors.0.
b) For each sensor from 1 to the number of solar radiation sensors, the management station shall GET
the following objects:
1) essTotalSunVv4.x
2) essInstantaneousTerrestrialRadiationV4.x.
3) essInstantaneousSolarRadiationV4.x.
4) essTotalRadiationV4.x.
¢) The management station shall GET essTotalRadiationPeriod.0.

Where,
x = the index of the solar radiation sensor
4.2.10 Retrieve Mobile Pavement Treatment System

The standardized dialog for a management station to retrieve the configuration of a mobile pavement
treatment system shall be as follows:
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a) The management station shall GET numEssTreatments.0.
b) For each treatment from 1 to the number of treatments, the management station shall GET the
following objects:
1) essPaveTreatProductType.x
2) essPaveTreatProductForm.x
3) essPercentProductMix.x
c) The management station shall GET the following objects:
1) essPaveTreatmentAmount.0
2) essPaveTreatmentWidth.0
3) ptsSignalDuration

Where,
x = the index of the treatment
4.3 State Transition Diagrams
The following define the states for various object classes that may be supported by the device.
4.3.1 Pavement Treatment System State Transition Diagram

Figure 8 depicts the state transition diagram for the Pavement Treatment System class.

Automatic

Detect Auto-activate Condition
Set PtsOperationaMode. 0= off
‘ [ TEEhe Set PtsCommandState.0 = activate Active

do/ trigger sprayer for duration

Set PtsOperation 2.0 = automatic
Set PtsOpepationalMode.0 = manual
off
Set PtsOperativhalMode. 0= automatic
Set PtsOperatiof de.0 = manual

{ Manual
Inactive Set PtsCommandState 0 = activate( Active
Set PtsOperationalMode.0 = off ‘

do/ trigger sprayer for duration

Sprayer Operational
State Maode

Figure 8 Pavement Treatment System State Machine Diagram

4311 Off

When in the "off" state, the PTS shall not trigger the sprayer even if commanded to do so and shall
always be inactive. The PTS shall transition to the requested operational mode, upon request.

4.3.1.2 Automatic

When in the "automatic" state, the PTS shall monitor conditions and trigger the sprayer based on a
manufacturer specific algorithm. The algorithm shall only consider input from the detectors selected in the
ptsMonitoringDetectors object. The PTS shall also trigger the sprayer if commanded to do so via the
ptsCommandStateV3 object. The PTS shall transition to the requested operational mode, upon request.
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4.3.1.3 Manual

When in the "manual” state, the PTS shall trigger the sprayer if commanded to do so via the
ptsCommandStateV3 object. The PTS shall transition to the requested operational mode, upon request.

4.3.1.4 Inactive
When in the "inactive" state, the PTS shall not be spraying.
4.3.1.5 Active

Upon entering the "active" state, the PTS shall trigger the sprayer and spray the chemical for a duration
as defined by the ptsSignalDuration object. Upon expiration of this duration, the PTS shall automatically
transition back to the "inactive" state.

44 Class Diagrams

The relationships between data elements are described through the use of UML class diagrams. The
class diagrams shown in this document are produced by PlantUML and only show current objects defined
in this document. Figure 9 provides a sample class diagram.

FieldDevice

_

ESS

0.1

Pressure

essNumPressureSensors Integer32

1..255

Pressure5ensor

essPressureSensorindex Integer32

o essPressureSensorLocation SnmpAdminString
essPressureSensorAtmosphericPressure Integer32

o essPressureSensorXOffset ITSIntegerl6

o essPressureSensorYOffset ITSIntegerl6

o essPressureSensorZ0ffset ITSIntegerl6
essPressureSensorEntityID PhysicalindexOrZero

Figure 9 Sample Class Diagram for Temperature Sensors

Each box represents a logical class (grouping) of data. The box contains a hame in the upper
compartment and a list of any applicable attributes (i.e., individual pieces of information to describe the
class) in the lower compartment along with its datatype. Lines between classes indicate that the classes
have a relationship.

A number at the end of a relationship line indicates the number of instances of the class that may exist in
relation to one instance of the other class. An asterisk (*) indicates an infinite number. A range of values
may be indicated in the format of a number followed by two periods followed by another number.

A green circle next to an attribute indicates that it has a maximum access or read-write while a yellow

diamond indicates a maximum access of read-only. A red square indicates that the attribute is not
accessible.
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An open arrow indicates that the class from which the arrow originates is a type of the class to which the
arrow points (i.e., an ESS is a type of FieldDevice).

The complete definition of each attribute identified in the diagram is provided in Section 5.

441 ESS Characteristics

As depicted in the UML class diagram provided in Figure 10, an ESS is a type of FieldDevice, which is
defined in ISO 26048-1 and can be characterized by its type of station. A MobilePlatform is a special type
of ESS that is able to collect information while in motion. While MobilePlatforms are relatively new to the

industry, this standard provides a basic level of support for obtaining data from such devices, in addition
to any base sensor information that might be available.

FieldDevice

—

255

< essTypeofStation enum

0.1

MobilePlatform

< essMobileObservationGroundStateV4 enum
< essMobileObservationPavementV4 enum

Figure 10 ESS Characteristics Class Diagram
44.2 Pressure Sensor

The ESS can support atmospheric pressure sensors as indicated in Figure 11.

255

0.1

Pressure

< essNumPressureSensors Integer32

1..255

PressureSensor

< essPressureSensorindex Integer32

o essPressureSensorLocation SnmpAdminString

< essPressureSensorAtmosphericPressure Integer32
o essPressureSensorXOffset ITSIntegerl6

o essPressureSensorYOffset ITSIntegerl6

o essPressureSensorZ0ffset ITSIntegerl6

< essPressureSensorEntityID PhysicallndexOrZero

Figure 11 Pressure Sensor Class Diagram
4.4.3 Wind Data

The ESS can support wind sensors as indicated in Figure 12.
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Figure 12 Wind Sensor Class Diagram

44.4 Temperature

0.1

wind

< essWindSituation enum
& windSensorTableNumSensors Integer32

1..255

WindSensor

< windSensorindex Integer32

o windSensorLocation SnmpAdminString
< windSensorAvgSpeed Integer32

< windSensorAvgDirection Integer32

< windSensorSpotSpeed Integer32

< windSensorSpotDirection Integer32

& windSensorGustSpeed Integer32

< windSensorGustDirection Integer32

< windSensorSituation enum

o windSensorXOffset ITSIntegerl6

o windSensorYOffset ITSIntegerl6

o windSensorZOffset ITSIntegerl6

< windSensorEntitylD PhysicallndexOrZero

The ESS can support temperature sensors as depicted in Figure 13.

Temperature

< essNumTemperatureSensors Integer32
< essMaxTemp Integer32
< essMinTemp Integer32

1..255

TemperatureSensor

< essTemperatureSensorindex Integer32
< essAirTemperature Integer32

o essTemperatureSensorLocation SnmpAdminString
o essTemperatureSensorXOffset ITSIntegerl6
o essTemperatureSensorYOffset ITSIntegerl6
o essTemperatureSensorZ0ffset ITSIntegerl6
< essTemperatureSensorEntitylD PhysicallndexOrZero

Figure 13 Temperature Sensor Class Diagram

4.4.5 Precipitation

ESS can support precipitation sensors as depicted in Figure 14.
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255

© essTypeofStation enum

0.1

Precipitation

< essPrecipSituation enum
< precipitationSensorTableNumSensors Integer32

1..255

PrecipitationSensor

< precipitationSensorindex Integer32

o precipitationSensorLocation SnmpAdminString

o precipitationSensorPeriod Integer32

< precipitationSensorAdjacentSnowDepth Integer32

< precipitationSensorRoadwaySnowDepth Integer32

© precipitationSensorRoadway SnowPackDepth Integer32
< precipitationSensorPrecipYesNo enum

< precipitationSensorPrecipRate Integer32

© precipitationSensorSnowfallAccumRate Integer32

< precipitationSensorPrecipSituation enum

< precipitationSensorPrecipitationOneHour Integer32

< precipitationSensorPrecipitationThreeHours Integer32
< precipitationSensorPrecipitationSixHours Integer32

< precipitationSensorPrecipitationTwelveHours Integer32
© precipitationSensorPrecipitation24Hours Integer32

© precipitationSensorPrecipitationUserDefined Integer32
© precipitationSensorPrecipStartDate ITSDateStamp

< precipitationSensorPrecipStartTimeV5 ITSDaily TimeStamp
© precipitationSensorPrecipEndDate ITSDateStamp

< precipitationSensorPrecipEndTimeV5 ITSDailyTimeStamp
o precipitationSensorXOffset ITSIntegerl6

o precipitationSensorYOffset ITSIntegerl6

o precipitationSensorZOffset ITSIntegerl6

< precipitationSensorEntitylD PhysicalindexOrZero

Figure 14 Precipitation Sensor Class Diagram

4.4.6 Water Level Class Diagram

The ESS can support water level sensors as depicted in Figure 16 .
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WaterLevel

< waterLevelSensorTableNumSensors Integer32

1..255

WaterLevelSensor

< waterLevelSensorindex Integer32

< waterLevelSensorReading Integer32

o waterLevelSensorWarningLevel Integer32

o waterLevelSensorLocation SnmpAdminString

o waterLevelSensorReferencePoint SnmpAdminString
o waterLevelSensorXOffset ITSIntegerl6

o waterLevelSensorYOffset ITSIntegerl6

o waterLevelSensorZOffset ITSIntegerl6

< waterLevelSensorEntitylD PhysicallndexOrZero

Figure 15 Water Level Sensor Class Diagram
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44,7 Humidity Class Diagram

The ESS can support humidity sensors as depicted in Figure 16.

255

0.1

Humidity

© humiditySensorTableNumSensors Integer32

1..255

HumiditySensor

<& humiditySensorindex Integer32

o humiditySensorLocation SnmpAdminString

< humiditySensorRelativeHumidity Integer32

o humiditySensorTemperaturelnformation Integer32
< humiditySensorWetbulbTemp Integer32

< humiditySensorDewpointTemp Integer32

o humiditySensorXOffset ITSIntegerl6

o humiditySensorYOffset ITSIntegerl6

o humiditySensorZOffset ITSIntegerl6

< humiditySensorEntity ID PhysicallndexOrZero

Figure 16 Humidity Sensor Class Diagram
4.4.8 Radiation

The ESS can support radiation sensors as depicted in Figure 17.

0.1

Radiation

< essTotalRadiationPeriod Integer32
< radiationSensorTableNumSensors Integer32
© essCloudSituationV4 Integer32

1..255

RadiationSensor

< radiationSensorindex Integer32

o radiationSensorLocation SnmpAdminString

< essTotalSunVv4 Integer32

< essInstantaneousTerrestrialRadiationV4 Integer32
< essInstantaneousSolarRadiationV4 Integer32

< essTotalRadiationV4 Integer32

o radiationSensorXOffset ITSIntegerlé

o radiationSensorYOffset ITSIntegerl6

o radiationSensorZOffset ITSIntegerl6

< radiationSensorgntitylD PhysicallndexOrZero

Figure 17 Radiation Sensor Class Diagram
4.49 \Visibility

The ESS can support visibility sensors as depicted in Figure 18.
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0.1

Visibility
< essNumVisibilitySensors Integer32
< essVisibilitySituation enum

1..255

VisibilitySensor

o essVisibilitySensorindex Integer32

o essVisibilitySensorXOffset ITSIntegerl6
o essVisibilitySensorYOffset I TSIntegerl6
o essVisibilitySensorZOffset ITSIntegerl6
< essVisibilitySensorDirection Integer32

o essVisibilitySensorLocation SnmpAdminString

& essVisibilitySensorEntitylD PhysicallndexOrZero
< essVisibilitySensorCurrentReading Integer32

Figure 18 Visibility Sensor Class Diagram

The ESS can support pavement sensors as depicted in Figure 19.

© 2022 AASHTO / ITE / NEMA

0.1

Pavement

< numEssPavementSensors Integer32

1..255

PavementSensor

& essPavementSensorindex Integer32

o essPavementSensorLocation SnmpAdminString
o essPavementType enum

o essPavementExposure Integer32

< essPavementSensorType enum

< essSurfaceTemperature Integer32

< essPavementTemperature Integer32

& essSurfaceSalinity Integer32

< essSurfaceFreezePoint Integer32

< essSurfaceBlacklceSignal enum

< essPavementSensorEmor enum

< essSurfacelceOrWaterDepth Integer32

< essSurfaceConductivityV2 Integer32

< pavementSensorTemperatureDepth Integer32
< pavementSensorSurfaceCondition enum

< pavementSensorForecastCondition enum

< pavementSensorFrictionCoefficient Integer32
< pavementlcePercentage Integer32

o essPavementMonitorXOffset ITSIntegerl6

o essPavementMonitorYOffset ITSIntegerl6

o essPavementMonitorZOffset ITSIntegerl6

o essPavementSensorXOffset ITSIntegerl6

o essPavementSensorYOffset ITSIntegerl6

& essPavementSensorEntity ID PhysicallndexOrZero

Figure 19 Pavement Sensor Class Diagram
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4411 Subsurface Data

The ESS can support subsurface sensors as depicted in Figure 20.

4.412 Air Quality Data

\is 5

0.1
SubSurface

< numEssSubSurfaceSensors Integer32

1..255

SubSurfaceSensor

& essSubSurfaceSensorindex Integer32

o essSubSurfaceSensorLocation SnmpAdminString

o essSubSurfaceType enum

o essSubSurfaceSensorDepth Integer32

< essSubSurfaceTemperature Integer32

< essSubSurfaceSensorEntitylD PhysicallndexOrZero
© essSubSurfaceMoisture Integer32

< essSubSurfaceSensorError enum

o essSubSurfaceSensorXOffset ITSIntegerl6

o essSubSurfaceSensorYOffset ITSIntegerl6

Figure 20 Subsurface Sensor Class Diagram

The ESS can support air quality sensors as depicted in Figure 21.

4.413 Snapshot Data

AirQuality

< essCO Integer32

< essNO2 Integer32

< 8ssS02 Integer32

< essPM10 Integer32

< e55PM25 Integer32

< essCO2V4 INTEGER

< essNOV4 INTEGER

< ess03V4 INTEGER

< essPM1 Integer32

< airQualitySensorTableNumSensors Integer32

1..255

AirQualitySensor

< airQualitySensorindex Integer32

o airQualitySensorLocation SnmpAdminString

o airQualitySensorXOffset ITSIntegerl6

o airQualitySensorY Offset ITSIntegerl6

o airQualitySensorZOffset ITSIntegerl6

© airQualitySensorEntitylD PhysicallndexOrZero

Figure 21 Air Quality Sensor Class Diagram

The ESS can support snapshot cameras and associated snapshots as depicted in Figure 22. The
shapshots are accessed using SFTP or a similar protocol and are not accessible through SNMP.
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ess|
0.1 0
SnapshotCameraTable Snapshot
o filename string
< essSnapshotNumberOfCameras Integer32 o I e

1..255

SnapshotCamera

< essSnapshotCameralndex Integer32

o essSnapshotCameraDescription SnmpAdminString
& essSnapshotCameraStoragePath SnmpAdminString
o essSnapshotCameraCommand enum

< essSnapshotCameraError enum

© essSnapshotCameraSupportedFormats BITS

o essSnapshotCameraFileFormat DisplayString

o essSnapshotCameraFilenameV5 SnmpAdminString
< essSnapshotCameraEntitylD PhysicallndexOrZero

Figure 22 Snapshot Class Diagram
4.414 Pavement Treatment System

The ESS can support a pavement treatment system as depicted in Figure 23.
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0.1

PavementTreatmentSystem

< ptsSprayerState enum

o ptsSignalDuration Integer32

© ptsSignalEventCount Counter32

< ptsActiveEventCount Counter32

< ptsinactiveEventCount Counter32

< ptsError enum

o ptsMonitoringDetectors OCTET STRING

o ptsOperationalModeV3 enum

o ptsCommandStateV3 enum

o essPavementTreatmentLocation SnmpAdminString
© ptsLastSignalEventDate ITSDateStamp

< ptsLastSignalEventTime ITSDailyTimeStamp
& ptsLastActiveEventDate ITSDateStamp

< ptsLastActiveEventTime ITSDaily TimeStamp
< ptsLastinactiveEventDate ITSDateStamp

© ptsLastinactiveEventTime ITSDailyTimeStamp
o ptsXOffset ITSIntegerl6

o ptsYOffset ITSIntegerl6

© ptsEntitylD PhysicallndexOrZero

1

PavementTreatmentTable

< numEssTreatments Integer32
o essPaveTreatmentAmount Integer32
o essPaveTreatmentWidth Integer32

1..255

PavementTreatment

< essPavementTreatmentindex Integer32
o essPaveTreatProductType enum
o essPaveTreatProductForm enum
o essPercentProductMix Integer32

Figure 23 Pavement Treatment Class Diagram
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Section 5
Management Information Base (MIB) [Normative]

This section defines those objects which are specific to ESS. The objects are defined using the OBJECT-
TYPE macro as specified in NTCIP 8004, which is based on RFC 2578 and related standards. The text
provided from Section 5.1 through the end of Section 5 (except the section headings) constitutes the
NTCIP1204-Ess MIB.

This section generally presents the objects in lexicographical order of their OBJECT IDENTIFIERS, which
correspond to their physical location within the global naming tree. Most of the objects defined in this
document reside under the “ess” node of the global naming tree. To aid in object management, the “ess”
node has been subdivided into logical categories, each defined by a node under the “ess” node. The
individual objects are then located under the appropriate node.

Conformance requirements for any object is determined by the use of the Requirements Traceability
Matrix (RTM) in Annex A. To support any defined Requirement, an implementation shall support all
objects to which the Requirement traces in the RTM. An implementation shall support the full
standardized range of each supported object, unless otherwise noted in the object refinement table in
Annex A. An implementation shall indicate their level of conformance to this standard through the use of
an AGENT-CAPABILITIES statement, as defined by RFC 2580, which indicates supported OBJECT-
GROUPSs and object ranges.

This MIB is managed by the NTCIP ESS Working Group and proprietary features should be defined
through vendor-specific nodes in vendor-specific extensions to this MIB. All values not explicitly defined
(e.g., enumerated values not listed, bits not defined, etc.) are reserved for future use by the ESS Working
Group and shall not be used by implementations until defined by the ESS WG.

A computer readable format of this information, called a Management Information Base, is available from
https://github.com/ite-org/NTCIP1203. The MIB has been verified using
https://www.simpleweb.org/ietf/mibs/validate/.

Previous versions of this document defined data elements that have been replaced to resolve
ambiguities; however, central systems may need to interoperate with older equipment and support such
data elements. These replaced objects have a status of 'deprecated' or 'obsolete’ and indicate the version
in which they were deprecated; Annex D documents the reason that the ESS WG decided to deprecate
various objects within the current version.

5.1 MIB Header

NTCIP1204-Ess DEFINITIONS ::= BEGIN
IMPORTS
MODULE-IDENTITY, OBJECT-IDENTITY, OBJECT-TYPE,
Integer32, Unsigned32, Counter32
FROM SNMPv2-SMI
-- RFC 2578
DisplayString
FROM SNMPv2-TC
-- RFC 2579
OBJECT-GROUP
FROM SNMPv2-CONF

-—- RFC 2580
SnmpAdminString
FROM SNMP-FRAMEWORK-MIB
-- RFC 3411
PhysicalIndexOrZero

FROM ENTITY-MIB
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-- RFC 6933
ITSDailyTimeStamp, ITSDateStamp, ITSIntegerl6, ITSOerString
FROM IS5026048-1-FieldDevice-TC
devices
FROM NTCIP8004-Transportation;

ess MODULE-IDENTITY
LAST-UPDATED "202307260500z"
ORGANIZATION "NTCIP ESSS WG"
CONTACT-INFO
"name: NTCIP Coordinator
email: ntcip@nema.org
postal: National Electrical Manufacturers Association
1300 North 17th Street, Suite 1752
Rosslyn, Virginia 22209-3801"

DESCRIPTION
"<Definition> This MIB defines the environmental sensor station (ESS)
objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5"
REVISION "202307260500z"
DESCRIPTION

"<Definition> NTCIP 1204 v05 - Upgraded to SMIv2 format and incorporated
objects from the ISO 26048 series into design."
REVISION "202204010500z"
DESCRIPTION
"<Definition> NTCIP 1204 v04 - Improved 1) support for multiple sensors
of the same type, 2) support for infrared sensors that collect
multiple parameters from the same sensor, and 3) support for metadata.
Other edits as needed."
REVISION "200910300500z"
DESCRIPTION
"<Definition> NTCIP 1204 v03 - Added test procedures to Annex C and
other edits."
REVISION "200507230500z"
DESCRIPTION
"<Definition> NTCIP 1204 v02 - Added systems engineering content,
including Section 2 (Concept of Operations), Section 3 (Requirements),
Section 4 (Dialogs), and Annex A (Requirements Traceability Table)
along with other refinements based on lessons learned."
REVISION "200111230500z"
DESCRIPTION
"<Definition> NTCIP 1204 v0lAl - Corrected typos and other issues in the
original document."
REVISION "199809280500z"
DESCRIPTION
"<Definition> NTCIP 1204 v0l - Initial version of NTCIP 1204."
::= { devices 5 }

essBufr OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> This node contains objects that describe BUFR information
based on the BUFR Standards.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1"
::= {ess 1}

essNtcip OBJECT-IDENTITY
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STATUS current
DESCRIPTION
"<Definition> This node contains objects that describe surface
transportation environmental information which deviates from the BUFR
Standards.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2"
::= {ess 2}

5.2 Identification Objects

essNtcipIdentification OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> These are objects used to describe the identification of
the environmental sensor station.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.1"
::= {essNtcip 1 }

5.2.1 Station Category

-- This object has been deprecated.
essNtcipCategory OBJECT-TYPE
SYNTAX INTEGER {
other (1),
permanent (2),
transportable (3),
mobile (4) }
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION
"<Definition> Indicates the category of station as it relates to
mobility.
<Format>
value description
other of a design not listed in this standard.
permanent not designed to be relocated.
transportable able to be relocated, but does not take readings while
moving.
mobile capable of taking readings while moving.

<Parameter Type> status
<Superseded by> I5026048-1-FieldDevice:fdMobility (ISO 26048-1)
<Informative> This object was deprecated in NTCIP 1204 vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.1.1"

::= { essNtcipIdentification 1 }

5.2.2 Site Description

-- This object has been deprecated.
essNtcipSiteDescription OBJECT-TYPE

SYNTAX DisplayString (SIZE (0..255))
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> A textual description of the station's location.

<Parameter Type> configuration

<Supplanted by> sysLocation (RFC 3418)

<Informative> Version 02 of the standard incorrectly defined a
SetConstraint of read-only, even though the object has always been
defined with an access of read-write. This was corrected in version
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03. This object was deprecated in NTCIP 1204 wvO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.1.2"
::= { essNtcipIdentification 2 }

5.3 Data Instrumentation Objects

essBufrInstrumentation OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the type of data and the type of
instrumentation used to collect the data being received from the ess
when the data has a BUFR equivalent.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.2"
::= { essBufr 2 }

essNtcipInstrumentation OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the type of data and the type of
instrumentation used to collect the data being received from the ESS
when there is not a BUFR equivalent to the data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15"
:= { essNtcip 15 }

-- It is also recognized that there would be a great value of an object to
-- indicate the quality of data; however, this is a very complex topic and
-- thus we have not determined an appropriate mechanism.

5.3.1 Type of Station

essTypeofStation OBJECT-TYPE
SYNTAX INTEGER {
automatic (0),
staffed (1),
reserved (2),
missingValue (3) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Integer value that indicates the type of station. If the
station is a hybrid station, it should be represented with two SNMP
contexts, one would report automatic and report all automatic readings
while the other would report staffed and provide only the human

readings.
<Format>
value description
0 - automatic the data is collected electronically/mechanically
1 - staffed the data is collected by humans
2 - reserved
3 - missingValue the type of station is unknown.

<Parameter Type> status
<Informative> The value of 2 has been explicitly defined as being
reserved. To be defined as two stations (e.g., for a hybrid), a
station needs to have two addresses and two instances of this MIB.
The syntax was changed from INTEGER (0..3) to an enumeration in version
05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.2.1"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 02 001"
::= { essBufrInstrumentation 1 }
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5.3.2 Door Status
-—- This object has been deprecated.
essDoorStatus OBJECT-TYPE

SYNTAX Integer32 (0..1)

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> Indicates whether any of the doors attached to the station
are open. If the value is one (1), at least one door is open; if the

value is zero (0), all doors associated with the ESS are closed.

<Parameter Type> status

<Superseded by> fdSrsaTypeWarning.FDO

<Informative> This object was deprecated in v05 to migrate to a more
generic SRSA design that allow reporting the status of each door
associated with the ESS.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.1"

::= { essNtcipInstrumentation 1 }

5.3.3 Battery Status

-- This object has been deprecated.
essBatteryStatus OBJECT-TYPE

SYNTAX Integer32 (0..101)

UNITS "percent"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
"<Definition> Indicates the current charge stored in the battery.
<Format>

Values 0 to 100 indicate percent of full charge. The value 101
indicates
an error in determining the percent of charge.
<Parameter Type> status
<Superseded by> fdSrsaPortValue.FBC
<Informative> This object was deprecated in vO05 to migrate to a more
generic SRSA design.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.2"
::= { essNtcipInstrumentation 2 }

5.3.4 Line Volts

-- This object has been deprecated.
essLineVolts OBJECT-TYPE

SYNTAX Integer32 (0..255)

UNITS "*2 Volts Root Mean Squared (Vrms)"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> Indicates the voltage measured on the incoming power line
for the controller. The value reported indicates one-half of the
actual voltage; thus, this object indicates a value of 55 when the
voltage is 110 Vrms. This object shall only be used to indicate A/C
power conditions. If the line power is DC, this object shall not apply
(i.e., either is not supported or has a value of 255) and the
essBatteryStatus object shall indicate the status of the batteries.

<Format>
Values 0 through 254 shall indicate valid values. The value 254 shall
mean a voltage of 508 Vrms or greater. The value of 255 shall indicate
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an error condition or missing value.
<Parameter Type> status
<Superseded by> fdSrsaPortValue.FLV

<Informative> This object was deprecated in v05 to migrate to a more

generic SRSA design.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.3"
::= { essNtcipInstrumentation 3 }

5.3.5 Station Meta Data Block

-- This object has been deprecated.
essStationMetaDataBlock OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssStationMetaData structure

as defined below.

This object is used for uploading configuration data from the ESS in a

bandwidth efficient manner.

The OPTIONAL fields shall be present if the data is

supported by the

implementation and is valid. The OPTIONAL fields shall be omitted for
any data that is invalid or not supported by the implementation.

EssStationMetaData ::= SEQUENCE ({

essNtcipCategory.0 OPTIONAL, -- @NTCIP1204-Ess
essTypeOfStation.0 OPTIONAL, -- @NTCIP1204-Ess
essLatitude.O OPTIONAL, -— @NTCIP1204-Ess
essLongitude.O OPTIONAL, -- @NTCIP1l204-Ess
essReferenceHeight.O OPTIONAL, -- @NTCIP1204-Ess
essPressureHeight.0 OPTIONAL, -- @NTCIP1204-Ess
essWindSensorHeight.O OPTIONAL, -- @NTCIP1204-Ess
temperatureMetaData SEQUENCE OF TemperatureMetaData OPTIONAL,
pavementMetaData SEQUENCE OF PavementMetaData OPTIONAL,
subSurfaceMetaData SEQUENCE OF SubSurfaceMetaData OPTIONAL,
treatmentMetaData SEQUENCE OF TreatmentMetaData OPTIONAL
}

TemperatureMetaData ::= SEQUENCE ({
essTemperatureSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
essTemperatureSensorHeight.x OPTIONAL -- @NTCIP1204-Ess

}

PavementMetaData ::= SEQUENCE ({

essPavementSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
essPavementType.x OPTIONAL, -- @NTCIP1204-Ess
essPavementElevation.x OPTIONAL, -- @NTCIP1204-Ess
essPavementExposure.x OPTIONAL, -- @NTCIP1204-Ess
essPavementSensorType.x OPTIONAL -- @NTCIP1204-Ess

}

SubSurfaceMetaData ::= SEQUENCE ({

essSubSurfaceSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
essSubSurfaceType.x OPTIONAL, -- @NTCIP1204-Ess
essSubSurfaceSensorDepth.x OPTIONAL -- @NTCIP1204-Ess

}
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TreatmentMetaData ::= SEQUENCE {
essPavementTreatmentIndex.x OPTIONAL, -— @NTCIP1204-Ess
essPaveTreatProductType.x OPTIONAL, -- @NTCIP1204-Ess
essPaveTreatProductForm.x OPTIONAL, -— @NTCIP1204-Ess
essPercentProductMix.x OPTIONAL -- @NTCIP1204-Ess

}
<Parameter Type> status
<Superseded by> essStationMetaDataV3Block (See 5.3.8)
<Informative> This object was deprecated in version 03.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.4"
::= { essNtcipInstrumentation 4 }

5.3.6 Weather Block

-- This object has been deprecated.
essWeatherBlock OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssWeatherData structure as
defined in Section 4.
This object is used for uploading current weather data from the ESS in
a bandwidth efficient manner.

The OPTIONAL fields shall be present if the data is supported by the
implementation and is valid. The OPTIONAL fields shall be omitted for
any data that is invalid or not supported by the implementation.

EssWeatherData ::= SEQUENCE {

essAtmosphericPressure.0 OPTIONAL, -- @NTCIP1204-Ess

essWindData EssWindData OPTIONAL,

essTemperatureData EssTemperatureData OPTIONAL,

essPrecipData EssPrecipData OPTIONAL,

essVisibilityData EssVisibilityData OPTIONAL

}

EssWindData ::= SEQUENCE ({

essAvgWindDirection.O OPTIONAL, -- @NTCIP1204-Ess

essAvgWindSpeed. 0 OPTIONAL, -- @NTCIP1204-Ess

essWindSituation.O OPTIONAL, -- @NTCIP1204-Ess

essMaxWindGustSpeed. O OPTIONAL, -- @NTCIP1204-Ess

essMaxWindGustDir.O0 OPTIONAL, -- @NTCIP1204-Ess

essSpotWindDirection.0 OPTIONAL, -- @NTCIP1204-Ess

essSpotWindSpeed. O OPTIONAL -- @NTCIP1204-Ess

}

EssTemperatureData ::= SEQUENCE {

essWetBulbTemp.0 OPTIONAL, -- @NTCIP1204-Ess

essDewpointTemp.0 OPTIONAL, -- @NTCIP1204-Ess

essMaxTemp.0 OPTIONAL, -- @NTCIP1204-Ess

essMinTemp.0 OPTIONAL, -- @NTCIP1204-Ess

essRelativeHumidity.O OPTIONAL, -- @NTCIP1204-Ess
-—- for (

-= x =1;

-- x < essNumTemperatureSensors.0;

-- x++)

temperatureTable SEQUENCE OF Temperature OPTIONAL
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}
Temperature ::= SEQUENCE {
essTemperatureSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
essAirTemperature.x OPTIONAL -- @NTCIP1204-Ess
}
EssPrecipData ::= SEQUENCE ({
essWaterDepth.O OPTIONAL, -- @NTCIP1204-Ess
essAdjacentSnowDepth.0 OPTIONAL, -- @NTCIP1204-Ess
essRoadwaySnowDepth.0 OPTIONAL, -- @NTCIP1204-Ess
essRoadwaySnowPackDepth. 0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipYesNo.O0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipRate.0 OPTIONAL, -- @NTCIP1204-Ess
essSnowfallAccumRate.O OPTIONAL, -— @NTCIP1204-Ess
essPrecipSituation.0 OPTIONAL, -- @NTCIP1204-Ess
essIceThickness.O OPTIONAL, -— @NTCIP1204-Ess
essPrecipitationStartTime.O OPTIONAL, -- @NTCIP1204-Ess
essPrecipitationEndTime.0 OPTIONAL -- @NTCIP1204-Ess
essPrecipitationOneHour.0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipitationThreeHours.0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipitationSixHours.0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipitationTwelveHours.O OPTIONAL, -- @NTCIP1204-Ess
essPrecipitation24Hours.0 OPTIONAL -- @NTCIP1204-Ess
}
EssVisibilityData ::= SEQUENCE {
essSolarRadiation. O OPTIONAL, -- @NTCIP1204-Ess
essTotalSun.0 OPTIONAL, -— @NTCIP1204-Ess
essCloudSituation.O OPTIONAL, -- @NTCIP1204-Ess
essVisibility.0 OPTIONAL, -- @NTCIP1204-Ess
essVisibilitySituation.O OPTIONAL -- @NTCIP1204-Ess

}
<Parameter Type> status
<Superseded by> essWeatherV3Block (See 5.3.9)
<Informative> This object was deprecated in NTCIP 1204 vO03.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.5"
:= { essNtcipInstrumentation 5 }

5.3.7 Mobile Block

-- This object has been deprecated.
essMobileBlock OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssMobileData structure as
defined below. This object is used for uploading current mobile station
data from the ESS in a bandwidth efficient manner.

The OPTIONAL fields shall be present if the data is supported by the
implementation and is wvalid. The OPTIONAL fields shall be omitted for
any data that is invalid or not supported by the implementation.

EssMobileData ::= SEQUENCE {
essLatitude.O OPTIONAL, -- @NTCIP1204-Ess
essLongitude.O OPTIONAL, -- @NTCIP1204-Ess
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@NTCIP1204-Ess
@NTCIP1204-Ess
@NTCIP1204-Ess

@NTCIP1204-Ess
@NTCIP1204-Ess

essMobileObservationGroundState.0 OPTIONAL, -- @NTCIP1204-Ess
essMobileObservationPavement.0 OPTIONAL, -- @NTCIP1204-Ess
essPaveTreatmentAmount.0 OPTIONAL, -- @NTCIP1204-Ess

essPaveTreatmentWidth.O

}

<Parameter Type> status

OPTIONAL

@NTCIP1204-Ess

<Informative> This object was deprecated and withdrawn in version 04 as
the associated requirement was deemed to be no longer necessary.

<Object Identifier> 1.3.6.1.4.1.1206.4.

{ essNtcipInstrumentation 6 }

5.3.8 Station Meta Data Block Version 3

-- This object has been deprecated.
essStationMetaDataV3Block OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of
structure as defined below.

2.5.2.15.6"

the EssStationMetaDataV3

This object is used for uploading configuration data from the ESS in a

bandwidth efficient manner.

The OPTIONAL fields shall be present
implementation and is valid.

if the data is supported by the

The OPTIONAL fields shall be omitted for

any data that is invalid or not supported by the implementation.

EssStationMetaDataV3 = SEQUENCE {
essNtcipCategory.0, OPTIONAL,
essTypeOfStation.O, OPTIONAL,
essLatitude.O, OPTIONAL, --
essLongitude.O, OPTIONAL, -
essReferenceHeight.O, OPTIONAL,
essPressureHeight.O, OPTIONAL,

precipitationSensorModelInformation.0
SEQUENCE OF WindMetaData
SEQUENCE OF TemperatureMetaData
SEQUENCE OF PavementMetaData
SEQUENCE OF SubSurfaceMetaData
SEQUENCE OF TreatmentMetaData

windMetaData.O,
temperatureMetaData
pavementMetaData
subSurfaceMetaData
treatmentMetaData

}

WindMetaData = SEQUENCE {
windSensorIndex.x OPTIONAL,
windSensorHeight.x OPTIONAL, -
}

TemperatureMetaData = SEQUENCE {

essTemperatureSensorIndex.x
essTemperatureSensorHeight.x

}
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OPTIONAL,
OPTIONAL,

@NTCIP1204-Ess
@NTCIP1204-Ess
@NTCIP1204-Ess
@NTCIP1204-Ess
@NTCIP1204-Ess
@NTCIP1204-Ess
OPTIONAL -- @NTCIP1204-Ess
OPTIONAL,
OPTIONAL,
OPTIONAL,
OPTIONAL,
OPTIONAL,

@NTCIP1204-Ess
@NTCIP1204-Ess

@NTCIP1204-Ess
@NTCIP1204-Ess
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PavementMetaData ::= SEQUENCE {
essPavementSensorIndex.x, OPTIONAL, -— @NTCIP1204-Ess
essPavementType.x, OPTIONAL, -- @NTCIP1204-Ess
essPavementklevation.x OPTIONAL, -- @NTCIP1204-Ess
essPavementExposure.x OPTIONAL, -- @NTCIP1204-Ess
essPavementSensorType.x OPTIONAL, -- @NTCIP1204-Ess
pavementSensorModelInformation.x OPTIONAL, -- @NTCIP1204-Ess
pavementSensorTemperatureDepth.x OPTIONAL -- @NTCIP1204-Ess
}
SubSurfaceMetaData ::= SEQUENCE ({
essSubSurfaceSensorIndex.x OPTIONAL, -— @NTCIP1204-Ess
essSubSurfaceType.x OPTIONAL, -- @NTCIP1204-Ess
essSubSurfaceSensorDepth.x OPTIONAL, -- @NTCIP1204-Ess
}
TreatmentMetaData ::= SEQUENCE ({
essPavementTreatmentIndex.x OPTIONAL, -— @NTCIP1204-Ess
essPaveTreatProductType.x OPTIONAL, -- @NTCIP1204-Ess
essPaveTreatProductForm.x OPTIONAL, -— @NTCIP1204-Ess
essPercentProductMix.x OPTIONAL, -— @NTCIP1204-Ess

}
<Parameter Type> status
<Informative> This object was deprecated and withdrawn in NTCIP 1204 v04
as the associated requirement was deemed to be no longer necessary.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.7"
::= { essNtcipInstrumentation 7 }

5.3.9 Weather Block Version 3

-- This object has been deprecated.
essWeatherV3Block OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssWeatherDataV3 structure as
defined below. This object is used for uploading current weather data
from the ESS in a bandwidth efficient manner.

The OPTIONAL fields shall be present if the data is supported by the
implementation and is valid. The OPTIONAL fields shall be omitted for
any data that is invalid or not supported by the implementation.

EssWeatherDataV3 ::= SEQUENCE {

essAtmosphericPressure.0 OPTIONAL, -- @NTCIP1204-Ess
essWindData SEQUENCE OF EssWindDataV3 OPTIONAL,
essTemperatureData EssTemperatureData OPTIONAL,
essPrecipData EssPrecipDataV3 OPTIONAL,
essVisibilityData EssVisibilityDataV3 OPTIONAL,
essRadiationData EssRadiationData OPTIONAL
}

EssWindDataV3 ::= SEQUENCE ({

windSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
windSensorAvgSpeed.x OPTIONAL, -- @NTCIP1204-Ess
windSensorAvgDirection.x OPTIONAL, -- @NTCIP1204-Ess
windSensorSpotSpeed.x OPTIONAL, -- @NTCIP1204-Ess

Copy Per MIB Distribution Permission © 2022 AASHTO / ITE / NEMA



NTCIP 1204 v04.26

Page 93
windSensorSpotDirection.x OPTIONAL, -- @NTCIP1204-Ess
windSensorGustSpeed. x OPTIONAL, -- @NTCIP1204-Ess
windSensorGustDirection.x OPTIONAL, -- @NTCIP1204-Ess
windSensorSituation.x OPTIONAL, -- @NTCIP1204-Ess
}

EssTemperatureData ::= SEQUENCE {
essWetBulbTemp. 0 OPTIONAL, -- @NTCIP1204-Ess
essDewpointTemp.0 OPTIONAL, -- @NTCIP1204-Ess
essMaxTemp. 0 OPTIONAL, -- @NTCIP1204-Ess
essMinTemp. 0 OPTIONAL, -- @NTCIP1204-Ess
essRelativeHumidity.0 OPTIONAL, -- @NTCIP1204-Ess

-- for (

-= x = 1;

-= x < essNumTemperatureSensors.O0;

-— x++)
temperatureTable SEQUENCE OF Temperature OPTIONAL,
}
Temperature ::= SEQUENCE {
essTemperatureSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
essAirTemperature.x OPTIONAL, -- @NTCIP1204-Ess
}
EssPrecipDataV3 ::= SEQUENCE {
waterLevelSensorTable SEQUENCE OF WaterLevel OPTIONAL,
essAdjacentSnowDepth.0 OPTIONAL, -- @NTCIP1l204-Ess
essRoadwaySnowDepth.0 OPTIONAL, -- @NTCIP1204-Ess
essRoadwaySnowPackDepth.0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipYesNo.0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipRate.0 OPTIONAL, -- @NTCIP1204-Ess
essSnowfallAccumRate.O OPTIONAL, -- @NTCIP1204-Ess
essPrecipSituation.O OPTIONAL, -- @NTCIP1204-Ess
essIceThickness.O OPTIONAL, -- @NTCIP1204-Ess
essPrecipitationStartTime.0 OPTIONAL, -- @NTCIP1204-Ess
essPrecipitationEndTime.0 OPTIONAL, -- @NTCIP1204-Ess
}
WaterLevel ::= SEQUENCE ({
waterLevelSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
waterLevelSensorReading.x OPTIONAL, -- @NTCIP1204-Ess
}
EssVisibilityDataV3 ::= SEQUENCE ({
essVisibility.0 OPTIONAL, -- @NTCIP1204-Ess
essVisibilitySituation.O OPTIONAL, -- @NTCIP1204-Ess
}
EssRadiationData ::= SEQUENCE {
essTotalSun.O0 OPTIONAL, -- @NTCIP1204-Ess
essInstantaneousTerrestrialRadiation.0 OPTIONAL, -- @NTCIP1204-Ess
essInstantaneousSolarRadiation.O OPTIONAL, -- @NTCIP1204-Ess
essTotalRadiation.0 OPTIONAL, -- @NTCIP1204-Ess
essTotalRadiationPeriod.0 OPTIONAL, -- @NTCIP1204-Ess
essCloudSituation.O OPTIONAL, -- @NTCIP1204-Ess

}

<Parameter Type> status
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<Informative> This object was deprecated and withdrawn in NTCIP 1204 v04
as the associated requirement was deemed to be no longer necessary.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.8"
::= { essNtcipInstrumentation 8 }

5.3.10 ESS Status

-- This object has been deprecated.
essStatus OBJECT-TYPE

SYNTAX Integer32 (0..3)
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> Integer value that indicates whether an error condition
has been detected in the ESS hardware or software.

<Format>
value description
0 - noError no error is reported
1 - watchdogFailure the watchdog has failed
2 - powerError irregular occurrence detected with primary power source
3 - sensorFailure condition detected preventing proper reporting or a

sensor value is deemed invalid or suspect
<Parameter Type> status
<Superseded by> fdControllerStatus (ISO 26048-1)
<Informative> The object was deprecated in NTCIP 1204 vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.15.9"
::= { essNtcipInstrumentation 9 }

5.4 Location Objects
essNtcipLocation OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> Contains objects used to describe the location of the ESS
that is

transmitting the collected data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.2"
::= {essNtcip 2 }

5.41 Latitude

-- This object has been deprecated.
essLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees of latitude"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 10"-6 degrees of the ESS station, per
WGS-84 datum.

<Format>
The essLatitude at the North Pole is 90,000,000. The essLatitude at the
South Pole is -90,000,000. The value 90,000,001 shall indicate a
missing value.

<Parameter Type> status

<Superseded by> IS026048-1-FieldDevice:fdConfiguredLatitude

<Informative> This object was deprecated in NTCIP 1204 v05 to use the
more generic object and to be consistent with preferred units used in
ITS (i.e., 107-7 degrees).
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.2.1"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { essNtcipLocation 1 }

5.4.2 Longitude

-—- This object has been deprecated.
essLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees of longitude"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 10%-6 degrees from the Prime
Meridian of the ESS location.

<Format>
The essLongitude of 180 degrees West shall be -180,000,000. The
essLongitude of 180 degrees East shall be 180,000,000. The wvalue
180,000,001 shall indicate a missing wvalue.

<Parameter Type> status

<Superseded by> I5026048-1-FieldDevice:fdConfiguredLongitude

<Informative> This object was deprecated in NTCIP 1204 v05 to use the
more generic object and to be consistent with preferred units used in
ITS (i.e., 107-7 degrees).

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.2.2"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this wvalue by 10."

::= { essNtcipLocation 2 }

5.4.3 Vehicle Speed

-- This object has been deprecated.
essVehicleSpeed OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "kilometers per hour"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the current speed being reported by the wvehicle
in kilometers per hour.

<Format>
The value 255 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> IS026048-1-FieldDevice:fdSpeed

<Informative> This object was deprecated in NTCIP 1204 vO05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.2.3"

:= { essNtcipLocation 3 }

5.4.4 Vehicle Bearing

-- This object has been deprecated.
essVehicleBearing OBJECT-TYPE

SYNTAX Integer32 (0..361)
UNITS "compass degrees"
MAX-ACCESS read-only
STATUS deprecated
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DESCRIPTION

"<Definition> Indicates the current bearing of the vehicle in degrees,
measured clockwise from True North.

<Format>
The value 0 shall indicate that the vehicle is stopped. The value 361
shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> IS026048-1-FieldDevice:fdBearing

<Informative> This object was deprecated in NTCIP 1204 vO05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.2.4"

::= { essNtcipLocation 4 }

5.4.5 Odometer

-- This object has been deprecated.
essOdometer OBJECT-TYPE

SYNTAX Unsigned32
UNITS "meters"
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> Indicates the distance traveled, in meters, by the vehicle
from a reference point. Could be a vehicle odometer reading or a
calculation from the vehicle's GPS.

<Parameter Type> status

<Superseded by> IS026048-1-FieldDevice:fdOdometer

<Informative> This object was deprecated in NTCIP 1204 vO05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.2.5"

::= { essNtcipLocation 5 }

5.5 Station Elevation Objects

essNtcipHeight OBJECT-IDENTITY
STATUS deprecated
DESCRIPTION
"<Definition> Objects used to describe the elevation at the ESS that is
transmitting
the collected data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.3"
::= {essNtcip 3 }

essBufrLocationVertical OBJECT-IDENTITY

STATUS deprecated
DESCRIPTION
"<Definition> Objects used to describe the atmospheric pressure at the
ESS.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.7"
:= {essBufr 7 }

essNtcipPressure OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the atmospheric pressure reported
by each ESS pressure sensor.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16"
::= {essNtcip 16 }
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5.5.1 Reference Height

-—- This object has been deprecated.
essReferenceHeight OBJECT-TYPE

SYNTAX Integer32 (-400..8001)
UNITS "meters"

MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The reference elevation of the ESS in meters above mean
sea level. For a permanent station, this height shall be measured to
the base of the structure; for transportable stations, this height
shall be measured to the ground surface upon which the station
resides; and for mobile, this height shall be measured to the surface
under the vehicle.

<Format>
The value of 8001 shall indicate a missing value.

<Parameter Type> status

<Superseded by> IS026048-1-FieldDevice:fdConfiguredElevation

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.3.1"

REFERENCE "Resolution based on WMO Binary Code Form FM 94 BUFR Table B
item 0 07 001."
::= { essNtcipHeight 1 }

5.5.2 Pressure Height

-- This object has been deprecated.
essPressureHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The height of the pressure sensor with respect to the
essReferenceHeight in meters.

<Format>
The value of 1001 shall indicate a missing value.

<Parameter Type> status

<Superseded by> essPressureSensorHeight.l (See 5.5.7.2)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.3.2"

REFERENCE "essReferenceHeight plus this value equals the WMO Binary Code
Form FM 94 BUFR Table B item 0 07 001."
::= { essNtcipHeight 2 }

5.5.3 Wind Sensor Height

-- This object has been deprecated.
essWindSensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The height of the primary wind sensor with respect to the
essReferenceHeight in meters.

<Format>
The value of 1001 shall indicate a missing value.
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<Parameter Type> status
<Superseded by> windSensorHeight.l (See 5.6.10.2)
<Informative> This object was deprecated in version 02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.3.3"

::= { essNtcipHeight 3 }

5.5.4 Atmospheric Pressure

-—- This object has been deprecated.
essAtmosphericPressure OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "decapascal"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The force per unit area exerted by the atmosphere in
1/10ths of millibars, a.k.a. tenths of hectoPascals.
<Format>
A value of 65535 shall indicate an error condition or missing value.
<Parameter Type> status
<Superseded by> essPressureSensorAtmosphericPressure.l (See 5.5.7.7)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.7.4"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 07 004."
:= { essBufrlocationVertical 4 }

5.5.5 Number of Pressure Sensors
essNumPressureSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the pressure sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.1"
::= { essNtcipPressure 1 }

5.5.6 Pressure Sensor Table
essPressureSensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF EssPressureSensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the pressure sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2"
:= { essNtcipPressure 2 }

5.5.7 Pressure Sensor

essPressureSensorEntry OBJECT-TYPE
SYNTAX EssPressureSensorEntry
MAX-ACCESS not-accessible
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"<Definition> A pressure sensor is a sensor that reports the atmospheric

pressure.

It can be described through a number of attributes as

indicated by the following subclauses."

INDEX { essPressureSensorIndex }
::= { essPressureSensorTable 1 }
EssPressureSensorkEntry ::= SEQUENCE {
essPressureSensorIndex
essPressureSensorHeight
essPressureSensorLatitude
essPressureSensorLongitude
essPressureSensorLocation
essPressureSensorModelInformation
-— SENSOR READINGS
essPressureSensorAtmosphericPressure
essPressureSensorXOffset
essPressureSensorYOffset
essPressureSensorzOffset
essPressureSensorEntityID

5.5.7.1 Pressure Sensor Index
essPressureSensorIndex OBJECT-TYPE
SYNTAX Integer32 (1..255)
MAX-ACCESS read-only
STATUS current
DESCRIPTION

Integer32,
Integer32,
Integer32,
Integer32,
SnmpAdminString,
Integer32,

Integer32,
ITSIntegerle,
ITSIntegerle,
ITSIntegerle,
PhysicalIndexOrZero}

"<Definition> Enumerated list of row entries that provide atmospheric

pressure sensor data.
<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.1"

::= { essPressureSensorkEntry 1 }

5.5.7.2 Pressure Sensor Height

-- This object has been deprecated.
essPressureSensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the pressure sensor with respect to the

essReferenceHeight in meters.
<Format>

The value of 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> essPressureSensorzOffset
<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.2"
REFERENCE "essReferenceHeight plus this value equals the WMO Binary Code
Form FM 94 BUFR Table B item 0 07 001."

::= { essPressureSensorkEntry 2 }

5.5.7.3 Pressure Sensor Latitude

-- This object has been deprecated.
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essPressureSensorLatitude OBJECT-TYPE
SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees of latitude"
MAX-ACCESS read-write
STATUS deprecated
DESCRIPTION

"<Definition> The latitude in 10"-6 degrees of the ESS pressure sensor,
per WGS-84 datum.

<Format>
The essPressurelatitude at the North Pole is 90,000,000. The
essPressurelatitude at the South Pole is -90,000,000. The value
90,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> essPressureSensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.3"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

:= { essPressureSensorEntry 3 }

5.5.7.4 Pressure Sensor Longitude

-- This object has been deprecated.
essPressureSensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees of longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS pressure sensor location.

<Format>
The essPressurelongitude of 180 degrees West shall be -180,000,000. The
essPressurelongitude of 180 degrees East shall be 180,000,000. The
value 180,000,001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> essPressureSensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.4"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

:= { essPressureSensorEntry 4 }

5.5.7.5 Pressure Sensor Location

essPressureSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> A textual string indicating the location of the pressure
sensor.

<Parameter Type> configuration
<Informative> Implementations are only required to support the NVT-ASCII
character set but may support additional UTF-8 characters.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.5"
::= { essPressureSensorkEntry 5 }
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"<Definition> Indicates the row in the Module Table (See NTCIP 1201)

that contains information about the make, model, and

version number of

the sensor associated with this row of the Pressure Sensor Table.

<Format>

The value of zero indicates that this information is
<Parameter Type> configuration
<Supplanted by> essPressureSensorkEntityID
<Informative> This object was deprecated in version 05
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.6"
{ essPressureSensorEntry 6 }

5.5.7.7 Pressure Sensor Atmospheric Pressure

essPressureSensorAtmosphericPressure OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "decapascal"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The force per unit area exerted by the a
1/10ths of millibars, a.k.a. tenths of hectoPascals.
<Format>
A value of 65535 shall indicate an error condition o
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.7"

not available.

tmosphere in

r missing value.

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 07 004."

{ essPressureSensorEntry 7 }

5.5.7.8 Pressure Sensor X Offset
essPressureSensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The X offset of the pressure sensor from the field
device's reference location as defined by fdConfiguredLatitude and

fdConfiguredLongitude.
<Format>
For stationary devices, the X offset shall indicate
(positive) or westward (negative) distance from the
location. For transportable and mobile devices, the
indicate distances to the starboard side (positive)
(negative) of the reference location on the vehicle.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.8"
{ essPressureSensorEntry 8 }

5.5.7.9 Pressure Sensor Y Offset
essPressureSensorYOffset OBJECT-TYPE
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SYNTAX ITSIntegerlb
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the pressure sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.9"

:= { essPressureSensorEntry 9 }

5.5.7.10 Pressure Sensor Z Offset
essPressureSensorZOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the pressure sensor from the
fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.10"
::= { essPressureSensorEntry 10 }

5.5.7.11 Pressure Sensor Entity ID
essPressureSensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this wvalue when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.11"

::= { essPressureSensorEntry 11 }

5.6 Wind Data Section

essBufrWind OBJECT-IDENTITY
STATUS current
DESCRIPTION
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"<Definition> Objects used to describe the wind data that is collected
at the ESS in a
format that is consistent with BUFR.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.11"
::= {essBufr 11 }

essNtcipWind OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the wind data that is collected
at the ESS in a
format that is not defined by BUFR.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4"
::= {essNtcip 4 }

5.6.1 Average Wind Direction

-- This object has been deprecated.
essAvgWindDirection OBJECT-TYPE

SYNTAX Integer32 (0..361)
UNITS "compass degrees"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> A two-minute average of the direction from which the wind
is blowing measured clockwise in degrees from true North and measured
at a height as indicated by essWindSensorHeight. A value of 361 shall
indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> windSensorAvgDirection.l (See 5.6.10.5)

<Informative> This object was deprecated in version 02.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.11.1"

REFERENCE "WMO Code Form FM 94 BUFR Table B item O 11 001."
::= { essBufrWind 1 }

5.6.2 Average Wind Speed

-- This object has been deprecated.
essAvgWindSpeed OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of meters per second"”
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> A two-minute average of the wind speed in tenths of meters
per second as measured by the primary wind sensor.

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> windSensorAvgSpeed.l (See 5.6.10.4)

<Informative> This object was deprecated in version 02.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.11.2"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 11 002."
::= { essBufrWind 2 }

5.6.3 Spot Wind Direction

-- This object has been deprecated.
essSpotWindDirection OBJECT-TYPE
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SYNTAX Integer32 (0..361)
UNITS "compass degrees"
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> The direction from which the wind is blowing measured in
degrees clockwise from true North and measured at a height as
indicated by essWindSensorHeight. A value of 361 shall indicate an
error condition or missing value. For mobile platforms, the wind
direction shall be corrected for vehicle movement.

<Parameter Type> status

<Superseded by> windSensorSpotDirection.l (See 5.6.10.7)

<Informative> This object was deprecated in version 02.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.1"

::= { essNtcipWind 1 }

5.6.4 Spot Wind Speed

-- This object has been deprecated.
essSpotWindSpeed OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of meters per second"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The wind speed in tenths of meters per second measured by
the primary wind sensor. For mobile platforms, the wind speed shall be
corrected for vehicle movement.

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> windSensorSpotSpeed.l (See 5.6.10.6)

<Informative> This object was deprecated in version 02.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.1"

::= { essNtcipWind 2 }

5.6.5 Wind Situation

essWindSituation OBJECT-TYPE

SYNTAX INTEGER {
other (1),
unknown (2),
calm (3),
lightBreeze (4),
moderateBreeze (5),
strongBreeze (6),
gale (7),
moderateGale (8),
strongGale (9),
stormWinds (10),
hurricaneForceWinds (11),
gustyWinds (12) 1}

MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> Describes the weather and travel situation in terms of

wind from staffed stations only. Specific ranges for these values are
defined in the Glossary of Meteorology.

<Format>

Copy Per MIB Distribution Permission © 2022 AASHTO / ITE / NEMA



NTCIP 1204 v04.26

Page 105

Range Meaning

other not defined within this standard, see manufacturers
documentation

unknown Unknown conditions

calm Calm

lightBreeze Light breeze

moderateBreeze Moderate breeze

strongBreeze Strong breeze

gale Gale

moderateGale Moderate gale

strongGale Strong gale

stormWinds Storm winds

hurricaneForceWinds Hurricane force winds

gustyWinds defined by a peak and a lull of greater than 46.3
tenths of meters per second within a 2 minute

period.

<Parameter Type> status
<Superseded by> windSensorSituation.l (See 5.6.10.10)
<Informative> This object was deprecated in version 02 and migrated to
the wind sensor table. It was reinstated in v05 specifically for
staffed stations.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.3"
::= { essNtcipWind 3 }

5.6.6 Wind Gust Speed

-- This object has been deprecated.
essMaxWindGustSpeed OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of meters per second"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The maximum wind gust recorded by the primary wind sensor
during the 10 minutes preceding the observation measured in tenths of
meters per second.

<Format>
The value 65535 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Superseded by> windSensorGustSpeed.l (See 5.6.10.8)

<Informative> This object was deprecated in version 02.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.11.41"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 11 041."
:= { essBufrWind 41 }

5.6.7 Wind Gust Direction

-- This object has been deprecated.
essMaxWindGustDir OBJECT-TYPE

SYNTAX Integer32 (0..361)
UNITS "compass degrees"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The direction of the maximum wind gust recorded during the
10 minutes preceding the observation at a height as indicated by
essWindSensorHeight; measured in degrees clockwise from true North.
The value 361 shall indicate an error condition or missing value.

<Parameter Type> status
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<Superseded by> windSensorGustDirection.l (See 5.6.10.9)
<Informative> This object was deprecated in version 02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.11.43"
REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 11 043."
::= { essBufrWind 43 }

5.6.8 Number of Wind Sensors
windSensorTableNumSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Indicates the number of entries in the wind sensor table.

<Parameter Type> status

<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.7"

:= { essNtcipWind 7 }

5.6.9 Wind Sensor Table
windSensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF WindSensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the wind sensor data fields.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8"
::= { essNtcipWind 8 }

5.6.10 Wind Sensor
windSensorEntry OBJECT-TYPE

SYNTAX WindSensorEntry
MAX-ACCESS not—-accessible
STATUS current
DESCRIPTION

"<Definition> Parameters for specific wind sensor data fields."
INDEX { windSensorIndex }
::= { windSensorTable 1 }

WindSensorEntry ::= SEQUENCE ({
windSensorIndex Integer32,
windSensorHeight Integer3z,
windSensorLocation SnmpAdminString,
windSensorAvgSpeed Integer32,
windSensorAvgDirection Integer32,
windSensorSpotSpeed Integer32,
windSensorSpotDirection Integer32,
windSensorGustSpeed Integer32,
windSensorGustDirection Integer32,
windSensorSituation INTEGER,
windSensorLatitude Integer32,
windSensorLongitude Integer32,

windSensorModelInformation Integer32,
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windSensorXOffset ITSIntegerlo,
windSensorYOffset ITSIntegerlo,
windSensorzZOffset ITSIntegerle,
windSensorEntityID PhysicalIndexOrZero

5.6.10.1 Wind Sensor Index
windSensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Enumerated list of row entries that provide wind sensor
data. The first entry shall be that of the primary wind sensor.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.1"

::= { windSensorEntry 1 }

5.6.10.2 Wind Sensor Height

-- This object has been deprecated.
windSensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the wind sensor with respect to the
essReferenceHeight in meters.

<Format>
The value of 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> windSensorZOffset

<Informative> Changed to read-write from read-only in version 04. This
object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.2"

::= { windSensorEntry 2 }

5.6.10.3 Wind Sensor Location
windSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> A textual string indicating the location of the wind
sensor.

<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.3"

::= { windSensorEntry 3 }

5.6.10.4 Wind Sensor Average Speed
windSensorAvgSpeed OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of meters per second"”
MAX-ACCESS read-only

STATUS current

DESCRIPTION
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"<Definition> A two-minute average of the wind speed in tenths of meters
per second as measured by the wind sensor.

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.4"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 11 002."
::= { windSensorEntry 4 }

5.6.10.5 Wind Sensor Average Direction
windSensorAvgDirection OBJECT-TYPE

SYNTAX Integer32 (0..361)
UNITS "compass degrees"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> A two minute mode (average) of the direction from which
the wind is blowing measured clockwise in degrees from true north as
measured by the wind sensor.

<Format>
The value of zero (0) shall indicate 'calm', when the associated speed
is zero (0), or 'light and wvariable,' when the associated speed is
greater than zero (0). Normal observations, as defined by the WMO,
shall report a wind direction in the range of 1 to 360 with 90 meaning
from the east and 360 meaning from the north. The value of 361 shall
indicate an error condition and shall always be reported if the
associated speed indicates error.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.5"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 11 001."
::= { windSensorEntry 5 }

5.6.10.6 Wind Sensor Spot Speed
windSensorSpotSpeed OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of meters per second"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The wind speed in tenths of meters per second measured by
the wind sensor. For mobile platforms, the wind speed shall be
corrected for vehicle movement.

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.6"

:= { windSensorEntry 6 }

5.6.10.7 Wind Sensor Spot Direction

windSensorSpotDirection OBJECT-TYPE

SYNTAX Integer32 (0..361)
UNITS "compass degrees"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The direction from which the wind is blowing measured in
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degrees clockwise from true North as measured by the wind sensor. For
mobile platforms, the wind direction shall be corrected for vehicle
movement.

<Format>
The value of zero (0) shall indicate 'calm', when the associated speed
is zero (0), or 'light and wvariable,' when the associated speed is
greater than zero (0). Normal observations, as defined by the WMO,
shall report a wind direction in the range of 1 to 360 with 90 meaning
from the east and 360 meaning from the north. The value of 361 shall
indicate an error condition and shall always be reported if the
associated speed indicates error.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.7"

::= { windSensorEntry 7 }

5.6.10.8 Wind Sensor Gust Speed
windSensorGustSpeed OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of meters per second"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The maximum wind gust recorded by the wind sensor during
the 10 minutes preceding the observation measured in tenths of meters
per second.

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.8"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 11 041."
::= { windSensorEntry 8 }

5.6.10.9 Wind Sensor Gust Direction
windSensorGustDirection OBJECT-TYPE

SYNTAX Integer32 (0..361)
UNITS "compass degrees"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The direction of the maximum wind gust recorded during the
10 minutes preceding the observation measured in degrees clockwise
from true North by the wind sensor.

<Format>
The value of zero (0) shall indicate 'calm', when the associated speed
is zero (0), or 'light and variable,' when the associated speed is
greater than zero (0). Normal observations, as defined by the WMO,
shall report a wind direction in the range of 1 to 360 with 90 meaning
from the east and 360 meaning from the north. The value of 361 shall
indicate an error condition and shall always be reported if the
associated speed indicates error.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.9"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 11 043."
::= { windSensorEntry 9 }
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5.6.10.10 Wind Sensor Situation

windSensorSituation OBJECT-TYPE
SYNTAX INTEGER {
other (1),
unknown (2),
calm (3),
lightBreeze (4),
moderateBreeze (5),
strongBreeze (6),
gale (7),
moderateGale (8),
strongGale (9),
stormWinds (10),
hurricaneForceWinds (11),
gustyWinds (12) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> The assessment of the wind situation from the sensor as
defined by the Beaufort Wind Scale in the Glossary of Meteorology.
Specific ranges for these values are defined in the Glossary of

Meteorology.
<Format>

Range Meaning (WMO Classification)

other not defined within this standard, see
manufacturer's documentation

unknown Unknown conditions

calm Calm - Light air

lightBreeze Light breeze - Gentle breeze

moderateBreeze Moderate breeze - Fresh breeze

strongBreeze Strong breeze

gale Near Gale

moderateGale Gale

strongGale Strong gale

stormWinds Storm

hurricaneForceWinds Violent Storm - Hurricane

gustyWinds defined by a peak and a lull of greater than 46.3
tenths of meters per second within a 2-minute
period.

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.10"
::= { windSensorEntry 10 }

5.6.10.11 Wind Sensor Latitude

-- This object has been deprecated.
windSensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 10"-6 degrees of the ESS wind sensor, per
WGS-84 datum.

<Format>
The windSensorLatitude at the North Pole is 90,000,000. The
windSensorLatitude at the South Pole is -90,000,000. The wvalue
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90,000,001 shall indicate a missing value.
<Parameter Type> configuration
<Superseded by> windSensorYOffset
<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.11"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { windSensorEntry 11 }

5.6.10.12Wind Sensor Longitude

-- This object has been deprecated.
windSensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS wind sensor location.

<Format>
The windSensorLongitude of 180 degrees West shall be -180,000,000. The
windSensorLongitude of 180 degrees East shall be 180,000,000. The
value 180,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> windSensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.12"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

::= { windSensorEntry 12 }

5.6.10.13 Wind Sensor Model Information

-- This object has been deprecated.
windSensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the Wind Sensor Table.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Supplanted by> windSensorEntityID

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.13"

::= { windSensorEntry 13 }

5.6.10.14Wind Sensor X Offset

windSensorXOffset OBJECT-TYPE
SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
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STATUS current
DESCRIPTION
"<Definition> The X offset
reference location as de
fdConfiguredLongitude.
<Format>
For stationary devices,

of the wind sensor from the field device's
fined by fdConfiguredLatitude and

the X offset shall indicate the eastward

(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall

indicate distances to th

e starboard side (positive) or port side

(negative) of the reference location on the wvehicle.

<Parameter Type> configura
<Object Identifier> 1.3.6.
::= { windSensorEntry 14 }

5.6.10.15Wind Sensor Y Offset
windSensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset
reference location as de
fdConfiguredLongitude.

<Format>
For stationary devices,
(positive) or southward

tion
1.4.1.1206.4.2.5.2.4.8.1.14"

of the wind sensor from the field device's
fined by fdConfiguredLatitude and

the Y offset shall indicate the northward
(negative) distance from the reference

location. For transportable and mobile devices, the Y offset shall

indicate distances to th
reference location on th
<Parameter Type> configura
<Object Identifier> 1.3.6.

::= { windSensorEntry 15 }

5.6.10.16 Wind Sensor Z Offset
windSensorzOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> The offset e
fdConfiguredElevation in
<Format>
Upward offsets shall be
negative.

<Parameter Type> configura
<Object Identifier> 1.3.6.
::= { windSensorEntry 16 }

5.6.10.17 Wind Sensor Entity ID
windSensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOr
MAX-ACCESS read-only
STATUS current
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e fore (positive) or aft (negative) of the
e vehicle.

tion

1.4.1.1206.4.2.5.2.4.8.1.15"

levation of the wind sensor from the
centimeters.

positive and downward offsets shall be

tion
1.4.1.1206.4.2.5.2.4.8.1.16"

Zero
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DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.4.8.1.17"

::= { windSensorEntry 17 }

5.7 Temperature Data Objects

essNtcipTemperature OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the temperature data that is
collected at the ESS.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5"
:= {essNtcip 5}

5.7.1 Number of Temperature Sensors

essNumTemperatureSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the temperature sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.1"
::= { essNtcipTemperature 1 }

5.7.2 Temperature Sensor Table

essTemperatureSensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF EssTemperatureSensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the temperature sensor data fields.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2"
::= { essNtcipTemperature 2 }

5.7.3 Temperature Sensor

essTemperatureSensorEntry OBJECT-TYPE

SYNTAX EssTemperatureSensorkEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Parameters for specific temperature sensor as described
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through a number of attributes as indicated by the following
subclauses."
INDEX { essTemperatureSensorIndex }
::= { essTemperatureSensorTable 1 }

EssTemperatureSensorkEntry ::= SEQUENCE ({
essTemperatureSensorIndex Integer32,
essTemperatureSensorHeight Integer32,
essAirTemperature Integer32,
essTemperatureSensorLatitude Integer32,
essTemperatureSensorLongitude Integer32,
essTemperatureSensorLocation SnmpAdminString,
essTemperatureSensorModelInformation Integer32,
essTemperatureSensorXOffset ITSIntegerle,
essTemperatureSensorYOffset ITSIntegerle,
essTemperatureSensorzZOffset ITSIntegerle,
essTemperatureSensorEntityID PhysicalIndexOrZero}

5.7.3.1 Temperature Sensor Index

essTemperatureSensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Enumerated list of row entries that provide temperature
sensor data.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.1"
::= { essTemperatureSensorEntry 1 }

5.7.3.2 Temperature Sensor Height

-— This object has been deprecated.
essTemperatureSensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the temperature sensor as measured in meters
above essReferenceHeight.

<Format>
The value 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> essTemperatureSensorzOffset

<Informative> Changed to read-write from read-only in version 04. This
object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.2"

:= { essTemperatureSensorkEntry 2 }

5.7.3.3 Air Temperature
essAirTemperature OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS current

DESCRIPTION
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"<Definition> The dry-bulb temperature in tenths of degrees Celsius. The
temperature is an instantaneous reading at the height specified by
essTemperatureSensorHeight.

<Format>
The value 1001 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.3"

REFERENCE "Resolution is based on WMO Binary Code Form FM 94 BUFR Table B
item 0 12 001; temperature in Kelvin is determined by adding 273.15 to
this value."

::= { essTemperatureSensorEntry 3 }

5.7.3.4 Temperature Sensor Latitude

-- This object has been deprecated.
essTemperatureSensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 10"-6 degrees of the ESS temperature
sensor, per WGS-84 datum.

<Format>
The essTemperatureSensorLatitude at the North Pole is 90,000,000. The
essTemperatureSensorLatitude at the South Pole is -90,000,000. The
value 90,000,001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> essTemperatureSensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.4"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { essTemperatureSensorEntry 4 }

5.7.3.5 Temperature Sensor Longitude

-- This object has been deprecated.
essTemperatureSensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS temperature sensor location.

<Format>
The essTemperatureSensorlLongitude of 180 degrees West shall be
-180,000,000. The essTemperatureSensorLongitude of 180 degrees East
shall be 180,000,000. The value 180,000,001 shall indicate a missing
value.

<Parameter Type> configuration

<Superseded by> essTemperatureSensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.5"

REFERENCE "Resolution based on on-going location referencing activities;

the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."
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::= { essTemperatureSensorEkEntry 5 }

5.7.3.6 Temperature Sensor Location

essTemperatureSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> A textual string indicating the location of the
temperature sensor.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.6"
::= { essTemperatureSensorEkEntry 6 }

5.7.3.7 Temperature Sensor Model Information

-- This object has been deprecated.
essTemperatureSensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the Temperature Sensor Table.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Supplanted by> essTemperatureSensorEntityID

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.7"

::= { essTemperatureSensorEntry 7 }

5.7.3.8 Temperature Sensor X Offset
essTemperatureSensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The lateral offset of the temperature sensor from the
field device's reference location as defined by fdConfiguredLatitude
and fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.8"

:= { essTemperatureSensorEntry 8 }

5.7.3.9 Temperature Sensor Y Offset

essTemperatureSensorYOffset OBJECT-TYPE
SYNTAX ITSIntegerl6
UNITS "centimeters"
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MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the temperature sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.9"

::= { essTemperatureSensorEntry 9 }

5.7.3.10 Temperature Sensor Z Offset
essTemperatureSensorZOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the temperature sensor from the
fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.10"
::= { essTemperatureSensorkEntry 10 }

5.7.3.11 Temperature Sensor Entity ID

essTemperatureSensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.11"

::= { essTemperatureSensorEntry 11 }

5.7.4 Wetbulb Temperature

-- This object has been deprecated.
essWetbulbTemp OBJECT-TYPE
SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only
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STATUS deprecated
DESCRIPTION
"<Definition> The wet-bulb temperature in tenths of degrees Celsius. The
temperature is an instantaneous reading by the temperature sensor
specified in the first row of the essTemperatureTable.
<Format>
The value 1001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Supplanted by> humiditySensorWetbulbTemp
<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.3"

REFERENCE "is based on WMO Binary Code Form FM 94 BUFR Table B item 0 12
002; temperature in Kelvin is determined by adding 273.15 to this
value."

::= { essNtcipTemperature 3 }

5.7.5 Dewpoint Temperature

-- This object has been deprecated.
essDewpointTemp OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The dewpoint temperature in tenths of degrees Celsius. The
temperature is an instantaneous reading by the temperature sensor
specified in the first row specified of the essTemperatureSensorTable.

<Format>
The value 1001 shall indicate an error condition or missing value.

<Parameter Type> status

<Supplanted by> humiditySensorDewpointTemp

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.4"

REFERENCE "Resolution is based on WMO Binary Code Form FM 94 BUFR Table B
item 0 12 003; temperature in Kelvin is determined by adding 273.15 to
this value."

::= { essNtcipTemperature 4 }

5.7.6 Maximum Temperature
essMaxTemp OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The maximum temperature in tenths of degrees Celsius
recorded during the 24 hours preceding the observation by the
temperature sensor specified in the first row of the
essTemperatureSensorTable.

<Format>
The value 1001 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.5"

REFERENCE "Resolution is based on WMO Binary Code Form FM 94 BUFR Table B
item 0 12 011l; temperature in Kelvin is determined by adding 273.15 to
this value."

::= { essNtcipTemperature 5 }
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5.7.7 Minimum Temperature
essMinTemp OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The minimum temperature in tenths of degrees Celsius
recorded during the 24 hours preceding the observation by the
temperature sensor specified in the first row of the
essTemperatureSensorTable.

<Format>
The value 1001 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.6"

REFERENCE "Resolution is based on WMO Binary Code Form FM 94 BUFR Table B
item 0 12 012; temperature in Kelvin is determined by adding 273.15 to
the Celsius value."

::= { essNtcipTemperature 6 }

5.8 Humidity and Precipitation Data Objects

essBufrPrecip OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the humidity and precipitation
data collected by the ESS and presented in BUFR-equivalent formats.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13"
::= {essBufr 13 }

essNtcipPrecip OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the humidity and precipitation
data collected by the ESS and presented in a format not defined by
BUFR.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6"
::= {essNtcip 6 }

5.8.1 Relative Humidity

-- This object has been deprecated.
essRelativeHumidity OBJECT-TYPE

SYNTAX Integer32 (0..101)

UNITS "percent humidity"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
"<Definition> The relative humidity in percent.
<Format>

The value of 101 shall indicate an error condition or missing value.
<Parameter Type> status
<Superseded by> humiditySensorRelativeHumidity.l (See 5.8.27.7)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.3"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 003."
::= { essBufrPrecip 3 }
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5.8.2 Water Depth

-—- This object has been deprecated.
essWaterDepth OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "centimeters"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the depth of the water from a user-defined point
in centimeters. The value of 65535 shall indicate an error condition
or missing value. This may be used for stream depth, depth of water
over a roadway, reservoir depth, or other such uses.

<Parameter Type> status

<Superseded by> waterLevelSensorReading.l (See 5.8.21.2)

<Informative> This object was deprecated in version 02.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.1"

::= { essNtcipPrecip 1 }

5.8.3 Adjacent Snow Depth

-- This object has been deprecated.
essAdjacentSnowDepth OBJECT-TYPE

SYNTAX Integer32 (0..3001)
UNITS "centimeters"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The depth of snow in centimeters on representative areas
other than the highway pavement, avoiding drifts and plowed areas.
<Format>
The value 3001 shall indicate an error condition or missing value.
<Parameter Type> status
<Superseded by> precipitationSensorAdjacentSnowDepth.l (See 5.8.24.8)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.2"
:= { essNtcipPrecip 2 }

5.8.4 Roadway Snow Depth

-- This object has been deprecated.
essRoadwaySnowDepth OBJECT-TYPE

SYNTAX Integer32 (0..3001)
UNITS "centimeters"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The current depth of unpacked snow in centimeters on the
driving surface.

<Format>
The value 3001 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Superseded by> precipitationSensorRoadwaySnowDepth.l (See 5.8.24.9)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.3"

::= { essNtcipPrecip 3 }

5.8.5 Roadway Snow Pack Depth

-- This object has been deprecated.
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essRoadwaySnowPackDepth OBJECT-TYPE
SYNTAX Integer32 (0..3001)
UNITS "centimeters"
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> The current depth of packed snow in centimeters on the
roadway surface.

<Format>
The value 3001 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Superseded by> precipitationSensorRoadwaySnowPackDepth.1l (See
5.8.24.10)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.4"

:= { essNtcipPrecip 4 }

5.8.6 Precipitation Indicator

-- This object has been deprecated.
essPrecipYesNo OBJECT-TYPE
SYNTAX INTEGER {
precip (1),
noPrecip (2),
error (3) }
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION
"<Definition> Indicates whether or not moisture is detected by the
sensor.
<Format>

precip - Moisture is currently being detected by the precipitation
sensor
noPrecip - Moisture is not currently being detected by the
precipitation
sensor
error - The sensor is either not connected, not reporting, or is
indicating an error
<Parameter Type> status
<Superseded by> precipitationSensorPrecipYesNo.l (See 5.8.24.11)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.5"
:= { essNtcipPrecip 5 }

5.8.7 Rainfall or Water Equivalent of Snow

-- This object has been deprecated.
essPrecipRate OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of grams per square meter per second"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The rainfall, or water equivalent of snow, rate in tenths
of grams per square meter per second (for rain, this is approximately
to 0.36 mm/hr) .

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status
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<Superseded by> precipitationSensorPrecipRate.l (See 5.8.24.12)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.14"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 014."
::= { essBufrPrecip 14 }

5.8.8 Snowfall Accumulation Rate

-—- This object has been deprecated.
essSnowfallAccumRate OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "10"-7 meters per second"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The snowfall accumulation rate in 10%-7 meters per second

(this is equivalent to 0.36 mm/hr).
<Format>

The value 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> precipitationSensorSnowfallAccumRate.l (See 5.8.24.13)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.15"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 015."
:= { essBufrPrecip 15 }

5.8.9 Precipitation Situation

essPrecipSituation OBJECT-TYPE
SYNTAX INTEGER {
other (1),
unknown (2),
noPrecipitation (3),
unidentifiedSlight (4),
unidentifiedModerate (5),
unidentifiedHeavy (6),
snowSlight (7),
snowModerate (8),
snowHeavy (9),
rainSlight (10),
rainModerate (11),
rainHeavy (12),
frozenPrecipitationSlight (13),
frozenPrecipitationModerate (14),
frozenPrecipitationHeavy (15) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> Describes the weather situation in terms of precipitation.
For automated stations, describes the intensity and precipitation type

as specified in the first row of the precipitationSensorTable.

<Format>
Intensity Meaning
slight < 2mm/h water equivalent
moderate >= 2 and < 8 mm/h water equivalent
heavy >= 8 mm/h water equivalent If one exists, the corresponding

BUFR value is indicated for staffed (BUFRs) and automated
(BUFRa) stations. The indicated wvalue can be found in the

BUFR Table referenced below. Defined values are:
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Meaning

other

unknown

no precipitation
unidentified slight
unidentified moderate
unidentified heavy

SNow
SNow
SNnow
rain
rain
rain

slight
moderate
heavy
slight
moderate
heavy

frozen precipitation slight
frozen precipitation moderate
frozen precipitation heavy

<Informative> Starting in NTCIP 1204 v05; this object should only report
automated sensors should use
precipitationSensorPrecipSituation (See 5.8.24.14).
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.6"
REFERENCE "The values identified in the above table for BUFRa and BUFRs
can be found in WMO Binary Code Form FM 94 BUFR Table B item 0 20 003."
::= { essNtcipPrecip 6 }

5.8.10 Ice Deposit (Thickness)

-- This object has been deprecated.

human readings;

essIceThickness OBJECT-TYPE
(0..65535)
"millimeters"

SYNTAX
UNITS
MAX-ACCESS
STATUS
DESCRIPTION

Integer32

read-only

deprecated

"<Definition> Indicates the thickness of the ice in millimeters.

<Format>

The value 65535 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Superseded by> precipitationSensorIceThickness.l (See 5.8.24.15)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.7"

:= { essNtcipPrecip 7 }

5.8.11 Precipitation Start Time

-- This object has been deprecated.
essPrecipitationStartTime OBJECT-TYPE
Unsigned32
"seconds"
read-only
deprecated

SYNTAX
UNITS
MAX-ACCESS
STATUS
DESCRIPTION

"<Definition> The time at which the most recent precipitation event

began,
<Format>

measured in seconds since 00:00:00 January 1, 1970 UTC.

As this standard has been developed long after 1970, a value of 0 for
time should indicate to the management station that the data received
is suspect.

<Parameter Type> status
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<Superseded by> precipitationSensorPrecipitationStartTime.l (See
5.8.24.106)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.8"
::= { essNtcipPrecip 8 }

5.8.12 Precipitation End Time

-—- This object has been deprecated.
essPrecipitationEndTime OBJECT-TYPE

SYNTAX Unsigned32
UNITS "seconds"

MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The time at which the most recently completed
precipitation event ended, measured in seconds since 00:00:00 January
1, 1970 UTC.

<Format>
As this standard has been developed long after 1970, a value of 0 for
the time should indicate to the management station that the data
received is suspect.

<Parameter Type> status

<Superseded by> precipitationSensorPrecipitationEndTime.l (See
5.8.24.17)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.9"

::= { essNtcipPrecip 9 }

5.8.13 Total Precipitation Past One Hour

-- This object has been deprecated.
essPrecipitationOneHour OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The total water equivalent precipitation over the hour
preceding the observation in tenths of kilograms per square meter (for
rain, this is approximately tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> precipitationSensorPrecipitationOneHour.1l (See
5.8.24.18)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.19"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 019."
:= { essBufrPrecip 19 }

5.8.14 Total Precipitation Past Three Hours

-- This object has been deprecated.
essPrecipitationThreeHours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS deprecated
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DESCRIPTION
"<Definition> The total water equivalent precipitation over the three
hours preceding the observation in tenths of kilograms per square
meter (for rain, this is approximately tenths of millimeters).
<Format>
The value of 65535 shall indicate an error condition or missing value.
<Parameter Type> status
<Superseded by> precipitationSensorPrecipitationThreeHours.l (See
5.8.24.19)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.20"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 020."
::= { essBufrPrecip 20 }

5.8.15 Total Precipitation Past Six Hours

-- This object has been deprecated.
essPrecipitationSixHours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The total water equivalent precipitation over the six
hours preceding the observation in tenths of kilograms per square
meter (for rain, this is approximately tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> precipitationSensorPrecipitationSixHours.l (See
5.8.24.20)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.21"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 021."
::= { essBufrPrecip 21 }

5.8.16 Total Precipitation Past Twelve Hours

-- This object has been deprecated.
essPrecipitationTwelveHours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The total water equivalent precipitation over the twelve
hours preceding the observation in tenths of kilograms per square
meter (for rain, this is approximately to tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> precipitationSensorPrecipitationTwelveHours.l (See
5.8.24.21)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.22"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 022."
::= { essBufrPrecip 22 }
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5.8.17 Total Precipitation Past Twenty-Four Hours

-—- This object has been deprecated.
essPrecipitation24Hours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The total water equivalent precipitation over the
twenty-four hours preceding the observation in tenths of kilograms per
square meter (for rain, this is equivalent to tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> precipitationSensorPrecipitation24Hours.l (See
5.8.24.22)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.13.23"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 023."
::= { essBufrPrecip 23 }

5.8.18 Precipitation Sensor Model Information

-- This object has been deprecated.
precipitationSensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> A reference to the row in the Module Table (See NTCIP
1201) that indicates the manufacturer, model, and version number of
the precipitation sensor.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Superseded by> precipitationSensorModelInformationvV4.1l (See 5.8.24.6)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.10"

::= { essNtcipPrecip 10 }

5.8.19 Number of Water Level Sensors
waterLevelSensorTableNumSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the water level sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.11"
::= { essNtcipPrecip 11 }
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SEQUENCE OF WaterLevelSensorEntry

"<Definition> Table containing the water level sensor data fields.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12"

:= { essNtcipPrecip 12 }
5.8.21 Water Level Sensor
waterLevelSensorEntry OBJECT-TYPE

SYNTAX WaterLevelSensorkEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Parameters for a specific water level sensor as described
through a number of attributes as indicated by the following

subclauses."

INDEX { waterLevelSensorIndex }
::= { waterLevelSensorTable 1 }
WaterLevelSensorkEntry ::= SEQUENCE {
waterLevelSensorIndex
waterLevelSensorReading
waterLevelSensorWarningLevel
waterLevelSensorHeight
waterLevelSensorLatitude
waterLevelSensorLongitude
waterLevelSensorLocation
waterLevelSensorModelInformation
waterLevelSensorReferencePoint
waterLevelSensorXOffset
waterLevelSensorYOffset
waterLevelSensorzOffset
waterLevelSensorEntityID

5.8.21.1 Water Level Sensor Index
waterLevelSensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

Integer32,
Integer32,
Integer32,
Integer32,
Integer32,
Integer32,
SnmpAdminString,
Integer32,
SnmpAdminString,
ITSIntegerlo,
ITSIntegerle,
ITSIntegerle,
PhysicalIndexOrZero }

"<Definition> Enumerated list of row entries that provide water level

sensor data.
<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.1"

::= { waterLevelSensorEntry 1 }

5.8.21.2 Water Level Sensor Reading
waterLevelSensorReading OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "centimeters"
MAX-ACCESS read-only

STATUS current

DESCRIPTION
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"<Definition> Indicates the depth of the water from a user-defined point
in centimeters. This may be used for stream depth, depth of water over
a roadway for flooding, reservoir depth, or other such uses.

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.2"

::= { waterLevelSensorEntry 2 }

5.8.21.3 Water Level Sensor Warning Level
waterLevelSensorWarningLevel OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "centimeters"
MAX-ACCESS read-write

STATUS current

DESCRIPTION

"<Definition> Indicates the depth of the water from a user defined point
in centimeters, that the water level is of concern.
<Format>
The value of 65535 shall indicate an error condition or missing value.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.3"
:= { waterLevelSensorEntry 3 }

5.8.21.4 Water Level Sensor Height

-- This object has been deprecated.
waterLevelSensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the water level sensor with respect to the
essReferenceHeight in meters.

<Format>
The value of 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> waterLevelSensorzZOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.4"

::= { waterLevelSensorEntry 4 }

5.8.21.5 Water Level Sensor Latitude

-- This object has been deprecated.
waterLevelSensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 107"-6 degrees of the ESS water level
sensor, per WGS-84 datum.

<Format>
The waterLevelSensorLatitude at the North Pole is 90,000,000. The
waterLevelSensorLatitude at the South Pole is -90,000,000. The wvalue
90,000,001 shall indicate a missing value.
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<Parameter Type> configuration

<Superseded by> waterLevelSensorYOffset

<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.5"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { waterlevelSensorEntry 5 }

5.8.21.6 Water Level Sensor Longitude

-- This object has been deprecated.
waterLevelSensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS water level sensor location.

<Format>
The waterLevelSensorLongitude of 180 degrees West shall be -

180,000,000.

The waterLevelSensorLongitude of 180 degrees East shall be
180,000,000. The value 180,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> waterLevelSensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.6"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

::= { waterLevelSensorEntry 6 }

5.8.21.7 Water Level Sensor Location
waterLevelSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> A textual string indicating the location of the water
level sensor., including a description of the reference point that the
water depth is measured against.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.7"

:= { waterLevelSensorEntry 7 }

5.8.21.8 Water Level Sensor Model Information

-- This object has been deprecated.
waterLevelSensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the Water Level Sensor Table.
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<Format>
The value of zero indicates that this information is not available.
<Parameter Type> configuration
<Supplanted by> waterLevelSensorEntityID
<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.8"
::= { waterLevelSensorEntry 8 }

5.8.21.9 Water Level Sensor Reference Point
waterLevelSensorReferencePoint OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> A textual string describing the location of the reference
point that the water depth is measured against.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.9"
::= { waterLevelSensorEntry 9 }

5.8.21.10 Water Level Sensor X Offset
waterLevelSensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The X offset of the water level sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.10"

::= { waterLevelSensorEntry 10 }

5.8.21.11 Water Level Sensor Y Offset
waterLevelSensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the water level sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.
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<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.11"
::= { waterlevelSensorEntry 11 }

5.8.21.12 Water Level Sensor Z Offset
waterLevelSensorzOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the water level sensor from the
fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.5.2.1.12"
::= { waterlevelSensorEntry 12 }

5.8.21.13 Water Level Sensor Entity Identifier
waterLevelSensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.12.1.13"

::= { waterlevelSensorEntry 13 }

5.8.22 Number of Precipitation Sensors

precipitationSensorTableNumSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Indicates the number of entries in the precipitation
sensor table.

<Parameter Type> status

<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.13"

::= { essNtcipPrecip 13 }
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5.8.23 Precipitation Sensor Table

precipitationSensorTable OBJECT-TYPE
SYNTAX

MAX-ACCESS not-accessible
STATUS current
DESCRIPTION

SEQUENCE OF PrecipitationSensorEntry

"<Definition> Table containing the precipitation sensor data fields.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14"

:= { essNtcipPrecip 14 }

5.8.24 Precipitation Sensor
precipitationSensorEntry OBJECT-TYPE

SYNTAX PrecipitationSensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Parameters for a specific precipitation sensor as
described through a number of attributes as indicated by the following

subclauses."
INDEX { precipitationSensorIndex }
::= { precipitationSensorTable 1 }

PrecipitationSensorEntry ::= SEQUENCE ({
precipitationSensorIndex
precipitationSensorHeight
precipitationSensorLatitude
precipitationSensorLongitude
precipitationSensorLocation
precipitationSensorModelInformationV4
precipitationSensorPeriod
precipitationSensorAdjacentSnowDepth
precipitationSensorRoadwaySnowDepth
precipitationSensorRoadwaySnowPackDepth
precipitationSensorPrecipYesNo
precipitationSensorPrecipRate
precipitationSensorSnowfallAccumRate
precipitationSensorPrecipSituation
precipitationSensorIceThickness

precipitationSensorPrecipitationStartTime

precipitationSensorPrecipitationEndTime
precipitationSensorPrecipitationOneHour

precipitationSensorPrecipitationThreeHours

precipitationSensorPrecipitationSixHours

precipitationSensorPrecipitationTwelveHours

precipitationSensorPrecipitation24Hours

precipitationSensorPrecipitationUserDefined

precipitationSensorPrecipStartDate
precipitationSensorPrecipStartTimeV5
precipitationSensorPrecipEndDate
precipitationSensorPrecipEndTimeV5
precipitationSensorXOffset
precipitationSensorYOffset
precipitationSensorzZOffset
precipitationSensorEntityID
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Integer32,
Integer32,
Integer32,
Integer32,
SnmpAdminString,
Integer32,
Integer32,
Integer32,
Integer32,
Integer32,
INTEGER,
Integer32,
Integer32,
INTEGER,
Integer32,
Unsigned32,
Unsigned32,
Integer32,
Integer32,
Integer32,
Integer32,
Integer32,
Integer32,
ITSDateStamp,
ITSDailyTimeStamp,
ITSDateStamp,
ITSDailyTimeStamp,
ITSIntegerle,
ITSIntegerlé,
ITSIntegerle,
PhysicalIndexOrZero }
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5.8.24.1 Precipitation Sensor Index
precipitationSensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Enumerated list of row entries that provide precipitation
sensor data.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.1"
:= { precipitationSensorkEntry 1 }

5.8.24.2 Precipitation Sensor Height

-—- This object has been deprecated.
precipitationSensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the precipitation sensor with respect to the
essReferenceHeight in meters.

<Format>
The value of 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> precipitationSensorzZOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.2"

REFERENCE "essReferenceHeight plus this value equals the WMO Binary Code
Form FM 94 BUFR Table B item 0 07 001."
::= { precipitationSensorEntry 2 }

5.8.24.3 Precipitation Sensor Latitude

-- This object has been deprecated.
precipitationSensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 107-6 degrees of the ESS precipitation
sensor, per WGS-84 datum.

<Format>
The precipitationSensorLatitude at the North Pole is 90,000,000. The
precipitationSensorLatitude at the South Pole is -90,000,000. The
value 90,000,001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> precipitationSensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.3"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { precipitationSensorEntry 3 }
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5.8.24.4 Precipitation Sensor Longitude

-—- This object has been deprecated.
precipitationSensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 10%-6 degrees from the Prime
Meridian of the ESS precipitation sensor location.

<Format>
The precipitationSensorLongitude of 180 degrees West shall be
-180,000,000. The precipitationSensorLongitude of 180 degrees East
shall be 180,000,000. The value 180,000,001 shall indicate a missing
value.

<Parameter Type> configuration

<Superseded by> precipitationSensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.4"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this wvalue by 10."

::= { precipitationSensorEntry 4 }

5.8.24.5 Precipitation Sensor Location

precipitationSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> A textual string indicating the location of the
precipitation sensor.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.5"
:= { precipitationSensorEntry 5 }

5.8.24.6 Precipitation Sensor Model Information Version 4

-- This object has been deprecated.
precipitationSensorModelInformationV4 OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> A reference to the row in the Module Table (See NTCIP
1201) that indicates the manufacturer, model, and version number of
the precipitation sensor.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Supplanted by> precipitationSensorEntityID (See 5.8.24.24)

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.6"

::= { precipitationSensorEntry 6 }

5.8.24.7 Total Precipitation Period
precipitationSensorPeriod OBJECT-TYPE
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SYNTAX Integer32 (0..86400)
UNITS "seconds"
MAX-ACCESS read-write

STATUS current

DESCRIPTION

"<Definition> The period, in seconds, that corresponds to the length of
time that the total water equivalent is measured in
precipitationSensorPrecipitationUserDefined.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.7"

::= { precipitationSensorEntry 7 }

5.8.24.8 Adjacent Snow Depth
precipitationSensorAdjacentSnowDepth OBJECT-TYPE

SYNTAX Integer32 (0..3001)
UNITS "centimeters"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The depth of snow in centimeters on representative areas
other than the highway pavement, avoiding drifts and plowed areas.
<Format>
The value 3001 shall indicate an error condition or missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.8"
::= { precipitationSensorEntry 8 }

5.8.24.9 Roadway Snow Depth
precipitationSensorRoadwaySnowDepth OBJECT-TYPE

SYNTAX Integer32 (0..3001)
UNITS "centimeters"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The current depth of unpacked snow in centimeters on the
driving surface.
<Format>
The value 3001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.9"
::= { precipitationSensorEntry 9 }

5.8.24.10 Roadway Snow Pack Depth
precipitationSensorRoadwaySnowPackDepth OBJECT-TYPE

SYNTAX Integer32 (0..3001)
UNITS "centimeters"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The current depth of packed snow in centimeters on the
roadway surface.
<Format>
The value 3001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.10"
::= { precipitationSensorEntry 10 }
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5.8.24.11 Precipitation Indicator

precipitationSensorPrecipYesNo OBJECT-TYPE
SYNTAX INTEGER {
precip (1),
noPrecip (2),
error (3) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates whether or not moisture is detected by the
sensor.
<Format>
precip - Moisture is currently being detected by the precipitation
sensor.
0.01 inches of liquid water equivalent is to be detected.
noPrecip - Moisture is not currently being detected by the
precipitation
sensor
error - The sensor is either not connected, not reporting, or is
indicating an error
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.11"
::= { precipitationSensorEntry 11 }

5.8.24.12 Rainfall or Water Equivalent of Snow
precipitationSensorPrecipRate OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of grams per square meter per second"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The rainfall, or water equivalent of snow, rate in tenths
of grams per square meter per second (for rain, this is approximately
to 0.36 mm/hr) .

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.12"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 014."
::= { precipitationSensorEntry 12 }

5.8.24.13 Snowfall Accumulation Rate
precipitationSensorSnowfallAccumRate OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "10"-7 meters per second"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The snowfall accumulation rate in 107-7 meters per second
(this is equivalent to 0.36 mm/hr).

<Format>
The value 65535 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.13"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 015."
::= { precipitationSensorEntry 13 }
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5.8.24.14 Precipitation Situation

precipitationSensorPrecipSituation OBJECT-TYPE
SYNTAX INTEGER {
other (1),
unknown (2),
noPrecipitation (3),
unidentifiedSlight (4),
unidentifiedModerate (5),
unidentifiedHeavy (6),
snowSlight (7),
snowModerate (8),
snowHeavy (9),
rainSlight (10),
rainModerate (11),
rainHeavy (12),
frozenPrecipitationSlight (13),
frozenPrecipitationModerate (14),
frozenPrecipitationHeavy (15) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION
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"<Definition> Describes the weather situation in terms of precipitation.
For automated stations, describes the intensity and precipitation type
as specified in the first row of the precipitationSensorTable.

the corresponding
and automated

<Format>

Intensity Meaning

slight < 2mm/h water equivalent

moderate >= 2 and < 8 mm/h water equivalent

heavy >= 8 mm/h water equivalent If one exists,
BUFR value is indicated for staffed (BUFRs)
(BUFRa) stations. The indicated value can be found in the
BUFR Table referenced below. Defined values are:

Range BUFRa BUFRs Meaning

1 other

2 unknown

3 no precipitation

4 unidentified slight

5 unidentified moderate

6 unidentified heavy

7 171 85 snow slight

8 172 86 snow moderate

9 173 86 snow heavy

10 61 rain slight

11 165 63 rain moderate

12 163 65 rain heavy

13 frozen precipitation slight

14 frozen precipitation moderate

15 frozen precipitation heavy

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.14"

REFERENCE "The values identified in the above table for BUFRa and BUFRs
can be found in WMO Binary Code Form FM 94 BUFR Table B item 0 20 003."

::= { precipitationSensorEntry 14 }
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5.8.24.151ce Deposit (Thickness)

-—- This object has been deprecated.
precipitationSensorIceThickness OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "millimeters"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
"<Definition> Indicates the thickness of the ice in millimeters.
<Format>

The value 65535 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Superseded by> essSurfacelceOrWaterDepth

<Informative> This object was deprecated in v05 because the thickness of
ice can vary by location, especially with the addition of chemicals.
As such, the superseding object is associated with a pavement sensor
rather than a precipitation sensor.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.15"

::= { precipitationSensorEntry 15 }

5.8.24.16 Precipitation Start Time

-- This object has been deprecated.
precipitationSensorPrecipitationStartTime OBJECT-TYPE

SYNTAX Unsigned32
UNITS "seconds"

MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The time at which the most recent precipitation event
began, measured in seconds since 00:00:00 January 1, 1970 UTC. The
precipitation event begins when 0.01 inches of liquid water equivalent
is detected.

<Format>
As this standard has been developed long after 1970, a value of 0 for
time should indicate to the management station that the data received
is suspect.

<Parameter Type> status

<Superseded by> precipitationSensorPrecipStartDate and
precipitationSensorPrecipStartTimeV5

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.16"

::= { precipitationSensorEntry 16 }

5.8.24.17 Precipitation End Time

-- This object has been deprecated.
precipitationSensorPrecipitationEndTime OBJECT-TYPE

SYNTAX Unsigned32
UNITS "seconds"

MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The time at which the most recently completed
precipitation event ended, measured in seconds since 00:00:00 January
1, 1970 UTC.

<Format>
As this standard has been developed long after 1970, a value of 0 for
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the time should indicate to the management station that the data
received is suspect.

<Parameter Type> status

<Superseded by> precipitationSensorPrecipEndDate and
precipitationSensorPrecipEndTimeV5

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.17"

::= { precipitationSensorEntry 17 }

5.8.24.18 Total Precipitation Past One Hour
precipitationSensorPrecipitationOneHour OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The total water equivalent precipitation over the hour
preceding the observation in tenths of kilograms per square meter (for
rain, this is approximately tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.18"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 019."
::= { precipitationSensorEntry 18 }

5.8.24.19 Total Precipitation Past Three Hours
precipitationSensorPrecipitationThreeHours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The total water equivalent precipitation over the three
hours preceding the observation in tenths of kilograms per square
meter (for rain, this is approximately tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.19"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 020."
::= { precipitationSensorEntry 19 }

5.8.24.20 Total Precipitation Past Six Hours
precipitationSensorPrecipitationSixHours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The total water equivalent precipitation over the six
hours preceding the observation in tenths of kilograms per square
meter (for rain, this is approximately tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.20"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 021."
::= { precipitationSensorEntry 20 }

5.8.24.21 Total Precipitation Past Twelve Hours

precipitationSensorPrecipitationTwelveHours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The total water equivalent precipitation over the twelve
hours preceding the observation in tenths of kilograms per square
meter (for rain, this is approximately to tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.21"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 022."
::= { precipitationSensorEntry 21 }

5.8.24.22 Total Precipitation Past Twenty-Four Hours
precipitationSensorPrecipitation24Hours OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The total water equivalent precipitation over the
twenty-four hours preceding the observation in tenths of kilograms per
square meter (for rain, this is equivalent to tenths of millimeters).

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.22"

REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 023."
::= { precipitationSensorEntry 22 }

5.8.24.23 Total Precipitation User Defined Period

precipitationSensorPrecipitationUserDefined OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "tenths of kilograms per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The total water equivalent precipitation over the
precipitationSensorPeriod preceding the observation in tenths of
kilograms per square meter (for rain, this is equivalent to tenths of
millimeters) .

<Format>
The value of 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.23"

::= { precipitationSensorEntry 23 }
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5.8.24.24 Precipitation Start Date
precipitationSensorPrecipStartDate OBJECT-TYPE

SYNTAX ITSDateStamp
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> The UTC date on which the most recent precipitation event
began. The precipitation event begins when 0.254 mm of liquid water
equivalent is detected.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.24"

DEFVAL { '00000000'H }
::= { precipitationSensorEntry 24 }

5.8.24.25 Precipitation Start Time Version 05
precipitationSensorPrecipStartTimeV5 OBJECT-TYPE

SYNTAX ITSDailyTimeStamp
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The UTC time at which the most recent precipitation event
began on the precipitationSensorPrecipStartDate. The precipitation
event begins when 0.254 mm of liquid water equivalent is detected.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.25"

DEFVAL { 86401001 }
::= { precipitationSensorEntry 25 }

5.8.24.26 Precipitation End Date
precipitationSensorPrecipEndDate OBJECT-TYPE

SYNTAX ITSDateStamp
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> The UTC date on which the most recently completed
precipitation event ended.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.26"
DEFVAL { '000O00000'H }
:= { precipitationSensorkEntry 26 }

5.8.24.27 Precipitation End Time Version 05
precipitationSensorPrecipEndTimeV5 OBJECT-TYPE

SYNTAX ITSDailyTimeStamp
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The UTC time at which the most recently completed
precipitation event ended on the precipitationSensorPrecipEndDate.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.27"
DEFVAL { 86401001 }
::= { precipitationSensorEntry 27 }

5.8.24.28 Precipitation Sensor X Offset
precipitationSensorXOffset OBJECT-TYPE
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SYNTAX ITSIntegerlb
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The X offset of the precipitation sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.28"

:= { precipitationSensorEntry 28 }

5.8.24.29 Precipitation Sensor Y Offset
precipitationSensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the precipitation sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.29"

::= { precipitationSensorEntry 29 }

5.8.24.30 Precipitation Sensor Z Offset
precipitationSensorzZOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the precipitation sensor from the
fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.30"
::= { precipitationSensorEntry 30 }

5.8.24.31 Precipitation Sensor Entity Identifier
precipitationSensorEntityID OBJECT-TYPE
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SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.14.1.31"

::= { precipitationSensorEntry 31 }

5.8.25 Number of Humidity Sensors
humiditySensorTableNumSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the humidity sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.15"
::= { essNtcipPrecip 15 }

5.8.26 Humidity Sensor Table
humiditySensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF HumiditySensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the humidity sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16"
::= { essNtcipPrecip 16 }

5.8.27 Humidity Sensor
humiditySensorEntry OBJECT-TYPE

SYNTAX HumiditySensorEntry
MAX-ACCESS not-accessible
STATUS current

DESCRIPTION

"<Definition> A humidity sensor is a sensor that reports the relative
humidity. It can be described through a number of attributes as
indicated by the following subclauses."

INDEX { humiditySensorIndex }
::= { humiditySensorTable 1 }

HumiditySensorEntry ::= SEQUENCE {
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humiditySensorIndex
humiditySensorHeight
humiditySensorLatitude
humiditySensorLongitude
humiditySensorLocation
humiditySensorModelInformation
humiditySensorRelativeHumidity

humiditySensorTemperatureInformation

humiditySensorWetbulbTemp
humiditySensorDewpointTemp
humiditySensorXOffset
humiditySensorYOffset
humiditySensorZOffset
humiditySensorEntityID

5.8.27.1 Humidity Sensor Index
humiditySensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

Integer32,
Integer32,
Integer32,
Integer32,
SnmpAdminString,
Integer32,
Integer32,
Integer32,
Integer32,
Integer32,
ITSIntegerle,
ITSIntegerle,
ITSIntegerle,
PhysicalIndexOrZero}

"<Definition> Enumerated list of row entries that provide humidity

sensor data.
<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.1"

::= { humiditySensorEntry 1 }
5.8.27.2 Humidity Sensor Height

-- This object has been deprecated.
humiditySensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the humidity sensor with respect to the

essReferenceHeight in meters.
<Format>

The value of 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> humiditySensorZOffset

<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.2"
REFERENCE "essReferenceHeight plus this value equals the WMO Binary Code
Form FM 94 BUFR Table B item 0 07 001."

:= { humiditySensorEntry 2 }
5.8.27.3 Humidity Sensor Latitude

-- This object has been deprecated.
humiditySensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 10"-6 degrees of the ESS humidity sensor,
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per WGS-84 datum.

<Format>
The humiditySensorLatitude at the North Pole is 90,000,000. The
humiditySensorLatitude at the South Pole is -90,000,000. The value
90,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> humiditySensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.3"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { humiditySensorEntry 3 }

5.8.27.4 Humidity Sensor Longitude

-- This object has been deprecated.
humiditySensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS humidity sensor location.

<Format>
The humiditySensorLongitude of 180 degrees West shall be -180,000,000.
The humiditySensorLongitude of 180 degrees East shall be 180,000,000.
The value 180,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> humiditySensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.4"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

::= { humiditySensorEntry 4 }

5.8.27.5 Humidity Sensor Location

humiditySensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> A textual string indicating the location of the humidity
sensor.

<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.5"
:= { humiditySensorEntry 5 }

5.8.27.6 Humidity Sensor Model Information

-- This object has been deprecated.
humiditySensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION
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"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the Humidity Sensor Table.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Supplanted by> humiditySensorEntityID

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.6"

::= { humiditySensorEntry 6 }

5.8.27.7 Relative Humidity
humiditySensorRelativeHumidity OBJECT-TYPE

SYNTAX Integer32 (0..101)

UNITS "percent humidity"

MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> The relative humidity in percent.
<Format>

The value of 101 shall indicate an error condition or missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.7"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 13 003."
::= { humiditySensorEntry 7 }

5.8.27.8 Humidity Sensor Temperature Information

humiditySensorTemperatureInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS current
DESCRIPTION

"<Definition> Indicates the row in the essTemperatureSensorTable that
contains the temperature associated with this row of the Humidity
Sensor Table. If a SetRequest-PDU attempts to set this object to a
value that does not reference an existing EssTemperatureSensorEntry,
the ESS shall respond with an inconsistentValue error. The ESS shall
automatically update this value if the index of the referenced temp
sensor changes (e.g., due to another temperature sensor being
disconnected and the index numbers being updated).

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.8"

DEFVAL {1}
:= { humiditySensorEntry 8 }

5.8.27.9 Wetbulb Temperature
humiditySensorWetbulbTemp OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The wet-bulb temperature in tenths of degrees Celsius for
the row of the essTemperatureSensorTable as specified by
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humiditySensorTemperatureInformation for this humidity sensor. The
temperature is an instantaneous reading.
<Format>
The value 1001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.9"

REFERENCE "is based on WMO Binary Code Form FM 94 BUFR Table B item 0 12
002; temperature in Kelvin is determined by adding 273.15 to this
value."

::= { humiditySensorEntry 9 }

5.8.27.10 Dewpoint Temperature
humiditySensorDewpointTemp OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The dewpoint temperature in tenths of degrees Celsius for
the row of the essTemperatureSensorTable as specified by
humiditySensorTemperatureInformation. The temperature is an
instantaneous reading.

<Format>
The value 1001 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.10"

REFERENCE "Resolution is based on WMO Binary Code Form FM 94 BUFR Table B
item 0 12 003; temperature in Kelvin is determined by adding 273.15 to
this value."

::= { humiditySensorEntry 10 }

5.8.27.11 Humidity Sensor X Offset
humiditySensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The X offset of the humidity sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.11"

::= { humiditySensorEntry 11 }

5.8.27.12 Humidity Sensor Y Offset

humiditySensorYOffset OBJECT-TYPE
SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
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STATUS current
DESCRIPTION
"<Definition> The Y offset of the humidity sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.
<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.12"
::= { humiditySensorEntry 12 }

5.8.27.13 Humidity Sensor Z Offset
humiditySensorZOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the humidity sensor from the
fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.13"
::= { humiditySensorEntry 13 }

5.8.27.14 Humidity Sensor Entity Identifier
humiditySensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.6.16.1.14"

:= { humiditySensorEntry 14 }

5.9 Radiation Objects

essBufrRadiation OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the data that is collected by the
pavement surface sensor and recorded in a format consistent with BUFR.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.14"
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::= {essBufr 14 }

essNtcipRadiation OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the data that is collected by the
pavement surface sensor and recorded in a format not directly derived
from BUFR.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7"
::= {essNtcip 7}

5.9.1 Solar Radiation

-—- This object has been deprecated.
essSolarRadiation OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "joules per square meter"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The direct solar radiation integrated over the 24 hours
preceding the observation in Joules per square meter. The value of
65535 shall indicate a missing wvalue.

<Parameter Type> status

<Superseded by> essInstantaneousSolarRadiation (See 5.9.5)

<Informative> This object was deprecated in version 02.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.14.24"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 024."
::= { essBufrRadiation 24 }

5.9.2 Total Sun

-- This object has been deprecated.
essTotalSun OBJECT-TYPE

SYNTAX Integer32 (0..1441)
UNITS "minutes"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The total amount of sunshine in minutes over the 24 hour
period preceding the observation.
<Format>
The value of 1441 shall indicate a missing value.
<Parameter Type> status
<Superseded by> essTotalSunV4 (See 5.9.10.7)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.14.31"
REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 031."
:= { essBufrRadiation 31 }

5.9.3 Cloud Cover Situation

-- This object has been deprecated.
essCloudSituation OBJECT-TYPE
SYNTAX INTEGER {
overcast (1),
cloudy (2),
partlyCloudy (3),
mostlyClear (4),
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clear (5) }
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION
"<Definition> Describes the amount of cloud cover. The associated
percentages of cloud cover are indicated to identify the differences
between the defined wvalues.

<Format>
Defined values are:
Value Meaning Percent Cloud Cover
1 Overcast 100%
2 Mostly cloudy 62.5%-99%
3 Partly cloudy 37.5%-62.4%
4 Mostly sunny 1%-37.4%

5 Clear skies 0%
<Parameter Type> status
<Superseded by> essCloudSituationV4 (See 5.9.11)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.1"
:= { essNtcipRadiation 1 }

5.9.4 Terrestrial Radiation

-- This object has been deprecated.
essInstantaneousTerrestrialRadiation OBJECT-TYPE

SYNTAX Integer32 (-2048..2049)
UNITS "watts per square meter"
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION
"<Definition> The instantaneous infrared (wavelength of 3.5 - 50

micrometers) radiation being emitted from the atmosphere in watts per
square meter.

<Format>
The value of 2049 shall indicate a missing value.

<Parameter Type> status

<Superseded by> essInstantaneousTerrestrialRadiationV4 (See 5.9.10.8)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.14.17"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 017"
::= { essBufrRadiation 17 }

5.9.5 Solar Radiation—Version 2

-- This object has been deprecated.
essInstantaneousSolarRadiation OBJECT-TYPE

SYNTAX Integer32 (-2048..2049)
UNITS "watts per square meter"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The instantaneous ultraviolet, visible, and near-infrared
(wavelength of less than 3.0 micrometers) radiation hitting the
earth's surface in watts per square meter.

<Format>
The value of 2049 shall indicate a missing value.

<Parameter Type> status

<Superseded by> essInstantaneousSolarRadiationV4 (See 5.9.10.9)

<Informative> This object was deprecated in version 04.
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.14.18"
REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 018"
::= { essBufrRadiation 18 }

5.9.6 Total Radiation

-- This object has been deprecated.
essTotalRadiation OBJECT-TYPE

SYNTAX Integer32 (-2048..2049)
UNITS "joules per square meter"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION

"<Definition> The average total radiation hitting the earth's surface in
watts per square meter during the radiation period.
<Format>
The value of 2049 shall indicate a missing value.
<Parameter Type> status
<Superseded by> essTotalRadiationV4 (See 5.9.10.10)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.1.14.25"
REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 025"
:= { essBufrRadiation 25 }

5.9.7 Total Radiation Period
essTotalRadiationPeriod OBJECT-TYPE

SYNTAX Integer32 (0..86400)
UNITS "seconds"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The rolling period, in seconds, that corresponds to the
length of time the essTotalRadiation is averaged.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.2"
::= { essNtcipRadiation 2 }

5.9.8 Number of Radiation Sensors
radiationSensorTableNumSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the radiation sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.3"
:= { essNtcipRadiation 3 }

5.9.9 Radiation Sensor Table

radiationSensorTable OBJECT-TYPE
SYNTAX SEQUENCE OF RadiationSensorEntry
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MAX-ACCESS not-accessible
STATUS current
DESCRIPTION

"<Definition> Table containing the radiation sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4"
::= { essNtcipRadiation 4 }

5.9.10 Radiation Sensor
radiationSensorEntry OBJECT-TYPE

SYNTAX RadiationSensorEntry
MAX-ACCESS not-accessible
STATUS current

DESCRIPTION

"<Definition> A radiation sensor is a sensor that reports the amount of
radiation detected. It can be described through a number of attributes
as indicated by the following subclauses."

INDEX { radiationSensorIndex }
::= { radiationSensorTable 1 }

RadiationSensorEntry ::= SEQUENCE ({
radiationSensorIndex Integer32,
radiationSensorHeight Integer32,
radiationSensorLatitude Integer32,
radiationSensorLongitude Integer32,
radiationSensorLocation SnmpAdminString,
radiationSensorModelInformation Integer32,
essTotalsunV4 Integer32,
essInstantaneousTerrestrialRadiationvV4 Integer32,
essInstantaneousSolarRadiationVv4 Integer32,
essTotalRadiationV4 Integer32,
radiationSensorXOffset ITSIntegerle,
radiationSensorYOffset ITSIntegerle,
radiationSensorZOffset ITSIntegerleo,
radiationSensorEntityID PhysicalIndexOrZero}

5.9.10.1 Radiation Sensor Index
radiationSensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Enumerated list of row entries that provide radiation
sensor data.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.1"
:= { radiationSensorEntry 1 }

5.9.10.2 Radiation Sensor Height

-- This object has been deprecated.
radiationSensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the radiation sensor with respect to the
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essReferenceHeight in meters.

<Format>
The value of 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> radiationSensorZOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.2"

REFERENCE "essReferenceHeight plus this value equals the WMO Binary Code
Form FM 94 BUFR Table B item 0 07 001."
::= { radiationSensorEntry 2 }

5.9.10.3 Radiation Sensor Latitude

-—- This object has been deprecated.
radiationSensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 10"-6 degrees of the ESS radiation sensor,
per WGS-84 datum.

<Format>
The radiationSensorLatitude at the North Pole is 90,000,000. The
radiationSensorLatitude at the South Pole is -90,000,000. The value
90,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> radiationSensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.3"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { radiationSensorEntry 3 }

5.9.10.4 Radiation Sensor Longitude

-- This object has been deprecated.
radiationSensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees of longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS radiation sensor location.

<Format>
The radiationSensorLongitude of 180 degrees West shall be -180,000,000.
The radiationSensorLongitude of 180 degrees East shall be 180,000,000.
The value 180,000,001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> radiationSensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.4"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

::= { radiationSensorEntry 4 }
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5.9.10.5 Radiation Sensor Location
radiationSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> A textual string indicating the location of the radiation
sensor.

<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.5"
:= { radiationSensorEntry 5 }

5.9.10.6 Radiation Sensor Model Information

-—- This object has been deprecated.
radiationSensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the Radiation Sensor Table.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Supplanted by> radiationSensorEntityID (See 5.9.10.11)

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.6"

::= { radiationSensorEntry 6 }

5.9.10.7 Total Sun V4
essTotalSunV4 OBJECT-TYPE

SYNTAX Integer32 (0..1441)
UNITS "minutes"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The total amount of sunshine in minutes over the 24 hour
period preceding the observation.

<Format>
The value of 1441 shall indicate a missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.7"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 031."
::= { radiationSensorEntry 7 }

5.9.10.8 Terrestrial Radiation V4
essInstantaneousTerrestrialRadiationV4 OBJECT-TYPE

SYNTAX Integer32 (-2048..2049)
UNITS "watts per square meter"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> The instantaneous infrared (wavelength of 3.5 - 50

micrometers) radiation being emitted from the atmosphere in watts per
square meter.
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<Format>
The value of 2049 shall indicate a missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.8"
REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 017"
::= { radiationSensorEntry 8 }

5.9.10.9 Solar Radiation Version 4
essInstantaneousSolarRadiationVv4 OBJECT-TYPE

SYNTAX Integer32 (-2048..2049)
UNITS "watts per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The instantaneous ultraviolet, visible, and near-infrared
(wavelength of less than 3.0 micrometers) radiation hitting the
earth's surface in watts per square meter.

<Format>
The value of 2049 shall indicate a missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.9"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 018"
:= { radiationSensorEntry 9 }

5.9.10.10 Total Radiation V4
essTotalRadiationV4 OBJECT-TYPE

SYNTAX Integer32 (-2048..2049)
UNITS "watts per square meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The average total radiation hitting the earth's surface in
watts per square meter during the radiation period.

<Format>
The value of 2049 shall indicate a missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.10"

REFERENCE "WMO Code Form FM 94 BUFR Table B item 0 14 025"
::= { radiationSensorEntry 10 }

5.9.10.11 Radiation Sensor X Offset
radiationSensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset latitude of the radiation sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.
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<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.11"
::= { radiationSensorEntry 11 }

5.9.10.12 Radiation Sensor Y Offset
radiationSensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the radiation sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.12"

:= { radiationSensorEntry 12 }

5.9.10.13 Radiation Sensor Z Offset
radiationSensorzOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the radiation sensor from the
fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.13"
::= { radiationSensorEntry 13 }

5.9.10.14 Radiation Sensor Entity Identifier
radiationSensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this wvalue when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.4.1.14"
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::= { radiationSensorEntry 14 }

5.9.11 Cloud Cover Situation V4
essCloudSituationv4 OBJECT-TYPE

SYNTAX Integer32 (0..8)
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> Describes the amount of cloud cover in the sky, measured
in oktas, as defined in WMO code table 2700.

<Format>
Defined values are:
Oktas Category Definition
0 Fine Sky clear
1 Fine 1/8 of sky covered or less, but not zero
2 Fine 2/8 of sky covered
3 Partly Cloudy 3/8 of sky covered
4 Partly Cloudy 4/8 of sky covered
5 Partly Cloudy 5/8 of sky covered
6 Cloudy 6/8 of sky covered
7 Cloudy 7/8 of sky covered or more, but not 8/8
8 Overcast 8/8 of sky completely covered, no breaks

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.7.5"
::= { essNtcipRadiation 5 }

5.10 Visibility Data Objects

essNtcipVisibility OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the visibility data that is
collected by the ESS.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8"
::= {essNtcip 8 }

5.10.1 Visibility

-- This object has been deprecated.
essVisibility OBJECT-TYPE

SYNTAX Integer32 (0..1000001)

UNITS "decimeters"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
"<Definition> Surface visibility measured in one tenth of a meter.
<Format>

The value 1000001 shall indicate an error condition or missing value.
<Parameter Type> status
<Superseded by> essVisibilitySensorCurrentReading
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.1"
REFERENCE "The value for WMO Code Form FM 94 BUFR Table B item 0 20 001 is
given by this wvalue divided by 100."
:= { essNtcipVisibility 1 }

5.10.2 Number of Visibility Sensors
essNumVisibilitySensors OBJECT-TYPE
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SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the visibility sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.2"
::= { essNtcipVisibility 2 }

5.10.3 Visibility Situation

essVisibilitySituation OBJECT-TYPE
SYNTAX INTEGER {
other (1),
unknown (2),
clear (3),
fogNotPatchy (4),
patchyFog (5),
blowingSnow (6),
smoke (7),
seaSpray (8),
vehicleSpray (9),
blowingDustOrSand (10),
sunGlare (11),
swarmsOfInsects (12) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Describes the travel environment in terms of visibility.
If one exists, the corresponding BUFR value is indicated for staffed
(BUFRs) and automated (BUFRa) stations. The indicated value can be
found in the BUFR Table referenced below.

<Format>
Range BUFRs BUFRa Meaning

1 other visibility anomaly
2 unknown
3 0 100 clear
4 44 130 Fog - not patchy
5 41 131 Patchy fog
6 36 127 Blowing snow
7 04 104 Smoke
8 07 207 Sea Spray
9 Vehicle Spray
10 31 127 Blowing dust or sand
11 sun glare
12 Swarms of insects

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.3"
REFERENCE "The values identified in the above table for BUFRa and BUFRs
can be found in WMO Code Form FM 94 BUFR Table B item 0 20 003."
::= { essNtcipVisibility 3 }
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5.10.4 Visibility Sensor Height

-—- This object has been deprecated.
visibilitySensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the visibility sensor with respect to the
essReferenceHeight in meters.

<Format>
The value of 1001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> essVisibilitySensorZOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.4"

REFERENCE "essReferenceHeight plus this value equals the WMO Binary Code
Form FM 94 BUFR Table B item 0 07 001."
::= { essNtcipVisibility 4 }

5.10.5 Visibility Sensor Latitude

-- This object has been deprecated.
visibilitySensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 107-6 degrees of the ESS visibility
sensor, per WGS-84 datum.

<Format>
The visibilitySensorLatitude at the North Pole is 90,000,000. The
visibilitySensorLatitude at the South Pole is -90,000,000. The value
90,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> essVisibilitySensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.5"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { essNtcipVisibility 5 }

5.10.6 Visibility Sensor Longitude

-- This object has been deprecated.
visibilitySensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS visibility sensor location.
<Format>
The visibilitySensorLongitude of 180 degrees West shall be -
180,000,000.
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The visibilitySensorLongitude of 180 degrees East shall be
180,000,000. The value 180,000,001 shall indicate a missing value.
<Parameter Type> configuration
<Superseded by> essVisibilitySensorXOffset
<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.6"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

::= { essNtcipVisibility 6 }

5.10.7 Visibility Sensor Location

-—- This object has been deprecated.
visibilitySensorLocation OBJECT-TYPE

SYNTAX DisplayString (SIZE (0..255))
MAX-ACCESS read-write
STATUS deprecated
DESCRIPTION
"<Definition> A textual string indicating the location of the visibility
sensor.

<Parameter Type> configuration
<Superseded by> essVisibilitySensorLocation
<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.7"

::= { essNtcipVisibility 7 }

5.10.8 Visibility Sensor Model Information

-- This object has been deprecated.
visibilitySensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the visibility sensor. If there is more than one visibility sensor,
the row indicates the information for the primary visibility sensor.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Superseded by> essVisibilitySensorEntityID

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.8"

::= { essNtcipVisibility 8 }

5.10.9 Visibility Sensor Table
essVisibilitySensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF EssVisibilitySensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the visibility sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9"
::= { essNtcipVisibility 9 }
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5.10.10 Visibility Sensor
essVisibilitySensorEntry OBJECT-TYPE

SYNTAX EssVisibilitySensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> A visibility sensor is a sensor that reports the surface
visibility distance. It can be described through a number of
attributes as indicated by the following subclauses.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1"

INDEX { essPressureSensorIndex }
:= { essVisibilitySensorTable 1 }

EssVisibilitySensorEntry ::= SEQUENCE ({
essVisibilitySensorIndex Integer32,
essVisibilitySensorLocation SnmpAdminString,
essVisibilitySensorXOffset ITSIntegerlé,
essVisibilitySensorYOffset ITSIntegerlé,
essVisibilitySensorZOffset ITSIntegerle,
essVisibilitySensorDirection Integer32,
essVisibilitySensorEntityID PhysicalIndexOrZero,
essVisibilitySensorCurrentReading Integer32 }

5.10.10.1 Visibility Sensor Index
essVisibilitySensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS not-accessible
STATUS current
DESCRIPTION

"<Definition> Enumerated list of row entries that provide visibility
sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1.1"
:= { essVisibilitySensorEntry 1 }

5.10.10.2 Visibility Sensor Location
essVisibilitySensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> A textual string indicating the location of the visibility
sensor.

<Parameter Type> configuration
<Informative> Implementations are only required to support the NVT-ASCII
character set but may support additional UTF-8 characters.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1.2"
::= { essVisibilitySensorEntry 2 }

5.10.10.3 Visibility Sensor X Offset
essVisibilitySensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The lateral offset of the visibility sensor from the field
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device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1.3"

::= { essVisibilitySensorEntry 3 }

5.10.10.4 Visibility Sensor Y Offset
essVisibilitySensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the visibility sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1.4"

::= { essVisibilitySensorEntry 4 }

5.10.10.5 Visibility Sensor Z Offset
essVisibilitySensorZOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the visibility sensor from the
fdConfiguredElevation in centimeters.

<Format>
Upward offsets shall be positive and downward offsets shall be

negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1.5"
:= { essVisibilitySensorEntry 5 }

5.10.10.6 Visibility Sensor Direction
essVisibilitySensorDirection OBJECT-TYPE

SYNTAX Integer32 (-3..359)
UNITS "compass degrees"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The direction in which the sensor measures visibility.
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<Format>

Values 0..359 indicate degrees from true north (e.g., 90 indicates
east)

for sensors that detect back scatter from a distance (e.g., LIDAR).
The value -1 indicates an error condition. The value -2 shall indicate
a missing or unknown value. The value -3 shall indicate that the
sensor detects a localized extinction coefficient to calculate
visibility range (e.g., forward scatter and transmissometer sensors).
This format is consist with ITSDirection with the addition of the -3
value.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1.6"

:= { essVisibilitySensorEntry 6 }

5.10.10.7 Visibility Sensor Entity Identifier
essVisibilitySensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.8.9.1.7"

::= { essVisibilitySensorEntry 7 }

5.10.10.8 Visibility Sensor Current Reading
essVisibilitySensorCurrentReading OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "decimeters (1/10ths of meter)"

MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> Indicates the current surface visibility reading.
<Format>

A value of 65535 shall indicate an error condition or missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.16.2.1.8"
REFERENCE "WMO Binary Code Form FM 94 BUFR Table B item 0 07 004."
::= { essVisibilitySensorEntry 8 }

5.1 Pavement Sensor Objects

essNtcipPavement OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used to describe the data that is collected by the
pavement surface sensor.
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9"
::= {essNtcip 9}
5.11.1 Number of Pavement Sensors
numkEssPavementSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the pavement sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.1"
::= { essNtcipPavement 1 }

5.11.2 Pavement Sensor Table
essPavementSensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF EssPavementSensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the pavement sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2"
::= { essNtcipPavement 2 }

5.11.3 Pavement Sensor
essPavementSensorEntry OBJECT-TYPE

SYNTAX EssPavementSensorkEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> A pavement sensor is a sensor that reports the temperature
and moisture condition of the roadway pavement. It can be described
through a number of attributes as indicated by the following
subclauses."

INDEX { essPavementSensorIndex }
::= { essPavementSensorTable 1 }

EssPavementSensorkEntry ::= SEQUENCE ({
essPavementSensorIndex Integer3z,
essPavementSensorLocation SnmpAdminString,
essPavementType INTEGER,
essPavementElevation Integer32,
essPavementExposure Integer32,
essPavementSensorType INTEGER,
essSurfaceStatus INTEGER,
essSurfaceTemperature Integer32,
essPavementTemperature Integer32,
essSurfaceWaterDepth Integer32,
essSurfaceSalinity Integer32,
essSurfaceConductivity Integer32,
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essSurfaceFreezePoint Integer32,
essSurfaceBlackIceSignal INTEGER,
essPavementSensorError INTEGER,
essSurfacelceOrWaterDepth Integer32,
essSurfaceConductivityV2 Integer32,
pavementSensorModelInformation Integer32,
pavementSensorTemperatureDepth Integer32,
pavementSensorLatitude Integer32,
pavementSensorLongitude Integer32,
pavementSensorSurfaceCondition INTEGER,
pavementSensorForecastCondition INTEGER,
pavementSensorFrictionCoefficient Integer32,
pavementMonitorLatitude Integer32,
pavementMonitorLongitude Integer32,
pavementIcePercentage Integer32,
essPavementMonitorXOffset ITSIntegerle,
essPavementMonitorYOffset ITSIntegerle,
essPavementMonitorZOffset ITSIntegerle,
essPavementSensorXOffset ITSIntegerle,
essPavementSensorYOffset ITSIntegerle,
essPavementSensorEntityID PhysicalIndexOrZero }

5.11.3.1 Pavement Sensor Index
essPavementSensorIndex OBJECT-TYPE
SYNTAX Integer32 (1..255)
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Enumerated list of row entries that provide surface sensor
data.

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.1"
::= { essPavementSensorEntry 1 }

5.11.3.2 Pavement Sensor Location
essPavementSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> A textual string indicating the location of the pavement
sensor and the location of the pavement being monitored.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.2"
:= { essPavementSensorEntry 2 }

5.11.3.3 Pavement Type

essPavementType OBJECT-TYPE
SYNTAX INTEGER {

other (1),
unknown (2),
asphalt (3),
openGradedAsphalt (4),
concrete (5),
steelBridge (6),
concreteBridge (7),
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asphaltOverlayBridge (8),
timberBridge (9)}
MAX-ACCESS read-write

STATUS current
DESCRIPTION
"<Definition> Indicates the type of pavement on the roadway.
<Format>
other a different type of bridge deck
unknown the data was never recorded in the system or is a
mobile sensor
asphalt asphalt pavement on ground
concrete concrete pavement on ground
steelBridgeconcrete a concrete driving surface on a steel girder
bridge
steelBridgeAsphalt an asphalt driving surface on a steel girder
bridge
steelBridge a steel lattice driving surface on the bridge
concreteBridge a concrete driving surface on a concrete bridge
concreteBridgeAsphalt an asphalt overlay driving surface on a concrete
bridge
timberBridge a wooden deck driving surface on the bridge

<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.3"
::= { essPavementSensorEntry 3 }

5.11.3.4 Pavement Elevation

-- This object has been deprecated.
essPavementElevation OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The elevation of the street surface in meters with respect
to the essReferenceHeight.

<Format>
The value 1001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> essPavementZOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.4"

:= { essPavementSensorEntry 4 }

5.11.3.5 Pavement Exposure
essPavementExposure OBJECT-TYPE

SYNTAX Integer32 (0..101)
UNITS "percent exposure"
MAX-ACCESS read-write

STATUS current
DESCRIPTION

"<Definition> Indicates a very rough percentage of the solar energy
which is anticipated to directly hit the sensor.

<Format>
A value of 100 indicates a fully visible sky. A value of 101 shall
indicate a missing value.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.5"
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::= { essPavementSensorEntry 5 }

5.11.3.6 Pavement Sensor Type

essPavementSensorType OBJECT-TYPE
SYNTAX INTEGER ({
other (1),
contactPassive (2),
contactActive (3),
infrared (4),
radar (5),
vibrating (6),
microwave (7),
laser (8),
audio (9) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> A value indicating the type of pavement sensor.
<Parameter Type> status
<Informative> The value 'laser' was added in v02. The value 'audio' was
added in vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.6"
:= { essPavementSensorEntry 6 }

5.11.3.7 Surface Status

-- This object has been deprecated.
essSurfaceStatus OBJECT-TYPE
SYNTAX INTEGER {
other (1),
error (2),
dry (3),
traceMoisture (4),
wet (5),
chemicallyWet (6),
iceWarning (7),
iceWatch (8),
snowWarning (9),
snowWatch (10),
absorption (11),
dew (12),
frost (13),
absorptionAtDewpoint (14) }
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
"<Definition> A value indicating the pavement surface status.
<Format>

other - The value reported by the sensor is not defined by the
standard.
See the manufacturer's documentation for more information.

noReport - The sensor is not providing any reading for surface status
and
may not be responding
errorReport - The sensor is providing a reading for surface status, but
either the reading indicates an error code or the data has been
deemed

invalid or suspect
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dry - The sensor does not detect any moisture or unusual conditions.
trace - The sensor detects some moisture, but it is suspected to be
isolated

absorption - A salt chemical is present that is not fully dissolved in
water. As a result, the conductivity readings result in erroneous
calculations for amount of chemical in the mix.

wet - The sensor detects a significant amount of moisture indicating a
wet
roadway.
chemically wet - The sensor detects a signaificant amount of moisture

mixed with a de-icing or anti-icing chemical
dew - The sensor detects moisture that is suspected to be from the
formation of dew
frost - The sensor detects the formation of frost
freezeAdvisory - The risk of the formation of some sort of frozen
moisture
on the roadway is elevated, but its occurrence, location, and/or
timing is still uncertain
slushAdvisory - The risk of the accumulation of snow or slush on the
roadway 1is elevated, but its occurrence, location, and/or timing is
still uncertain
iceAdvisory - The risk of the formation of ice or black ice on the
roadway
is elevated, but its occurrence, location, and/or timing is still
uncertain
freezeHazard - The sensor detects some sort of frozen moisture but is
unable to classify as slush or ice.
slush - The sensor detects snow or slush.
ice - The sensor detects ice or black ice. (See
essSurfaceBlackIceSignal)
<Parameter Type> status
<Superseded by> pavementSesnsorSurfaceCondition (See 5.11.3.22) and
pavementSensorForecastCondition (See 5.11.3.23)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.7"
:= { essPavementSensorEntry 7 }

5.11.3.8 Surface Temperature
essSurfaceTemperature OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The current pavement surface temperature in tenths of
degrees Celsius.
<Format>
The value 1001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.8"
::= { essPavementSensorEntry 8 }

5.11.3.9 Pavement Temperature

essPavementTemperature OBJECT-TYPE
SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only
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STATUS current
DESCRIPTION
"<Definition> The current pavement temperature 2-10 cm below the
pavement surface in tenths of degrees Celsius. The specific depth at
which the reading is taken is defined by
pavementSensorTemperatureDepth.
<Format>
The value 1001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.9"
::= { essPavementSensorEntry 9 }

5.11.3.10 Surface Water Depth

-- This object has been deprecated.
essSurfaceWaterDepth OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "millimeters"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The current depth of water on the surface of the roadway
measured in millimeters. The value 255 shall indicate an error
condition or missing value.

<Parameter Type> status

<Superseded by> essSurfacelceOrWaterDepth (See 5.11.3.16)

<Informative> This object was deprecated in version 2.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.10"

::= { essPavementSensorEntry 10 }

5.11.3.11 Surface Salinity
essSurfaceSalinity OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "parts per 100,000 by weight"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The pavement salinity in parts per one hundred thousand by
weight (i.e., grams of solute per 100,000 grams of solution).
<Format>
The value 65535 shall indicate an error condition or missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.11"
::= { essPavementSensorEntry 11 }

5.11.3.12 Surface Conductivity

-- This object has been deprecated.
essSurfaceConductivity OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "mhos"

MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the conductance of the ice/liquid mixture on the
pavement as detected by the sensor, in mhos, which is the inverse of
ohms. The value 65535 shall indicate an error condition or missing
value.
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<Parameter Type> status

<Superseded by> essSurfaceConductivityV2 (See 5.11.3.17)

<Informative> This object was deprecated in version 2.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.12"
::= { essPavementSensorEntry 12 }

5.11.3.13 Surface Freezing Point
essSurfaceFreezePoint OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The temperature in tenths of degrees Celsius at which the
existing solution on the roadway freezes.
<Format>
The value 1001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.13"
::= { essPavementSensorkEntry 13 }

5.11.3.14 Surface Black Ice Signal

essSurfaceBlackIceSignal OBJECT-TYPE
SYNTAX INTEGER ({
other (1),
nolce (2),
blackIce (3),
detectorError (4) }
MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> A value indicating if Black Ice is detected by the sensor.
<Format>

other - The sensor is reporting a value that is not defined by the
standard. See the manufacturer's documentation for more
information.
nolce - The sensor is not currently detecting black ice.
blackIce - The sensor is currently detecting black ice.
detectorError - The sensor is not connected, is not reporting, or is
reporting an error.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.14"
::= { essPavementSensorEntry 14 }

5.11.3.15Pavement Sensor Error

essPavementSensorError OBJECT-TYPE
SYNTAX INTEGER {
other (1),
none (2),
noResponse (3),
cutCable (4),
shortCircuit (5),
dirtyLens (6) 1}
MAX-ACCESS read-only
STATUS current
DESCRIPTION
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"<Definition> A value indicating the type of pavement sensor error.
<Format>
other - An error has been detected that is not defined by the standard;
see the manufacturer's documentation for more information.
none - No error is detected, the sensor appears to be working properly

noResponse - The sensor is configured and is believed to be connected,
but is not responding

cutCable - The sensor is not configured, not present or not fully
connected, perhaps because the cable was cut

shortCircuit - The sensor input has detected a short-circuit.

dirtyLens - The lens of the sensor appears to be dirty.

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.15"
::= { essPavementSensorEntry 15 }

5.11.3.16 Surface Water Depth—Version 2
essSurfacelceOrWaterDepth OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "tenths of millimeters"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The current thickness of ice or depth of water on the
surface of the roadway measured in 1/10th of millimeters.
<Format>
The value 65535 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.16"
::= { essPavementSensorEntry 16 }

5.11.3.17 Surface Conductivity—Version 2
essSurfaceConductivityV2 OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "tenths of milli-mhos/cm"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the conductivity of the ice/liquid mixture on
the pavement as detected by the sensor, in 1/10ths of milli-mhos/cm
(mhos is the inverse of ohms). This value is independent of the size
or shape of the sensor and can be directly translated into a percent
concentration of chemical (e.g. salinity) through look-up tables for a
given chemical.

<Format>
The value 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.17"

:= { essPavementSensorEntry 17 }

5.11.3.18 Pavement Sensor Model Information

-- This object has been deprecated.
pavementSensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION
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"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the Pavement Sensor Table.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Supplanted by> pavementSensorEntityID (See 5.11.3.28)

<Informative> This object was deprecated in version 5.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.18"

::= { essPavementSensorEntry 18 }

5.11.3.19 Pavement Temperature Depth
pavementSensorTemperatureDepth OBJECT-TYPE

SYNTAX Integer32 (2..11)

UNITS "centimeters"

MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> The depth at which the pavement temperature is detected.
<Format>

The value of 11 indicates that the information is not available.
<Parameter Type> status
<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.19"
::= { essPavementSensorEntry 19 }

5.11.3.20 Pavement Sensor Latitude

-- This object has been deprecated.
pavementSensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 107-6 degrees of the ESS pavement sensor,
per WGS-84 datum.

<Format>
The pavementSensorLatitude at the North Pole is 90,000,000. The
pavementSensorLatitude at the South Pole is -90,000,000. The value
90,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> pavementSensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.20"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { essPavementSensorEntry 20 }

5.11.3.21 Pavement Sensor Longitude

-- This object has been deprecated.
pavementSensorLongitude OBJECT-TYPE
SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
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MAX-ACCESS read-write
STATUS deprecated
DESCRIPTION

"<Definition> The east longitude in 10%-6 degrees from the Prime
Meridian of the ESS pavement sensor location.

<Format>
The pavementSensorLongitude of 180 degrees West shall be -180,000,000.
The pavementSensorLongitude of 180 degrees East shall be 180,000,000.
The value 180,000,001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> pavementSensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.21"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this wvalue by 10."

:= { essPavementSensorEntry 21 }

5.11.3.22 Pavement Surface Condition
pavementSensorSurfaceCondition OBJECT-TYPE

SYNTAX INTEGER {
other (1),
error (2),
dry (3),

moist (4),

chemicallyMoist (5),

wet (6),

chemicallyWet (7),

standingWater (8),

frost (9),

slush (10),

snow (11),

ice (12),

noReport (13) }
MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> A value indicating the pavement surface status.
<Format>

other: The value reported by the sensor is not defined by the standard.
See the manufacturer's documentation for more information

error: The sensor is providing a reading for surface status, but either
the reading indicates an error code or the data has been deemed
invalid or suspect

dry: no humidity over the sensor (EN 15518-3)

moist: from 0.01 mm to 0.2 mm water film thickness over the sensor
(EN 15518-3)

chemically moist: from 0.01 mm to 0.2 mm water film thickness over the
sensor mixed with de-icing or anti-icing chemical

wet: from 0.2 mm water film thickness to 2.0 mm water film thickness

over

the sensor (EN 15518-3)

chemically wet: from 0.2 mm water film thickness or greater mixed with
de-icing or anti-icing chemical

standing water: from 2.0 mm or greater water film thickness over the
sensor (EN 15518-3)

frost: formation of frost (ice crystals) is detected over the sensor
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slush: snow or ice that has been reduced to a soft water mixture by
rain,
warm temperature, and/or chemical treatment (Glossary of
Meteorology)
snow: snow is detected over the sensor
ice: ice or black ice is detected (See essSurfaceBlackIceSignal)
noReport: The sensor is not providing any reading for surface status
and
may not be responding
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.22"
::= { essPavementSensorEntry 22 }

5.11.3.23 Pavement Forecasted Condition

pavementSensorForecastCondition OBJECT-TYPE

SYNTAX INTEGER {
other (1),
error (2),
noAdvisory (3),
iceAdvisory (4),
slushAdvisory (5),
freezeAdvisory (6),
freezeHazard (7),
noReport (8) }

MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> A value indicating the pavement surface status.
<Format>

other: The value reported by the sensor is not defined by the standard.
See the manufacturer's documentation for more information.
error: The sensor is providing a reading for surface status, but either
the reading indicates an error code or the data has been deemed
invalid or suspect
noAdvisory: No frozen moisture is detected and the risk of frozen
moisture
is low.
iceAdvisory: The risk of the formation of ice or black ice on the
roadway
is elevated, but its occurrence, location, and/or timing is still
uncertain
slushAdvisory: The risk of the accumulation of snow or slush on the
roadway 1s elevated, but its occurrence, location, and/or timing is
still uncertain
freezeAdvisory: The risk of the formation of some sort of frozen
moisture
on the roadway is elevated, but its occurrence, location, and/or
timing is still uncertain
freezeHazard: The sensor detects some sort of frozen moisture but is
unable to classify as slush or ice
noReport: The sensor is not providing any reading for surface status
and
may not be responding
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.23"
::= { essPavementSensorEntry 23 }
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5.11.3.24 Pavement Surface Friction Coefficient

pavementSensorFrictionCoefficient OBJECT-TYPE

SYNTAX Integer32 (0..101)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> A value representing the manufacturer's estimate of the
friction coefficient of the roadway pavement for the specified
pavement sensor. The actual coefficient of friction is dependent on
many variables, including characteristics of the tire traveling on the
pavement; thus it is recognized that it is impossible to provide a
single mathematically precise value. However, the reported friction
coefficient shall be based on an empirical model that has a strong
correlation with actual measured friction coefficients using a
standard test method and test apparatus, such as a decelerometer or a
locked-wheel tester. The estimate is provided in hundredths (i.e., if
the weight of a vehicle is 15,000 N and the estimated friction
coefficient is 50, the resultant friction force offered by locked
wheels on the pavement is expected to be approximately 15,000 N *
50/100 = 7,500 N). This value should not be compared across vendors or
sites due to the number of site-specific factors that can impact its
accuracy, but the value can be useful to gauge the relative friction
of a specific site at different points in time. For example, this
value could be used to activate a warning message, but the exact value
that would trigger that condition would need to be discovered
empirically at each site.

<Format>
The value 101 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.24"

:= { essPavementSensorEntry 24 }

5.11.3.25 Pavement Monitoring Latitude

-- This object has been deprecated.
pavementMonitorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 107-6 degrees of the location that the ESS
pavement sensor is monitoring, per WGS-84 datum. A value of 0 for this
object and pavementMonitorLongitude indicates that the location being
monitored is the same as defined in pavementSensorLatitude and
pavementSensorLongitude.

<Format>
The pavementMonitorLatitude at the North Pole is 90,000,000. The
pavementMonitorLatitude at the South Pole is -90,000,000. The wvalue
90,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> essPavementMonitorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.25"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."
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::= { essPavementSensorEntry 25 }

5.11.3.26 Pavement Monitoring Longitude

-—- This object has been deprecated.
pavementMonitorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the location that the ESS pavement sensor is monitoring. A
value of 0 for this object and pavementMonitorLatitude indicates that
the location being monitored is the same as defined in
pavementSensorLatitude and pavementSensorLongitude.

<Format>
The pavementMonitorLongitude of 180 degrees West shall be -180,000,000.
The pavementMonitorLongitude of 180 degrees East shall be 180,000,000.
The value 180,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> essPavementMonitorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.26"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

::= { essPavementSensorkEntry 26 }

5.11.3.27 Pavement Ice Percentage
pavementIcePercentage OBJECT-TYPE

SYNTAX Integer32 (0..101)

UNITS "percent"

MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> The percentage of ice on the surface by volume.
<Format>

The value 101 shall indicate an error condition or missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.27"
::= { essPavementSensorEntry 27 }

5.11.3.28 Pavement Monitor X Offset
essPavementMonitorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The X offset of the pavement monitor site from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
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indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the wvehicle.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.28"
::= { essPavementSensorEntry 28 }

5.11.3.29 Pavement Monitor Y Offset
essPavementMonitorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the pavement monitor site from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.29"

::= { essPavementSensorkEntry 29 }

5.11.3.30 Pavement Monitor Z Offset
essPavementMonitorZOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the pavement at the monitor site
as measured from the fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.30"
::= { essPavementSensorEntry 30 }

5.11.3.31 Pavement Sensor X Offset
essPavementSensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The X offset of the pavement sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
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indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the wvehicle.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.31"
::= { essPavementSensorEntry 31 }

5.11.3.32 Pavement Sensor Y Offset
essPavementSensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the pavement sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.32"

::= { essPavementSensorkEntry 32 }

5.11.3.33 Pavement Sensor Entity Identifier
essPavementSensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.2.1.33"

::= { essPavementSensorEntry 33 }

5.11.4 Number of Subsurface Sensors

numkEssSubSurfaceSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the Subsurface Sensor
Table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
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static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.3"
::= { essNtcipPavement 3 }

5.11.5 Subsurface Sensor Table
essSubSurfaceSensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF EssSubSurfaceSensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the subsurface sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4"
::= { essNtcipPavement 4 }

5.11.6 Subsurface Sensor
essSubSurfaceSensorkEntry OBJECT-TYPE

SYNTAX EssSubSurfaceSensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> A subsurface sensor is a sensor that reports the
temperature and moisture condition of the roadway subsurface. It can
be described through a number of attributes as indicated by the
following subclauses."

INDEX { essSubSurfaceSensorIndex }
:= { essSubSurfaceSensorTable 1 }

EssSubSurfaceSensorEntry ::= SEQUENCE ({
essSubSurfaceSensorIndex Integer32,
essSubSurfaceSensorLocation SnmpAdminString,
essSubSurfaceType INTEGER,
essSubSurfaceSensorDepth Integer3z,
essSubSurfaceTemperature Integer3z,
essSubSurfaceSensorEntityID PhysicalIndexOrZero,
essSubSurfaceMoisture Integer32,
essSubSurfaceSensorError INTEGER,
essSubSurfaceSensorLatitude Integer3z,
essSubSurfaceSensorLongitude Integer3z,
essSubSurfaceSensorModelInformation Integer32,
essSubSurfaceSensorXOffset ITSIntegerle,
essSubSurfaceSensorYOffset ITSIntegerl6 }

5.11.6.1 Subsurface Sensor Index

essSubSurfaceSensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Enumerated list of row entries that provide subsurface
sensor data.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.1"
::= { essSubSurfaceSensorEntry 1 }
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5.11.6.2 Subsurface Sensor Location
essSubSurfaceSensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> A textual string indicating the location of the subsurface
sensor.

<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.2"
:= { essSubSurfaceSensorEntry 2 }

5.11.6.3 Subsurface Type

essSubSurfaceType OBJECT-TYPE
SYNTAX INTEGER {

other (1),
unknown (2),
concrete (3),
asphalt (4),
openGradedAsphalt (5),
gravel (6),
clay (7),
loam (8),
sand (9),
permafrost (10),
variousAggregates (11),

air (12) }
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> Indicates the type of subsurface. A value of air would
indicate a bridge.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.3"
:= { essSubSurfaceSensorEntry 3 }

5.11.6.4 Subsurface Sensor Depth
essSubSurfaceSensorDepth OBJECT-TYPE

SYNTAX Integer32 (0..1001)
UNITS "centimeters"
MAX-ACCESS read-write

STATUS current
DESCRIPTION

"<Definition> Depth of subsurface sensor in centimeters below the
pavement surface.
<Format>
The value 1001 shall indicate an error condition or missing wvalue.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.4"
::= { essSubSurfaceSensorEntry 4 }

5.11.6.5 Subsurface Temperature

essSubSurfaceTemperature OBJECT-TYPE
SYNTAX Integer32 (-1000..1001)
UNITS "tenths of degrees Celsius"
MAX-ACCESS read-only
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STATUS current
DESCRIPTION
"<Definition> The current subsurface temperature in tenths of degrees
Celsius.
<Format>

The value 1001 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.5"
::= { essSubSurfaceSensorEntry 5 }

5.11.6.6 Subsurface Sensor Entity Identifier
essSubSurfaceSensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.6"

::= { essSubSurfaceSensorEntry 6 }

5.11.6.7 Subsurface Moisture
essSubSurfaceMoisture OBJECT-TYPE

SYNTAX Integer32 (0..101)
UNITS "percent moisture"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The subsurface moisture expressed as a percentage (e.g. 0
indicates dry, 100 indicates saturated).
<Format>
The value 101 indicates an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.7"
::= { essSubSurfaceSensorEntry 7 }

5.11.6.8 Subsurface Sensor Error

essSubSurfaceSensorError OBJECT-TYPE
SYNTAX INTEGER {
other (1),
none (2),
noResponse (3),
cutCable (4),
shortCircuit (5) }
MAX-ACCESS read-only

STATUS current

DESCRIPTION
"<Definition> A value indicating the type of sensor error.
<Format>
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other - An error has been detected that is not defined by the standard;
see the manufacturer's documentation for more information.
none - No error 1s detected, the sensor appears to be working properly
noResponse - The sensor is configured and is believed to be connected,
but
is not responding
cutCable - The sensor is not configured, not present or not fully
connected, perhaps because the cable was cut
shortCircuit - The sensor input has detected a short-circuit.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.8"
::= { essSubSurfaceSensorEntry 8 }

5.11.6.9 Subsurface Sensor Latitude

-- This object has been deprecated.
essSubSurfaceSensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 107"-6 degrees of the ESS subsurface
sensor, per WGS-84 datum.

<Format>
The essSubSurfaceSensorLatitude at the North Pole is 90,000,000. The
essSubSurfaceSensorLatitude at the South Pole is -90,000,000. The
value 90,000,001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> essSubSurfaceSensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.9"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { essSubSurfaceSensorEntry 9 }

5.11.6.10 Subsurface Sensor Longitude

-- This object has been deprecated.
essSubSurfaceSensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS subsurface sensor location.

<Format>
The essSubSurfaceSensorLongitude of 180 degrees West shall be
-180,000,000. The essSubSurfaceSensorLongitude of 180 degrees East
shall be 180,000,000. The value 180,000,001 shall indicate a missing
value.

<Parameter Type> configuration

<Superseded by> essSubSurfaceSensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.10"

REFERENCE "Resolution based on on-going location referencing activities;

the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be

Copy Per MIB Distribution Permission © 2022 AASHTO / ITE / NEMA



NTCIP 1204 v04.26
Page 183

obtained by dividing this value by 10."
::= { essSubSurfaceSensorEntry 10 }

5.11.6.11 Subsurface Sensor Model Information

-- This object has been deprecated.
essSubSurfaceSensorModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the SubSurface Sensor Table.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Supplanted by> essSubSurfaceSensorEntityID (See 5.11.6.11)

<Informative> This object was deprecated in version 5.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.11"

::= { essSubSurfaceSensorEntry 11 }

5.11.6.12 Subsurface Sensor X Offset
essSubSurfaceSensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset latitude of the subsurface sensor from the
field device's reference location as defined by fdConfiguredLatitude
and fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.12"

::= { essSubSurfaceSensorEntry 12 }

5.11.6.13 Subsurface Sensor Y Offset
essSubSurfaceSensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the subsurface sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
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reference location on the vehicle.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.4.1.13"
::= { essSubSurfaceSensorEntry 13 }

5.11.7 Pavement Block

-- This object has been deprecated.
essPavementBlock OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssPavementData structure as

defined below.

This object is used for uploading current pavement data

from the ESS in a bandwidth efficient manner.

<Format>

The OPTIONAL fields shall be present if the data is supported by the
implementation and is valid. The OPTIONAL fields shall be omitted for

any

data that is invalid or not supported by the implementation.

EssPavementData := SEQUENCE OF PavementSensorData
-- for (

-- x =1;

-- x < numEssPavementSensors.0;

-— X++)

PavementSensorData ::= SEQUENCE ({
essPavementSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceStatusV2.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceTemperature.x OPTIONAL, -- @NTCIP1204-Ess
essPavementTemperature.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceWaterDepth.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceSalinity.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceConductivity.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceFreezePoint.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceBlackIceSignal.x OPTIONAL, -- @NTCIP1204-Ess
essPavementSensorError.x OPTIONAL -- @NTCIP1204-Ess

}

<Parameter Type> status
<Superseded by> essPavementV3Block (See 5.11.9)
<Informative> This object was deprecated in version 03.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.5"

::= { essNtcipPavement 5 }

5.11.8 Subsurface Block Object

-- This object has been deprecated.
essSubSurfaceBlock OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssSubsurfaceData structure
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as defined below. This object is used for uploading current subsurface
data from the ESS in a bandwidth efficient manner.
<Format>
The OPTIONAL fields shall be present if the data is supported by the
implementation and is valid. The OPTIONAL fields shall be omitted for
any
data that is invalid or not supported by the implementation.

EssSubSurfaceData ::= SEQUENCE OF SubSurfaceSensorData
-—- for (

-- x =1;

-- x < numEssSubSurfaceSensors.0;

-— X++)

SubSurfaceSensorData ::= SEQUENCE {
essSubSurfaceSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
essSubSurfaceTemperature.x OPTIONAL, -- @NTCIP1204-Ess
essSubSurfaceMoisture.x OPTIONAL, -- @NTCIP1204-Ess
essSubSurfaceSensorError.x OPTIONAL -- @NTCIP1204-Ess

}
<Parameter Type> status
<Informative> This object was deprecated and withdrawn in version 05 as
the associated requirement was deemed to be no longer necessary in
version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.6"
::= { essNtcipPavement 6 }

5.11.9 Pavement Block V3

-- This object has been deprecated.
essPavementV3Block OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssPavementDataV3 structure
as defined below. This object is used for uploading current pavement
data from the ESS in a bandwidth efficient manner.

<Format>
The OPTIONAL fields shall be present if the data is supported by the
implementation and is valid. The OPTIONAL fields shall be omitted for

any
data that is invalid or not supported by the implementation.

EssPavementDataV3 ::= SEQUENCE OF PavementSensorDataV3
-—- for (

-- x =1;

-- x < numEssPavementSensors.0;

-—  xX++)

PavementSensorDataV3 ::= SEQUENCE {
essPavementSensorIndex.x OPTIONAL, -- @NTCIP1204-Ess
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essSurfaceStatus.x OPTIONAL, —-- @NTCIP1204-Ess
essSurfaceTemperature.x OPTIONAL, -- @NTCIP1204-Ess
essPavementTemperature.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceSalinity.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceFreezePoint.x OPTIONAL, —-- @NTCIP1204-Ess
essSurfaceBlackIceSignal.x OPTIONAL, -- @NTCIP1204-Ess
essPavementSensorError.x OPTIONAL, —-- @NTCIP1204-Ess
essSurfacelceOrWaterDepth.x OPTIONAL, -- @NTCIP1204-Ess
essSurfaceConductivityV2.x OPTIONAL -- @NTCIP1204-Ess

}
<Parameter Type> status
<Informative> This object was deprecated and withdrawn in NTCIP 1204 v04
as the associated requirement was deemed to be no longer necessary.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.9.7"
::= { essNtcipPavement 7 }

5.12 Mobile Platform Objects

essNtcipMobile OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects related to monitoring mobile platforms that act as
an ESS (e.g., specially-equipped maintenance vehicles).
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.10"
:= {essNtcip 10}

5.12.1 Detected Friction

-- This object has been deprecated.
essMobileFriction OBJECT-TYPE

SYNTAX Integer32 (0..101)

UNITS "percent friction"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
"<Definition> Indicates measured coefficient of friction in percent.
<Format>

The value 101 shall indicate an error condition or missing value.
<Parameter Type> status
<Superseded by> pavementSensorFrictionCoefficient (See 5.11.3.24)
<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.10.1"
::= { essNtcipMobile 1 }

5.12.2 Observed Ground State

-- This object has been deprecated.
essMobileObservationGroundState OBJECT-TYPE
SYNTAX INTEGER {

other (1),

dry (2),

moist (3),

wet (4),

flooded (5),

frozen (6),

glaze (7),

dustySandy (8),

veryDry (9),

icy (10),
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moderateWetSnowCover (12),

fullWetSnowCover (13),
patchyDrySnow (14),

moderateDrySnowCover (15),

fullDrySnowCover (16),

driftingSnow (17),

unknown (18) }
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

NTCIP 1204 v04.26
Page 187

"<Definition> The prevailing observed ground state of the surrounding

environment as determined by the observer.
past weather conditions.

<Parameter Type> status

<Superseded by> essMobileObservationGroundStateV4

This is an indicator of

(See 5.12.4)

<Informative> This object was deprecated in version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.10.2"

:= { essNtcipMobile 2 }

5.12.3 Observed Pavement State

-- This object has been deprecated.
essMobileObservationPavement OBJECT-TYPE

SYNTAX INTEGER {
other (1),
dry (2),
wet (3),
puddles (4),

shallowStandingWater (5),

shallowFlowingWater (6),
deepStandingWater (7),
deepFlowingWater (8),
dustingFreshSnow (9),
moderateFreshSnow (10),
deepFreshSnow (11),
plowedSnow (12),
slush (13),
packedSnowPatches (14),
packedSnow (15),
lightSnowDrifts (16),
moderateSnowDrifts (17),
heavySnowDrifts (18),
frost (19),
icePatches (20),
moderatelyIcy (21),
heavyIcing (22),
blackIce (23),
sheetIce (24),
frozenSlush (25) }
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> The prevailing observed conditions on the driving surface

as determined by the observer.

<Parameter Type> status

<Superseded by> essMobileObservationPavementV4

(See 5.12.5)

<Informative> This object was deprecated in version 04.
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.10.3"

::= { essNtcipMobile 3 }
5.12.4 Observed Ground State - Version 4

essMobileObservationGroundStatevV4 OBJECT-TYPE

SYNTAX INTEGER ({
other (1),
dry (2),
moist (3),
wet (4),
flooded (5),
frozen (0),
glaze (7),
dustySandy (8),
veryDry (9),
icy (10),
patchyWetSnow (11),
moderateWetSnowCover (12),
fullWetSnowCover (13),
patchyDrySnow (14),
moderateDrySnowCover (15),
fullDrySnowCover (16),
driftingSnow (17),
unknown (18),
puddles (19),
standingWater (20),
flowingWater (21),
freshSnow (22),
plowedSnow (23),
slush (24) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> The prevailing observed ground state of the surrounding

environment as determined by the observer.

past weather conditions.
<Parameter Type> status

This is an indicator of

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.10.4"

::= { essNtcipMobile 4 }
5.12.5 Observed Pavement State - Version 4

essMobileObservationPavementV4 OBJECT-TYPE

SYNTAX INTEGER {
other (1),
dry (2),
wet (3),
puddles (4),
shallowStandingWater (5),
shallowFlowingWater (6),
deepStandingWater (7),
deepFlowingWater (8),
dustingFreshSnow (9),
moderateFreshSnow (10),
deepFreshSnow (11),
plowedSnow (12),
slush (13),
packedSnowPatches (14),
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packedSnow (15),
lightSnowDrifts (16),
moderateSnowDrifts (17),
heavySnowDrifts (18),
frost (19),
icePatches (20),
moderatelyIcy (21),
heavyIcing (22),
blackIce (23),
sheetlIce (24),
frozenSlush (25),
absorption (26),
absorptionAtDewpoint (27),
bareAndDry (28),
bareAndWet (29),
blowingsnow (30),
chemicallyWet (31),
dew (32),
damp (33),
wetSlush (34) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> The prevailing observed conditions on the driving surface
as determined by the observer.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.10.5"
::= { essNtcipMobile 5 }

513 Pavement Treatment Objects

essNtcipTreatment OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects that monitor the various types and amounts of
treatments that are spread on the pavement surface.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11"
::= { essNtcip 11 }

5.13.1 Number of Treatments
numkEssTreatments OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "treatments"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the Pavement Treatment
Table.

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.1"
::= { essNtcipTreatment 1 }

5.13.2 Pavement Treatment Table
essPavementTreatmentTable OBJECT-TYPE

SYNTAX SEQUENCE OF EssPavementTreatmentEntry
MAX-ACCESS not-accessible
STATUS current
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DESCRIPTION

"<Definition> Table containing the pavement treatment data.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.2"

{ essNtcipTreatment 2 }

5.13.3 Pavement Treatment

essPavementTreatmentEntry OBJECT-TYPE

SYNTAX EssPavementTreatmentEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> A pavement treatment is a chemical that can be applied to
the roadway to de-ice or prevent icing of the pavement. It can be
described through a number of attributes as indicated by the following
subclauses."

INDEX { essPavementTreatmentIndex }

{ essPavementTreatmentTable 1 }

EssPavementTreatmentEntry ::= SEQUENCE ({
essPavementTreatmentIndex Integer32,
essPaveTreatProductType INTEGER,
essPaveTreatProductForm INTEGER,
essPercentProductMix Integer32}

5.13.3.1 Pavement Treatment Index

essPavementTreatmentIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> Enumerated list of row entries that provide pavement
treatment data.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.2.1.1"

{ essPavementTreatmentEntry 1 }

5.13.3.2 Pavement Treatment Product Type

essPaveTreatProductType OBJECT-TYPE
SYNTAX INTEGER {

other (
sand (2
dirt (3),
gravel (4),
cinders (5),

water (6),
enhancedSalts (7),
naCl (8),

caCl (9),

mgCl (10),

cMA (11),

kAC (12),
naFormate (13),
nalA (14) }

1),
),
)

MAX-ACCESS read-write
STATUS current
DESCRIPTION
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"<Definition> Indicates the type of treatment being applied to the road.
An enhanced definition of some of the values are as follows: other -
any other type of treatment water - used as a diluting agent cMA -

Calcium-Magnesium Acetate kAC - Potassium-Magnesium Acetate naFormate
- Sodium Formate naA - Sodium Acetate
<Format>

An enhanced definition of some of the values are as follows.
other - any other type of treatment
water - used as a diluting agent
cMA - Calcium-Magnesium Acetate
kKAC - Potassium-Magnesium Acetate
naFormate - Sodium Formate
naA - Sodium Acetate

<Parameter Type> configuration

<Informative> Version 02 of this standard incorrectly defined the set
constraint of this read-write object to be read-only; it should be
always, however, the intent is that it would only be set by a local
connection when the new product is being loaded and that remote
systems would only read this object.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.2.1.2"

::= { essPavementTreatmentEntry 2 }

5.13.3.3 Treatment Product Form

essPaveTreatProductForm OBJECT-TYPE
SYNTAX INTEGER {
other (1),
dry (2),
prewet (3),
liquid (4) }
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> Indicates the condition of the treatment being applied to
the road.
<Parameter Type> configuration
<Informative> Version 02 and 03 of this standard incorrectly defined the
set constraint of this read-write object to be read-only; it should be
always, however, the intent is that it would only be set by a local
connection when the new product is being loaded and that remote
systems would only read this object.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.2.1.3"
:= { essPavementTreatmentEntry 3 }

5.13.3.4 Percentage of Treatment Type in Mix
essPercentProductMix OBJECT-TYPE

SYNTAX Integer32 (0..100)
UNITS "percent"
MAX-ACCESS read-write

STATUS current
DESCRIPTION

"<Definition> Indicates the percentage of the total application mix by
weight that is of the type specified in essPaveTreatProductType.
<Format>
The sum of these percentages within the total mixture shall equal 100.
<Parameter Type> configuration
<Informative> Version 02 of this standard incorrectly defined the set
constraint of this read-write object to be read-only; it should be
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always, however, the intent is that it would only be set by a local
connection when the new product is being loaded and that remote
systems would only read this object.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.2.1.4"
::= { essPavementTreatmentEntry 4 }

5.13.4 Treatment Amount
essPaveTreatmentAmount OBJECT-TYPE

SYNTAX Integer32 (0..255)

UNITS " kilograms per lane kilometer"
MAX-ACCESS read-write

STATUS current

DESCRIPTION

"<Definition> Indicates quantity of the treatment being applied in
kilograms per lane kilometer.
<Format>
The value of 255 shall indicate an error condition or missing value.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.3"
::= { essNtcipTreatment 3 }

5.13.5 Treatment Width
essPaveTreatmentWidth OBJECT-TYPE

SYNTAX Integer32 (0..255)

UNITS "meters"

MAX-ACCESS read-write

STATUS current

DESCRIPTION
"<Definition> Indicates the width of the spread of treatment in meters.
<Format>

The value of 255 shall indicate an error condition or missing value.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.4"
::= { essNtcipTreatment 4 }

5.13.6 Pavement Treatment Block

-- This object has been deprecated.
pavementTreatmentBlock OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the Pavement Treatment data. This
object is used for uploading current pavement treatment data from the
ESS in a bandwidth efficient manner.

<Format>
The OPTIONAL fields shall be present if the data is supported by the
implementation and is valid. The OPTIONAL fields shall be omitted for

any

data that is invalid or not supported by the implementation.

Note: The following structure contains pts data elements in addition to
the ess data elements. Although these are not currently required to
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fulfill any existing requirements, they are included to maintain
backward
compatibility with the version 02 standard.

PavementTreatmentBlock ::= SEQUENCE {
treatmentInfo SEQUENCE OF PavementTreatmentData OPTIONAL,
essPaveTreatmentAmount.0 OPTIONAL, -- @NTCIP1204-Ess
essPaveTreatmentWidth.O OPTIONAL, -- @NTCIP1204-Ess
ptsOperationalMode.0 OPTIONAL, -- @NTCIP1204-Ess
ptsCommandState.O OPTIONAL, -- @NTCIP1204-Ess
ptsSprayerState.O OPTIONAL, -- @NTCIP1204-Ess
ptsSignalDuration.O OPTIONAL, -- @NTCIP1204-Ess
ptsSignalEventCount.0 OPTIONAL, -- @NTCIP1204-Ess
ptsLastSignalEvent.0 OPTIONAL, -- @NTCIP1204-Ess
ptsActiveEventCount.O OPTIONAL, -- @NTCIP1204-Ess
ptsInactiveEventCount.O OPTIONAL, -- @NTCIP1204-Ess
ptsLastactiveEvent.0 OPTIONAL, -- @NTCIP1204-Ess
ptsLastInactiveEvent.0 OPTIONAL, -- @NTCIP1204-Ess
ptsError.0 OPTIONAL, -- @NTCIP1204-Ess
ptsMonitoringDetectors.0 OPTIONAL -- @NTCIP1204-Ess

PavementTreatmentData ::=
-- for (
-- x =1;
-- x < numEssTreatments.O;
-— X++)
SEQUENCE {
essPavementTreatmentIndex.x OPTIONAL, -- @NTCIP1204-Ess
essPaveTreatProductType.x OPTIONAL, -- @NTCIP1204-Ess
essPaveTreatProductForm.x OPTIONAL, -- @NTCIP1204-Ess
essPercentProductMix.x OPTIONAL -- @NTCIP1204-Ess
}
<Parameter Type> status
<Informative> This object was deprecated and withdrawn in version 05 as
the associated requirement was deemed to be no longer necessary in
version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.5"
::= { essNtcipTreatment 5 }

5.13.7 Operational Mode [Obsolete]

-- This object is obsolete.
ptsOperationalMode OBJECT-TYPE
SYNTAX INTEGER {
off (1),
manual (2),
automatic (3) 1}
MAX-ACCESS read-write

STATUS obsolete
DESCRIPTION
"<Definition> Indicates the operational mode of the Pavement Treatment
System.

When in the 'off' state, the PTS shall not trigger the sprayer even if
commanded to do so and shall always be inactive. The PTS shall
transition to the requested operational mode, upon request.
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When in the 'automatic' state, the PTS shall monitor conditions and
trigger

the sprayer based on a manufacturer specific algorithm. The algorithm

shall only consider input from the detectors selected in the

ptsMonitoringDetectors object. The PTS shall also trigger the sprayer

if commanded to do so via the ptsCommandState object. The PTS shall

transition to the requested operational mode, upon request.

When in the 'manual' state, the PTS shall trigger the sprayer if
commanded

to do so via the ptsCommandState object. The PTS shall transition to

the requested operational mode, upon request.

<Format>
off When set to this wvalue the ESS does not trigger the
bridge sprayer

manual When set to this value the ESS only triggers the
bridge sprayer when manually commanded to do
so (e.g., see bridgeSprayerMgmtSignalState).

automatic When set to this value the ESS triggers the
bridge sprayer when manually commanded to do
so or when the internal algorithm determines
that the sprayer should be triggered.
<Parameter Type> control
<Superseded by> ptsOperationalModeV3 (See 5.13.19)
<Informative> This object was made obsolete in version 03.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.6"
::= { essNtcipTreatment 6 }

5.13.8 Command State [Obsolete]

-- This object is obsolete.
ptsCommandState OBJECT-TYPE

SYNTAX INTEGER {
other (1),
inactive (2),
activate (3) }
MAX-ACCESS read-write
STATUS obsolete
DESCRIPTION

"<Definition> Indicates the operational state of the PTS. When in the
'inactive' state, the PTS shall not be spraying. Upon entering the
'active' state, either by a manual SET of this object or through an
automated algorithm, the PTS shall trigger the sprayer and spray the
chemical for a duration as defined by the ptsSignalDuration object.
Upon expiration of this duration, the PTS shall automatically
transition back to the 'inactive' state.

<Format>
other -
read - indicates a unknown or initial state
write - no effect
inactive -
read - indicates the ess is not signaling the bridge sprayer
write - no effect
activate -
read - indicates the ess is signaling the bridge sprayer
write - causes the ess to signal the bridge sprayer

<Parameter Type> control
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<Superseded by> ptsCommandStateV3 (See 5.13.19)
<Informative> This object was made obsolete in version 03.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.7"

::= { essNtcipTreatment 7 }

5.13.9 Sprayer State
ptsSprayerState OBJECT-TYPE

SYNTAX INTEGER {
other (1),
inactive (2),

active (3)

}

MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> other - indicates a unknown or initial state
inactive - indicates the bridge sprayer is inactive
active - indicates the bridge sprayer is active

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.8"
::= { essNtcipTreatment 8 }

5.13.10 Signal Duration
ptsSignalDuration OBJECT-TYPE

SYNTAX Integer32 (0..3600000)
UNITS "milliseconds"
MAX-ACCESS read-write

STATUS current

DESCRIPTION

"<Definition> The number of milliseconds of a simple logic level or
state the bridge sprayer needs to detect a signal from the ESS.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.9"
::= { essNtcipTreatment 9 }

5.13.11 Signal Event Count
ptsSignalEventCount OBJECT-TYPE

SYNTAX Counter32
UNITS "events"
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> An indication of the number of Signal Events that have
occurred since the last SNMP engine initialization.

<Parameter Type> status

<Informative> SNMP counter objects do not have a defined initialization
value nor any ability to be reset. The value reported by this object
only has meaning when compared to a previous reading and when there is
no intervening device initialization as indicated by snmpEngineBoots.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.10"

:= { essNtcipTreatment 10 }

5.13.12 Last Signal Event

-- This object has been deprecated.
ptsLastSignalEvent OBJECT-TYPE

SYNTAX
UNITS
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MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION
"<Definition> The number of seconds since 00:00:00 Jan 1 1970 UTC.
<Format>

The value of 0 indicates an unknown or initial value.

<Parameter Type> status

<Superseded by> ptslastSignalEventDate and ptslLastSignalEventTime (See
5.13.26 and 5.13.27)

<Informative> This object was deprecated in version 05.
Within SNMPv1l, this object was represented as a Counter in violation of
Counter semantics. Within SNMPv3 exchanges, it is encoded as an
Unsigned32 to conform to SMIv2 and SNMPv3 rules.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.11"

::= { essNtcipTreatment 11 }

5.13.13 Active Event Count
ptsActiveEventCount OBJECT-TYPE

SYNTAX Counter32
UNITS "events"
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> An indication of the number of Active Events that have
occurred since the last SNMP engine initialization.

<Parameter Type> status

<Informative> SNMP counter objects do not have a defined initialization
value nor any ability to be reset. The value reported by this object
only has meaning when compared to a previous reading and when there is
no intervening device initialization as indicated by snmpEngineBoots.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.12"

::= { essNtcipTreatment 12 }

5.13.14 Inactive Event Count
ptsInactiveEventCount OBJECT-TYPE

SYNTAX Counter32
UNITS "events"
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> An indication of the number of Inactive Events that have
occurred since the last SNMP engine initialization.

<Parameter Type> status

<Informative> SNMP counter objects do not have a defined initialization
value nor any ability to be reset. The value reported by this object
only has meaning when compared to a previous reading and when there is
no intervening device initialization as indicated by snmpEngineBoots.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.13"

::= { essNtcipTreatment 13 }

5.13.15 Last Active Event

-- This object has been deprecated.
ptsLastActiveEvent OBJECT-TYPE
SYNTAX Unsigned32
UNITS "seconds"
MAX-ACCESS read-only
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STATUS deprecated
DESCRIPTION
"<Definition> The number of seconds since 00:00:00 Jan 1 1970 UTC.
<Format>

The value of 0 indicates an unknown or initial value.

<Parameter Type> status

<Superseded by> ptsLastActiveEventDate and ptsLastActiveEventTime (See
5.13.28 and 5.13.29)

<Informative> This object was deprecated in version 05.
Within SNMPv1l, this object was represented as a Counter in violation of
Counter semantics. Within SNMPv3 exchanges, it is encoded as an
Unsigned32 to conform to SMIv2 and SNMPv3 rules.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.14"

::= { essNtcipTreatment 14 }

5.13.16 Last Inactive Event

-- This object has been deprecated.
ptslLastInactiveEvent OBJECT-TYPE

SYNTAX Counter32

UNITS "seconds"

MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
"<Definition> The number of seconds since 00:00:00 Jan 1 1970 UTC.
<Format>

The value of 0 indicates an unknown or initial value.

<Parameter Type> status

<Superseded by> ptslLastInactiveEventDate and ptslastInactiveEventTime
(See 5.13.30 and 5.13.31)

<Informative> This object was deprecated in version 05.
Within SNMPvl, this object was represented as a Counter in violation of
Counter semantics. Within SNMPv3 exchanges, it is encoded as an
Unsigned32 to conform to SMIv2 and SNMPv3 rules.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.15"

::= { essNtcipTreatment 15 }

5.13.17 PTS Error Code

ptsError OBJECT-TYPE
SYNTAX INTEGER {
other (1),
ok (2),
genericError (3),
tankLow (4) }
MAX-ACCESS read-only

STATUS current
DESCRIPTION
"<Definition> Indicates the status of the bridge sprayer.
<Format>
other - indicates a unknown or initial state
ok - indicates the bridge sprayer is operational
genericError - indicates the bridge sprayer has an error
tankLow - indicates the bridge sprayer's tank is low

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.16"
::= { essNtcipTreatment 16 }
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5.13.18 Monitoring Detectors
ptsMonitoringDetectors OBJECT-TYPE

SYNTAX OCTET STRING (SIZE (4))
MAX-ACCESS read-write

STATUS current

DESCRIPTION

"<Definition> Indicates the pavement detectors that the PTS shall use in
its algorithm that determines when the PTS automatically triggers the
sprayer.

<Format>
Each bit indicates whether or not the associated pavement sensor shall
be used within the algorithm. The first (high order) bit in the bit
string shall reference the first pavement sensor. A value of one for
any bit shall indicate that the sensor input shall be considered, and
a value of zero shall mean that the input shall not be considered.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.17"

::= { essNtcipTreatment 17 }

5.13.19 Operational Mode - Version 3

ptsOperationalModeV3 OBJECT-TYPE
SYNTAX INTEGER ({
off (1),
manual (2),
automatic (3) }
MAX-ACCESS read-write

STATUS current
DESCRIPTION
"<Definition> Indicates the operational mode of the Pavement Treatment
System.

When in the 'off' state, the PTS shall not trigger the sprayer even if

commanded to do so and shall always be inactive. The PTS shall

transition to the requested operational mode, upon request.

When in the 'automatic' state, the PTS shall monitor conditions and
trigger

the sprayer based on a manufacturer specific algorithm. The algorithm

shall only consider input from the detectors selected in the

ptsMonitoringDetectors object. The PTS shall also trigger the sprayer

if commanded to do so via the ptsCommandStateV3 object. The PTS shall

transition to the requested operational mode, upon request.

When in the 'manual' state, the PTS shall trigger the sprayer if
commanded

to do so via the ptsCommandStateV3 object. The PTS shall transition to

the requested operational mode, upon request.

<Format>
off When set to this wvalue the ESS does not trigger the
bridge sprayer

manual When set to this wvalue the ESS only triggers the
bridge sprayer when manually commanded to do
so (e.g., see ptsCommandStateV3).

automatic When set to this value the ESS triggers the
bridge sprayer when manually commanded to do
so or when the internal algorithm determines
that the sprayer should be triggered.
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<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.18"
::= { essNtcipTreatment 18 }

5.13.20 Command State - Version 3
ptsCommandStateV3 OBJECT-TYPE

SYNTAX INTEGER ({
other (1),
inactive (2),
activate (3) }
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> Indicates the operational state of the PTS. When in the
'inactive' state, the PTS shall not be signaling the sprayer. Upon
entering the 'active' state, either by a manual SET of this object or
through an automated algorithm, the PTS shall trigger the sprayer
using a signal that lasts for a duration as defined by the
ptsSignalDuration object. Upon expiration of this duration, the PTS
shall automatically transition back to the 'inactive' state.

<Format>
other -
read - indicates a unknown or initial state
write - no effect
inactive -
read - indicates the ess is not signaling the bridge sprayer
write - no effect
activate -
read - indicates the ess is signaling the bridge sprayer
write - causes the ess to signal the bridge sprayer

<Parameter Type> control
<Informative> This object does not directly control the sprayer, rather
it merely signals an external sprayer.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.19"
::= { essNtcipTreatment 19 }

5.13.21 PTS Latitude

-- This object has been deprecated.
essPavementTreatmentLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The latitude in 107-6 degrees of the pavement treatment
system, per WGS-84 datum.

<Format>
The essPavementTreatmentLatitude at the North Pole is 90,000,000. The
essPavementTreatmentLatitude at the South Pole is -90,000,000. The
value 90,000,001 shall indicate a missing wvalue.

<Parameter Type> configuration

<Superseded by> essPavementTreatmentYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.20"

REFERENCE "Resolution based on on-going location referencing activities;

the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."
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::= { essNtcipTreatment 20 }
5.13.22 PTS Longitude

-—- This object has been deprecated.
essPavementTreatmentLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the pavement treatment system location.

<Format>
The essPavementTreatmentLongitude of 180 degrees West shall be
-180,000,000. The essPavementTreatmentLongitude of 180 degrees East
shall be 180,000,000. The value 180,000,001 shall indicate a missing
value.

<Parameter Type> configuration

<Superseded by> essPavementTreatmentXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.21"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this wvalue by 10."

::= { essNtcipTreatment 21 }

5.13.23 PTS Location
essPavementTreatmentLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> A textual string indicating the location of the pavement
treatment system.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.22"
::= { essNtcipTreatment 22 }

5.13.24 PTS Model Information

-- This object has been deprecated.
essPavementTreatmentModelInformation OBJECT-TYPE

SYNTAX Integer32 (0..255)
MAX-ACCESS read-write

STATUS deprecated
DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the pavement treatment system.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Superseded by> ptsEntityID (See 5.13.25)

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.23"

::= { essNtcipTreatment 23 }
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5.13.25 PTS Last Signal Event Date
ptsLastSignalEventDate OBJECT-TYPE

SYNTAX ITSDateStamp
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> The UTC date of the last signal event.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.24"
:= { essNtcipTreatment 24}

5.13.26 PTS Last Signal Event Time
ptsLastSignalEventTime OBJECT-TYPE

SYNTAX ITSDailyTimeStamp
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The number of milliseconds after 00:00:00.000 UTC on
ptslLastSignalEventDate that the last signal event occurred.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.25"
::= { essNtcipTreatment 25 }

5.13.27 PTS Last Active Event Date
ptsLastActiveEventDate OBJECT-TYPE

SYNTAX ITSDateStamp
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> The UTC date of the last active event.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.26"
::= { essNtcipTreatment 26 }

5.13.28 PTS Last Active Event Time
ptsLastActiveEventTime OBJECT-TYPE

SYNTAX ITSDailyTimeStamp
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The number of milliseconds after 00:00:00.000 UTC on
ptsLastActiveEventDate that the last active event occurred.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.27"
:= { essNtcipTreatment 27 }

5.13.29 PTS Last Inactive Event Date
ptsLastInactiveEventDate OBJECT-TYPE

SYNTAX ITSDateStamp
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> The UTC date of the last inactive event.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.28"
::= { essNtcipTreatment 28 }
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5.13.30 PTS Last Inactive Event Time
ptsLastInactiveEventTime OBJECT-TYPE

SYNTAX ITSDailyTimeStamp
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The number of milliseconds after 00:00:00.000 UTC on
ptslLastActiveEventDate that the last inactive event occurred.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.29"
:= { essNtcipTreatment 29 }

5.13.31 PTS X Offset
ptsXOffset OBJECT-TYPE

SYNTAX ITSIntegerlb
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The lateral offset of the pavement treatment system from
the field device's reference location as defined by
fdConfiguredLatitude and fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.30"

::= { essNtcipTreatment 30 }

5.13.32 PTS Y Offset
ptsYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the pavement treatment system from the
field device's reference location as defined by fdConfiguredLatitude
and fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.31"

::= { essNtcipTreatment 31 }

5.13.33 PTS Entity Identifier

ptsEntityID OBJECT-TYPE
SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only
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STATUS current
DESCRIPTION
"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the pavement treatment system, such as
the manufacturer, model, and hardware and software revision
identifiers.
<Format>
The value of zero indicates that this information is not available.
<Parameter Type> status
<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.11.32"
::= { essNtcipTreatment 32 }

5.14  Air Quality Parameters

essNtcipAirQuality OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> Objects used for monitoring air quality conditions.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12"
:= { essNtcip 12 }

5.14.1 Carbon Monoxide Parameter
essCO OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "parts per million"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of carbon monoxide in the air, measured
in parts per million.
<Format>
The value 255 shall indicate an error condition or missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.1"
::= { essNtcipAirQuality 1 }

5.14.2 Carbon Dioxide Parameter

-- This object has been deprecated.
essCO02 OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "parts per billion"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The concentration of carbon dioxide in the air, measured
in parts per billion.

<Format>
The value 65535 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Superseded by> essCO2V4 (See 5.14.13)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.2"

::= { essNtcipAirQuality 2 }
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5.14.3 Nitrous Oxide Parameter

-—- This object has been deprecated.
essNO OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "parts per million"
MAX-ACCESS read-only

STATUS deprecated
DESCRIPTION

"<Definition> The concentration of nitrous oxide in the air, measured in

parts per million.
<Format>

The value 255 shall indicate an error condition or missing value.

<Parameter Type> status
<Superseded by> essNOV4 (See 5.14.14)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.3"
::= { essNtcipAirQuality 3 }

5.14.4 Nitrogen Dioxide Parameter
essNO2 OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "parts per billion"
MAX-ACCESS read-only

STATUS current
DESCRIPTION

"<Definition> The concentration of nitrogen dioxide in the air, measured

in parts per billion.
<Format>

The value 255 shall indicate an error condition or missing value.

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.4"
::= { essNtcipAirQuality 4 }

5.14.5 Sulfur Dioxide Parameter

essS02 OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "parts per billion"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of sulfur dioxide in the air, measured

in parts per billion.
<Format>

The value 65535 shall indicate an error condition or missing wvalue.

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.5"
::= { essNtcipAirQuality 5 }

5.14.6 Ozone Parameter

-- This object has been deprecated.
ess03 OBJECT-TYPE

SYNTAX Integer32 (0..255)

UNITS "parts per one hundred billion"
MAX-ACCESS read-only

STATUS deprecated

DESCRIPTION
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"<Definition> The concentration of ozone in the air, measured in parts
per one hundred billion.

<Format>
The value 255 shall indicate an error condition or missing value.

<Parameter Type> status

<Superseded by> essO3V4 (See 5.14.15)

<Informative> This object was deprecated in version 04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.6"

::= { essNtcipAirQuality 6 }

5.14.7 Particulate Matter Parameter
essPM10 OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "micrograms per cubic meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of small particulate matter of 10
micrometers or less in diameter in the air, measured in micrograms per
cubic meter.

<Format>
The value 65535 shall indicate an error condition or missing wvalue.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.7"

::= { essNtcipAirQuality 7 }

5.14.8 Air Quality Block Object

-- This object has been deprecated.
essAirQualityBlock OBJECT-TYPE

SYNTAX ITSOerString
MAX-ACCESS read-only
STATUS deprecated
DESCRIPTION

"<Definition> An OER encoded string of the EssAirQualityData structure
as defined below.
This object is used for uploading current air quality data from the ESS

in a

bandwidth efficient manner.

A GET shall return data for all of the fields in the structure (even if
they

are indicated as OPTIONAL); unless the data values are not supported by
the

controller or are invalid (e.g., the sensor is not attached), in which
case

the values shall be omitted.

essAirQualityData ::= SEQUENCE ({
essCO0.0 OPTIONAL, -- @NTCIP1204-Ess
essC02.0 OPTIONAL, -— @NTCIP1204-Ess
essNO.O0 OPTIONAL, -- @NTCIP1204-Ess
essNO02.0 OPTIONAL, -— @NTCIP1204-Ess
essS02.0 OPTIONAL, -- @NTCIP1204-Ess
ess03.0 OPTIONAL, -- @NTCIP1204-Ess
essPM10.0 OPTIONAL -- @NTCIP1204-Ess

}

<Parameter Type> status
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<Informative> This object was deprecated and withdrawn in version 05 as
the associated requirement was deemed to be no longer necessary in
version 04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.8"
::= { essNtcipAirQuality 8 }

5.14.9 Particulate Matter (2.5) Parameter
essPM25 OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "micrograms per cubic meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of small particulate matter of 2.5
micrometers or less in diameter in the air, measured in micrograms per
cubic meter.

<Format>
The value 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.9"

:= { essNtcipAirQuality 9 }

5.14.10 Number of Air Quality Sensors
airQualitySensorTableNumSensors OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "sensors"
MAX-ACCESS read-only
STATUS current
DESCRIPTION
"<Definition> Indicates the number of entries in the air quality sensor
table.

<Parameter Type> status
<Informative> This value may automatically change upon connecting or
disconnecting a sensor; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.10"
::= { essNtcipAirQuality 10 }

5.14.11 Air Quality Sensor Table
airQualitySensorTable OBJECT-TYPE

SYNTAX SEQUENCE OF AirQualitySensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> Table containing the air quality sensor data.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11"
::= { essNtcipAirQuality 11 }

5.14.12 Air Quality Sensor
airQualitySensorEntry OBJECT-TYPE

SYNTAX AirQualitySensorEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> An air quality sensor is described through a number of
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attributes as indicated by the following subclauses."

INDEX { airQualitySensorIndex }
::= { airQualitySensorTable 1 }

AirQualitySensorEntry ::= SEQUENCE ({

airQualitySensorIndex Integer32,
airQualitySensorHeight Integer32,
airQualitySensorLatitude Integer32,
airQualitySensorLongitude Integer32,
airQualitySensorLocation SnmpAdminString,
airQualitySensorModelInformation Integer32,
airQualitySensorXOffset ITSIntegerlo,
airQualitySensorYOffset ITSIntegerle,
airQualitySensorZOffset ITSIntegerle,

airQualitySensorEntityID

5.14.12.1 Air Quality Sensor Index
airQualitySensorIndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only

STATUS current
DESCRIPTION

PhysicalIndexOrZero }

"<Definition> Enumerated list of row entries that provide air quality

sensor data.
<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.1"

::= { airQualitySensorEntry 1 }
5.14.12.2 Air Quality Sensor Height

-- This object has been deprecated.
airQualitySensorHeight OBJECT-TYPE

SYNTAX Integer32 (-1000..1001)
UNITS "meters"

MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The height of the air quality sensor with respect to the

essReferenceHeight in meters.
<Format>

The value of 1001 shall indicate a missing value.
<Parameter Type> configuration
<Superseded by> airQualitySensorzZOffset
<Informative> This object was deprecated in version 05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.2"
REFERENCE "essReferenceHeight plus this value equals the WMO Binary Code
Form FM 94 BUFR Table B item 0 07 001."
:= { airQualitySensorEntry 2 }

5.14.12.3 Air Quality Sensor Latitude

-- This object has been deprecated.
airQualitySensorLatitude OBJECT-TYPE

SYNTAX Integer32 (-90000000..90000001)
UNITS "microdegrees latitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION
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"<Definition> The latitude in 10"-6 degrees of the ESS air quality
sensor, per WGS-84 datum.

<Format>
The airQualitySensorLatitude at the North Pole is 90,000,000. The
airQualitySensorLatitude at the South Pole is -90,000,000. The value
90,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> airQualitySensorYOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.3"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be
obtained by dividing this value by 10."

::= { airQualitySensorEntry 3 }

5.14.12.4 Air Quality Sensor Longitude

-- This object has been deprecated.
airQualitySensorLongitude OBJECT-TYPE

SYNTAX Integer32 (-180000000..180000001)
UNITS "microdegrees longitude"
MAX-ACCESS read-write

STATUS deprecated

DESCRIPTION

"<Definition> The east longitude in 107-6 degrees from the Prime
Meridian of the ESS air quality sensor location.

<Format>
The airQualityLongitude of 180 degrees West shall be -180,000,000. The
airQualityLongitude of 180 degrees East shall be 180,000,000. The
value 180,000,001 shall indicate a missing value.

<Parameter Type> configuration

<Superseded by> airQualitySensorXOffset

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.4"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 06 001 can be
obtained by dividing this value by 10."

::= { airQualitySensorEntry 4 }

5.14.12.5 Air Quality Sensor Location
airQualitySensorLocation OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> A textual string indicating the location of the air
quality sensor.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.5"
::= { airQualitySensorEntry 5 }

5.14.12.6 Air Quality Sensor Model Information

-- This object has been deprecated.
airQualitySensorModelInformation OBJECT-TYPE

SYNTAX Integer32(0..255)
MAX-ACCESS read-write
STATUS deprecated
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DESCRIPTION

"<Definition> Indicates the row in the Module Table (See NTCIP 1201)
that contains information about the make, model, and version number of
the sensor associated with this row of the AirQuality Sensor Table.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> configuration

<Supplanted by> airQualitySensorkEntityID

<Informative> This object was deprecated in version 05.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.6"

::= { airQualitySensorEntry 6 }

5.14.12.7 Air Quality Sensor X Offset
airQualitySensorXOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The lateral offset of the air quality sensor from the
field device's reference location as defined by fdConfiguredLatitude
and fdConfiguredLongitude.

<Format>
For stationary devices, the X offset shall indicate the eastward
(positive) or westward (negative) distance from the reference
location. For transportable and mobile devices, the X offset shall
indicate distances to the starboard side (positive) or port side
(negative) of the reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.7"

::= { airQualitySensorEntry 7 }

5.14.12.8 Air Quality Sensor Y Offset
airQualitySensorYOffset OBJECT-TYPE

SYNTAX ITSIntegerl6
UNITS "centimeters"
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The Y offset of the air quality sensor from the field
device's reference location as defined by fdConfiguredLatitude and
fdConfiguredLongitude.

<Format>
For stationary devices, the Y offset shall indicate the northward
(positive) or southward (negative) distance from the reference
location. For transportable and mobile devices, the Y offset shall
indicate distances to the fore (positive) or aft (negative) of the
reference location on the vehicle.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.8"

::= { airQualitySensorEntry 8 }

5.14.12.9 Air Quality Sensor Z Offset

airQualitySensorZOffset OBJECT-TYPE
SYNTAX ITSIntegerl6
UNITS "centimeters"
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MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> The offset elevation of the air quality sensor from the
fdConfiguredElevation in centimeters.
<Format>
Upward offsets shall be positive and downward offsets shall be
negative.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.9"
::= { airQualitySensorEntry 9 }

5.14.12.10 Air Quality Sensor Entity Identifier
airQualitySensorEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a sensor is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.11.1.10"

::= { airQualitySensorEntry 10 }

5.14.13 Carbon Dioxide Version 4 Parameter
essCO2V4 OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "parts per million"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of carbon dioxide in the air, measured
in parts per million.
<Format>
The value 65535 shall indicate an error condition or missing value.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.13"
::= { essNtcipAirQuality 13 }

5.14.14 Nitric Oxide Version 4 Parameter
essNOV4 OBJECT-TYPE

SYNTAX Integer32 (0..255)
UNITS "parts per billion"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of nitric oxide in the air, measured in
parts per billion.

<Format>
The value 255 shall indicate an error condition or missing value.
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<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.14"
::= { essNtcipAirQuality 14 }

5.14.15 Ozone Version 4 Parameter
ess03V4 OBJECT-TYPE

SYNTAX Integer32 (0..65535)
UNITS "parts per billion"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of ozone in the air, measured in parts
per billion.
<Format>
The value 65535 shall indicate an error condition or missing wvalue.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.15"
::= { essNtcipAirQuality 15 }

5.14.16 Particulate Matter (1.0) Parameter
essPM1 OBJECT-TYPE

SYNTAX Integer32 (0..65535)

UNITS "micrograms per cubic meter"
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> The concentration of small particulate matter of 1.0
micrometers or less in diameter in the air, measured in micrograms per
cubic meter.

<Format>
The value 65535 shall indicate an error condition or missing value.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.12.16"

::= { essNtcipAirQuality 16 }

5.15 Water Quality Parameters

essNtcipWaterQuality OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> This node contains objects used for monitoring water
quality conditions. Reserved for future use.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.13"
::= { essNtcip 13 }

5.16  Snapshot Parameters
essNtcipSnapshot OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> Contains objects used to describe the snapshot camera
feature.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14"
::= { essNtcip 14 }

5.16.1 Number of Snapshot Cameras

essSnapshotNumberOfCameras OBJECT-TYPE
SYNTAX Integer32 (0..255)
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MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> Indicates the number of cameras that can be utilized for
capturing snapshots on the ESS.

<Parameter Type> status

<Informative> This value may automatically change upon connecting or
disconnecting a camera; however, the table is still defined as a
static table since the creation/deletion of rows is not managed
through SNMP logic.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.1"

::= { essNtcipSnapshot 1 }

5.16.2 Snapshot Camera Table
essSnapshotCameraTable OBJECT-TYPE

SYNTAX SEQUENCE OF EssSnapshotCameraEntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> The snapshot camera table provides summary information
about the snapshot cameras supported by the ESS. It can be described
through a number of attributes as indicated by the following
subclauses.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2"

::= { essNtcipSnapshot 2 }

5.16.3 Snapshot Camera
essSnapshotCamerakEntry OBJECT-TYPE

SYNTAX EssSnapshotCamerakntry
MAX-ACCESS not-accessible

STATUS current

DESCRIPTION

"<Definition> A snapshot camera is a camera that is able to capture a
picture and store it within the device's memory as a file. It can be
described through a number of attributes as indicated by the following
subclauses."

INDEX { essSnapshotCameralndex }
::= { essSnapshotCameraTable 1 }

EssSnapshotCamerakntry ::= SEQUENCE ({
essSnapshotCameralndex Integer32,
essSnapshotCameraDescription SnmpAdminString,
essSnapshotCameraStoragePath SnmpAdminString,
essSnapshotCameraCommand INTEGER,
essSnapshotCameraError INTEGER,
essSnapshotCameraFilename OCTET STRING,
essSnapshotCameraSupportedFormats BITS,
essSnapshotCameraFileFormat DisplayString,
essSnapshotCameraFilenameV5 SnmpAdminString,
essSnapshotCameraEntityID PhysicalIndexOrZero }

5.16.3.1 Snapshot Camera Index
essSnapshotCameralndex OBJECT-TYPE

SYNTAX Integer32 (1..255)
MAX-ACCESS read-only
STATUS current
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DESCRIPTION
"<Definition> Indicates the row number of this entry.
<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.1.1"
::= { essSnapshotCamerakEntry 1 }

5.16.3.2 Snapshot Camera Description
essSnapshotCameraDescription OBJECT-TYPE

SYNTAX SnmpAdminString
MAX-ACCESS read-write
STATUS current
DESCRIPTION

"<Definition> Indicates the description of this entry. The description
should include information about the location, direction (for fixed
cameras), and subject of the camera.

<Parameter Type> configuration

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.1.2"

::= { essSnapshotCamerakEntry 2 }

5.16.3.3 Snapshot Camera Storage Path
essSnapshotCameraStoragePath OBJECT-TYPE

SYNTAX SnmpAdminString (SIZE(1l..255))
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the storage path of snapshots taken from this
camera. The path indicated here shall be relative to the FTP login
root. This path can only include the FTP login root and its
subdirectories and cannot include any parent directories that may
exist. The root is specified by the string '/' (one forward slash). A
subdirectory from the root may be specified by the string '/subdir'.

<Parameter Type> status

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.1.3"

DEFVAL { "/" }
::= { essSnapshotCamerakEntry 3 }

5.16.3.4 Snapshot Camera Command

essSnapshotCameraCommand OBJECT-TYPE
SYNTAX INTEGER {
ready (1),
captureSnapshot (2) }
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> A command to control the snapshot feature of the ESS.
Setting this object to a value of captureSnapshot (2) commands the ESS
to take a snapshot and save the image to memory. A Get of this object
returns a value of captureSnapshot(2) while the ESS is in the process
of capturing and saving the image to memory. A Get of this object when
the ESS is not in the process of capturing and saving the image to

memory returns a value of ready(l). If any errors occur in the process
of capturing and saving the image they shall be noted in
essSnapshotError.

<Parameter Type> control
<Informative> Version 02 of this standard had a typo for the MAX-ACCESS;
this object is required tobe read-write for the camera to capture a
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snapshot image.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.1.4"
::= { essSnapshotCamerakEntry 4 }

5.16.3.5 Snapshot Camera Error
essSnapshotCamerakError OBJECT-TYPE

SYNTAX INTEGER {
none (1),
hardware (2),
insufficientMemory (3) }
MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> Indicates the status of the last attempt to capture a
snapshot using essSnapshotCommand.

<Format>
none - no error was detected
hardware - an error occurred with the camera hardware when attempting
to
capture a picture.
insufficientMemory - the ESS does not have sufficient memory to store
the
new
picture.

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.1.5"
::= { essSnapshotCamerakEntry 5 }

5.16.3.6 Snapshot Camera Filename

-- This object has been deprecated.
essSnapshotCameraFilename OBJECT-TYPE

SYNTAX OCTET STRING (SIZE(0..255))
MAX-ACCESS read-write
STATUS deprecated
DESCRIPTION
"<Definition> Indicates the filename used when storing new snapshot
images.
<Format>
This parameter shall only consist of upper and lower case characters
(A_ZI
a-z), digits (0-9), underscores ( ), periods (.), spaces, and the
following

case-sensitive field names enclosed in chevrons (<>):

camera: A three digit camera number equal to essSnapshotCameralndex.
sequence: A three digit value that increments by one each time this
camera 1is used to take a picture. This wvalue shall roll-over from '999'

to
'000'". The initial value of this field and its value after a power
outage
is manufacture dependent.
date: A six digit code indicating the UTC date in the format of YYMMDD.
time: A six digit code indicating the UTC time in the format of HHMMSS.
All implementations shall support all static character filenames with
up to
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eight characters in the base filename, a period, and up to three
characters

in the filename extension. Support for longer filenames and the above
fields
are optional.

For example, 1if this parameter has a value of 'latest.jpg', every
snapshot

taken is saved to 'latest.jpg' and overwrites any previous image saved

to
that filename. If this parameter has a value of ' .jpg’',
each
snapshot has a name (e.g., '060925 038') indicating the date it was
taken
along with a relatively unique code. While the second form prevents the
inadvertent overwriting of filenames, it increases the likelihood of
consuming large amounts of field device memory (eventually resulting in
insufficientMemory errors) if not properly managed by the management
station.
<Parameter Type> configuration
<Superseded by> essSnapshotCameraFilenameV5 and
essSnapshotCameraFileFormat
<Informative> This object was deprecated in version 05.
The filename does not necessarily define file format and it is left to
the

users to define an appropriate filename. For example, this object may
be set to a value of 'latest.bmp'. All implementations would be
required to save their images with this filename; however, the image
saved may vary. Some implementations may only save bitmapped images
and the file would have an appropriate name. Other implementations may
only save JPEG images and the '.bmp' extension may be confusing. Other
implementations may support both formats and use the extension in this
field to select the storage format, while yet others may support both
formats but ignore the extension assigned by this field (and use some
other mechanism to select the storage format).
A zero length filename may result in unexpected operations. An
implementation may reject a zero length filename by responding with
genkrr.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.6"
::= { essSnapshotCamerakEntry 6 }

5.16.3.7 Snapshot Camera Supported Formats

essSnapshotCameraSupportedFormats OBJECT-TYPE
SYNTAX BITS {
other
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MAX-ACCESS read-only
STATUS current
DESCRIPTION

"<Definition> Indicates the file formats supported by the camera when
storing new snapshot images.
Can only be set to 'captureSnapshot' when value is currently
'ready'; any other SET shall return a genErr, including a SET to

'ready'.
<Format>
other: A file format not identified by this document. If other file
formats
are used, they shall be presented in all uppercase to avoid
conflicts

with future extensions to this list.
jpeg: Joint Photographic Experts Group format as standardized in
ISO/IEC
10918.
heif: High Efficiency Image File format as standardized in ISO/IEC
23008-12.
tiff: Tagged Image File Format, Revision 6.0 as defined by the Aldus
Corporation and available from ITU at
https://www.itu.int/itudoc/itu-
t/comlée/tiff-fx/docs/tiff6.pdf
png: Portable Network Graphics (Third Edition) as defined by the World
Wide
Web Consortium (W3C) and available at https://www.w3.org/TR/png-
3/.
gif: Graphics Interchange Format Version 89%a as developed by
CompuServe
Incorporated and available at
https://www.w3.0rg/Graphics/GIF/spec—
gif89a.txt
bmp: Microsoft Windows Bitmap Format, version 5 as defined by
Microsoft
Corporation and available at https://learn.microsoft.com/en-
us/windows/win32/gdi/bitmap-storage
webp: The raster graphics file format developed by Google and available
at
https://developers.google.com/speed/webp/docs/riff container
pdf: Portable Document Format as developed by Adobe, Inc. and
standardized
in ISO 32000-2.
eps: Encapsulated PostScript File Format, Version 3 as specified by
Adobe
Systems Incorporated in May 1992 and available at
https://printtechnologies.org/standards/files/epsf spec v3 0.pdf
raw: The native format offered by the camera manufacturer. This format
is
not interoperable among manufacturers or perhaps even models, but
ensures no loss of information.
dng: Digital Negative, Version 1.7.1.0 format as developed by Adobe as

generic, interoperable raw format and available at https://
helpx.adobe.com/content/dam/help/en/photoshop/pdf/DNG Spec 1 7 1 0.pdf

<Parameter Type> status
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.7"
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{ essSnapshotCameraEntry 7 }

5.16.3.8 Snapshot Camera File Format

essSnapshotCameraFileFormat OBJECT-TYPE

SYNTAX DisplayString (SIZE (1..8))
MAX-ACCESS read-write

STATUS current

DESCRIPTION

this

"<Definition> Indicates the filename extension to use when storing new

snapshot images. If this parameter equals the name of a named bit
defined by essSnapshotCameraSupportedFormats, the format shall be
stored in the indicated file format. Other file formats can be used
but shall use all uppercase characters to prevent conflicts with
future standardized assignments.

The ESS shall respond with a wrongValue error for an attempt to set

object to a file format value that the camera does not support

<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.8"
{ essSnapshotCameraEntry 8 }

5.16.3.9 Snapshot Camera Filename Version 5

essSnapshotCameraFilenameV5 OBJECT-TYPE

SYNTAX SnmpAdminString (SIZE (1..255))
MAX-ACCESS read-write
STATUS current
DESCRIPTION
"<Definition> Indicates the filename used when storing new snapshot
images.
<Format>

to

Case-sensitive field names enclosed in chevrons (<>) shall be
interpreted as
follows:

camera: A three digit camera number equal to essSnapshotCameralndex.
sequence: A three digit value that increments by one each time this
camera is used to take a picture. This wvalue shall roll-over from '999'

'000'. The initial wvalue of this field and its value after a power
outage

is manufacture dependent.
date: A six digit code indicating the UTC date in the format of YYMMDD.
time: A six digit code indicating the UTC time in the format of HHMMSS.

All implementations shall support all static NVT-ASCII character

filenames

If

with up to eight characters in the base filename. Support for longer
filenames, the above fields, and non-NVT-ASCII characters are optional.

For example, if this parameter has a value of 'latest' and the value of
essSnapshotCameraFileFormat is 'jpeg', every snapshot taken is saved to
'latest.jpeg' and overwrites any previous image saved to that filename.

this parameter has a value of ' ', each snapshot has a base
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name (e.g., '060925 038') indicating the date it was taken along with a
relatively unique code. While the second form prevents the inadvertent
overwriting of filenames, it increases the likelihood of consuming
large
amounts of field device memory (eventually resulting in
insufficientMemory
errors) if not properly managed by the management station.
<Parameter Type> configuration
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.9"
::= { essSnapshotCamerakEntry 9 }

5.16.3.10 Snapshot Camera Entity ID
essSnapshotCamerakEntityID OBJECT-TYPE

SYNTAX PhysicalIndexOrZero
MAX-ACCESS read-only

STATUS current

DESCRIPTION

"<Definition> Indicates the row in the entPhysicalTable (See RFC 4133)
that contains information about the sensor, such as the manufacturer,
model, and hardware and software revision identifiers.

<Format>
The value of zero indicates that this information is not available.

<Parameter Type> status

<Informative> The mechanism used to configure this value when adding or
modifying a camera is not defined by this document and is considered
manufacturer-specific.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.2.14.2.10"

::= { essSnapshotCameraEntry 10 }

5.17 Conformance Information
essConformance OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node defining conformance information related to ESS
objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127"
1= {ess 127}

essCompliances OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> A node for compliance statements for ESS objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.1"
::= {essConformance 1}

essGroups OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2"
::= {essConformance 2}

5.17.1 Controller Groups

essControllerGroups OBJECT-IDENTITY
STATUS current
DESCRIPTION
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"<Definition> A node for group definitions related to ESS objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1"
::= {essGroups 1}

essCharacteristicsGroupVl OBJECT-GROUP
OBJECTS {
essNtcipCategory,
essNtcipSiteDescription,
essTypeofStation,
essLatitude,
essLongitude,
essReferenceHeight }
STATUS deprecated
DESCRIPTION
"<Definition> The NTCIP 1204 objects required to claim base conformance
to NTCIP 1204 vOl.
<Superseded by> essCharacteristicsGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.1"
:= {essControllerGroups 1}

essMobileGroupVl OBJECT-GROUP
OBJECTS {
essVehicleSpeed,
essVehicleBearing,
essOdometer }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for a mobile ESS in
v0l.
<Superseded by> fdMobilityGroupVl
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.2"
::= {essControllerGroups 2}

essMobileFrictionGroupVl OBJECT-GROUP
OBJECTS {
essMobileFriction }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for mobile mobile
friction in vO01.
<Superseded by> essPavementFrictionGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.3"
::= {essControllerGroups 3}

essDoorStatusGroupV2 OBJECT-GROUP
OBJECTS {
essDoorStatus }
STATUS deprecated
DESCRIPTION
"<Definition> The NTCIP 1204 objects required to claim conformance to
door status in vO02.
<Superseded by> fdSrsaBasicGroupVl, where fdSrsaTypeCode = FBO
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.4"
::= {essControllerGroups 4}

essBatteryGroupV2 OBJECT-GROUP
OBJECTS {
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essBatteryStatus }
STATUS deprecated
DESCRIPTION
"<Definition> The NTCIP 1204 objects required to claim base conformance
to battery status in v02.
<Superseded by> fdSrsalnputGroupVl, where fdSrsaTypeCode = FBC
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.5"
::= {essControllerGroups 5}

essLineVoltsGroupV2 OBJECT-GROUP
OBJECTS {
essLineVolts }
STATUS deprecated
DESCRIPTION
"<Definition> The NTCIP 1204 objects required to claim base conformance
to line volts in v02.
<Superseded by> fdSrsalnputGroupVl, where fdSrsaTypeCode = FLV
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.6"
:= {essControllerGroups 6}

essMetaDataBlockGroupV2 OBJECT-GROUP
OBJECTS {
essStationMetaDataBlock }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the metadata
block in v02.
<Superseded by> essMetaDataBlockGroupV3
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.7"
::= {essControllerGroups 7}

essMobileBlockGroupV2 OBJECT-GROUP
OBJECTS {
essMobileBlock }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the mobile block
in v02.
<Withdrawn> In v04
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.8"
::= {essControllerGroups 8}

essWeatherBlockGroupV2 OBJECT-GROUP
OBJECTS {
essWeatherBlock }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the weather
block in v02.
<Superseded by> essWeatherBlockGroupV3
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.9"
::= {essControllerGroups 9}

essMetaDataBlockGroupV3 OBJECT-GROUP
OBJECTS {
essStationMetaDataV3Block }
STATUS deprecated

Copy Per MIB Distribution Permission © 2022 AASHTO / ITE / NEMA



NTCIP 1204 v04.26
Page 221

DESCRIPTION
"<Definition> The objects required to claim support for the metadata
block in v03.
<Withdrawn> In v04
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.10"
::= {essControllerGroups 10}

essWeatherBlockGroupV3 OBJECT-GROUP
OBJECTS {
essWeatherV3Block }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the weather
block in v03.
<Withdrawn> In v04
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.11"
:= {essControllerGroups 11}

essStatusGroupV3 OBJECT-GROUP
OBJECTS {
essStatus }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for monitoring ESS
status in v04.
<Superseded by> fdControllerGroupVl
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.1.12"
::= {essControllerGroups 12}

essCharacteristicsGroupV5 OBJECT-GROUP
OBJECTS {
essTypeofStation }
STATUS current
DESCRIPTION
"<Definition> The NTCIP 1204 objects required to claim base conformance
to NTCIP 1204 vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13"
:= {essControllerGroups 13}

5.17.2 Pressure Groups

essPressureGroups OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS pressure
sensor objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.2"
::= {essGroups 2}

essPressureGroupVl OBJECT-GROUP
OBJECTS {
essPressureHeight,
essAtmosphericPressure }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for atmospheric
pressure readings for v01l.
<Superseded by> essPressureSensorLocationGroupV4 and
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essPressureDataGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.2.1"

::= {essPressureGroups 1}

essPressureSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
essPressureSensorHeight,
essPressureSensorLatitude,
essPressureSensorLongitude,
essPressureSensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for atmospheric
pressure readings for v04.
<Superseded by> essPressureSensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.2.2"
:= {essPressureGroups 2}

essPressureSensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
essPressureSensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for pressure sensor
identification for v04.
<Superseded by> essPressureSensorInfoGroupVb5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.2.3"
::= {essPressureGroups 3}

essPressureDataGroupV4 OBJECT-GROUP
OBJECTS {
essNumPressureSensors,
essPressureSensorIndex,
essPressureSensorAtmosphericPressure }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for atmospheric
pressure readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.2.4"
:= {essPressureGroups 4}

essPressureSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
essPressureSensorLocation,
essPressureSensorXOffset,
essPressureSensorYOffset,
essPressureSensorzOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pressure sensor
location for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.2.5"
::= {essPressureGroups 5}

essPressureSensorInfoGroupV5 OBJECT-GROUP

OBJECTS {
essPressureSensorEntityID }
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STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pressure sensor
identification for wvO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.2.6"
::= {essPressureGroups 6}

5.17.3 Wind Groups
essWindGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS wind sensor
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3"
::= {essGroups 3}

essWindGroupVl OBJECT-GROUP
OBJECTS {
essWindSensorHeight,
essAvgWindDirection,
essAvgWindSpeed,
essMaxWindGustSpeed,
essMaxWindGustDir }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for wind data in
v0l.
<Superseded by> essWindDataGroupV2 and essWindSensorLocationGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.1"
::= {essWindGroups 1}

essMobileWindGroupVl OBJECT-GROUP
OBJECTS {
essSpotWindDirection,
essSpotWindSpeed,
essWindSituation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for mobile wind data
in vO01.
<Superseded by> essWindDataGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.2"
:= {essWindGroups 2}

essWindDataGroupV2 OBJECT-GROUP

OBJECTS {
windSensorTableNumSensors,
windSensorIndex,
windSensorAvgSpeed,
windSensorAvgDirection,
windSensorSpotSpeed,
windSensorSpotDirection,
windSensorGustSpeed,
windSensorGustDirection,
windSensorSituation }

STATUS current

DESCRIPTION
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"<Definition> The objects required to claim support for wind data in
v02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.3"
::= {essWindGroups 3}

essWindSensorLocationGroupV2 OBJECT-GROUP
OBJECTS {
windSensorHeight,
windSensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for wind sensor
location for v02.
<Superseded by> essWindSensorLocationGroupVb5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.4"
:= {essWindGroups 4}

essWindSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
windSensorLatitude,
windSensorLongitude }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for wind sensor
location for v04.
<Superseded by> essWindSensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.5"
::= {essWindGroups 5}

essWindSensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
windSensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for wind sensor
model information for v04.
<Superseded by> essWindSensorInfoGroupV>
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.6"
:= {essWindGroups 6}

essWindSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
windSensorLocation,
windSensorXOffset,
windSensorYOffset,
windSensorZOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for wind sensor
location for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.7"
::= {essWindGroups 7}

essWindSensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
windSensorEntityID }
STATUS current
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DESCRIPTION
"<Definition> The objects required to claim support for wind sensor
identification for wvO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.3.8"
::= {essWindGroups 8}

5.17.4 Temperature Groups

essTemperatureGroups OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS temperture
sensor objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.4"
::= {essGroups 4}

essTemperatureGroupVl OBJECT-GROUP
OBJECTS {
essNumTemperatureSensors,
essTemperatureSensorIndex,
essAirTemperature,
essMaxTemp,
essMinTemp }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for temperature
readings for vO0l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.4.1"
::= {essTemperatureGroups 1}

essTemperatureSensorLocationGroupVl OBJECT-GROUP
OBJECTS {
essTemperatureSensorHeight }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for temperature
sensor location for vO01.
<Superseded by> essTemperatureSensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.4.2"
::= {essTemperatureGroups 2}

essTemperatureSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
essTemperatureSensorLatitude,
essTemperatureSensorLongitude,
essTemperatureSensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for temperature
sensor location for wv04.
<Superseded by> essTemperatureSensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.4.3"
::= {essTemperatureGroups 3}

essTemperatureSensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
essTemperatureSensorModelInformation }
STATUS deprecated
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DESCRIPTION
"<Definition> The objects required to claim support for temperature

sensor model information for v04.
<Superseded by> essTemperatureSensorInfoGroupV>
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.4.4"
::= {essTemperatureGroups 4}

essTemperatureSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
essTemperatureSensorLocation,
essTemperatureSensorXOffset,
essTemperatureSensorYOffset,
essTemperatureSensorzZOffset }
STATUS current

DESCRIPTION
"<Definition> The objects required to claim support for temperature

sensor location for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.4.5"
:= {essTemperatureGroups 5}

essTemperatureSensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
essTemperatureSensorEntityID }
STATUS current

DESCRIPTION
"<Definition> The objects required to claim support for temperature

sensor identification for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.4.6"
::= {essTemperatureGroups 6}
5.17.5 Humidity Groups

essHumidityGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS humidity
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.5"
::= {essGroups 5}

essHumidityGroupVl OBJECT-GROUP
OBJECTS {
essWetbulbTemp,
essDewpointTemp,
essRelativeHumidity }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for humidity
readings for vO0l.
<Superseded by> essHumidityDataGroupVb5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.5.1"
::= {essHumidityGroups 1}

essHumiditySensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
humiditySensorHeight,
humiditySensorLatitude,
humiditySensorLongitude,
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humiditySensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for humidity sensor
location for v04.
<Superseded by> essHumiditySensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.5.2"
::= {essHumidityGroups 2}

essHumiditySensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
humiditySensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for humidity sensor
identification for v04.
<Superseded by> essHumiditySensorInfoGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.5.3"
:= {essHumidityGroups 3}

essHumidityDataGroupV4 OBJECT-GROUP
OBJECTS {
humiditySensorTableNumSensors,
humiditySensorIndex,
humiditySensorRelativeHumidity,
humiditySensorTemperatureInformation,
humiditySensorWetbulbTemp,
humiditySensorDewpointTemp }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for humidity
readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.5.4"
::= {essHumidityGroups 4}

essHumiditySensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
humiditySensorLocation,
humiditySensorXOffset,
humiditySensorYOffset,
humiditySensorzOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for humidity sensor
location for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.5.5"
::= {essHumidityGroups 5}

essHumiditySensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
humiditySensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for humidity sensor
identification for wvO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.5.6"
:= {essHumidityGroups 6}

© 2022 AASHTO / ITE / NEMA Copy Per MIB Distribution Permission



NTCIP 1204 v04.26
Page 228

5.17.6 Precipitation Groups
essPrecipitationGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS precipitation
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6"
:= {essGroups 6}

essPrecipPresenceGroupVl OBJECT-GROUP
OBJECTS {
essPrecipYesNo }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
presence for v01l.
<Superseded by> essPrecipPresenceGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.1"
::= {essPrecipitationGroups 1}

essPrecipRateGroupVl OBJECT-GROUP
OBJECTS {
essPrecipRate,
essPrecipitationStartTime,
essPrecipitationEndTime }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
rate for vOl.
<Superseded by> essPrecipDataGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.2"
:= {essPrecipitationGroups 2}

essPrecipTotalsGroupVl OBJECT-GROUP
OBJECTS {
essPrecipSituation,
essPrecipitationOneHour,
essPrecipitationThreeHours,
essPrecipitationSixHours,
essPrecipitationTwelveHours,
essPrecipitation24Hours }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
totals for vO01.
<Superseded by> essPrecipTotalsGroupV4 and essPrecipSituationGroupVi4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.3"
::= {essPrecipitationGroups 3}

essPrecipEmergingGroupVl OBJECT-GROUP
OBJECTS {
essAdjacentSnowDepth,
essRoadwaySnowDepth,
essRoadwaySnowPackDepth,
essSnowfallAccumRate,
essIceThickness }
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STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for emergent
precipitation information for vO1l.
<Superseded by> essPrecipDataGroupV4, essPreciplceThicknessGroupV4,
essPrecipAdjacentSnowGroupV4, and essPrecipRoadwaySnowGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.4"
::= {essPrecipitationGroups 4}

essPrecipSensorInfoGroupV2 OBRJECT-GROUP
OBJECTS {
precipitationSensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
sensor model information for v02.
<Superseded by> essPrecipSensorInfoGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.5"
:= {essPrecipitationGroups 5}

essPrecipPresenceGroupV4 OBJECT-GROUP
OBJECTS {
precipitationSensorTableNumSensors,
precipitationSensorIndex,
precipitationSensorPrecipYesNo }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
presence for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.6"
::= {essPrecipitationGroups 6}

essPrecipDataGroupV4 OBJECT-GROUP
OBJECTS {
precipitationSensorPrecipRate,
precipitationSensorSnowfallAccumRate,
precipitationSensorPrecipitationStartTime,
precipitationSensorPrecipitationEndTime }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
data readings for v04.
<Superseded by> essPrecipDataGroupVbs
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.7"
::= {essPrecipitationGroups 7}

essPrecipSituationGroupVvV4 OBJECT-GROUP
OBJECTS {
precipitationSensorPrecipSituation }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for precipitation

situation readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.8"
::= {essPrecipitationGroups 8}

essPrecipIceThicknessGroupV4 OBJECT-GROUP
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OBJECTS {
precipitationSensorIceThickness }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for ice thickness
readings for v04.
<Superseded by> essPavementTemperatureGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.9"
::= {essPrecipitationGroups 9}

essPrecipTotalsGroupV4 OBJECT-GROUP
OBJECTS {
precipitationSensorPrecipitationOneHour,
precipitationSensorPrecipitationThreeHours,
precipitationSensorPrecipitationSixHours,
precipitationSensorPrecipitationTwelveHours,
precipitationSensorPrecipitation24Hours }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
totals for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.10"
::= {essPrecipitationGroups 10}

essPrecipUserTotalGroupV4 OBJECT-GROUP
OBJECTS {
precipitationSensorPeriod,
precipitationSensorPrecipitationUserDefined }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
user-defined totals for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.11"
::= {essPrecipitationGroups 11}

essPrecipSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
precipitationSensorHeight,
precipitationSensorLatitude,
precipitationSensorLongitude,
precipitationSensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
sensor location for v04.
<Superseded by> essPrecipSensorInfoGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.12"
::= {essPrecipitationGroups 12}

essPrecipSensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
precipitationSensorModelInformationVv4 }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
sensor model information for v04.
<Superseded by> essPrecipSensorInfoGroupVb
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.13"
::= {essPrecipitationGroups 13}

essPrecipDataGroupV5 OBJECT-GROUP
OBJECTS {
precipitationSensorPrecipRate,
precipitationSensorSnowfallAccumRate,
precipitationSensorPrecipStartDate,
precipitationSensorPrecipStartTimeV5,
precipitationSensorPrecipEndDate,
precipitationSensorPrecipEndTimeV5 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
data readings for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.14"
:= {essPrecipitationGroups 14}

essPrecipSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
precipitationSensorLocation,
precipitationSensorXOffset,
precipitationSensorYOffset,
precipitationSensorzZOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
sensor location for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.15"
::= {essPrecipitationGroups 15}

essPrecipSensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
precipitationSensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for precipitation
sensor identification for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.16"
:= {essPrecipitationGroups 16}

essPrecipAdjacentSnowGroupV5 OBJECT-GROUP
OBJECTS {
precipitationSensorAdjacentSnowDepth }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for adjacent snow
readings for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.17"
::= {essPrecipitationGroups 17}

essPrecipRoadwaySnowGroupV5 OBJECT-GROUP
OBJECTS {
precipitationSensorRoadwaySnowDepth,
precipitationSensorRoadwaySnowPackDepth }
STATUS current
DESCRIPTION
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"<Definition> The objects required to claim support for roadway snow
readings for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.6.18"
::= {essPrecipitationGroups 18}

5.17.7 Radiation Groups
essRadiationGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS radiation
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7"
::= {essGroups 7}

essRadiationGroupVl OBJECT-GROUP
OBJECTS {
essSolarRadiation,
essTotalSun }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for radiation
readings for vO0l.
<Superseded by> essRadiationGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7.1"
::= {essRadiationGroups 1}

essRadiationGroupV2 OBJECT-GROUP
OBJECTS {
essTotalSun,
essInstantaneousTerrestrialRadiation,
essInstantaneousSolarRadiation,
essTotalRadiation,
essTotalRadiationPeriod }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for radiation
readings for v02.
<Superseded by> essRadiationDataGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7.2"
::= {essRadiationGroups 2}

essRadiationDataGroupV4 OBJECT-GROUP
OBJECTS {
essTotalRadiationPeriod,
radiationSensorTableNumSensors,
radiationSensorIndex,
essTotalSunV4,
essInstantaneousTerrestrialRadiationV4,
essInstantaneousSolarRadiationV4,
essTotalRadiationV4 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for radiation
readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7.3"
::= {essRadiationGroups 3}
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essRadiationSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
radiationSensorHeight,
radiationSensorLatitude,
radiationSensorLongitude,
radiationSensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for radiation sensor
location for v04.
<Superseded by> essRadiationSensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7.4"
::= {essRadiationGroups 4}

essRadiationSensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
radiationSensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for radiation sensor
identification for v04.
<Superseded by> essRadiationSensorInfoGroupV>
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7.5"
::= {essRadiationGroups 5}

essRadiationSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
radiationSensorLocation,
radiationSensorXOffset,
radiationSensorYOffset,
radiationSensorZOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for radiation sensor
location for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7.6"
:= {essRadiationGroups 6}

essRadiationSensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
radiationSensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for radiation sensor
identification for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.7.7"
::= {essRadiationGroups 7}

5.17.8 Visibility Groups
essVisibilityGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS visibility
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8"
::= {essGroups 8}
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essVisibilityGroupVl OBJECT-GROUP
OBJECTS {
essVisibility }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for visibility
readings for v01.
<Superseded by> essVisibilityDataGroupVb
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.1"
::= {essVisibilityGroups 1}

essVisibilitySituationGroupVl OBJECT-GROUP
OBJECTS {
essVisibilitySituation }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for visibility
situation readings for vO01l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.2"
:= {essVisibilityGroups 2}

essVisibilitySensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
visibilitySensorHeight,
visibilitySensorLatitude,
visibilitySensorLongitude,
visibilitySensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for visibility
sensor location for v04.
<Superseded by> essVisibilitySensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.3"
::= {essVisibilityGroups 3}

essVisibilitySensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
visibilitySensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for visibility
sensor identification for v04.
<Superseded by> essVisibilitySensorInfoGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.4"
::= {essVisibilityGroups 4}

essVisibilityDataGroupV5 OBJECT-GROUP
OBJECTS {
essNumVisibilitySensors,
essVisibilitySensorCurrentReading }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for visibility
readings for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.5"
::= {essVisibilityGroups 5}
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essCloudSituationGroupV5 OBJECT-GROUP
OBJECTS {
essCloudSituationV4 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for cloud situation
readings for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.6"
::= {essVisibilityGroups 6}

essVisibilitySensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
essVisibilitySensorLocation,
essVisibilitySensorXOffset,
essVisibilitySensorYOffset,
essVisibilitySensorZOffset,
essVisibilitySensorDirection }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for visibility
sensor location for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.7"
::= {essVisibilityGroups 7}

essVisibilitySensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
essVisibilitySensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for visibility
sensor identification for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.8.8"
::= {essVisibilityGroups 8}

5.17.9 Pavement Groups

essPavementGroups OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9"
:= {essGroups 9}

essPavementSensorCountGroupVl OBJECT-GROUP
OBJECTS {
numEssPavementSensors,
essPavementSensorIndex }
STATUS current
DESCRIPTION
"<Definition> The objects required to identify the number of pavement
sensors are available for v01.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.1"
::= {essPavementGroups 1}

essPavementSensorMetaDataGroupVl OBJECT-GROUP
OBJECTS {
essPavementSensorLocation,
essPavementType,
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essPavementExposure,
essPavementSensorType }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement sensor
meta-data for vO01l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.2"
::= {essPavementGroups 2}

essPavementSensorSurfaceStatusGroupVl OBJECT-GROUP
OBJECTS {
essSurfaceStatus }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for pavement sensor
condition for vO01.
<Superseded by> essPavementSurfaceCondGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.3"
:= {essPavementGroups 3}

essPavementSensorElevationGroupVl OBJECT-GROUP
OBJECTS {
essPavementElevation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for pavement sensor
elevation data for vO0l.
<Superseded by> essPavementSensorLocationGroupVb
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.4"
::= {essPavementGroups 4}

essPavementSurfaceTempGroupVl OBJECT-GROUP
OBJECTS {
essSurfaceTemperature,
essPavementSensorError }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement surface
readings for vO0l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.5"
::= {essPavementGroups 5}

essPavementEnhancedGroupVl OBJECT-GROUP
OBJECTS {
essPavementTemperature,
essSurfaceWaterDepth }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for enhanced
pavement readings for v01l.
<Superseded by> essPavementTemperatureGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.6"
::= {essPavementGroups 6}

essSurfaceConductivityGroupVl OBJECT-GROUP

OBJECTS {
essSurfaceConductivity }
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STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for pavement surface
conductivity for vO0l.
<Superseded by> essSurfaceConductivityGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.7"
::= {essPavementGroups 7}

essSurfaceSalinityGroupVl OBJECT-GROUP
OBJECTS {
essSurfaceSalinity }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
salinity for vO01.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.8"
:= {essPavementGroups 8}

essPavementFreezeGroupVl OBJECT-GROUP
OBJECTS {
essSurfaceFreezePoint,
essSurfaceBlackIceSignal }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement surface
freeze readings for vO0l.
<Superseded by> essPavementTemperatureGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.9"
::= {essPavementGroups 9}

essSurfaceConductivityGroupV2 OBJECT-GROUP
OBJECTS {
essSurfaceConductivityVv2 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement surface
conductivity for v02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.10"
:= {essPavementGroups 10}

essPavementTemperatureGroupV2 OBJECT-GROUP
OBJECTS {
essPavementTemperature,
essSurfacelceOrWaterDepth }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
temperature readings for v02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.11"
::= {essPavementGroups 11}

essPavementBlockGroupV2 OBJECT-GROUP
OBJECTS {
essPavementBlock }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the pavement
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block in v02.
<Superseded by> essPavementBlockGroupV3
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.12"
::= {essPavementGroups 12}

essPavementSensorDepthGroupV2 OBJECT-GROUP
OBJECTS {
pavementSensorTemperatureDepth }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for the pavement
sensor depth in v02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.13"
::= {essPavementGroups 13}

essPavementSensorInfoGroupV2 OBJECT-GROUP
OBJECTS {
pavementSensorModelInformation }
STATUS deprecated

DESCRIPTION
"<Definition> The objects required to claim support for pavement sensor

identification for v02.
<Superseded by> essPavementSensorInfoGroupVb
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.14"
::= {essPavementGroups 14}

essPavementBlockGroupV3 OBJECT-GROUP
OBJECTS {
essPavementV3Block }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the pavement
block in v03.
<Withdrawn> In v04
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.15"
:= {essPavementGroups 15}

essPavementSurfaceCondGroupV4 OBJECT-GROUP
OBJECTS {
pavementSensorSurfaceCondition }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement surface
condition readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.16"
::= {essPavementGroups 16}

essPavementFrictionGroupv4 OBJECT-GROUP
OBJECTS {
pavementSensorFrictionCoefficient }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
friction readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.17"
::= {essPavementGroups 17}
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essPavementIcePercentGroupV4d OBJECT-GROUP
OBJECTS {
pavementIcePercentage }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for monitoring
pavement ice percentage for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.18"
::= {essPavementGroups 18}

essPavementSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
essPavementSensorLocation,
pavementSensorLatitude,
pavementSensorLongitude,
pavementMonitorLatitude,
pavementMonitorLongitude }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for pavement sensor
location for v04.
<Superseded by> essPavementSensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.19"
::= {essPavementGroups 19}

essPavementForecastGroupV5 OBJECT-GROUP
OBJECTS {
pavementSensorForecastCondition }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
forecast readings for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.20"
::= {essPavementGroups 20}

essPavementSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
essPavementSensorLocation,
essPavementMonitorXOffset,
essPavementMonitorYOffset,
essPavementMonitorzOffset,
essPavementSensorXOffset,
essPavementSensorYOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement sensor
location for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.21"
::= {essPavementGroups 21}

essPavementSensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
essPavementSensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement sensor
identification for v05.
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.9.22"
::= {essPavementGroups 22}

5.17.10 Subsurface Groups
essSubSurfaceGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS subsurface
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10"
::= {essGroups 10}

essSubSurfaceSensorCountGroupGroupVl OBJECT-GROUP
OBJECTS {
numEssSubSurfaceSensors,
essSubSurfaceSensorIndex }
STATUS current
DESCRIPTION
"<Definition> The objects required to identify the number of subsurface
sensors are available for vO01l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.1"
:= {essSubSurfaceGroups 1}

essSubSurfaceMoistureGroupVl OBJECT-GROUP
OBJECTS {
essSubSurfaceMoisture }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for subsurface
moisture readings for vO01l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.2"
::= {essSubSurfaceGroups 2}

essSubSurfaceBlockGroupV2 OBJECT-GROUP
OBJECTS {
essSubSurfaceBlock }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the subsurface
block in v02.
<Withdrawn> In v04
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.3"
:= {essSubSurfaceGroups 3}

essSubSurfaceSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
essSubSurfaceSensorLatitude,
essSubSurfaceSensorLongitude }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for subsurface
sensor location for v04.
<Superseded by> essSubSurfaceSensorLocationGroupVb
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.4"
::= {essSubSurfaceGroups 4}

essSubSurfaceSensorInfoGroupv4 OBJECT-GROUP
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OBJECTS {
essSubSurfaceSensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for subsurface
sensor identification for v04.
<Superseded by> essSubSurfaceSensorInfoGroupV5S
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.5"
::= {essSubSurfaceGroups 5}

essSubSurfaceDataGroupV5 OBJECT-GROUP
OBJECTS {
essSubSurfaceTemperature,
essSubSurfaceSensorError }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for subsurface data
readings for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.6"
:= {essSubSurfaceGroups 6}

essSubSurfaceSensorMetaDataGroupV5 OBJECT-GROUP
OBJECTS {
essSubSurfaceSensorLocation,
essSubSurfaceType,
essSubSurfaceSensorDepth }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for subsurface
sensor meta-data for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.7"
::= {essSubSurfaceGroups 7}

essSubSurfaceSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
essSubSurfaceSensorXOffset,
essSubSurfaceSensorYOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for subsurface
sensor location for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.8"
::= {essSubSurfaceGroups 8}

essSubSurfaceSensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
essSubSurfaceSensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for subsurface
sensor identification for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.10.9"
::= {essSubSurfaceGroups 9}

5.17.11 Snapshot Groups

essSnapshotGroups OBJECT-IDENTITY
STATUS current
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DESCRIPTION
"<Definition> A node for group definitions related to ESS snapshot
objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.11"
::= {essGroups 11}

essSnapshotCameraGroupV2 OBJECT-GROUP
OBJECTS {
essSnapshotNumberOfCameras,
essSnapshotCameralndex,
essSnapshotCameraDescription,
essSnapshotCameraStoragePath,
essSnapshotCameraCommand,
essSnapshotCamerakError }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for snapshots for
v02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.11.1"
:= {essSnapshotGroups 1}

essSnapshotFilenameGroupV3 OBJECT-GROUP
OBJECTS {
essSnapshotCameraFilename }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for snapshots for
v03.
<Superseded by> essSnapshotFilenameGroupVbs
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.11.2"
::= {essSnapshotGroups 2}

essSnapshotFilenameGroupV5 OBJECT-GROUP
OBJECTS {
essSnapshotCameraSupportedFormats,
essSnapshotCameraFileFormat,
essSnapshotCameraFilenameV5 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for snapshots for
v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.11.3"
::= {essSnapshotGroups 3}

essSnapshotCameraInfoGroupV5 OBJECT-GROUP
OBJECTS {
essSnapshotCameraEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for snapshot camera
identification for wvO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.11.4"
::= {essSnapshotGroups 4}

5.17.12 Observed Groups

essObservedGroups OBJECT-IDENTITY
STATUS current
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DESCRIPTION
"<Definition> A node for group definitions related to ESS observed
readings.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.12"
::= {essGroups 12}

essObservedReadingGroupVl OBJECT-GROUP
OBJECTS {
essWindSituation,
essPrecipSituation,
essCloudSituation,
essVisibilitySituation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for observed
readings for vO0l.
<Superseded by> essObservedReadingGroupV4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.12.1"
:= {essObservedGroups 1}

essMobileObservationGroupVl OBJECT-GROUP
OBJECTS {
essMobileObservationGroundState,
essMobileObservationPavement }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for mobile observed
readings for vO0l.
<Superseded by> essObservedGroundStateGroupV4 and
essObservedPavementStateGroupVv4
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.12.2"
::= {essObservedGroups 2}

essObservedReadingGroupV4 OBJECT-GROUP
OBJECTS {
essWindSituation,
essPrecipSituation,
essCloudSituationVv4,
essVisibilitySituation }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for observed
readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.12.3"
::= {essObservedGroups 3}

essObservedGroundStateGroupvV4 OBJECT-GROUP
OBJECTS {
essMobileObservationGroundStatev4 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for observed ground
state readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.12.4"
::= {essObservedGroups 4}

essObservedPavementStateGroupV4 OBJECT-GROUP
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OBJECTS {
essMobileObservationPavementV4 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for observed
pavement state readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.12.5"
::= {essObservedGroups 5}

5.17.13 Water Level Groups
essWaterLevelGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS water level
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13"
::= {essGroups 13}

essWaterDepthGroupVvl OBJECT-GROUP
OBJECTS {
essWaterDepth }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for water depth
readings for vO0l.
<Superseded by> essWaterLevelDataGroupV2
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13.1"
::= {essWaterLevelGroups 1}

essWaterLevelDataGroupV2 OBJECT-GROUP
OBJECTS {
waterLevelSensorTableNumSensors,
waterLevelSensorIndex,
waterLevelSensorReading }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for water level
readings for v02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13.2"
::= {essWaterLevelGroups 2}

essWaterLevelSensorConfigurationGroupV4 OBJECT-GROUP
OBJECTS {
waterLevelSensorWarningLevel }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for water level
configuration for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13.3"
::= {essWaterLevelGroups 3}

essWaterLevelSensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
waterLevelSensorHeight,
waterLevelSensorLatitude,
waterLevelSensorLongitude,
waterLevelSensorLocation,
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waterLevelSensorReferencePoint }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for water level
sensor location for v04.
<Superseded by> essWaterLevelSensorLocationGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13.4"
::= {essWaterLevelGroups 4}

essWaterLevelSensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
waterLevelSensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for water level
sensor identification for v04.
<Superseded by> essWaterLevelSensorInfoGroupVb5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13.5"
:= {essWaterLevelGroups 5}

essWaterLevelSensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
waterLevelSensorLocation,
waterLevelSensorReferencePoint,
waterLevelSensorXOffset,
waterLevelSensorYOffset,
waterLevelSensorZOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for water level
sensor location for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13.6"
::= {essWaterLevelGroups 6}

essWaterLevelSensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
waterLevelSensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for water level
sensor identification for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.13.7"
::= {essWaterLevelGroups 7}

5.17.14 Air Quality Groups
essAirQualityGroups OBJECT-IDENTITY

STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to ESS air quality
objects.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14"
::= {essGroups 14}

essAirQualityCOGroupVl OBJECT-GROUP
OBJECTS {
essCO }
STATUS current
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DESCRIPTION
"<Definition> The objects required to claim support
readings for vO0l.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

::= {essAirQualityGroups 1}

essAirQualityCO2GroupVl OBJECT-GROUP
OBJECTS {
essCO02 }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support
readings for vO0l.
<Superseded by> essAirQualityCO2GroupV4

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

:= {essAirQualityGroups 2}

essAirQualityNOGroupVl OBJECT-GROUP
OBJECTS {
essNO }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support
readings for vO0l.
<Superseded by> essAirQualityNOGroupV4

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

::= {essAirQualityGroups 3}

essAirQualityNO2GroupV1l OBJECT-GROUP
OBJECTS {
essNO2 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support
readings for vO01l.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

:= {essAirQualityGroups 4}

essAirQualityS02GroupVl OBJECT-GROUP
OBJECTS {
essS02 '}
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support
readings for vO01l.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

::= {essAirQualityGroups 5}

essAirQuality0O3GroupVl OBJECT-GROUP
OBJECTS {
ess03 }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support
for vO1.
<Superseded by> essAirQuality0O3GroupV4

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.
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essAirQualityPM10GroupVl OBJECT-GROUP
OBJECTS {
essPM10 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support
micrometer) particulate matter readings for vO1l.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

{essAirQualityGroups 7}

essAQBlockGroupV2 OBJECT-GROUP
OBJECTS {
essAirQualityBlock }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support
block in v02.
<Withdrawn> In v04

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

{essAirQualityGroups 8}
essAirQualityCO2GroupV4 OBJECT-GROUP
OBJECTS {
essCOo2v4 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support
readings for v04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

{essAirQualityGroups 9}

essAirQualityNOGroupV4 OBJECT-GROUP
OBJECTS {
essNOV4 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support
readings for vO04.

<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.

{essAirQualityGroups 10}

essAirQualityO3GroupV4 OBJECT-GROUP
OBJECTS {
essO3V4 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support
for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14
{essAirQualityGroups 11}

essAirQualityPM25GroupV4 OBJECT-GROUP
OBJECTS {
essPM25 }
STATUS current
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DESCRIPTION
"<Definition> The objects required to claim support for small (2.5
micrometer) particulate matter readings for v04.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.12"
::= {essAirQualityGroups 12}

essAirQualitySensorLocationGroupV4 OBJECT-GROUP
OBJECTS {
airQualitySensorTableNumSensors,
airQualitySensorIndex,
airQualitySensorHeight,
airQualitySensorLatitude,
airQualitySensorLongitude,
airQualitySensorLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for air quality
sensor location for v04.
<Superseded by> essAirQualitySensorLocationGroupVbs
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.13"
::= {essAirQualityGroups 13}

essAirQualitySensorInfoGroupV4 OBJECT-GROUP
OBJECTS {
airQualitySensorModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for air quality
sensor identification for wv04.
<Superseded by> essAirQualitySensorInfoGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.14"
::= {essAirQualityGroups 14}

essAirQualityPM1GroupV5 OBJECT-GROUP
OBJECTS {
essPM1 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for small (1.0
micrometer) particulate matter readings for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.15"
::= {essAirQualityGroups 15}

essAirQualitySensorLocationGroupV5 OBJECT-GROUP
OBJECTS {
airQualitySensorTableNumSensors,
airQualitySensorIndex,
airQualitySensorLocation,
airQualitySensorXOffset,
airQualitySensorYOffset,
airQualitySensorZOffset }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for air quality
sensor location for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.16"
:= {essAirQualityGroups 16}
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essAirQualitySensorInfoGroupV5 OBJECT-GROUP
OBJECTS {
airQualitySensorEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for air quality
sensor identification for wvO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.14.17"
::= {essAirQualityGroups 17}

5.17.15 Pavement Treatment Groups

essPavementTreatmentGroups OBJECT-IDENTITY
STATUS current
DESCRIPTION
"<Definition> A node for group definitions related to PTS objects.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15"
::= {essGroups 15}

ptsProductGroupVl OBJECT-GROUP
OBJECTS {
numEssTreatments,
essPavementTreatmentIndex,
essPaveTreatProductType,
essPaveTreatProductForm,
essPercentProductMix }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment table for vO0l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.1"
::= {essPavementTreatmentGroups 1}

ptsSpreadConfigGroupVl OBJECT-GROUP
OBJECTS {
essPaveTreatmentAmount,
essPaveTreatmentWidth }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment spread configuration details for vO0l.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.2"
:= {essPavementTreatmentGroups 2}

ptsStatusGroupV2 OBJECT-GROUP

OBJECTS {
ptsSprayerState,
ptsSignalEventCount,
ptslLastSignalEvent,
ptsActiveEventCount,
ptsInactiveEventCount,
ptsLastActiveEvent,
ptsLastInactiveEvent,
ptsError }

STATUS deprecated

DESCRIPTION

"<Definition> The objects required to claim support for pavement
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treatment status for v02.
<Superseded by> ptsStatusGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.3"
::= {essPavementTreatmentGroups 3}

ptsConfigurationGroupV2 OBJECT-GROUP
OBJECTS {
ptsSignalDuration,
ptsMonitoringDetectors }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment configuration for v02.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.4"
::= {essPavementTreatmentGroups 4}

ptsCommandGroupV2 OBJECT-GROUP
OBJECTS {
ptsOperationalMode,
ptsCommandState }
STATUS obsolete
DESCRIPTION
"<Definition> The objects required to claim support for the pavement
treatment command objects for v02.
<Superseded by> ptsOperationGroupV3 and ptsCommandGroupV3
<Informative> Made obsolete in v03.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.5"
::= {essPavementTreatmentGroups 5}

essPtsBlockGroupV2 OBJECT-GROUP
OBJECTS {
pavementTreatmentBlock }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for the pavement
treatment block in v02.
<Withdrawn> In v04
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.6"
:= {essPavementTreatmentGroups 6}

ptsOperationGroupV3 OBJECT-GROUP
OBJECTS {
ptsOperationalModeV3 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for the pavement
treatment operation parameter for v03.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.7"
::= {essPavementTreatmentGroups 7}

ptsCommandGroupV3 OBJECT-GROUP
OBJECTS {
ptsCommandStateV3 }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment commands for vO03.
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<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.8"
::= {essPavementTreatmentGroups 8}

ptsLocationGroupV4 OBJECT-GROUP
OBJECTS {
essPavementTreatmentLatitude,
essPavementTreatmentLongitude,
essPavementTreatmentLocation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment location for v04.
<Superseded by> ptsLocationGroupVb
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.9"
::= {essPavementTreatmentGroups 9}

ptsInfoGroupVv4 OBJECT-GROUP
OBJECTS {
essPavementTreatmentModelInformation }
STATUS deprecated
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment system identification for v04.
<Superseded by> ptsInfoGroupV5
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.10"
::= {essPavementTreatmentGroups 10}

ptsStatusGroupV5 OBJECT-GROUP
OBJECTS {
ptsSprayerState,
ptsSignalEventCount,
ptsActiveEventCount,
ptsInactiveEventCount,
ptsError,
ptslLastSignalEventDate,
ptslLastSignalEventTime,
ptslLastActiveEventDate,
ptsLastActiveEventTime,
ptsLastInactiveEventDate,
ptsLastInactiveEventTime }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment status for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.11"
::= {essPavementTreatmentGroups 11}

ptsLocationGroupV5 OBJECT-GROUP
OBJECTS {
essPavementTreatmentLocation,
ptsXOffset,
ptsYOffset 1}
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment location for vO05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.12"
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::= {essPavementTreatmentGroups 12}

ptsInfoGroupV5 OBJECT-GROUP
OBJECTS {
ptsEntityID }
STATUS current
DESCRIPTION
"<Definition> The objects required to claim support for pavement
treatment system identification for v05.
<Object Identifier> 1.3.6.1.4.1.1206.4.2.5.127.2.15.13"
{essPavementTreatmentGroups 13}

END

5.18 Cameralmages

A snapshot is an image captured in a computer file. The data related to the exchange of computer files is
defined in SFTS v3.
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Annex A
Requirements Traceability Matrix (RTM) [Normative]

The Requirements Traceability Matrix (RTM) links the Functional Requirements as presented in Section 3 with the corresponding Dialogs (Section
4.2) on the same (gray) line. Each Functional Requirement/Dialog relates/uses one or more groups of Objects. The Objects (also known as Data
Elements) are listed to the side; the formal definition of each object is contained within Section 5. Using this table, each Functional Requirement
can thus be traced in a standardized way.

Note: The INDEX objects into any of the tables are not explicitly exchanged but are used as index values for other objects that are
exchanged.

The audience for this table is implementers (vendors and central system developers) and conformance testers. Additionally, other interested
parties might use this table to determine how particular functions are to be implemented using the standardized dialogs, interfaces, and object
definitions.

To conform to a Functional Requirement, an ESS shall implement all Objects and Dialogs traced from that Functional Requirement; a
management station shall implement all Dialogs traced from the Functional Requirement. In order to be consistent with a Functional Requirement,
a management station shall be able to fulfill the Functional Requirement using only Objects and Dialogs that a conforming ESS is required to
support.

Section 3.6 defines Supplemental Requirements, which are refining other functional requirements. These functional requirements in turn are
generally traced to design elements (e.g., rather than being directly traced to design elements).

A1 Notation [Informative]
A.1.1  Functional Requirement Columns

The functional requirements are defined within Section 3 and the RTM is based upon the requirements within that Section. The section humber
and the functional requirement name are indicated within these columns.

A.1.2 Dialog Column

The standardized dialogs are defined within Section 4 and the RTM references the traces from requirements to this dialog. The section number of
the dialog is indicated within this column.
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A.1.3 Object Columns

The objects are defined within Section 5 of this document and Section 2 of NTCIP 1201. The RTM references the data objects that are referenced
by the dialog. The section number and object name are indicated within these columns.

A.1.4 Additional Specifications

The "Additional Specifications" column may (and should) be used to provide additional notes and requirements about the dialog or may be used
by an implementer to provide any additional details about the implementation.

A.2 Instructions for Completing the RTM [Informative]

To find the standardized design content for a functional requirement, search for the requirement identification number and functional requirement
under the functional requirements columns. Next to the functional requirements column is a dialog identification number, identifying either a
generic dialog (found in Annex G) or a specified dialog (found in Section 4.2) to be used to fulfill that requirement. To the right of the dialog
identification number are the identification number and name of the data objects that are referenced or used by the dialog to fulfill the functional
requirement. Object definitions specific to this document can be found in Section 5. If an object is defined in a different standard, that standard
shall be listed first, followed by the section number where the object definition can be found. The "Additional Specifications" column provides
additional notes or details about the design content.

A3 Requirements Traceability Matrix (RTM) Table

Requirement Object Reference Object Dialogue Notes
3.5.1.1 : Retrieve ESS Type of Station ISO 26048-1 : Get elemental data
5.3.1 essTypeofStation
3.5.1.2 : Retrieve Mobile ESS Movement ISO 26048-1 : Get elemental data
1ISO26048-1-FieldDevice fdGnssLatitude
1SO26048-1-FieldDevice fdGnssLongitude
1ISO26048-1-FieldDevice fdGnssElevation
1SO26048-1-FieldDevice fdSpeed
1ISO26048-1-FieldDevice fdBearing
1SO26048-1-FieldDevice fdOdometer
3.5.2.1.1 : Determine Number of Atmospheric Pressure Sensors ISO 26048-1 : Get elemental data
555 essNumPressureSensors
3.5.2.1.2 : Retrieve Atmospheric Pressure Sensor Location ISO 26048-1 : Get tabular data
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Requirement Object Reference Object Dialogue Notes

55.7.5 essPressureSensorLocation

5.5.7.8 essPressureSensorXOffset

5.5.7.9 essPressureSensorYOffset

5.5.7.10 essPressureSensorZOffset
3.5.2.1.3 : Retrieve Atmospheric Pressure Sensor ldentity ISO 26048-1 : Get tabular data

55.7.11 essPressureSensorEntitylD
3.5.2.1.4 : Configure Atmospheric Pressure Sensor Location ISO 26048-1 : Set tabular data

55.7.5 essPressureSensorLocation

5.5.7.8 essPressureSensorXOffset

5.5.7.9 essPressureSensorYOffset

5.5.7.10 essPressureSensorZOffset
3.5.2.1.5 : Retrieve Atmospheric Pressure ISO 26048-1 : Get tabular data

55.7.7 |essPressureSensorAtmosphericPressure |
3.5.2.2.1 : Determine Number of Wind Sensors ISO 26048-1 : Get elemental data

5.6.8 |WindSensorTabIeNumSensors |
3.5.2.2.2 : Retrieve Wind Sensor Location ISO 26048-1 : Get tabular data

5.6.10.3 windSensorLocation

5.6.10.14 windSensorXOffset

5.6.10.15 windSensorY Offset

5.6.10.16 windSensorZOffset
3.5.2.2.3 : Retrieve Wind Sensor Identity ISO 26048-1 : Get tabular data

5.6.10.17 windSensorEntityID
3.5.2.2.4 : Configure Wind Sensor Location ISO 26048-1 : Set tabular data

5.6.10.3 windSensorLocation

5.6.10.14 windSensorXOffset

5.6.10.15 windSensorY Offset

5.6.10.16 windSensorZOffset
3.5.2.2.5 : Retrieve Wind Data ISO 26048-1 : Get tabular data

© 2018 AASHTO / ITE / NEMA Copy Per RTM Distribution Permission



NTCIP 1204 v04.26

Page 256

Requirement Object Reference Object Dialogue Notes
5.6.10.4 windSensorAvgSpeed
5.6.10.5 windSensorAvgDirection
5.6.10.6 windSensorSpotSpeed
5.6.10.7 windSensorSpotDirection
5.6.10.8 windSensorGustSpeed
5.6.10.9 windSensorGustDirection
5.6.10.10 windSensorSituation

3.5.2.3.1 : Determine Number of Temperature Sensors ISO 26048-1 : Get tabular data
57.1 essNumTemperatureSensors

3.5.2.3.2 : Retrieve Temperature Sensor Location ISO 26048-1 : Get tabular data
5.7.3.6 essTemperatureSensorLocation
5.7.3.8 essTemperatureSensorXOffset
5.7.3.9 essTemperatureSensorY Offset
5.7.3.10 essTemperatureSensorZOffset

3.5.2.3.3 : Retrieve Temperature Sensor Identity ISO 26048-1 : Get tabular data
5.7.3.11 essTemperatureSensorEntitylD

3.5.2.3.4 : Configure Temperature Sensor Location ISO 26048-1 : Set tabular data
5.7.3.6 essTemperatureSensorLocation
5.7.3.8 essTemperatureSensorXOffset
5.7.3.9 essTemperatureSensorY Offset
5.7.3.10 essTemperatureSensorZOffset

3.5.2.3.5 : Retrieve Air Temperature ISO 26048-1 : Get tabular data
5.7.3.3 essAirTemperature

3.5.2.3.6 : Retrieve Daily Minimum and Maximum Temperature ISO 26048-1 : Get elemental data
5.7.6 essMaxTemp
5.7.7 essMinTemp

3.5.2.4.1 : Determine Number of Humidity Sensors ISO 26048-1 : Get elemental data
5.8.25 humiditySensorTableNumSensors

Copy Per RTM Distribution Permission © 2018 AASHTO / ITE / NEMA



NTCIP 1204 v04.26

Page 257
Requirement Object Reference Object Dialogue Notes
3.5.2.4.2 : Retrieve Humidity Sensor Location ISO 26048-1 : Get tabular data
5.8.27.5 humiditySensorLocation
5.8.27.11 humiditySensorXOffset
5.8.27.12 humiditySensorY Offset
5.8.27.13 humiditySensorZOffset
3.5.2.4.3 : Retrieve Humidity Sensor Identity ISO 26048-1 : Get tabular data
5.8.27.14 humiditySensorEntity|D
3.5.2.4.4 : Configure Humidity Sensor Location ISO 26048-1 : Set tabular data
5.8.27.5 humiditySensorLocation
5.8.27.11 humiditySensorXOffset
5.8.27.12 humiditySensorY Offset
5.8.27.13 humiditySensorZOffset
3.5.2.4.5 : Configure Humidity Sensor Temperature ISO 26048-1 : Set tabular data
5.8.27.8 humiditySensorTemperaturelnformation
3.5.2.4.6 : Retrieve Relative Humidity ISO 26048-1 : Get tabular data
5.8.27.7 humiditySensorRelativeHumidity
5.8.27.8 humiditySensorTemperaturelnformation
5.8.27.9 humiditySensorWetbulbTemp
5.8.27.10 humiditySensorDewpointTemp
3.5.2.5.1 : Determine Number of Precipitation Sensors ISO 26048-1 : Get elemental data
5.8.22 precipitationSensorTableNumSensors
3.5.2.5.2 : Retrieve Precipitation Sensor Location ISO 26048-1 : Get tabular data
5.8.24.5 precipitationSensorLocation
5.8.24.28 precipitationSensorXOffset
5.8.24.29 precipitationSensorY Offset
5.8.24.30 precipitationSensorZOffset
3.5.2.5.3 : Retrieve Precipitation Sensor Identity ISO 26048-1 : Get tabular data
5.8.24.31 precipitationSensorEntitylD
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Requirement Object Reference

Object Dialogue

Notes

3.5.2.5.4 : Configure Precipitation Sensor Location

ISO 26048-1 : Set tabular data

5.8.24.5 precipitationSensorLocation
5.8.24.28 precipitationSensorXOffset
5.8.24.29 precipitationSensorY Offset
5.8.24.30 precipitationSensorZOffset

3.5.2.5.5 : Configure Precipitation Total User-Specified Period

ISO 26048-1 : Set tabular data

5.8.24.7 |precipitationSensorPeriod

3.5.2.5.6 : Retrieve Precipitation Presence ISO 26048-1 : Get tabular data
5.8.24.11 |precipitationSensorPrecipYesNo

3.5.2.5.7 : Retrieve Precipitation Rates ISO 26048-1 : Get tabular data
5.8.24.12 precipitationSensorPrecipRate
5.8.24.13 precipitationSensorSnowfallAccumRate
5.8.24.24 precipitationSensorPrecipStartDate
5.8.24.25 precipitationSensorPrecipStartTimeV5
5.8.24.26 precipitationSensorPrecipEndDate
5.8.24.27 precipitationSensorPrecipEndTimeV5

3.5.2.5.8 : Retrieve Precipitation Totals ISO 26048-1 : Get tabular data
5.8.24.18 precipitationSensorPrecipitationOneHour
5.8.24.19 precipitationSensorPrecipitationThreeHours
5.8.24.20 precipitationSensorPrecipitationSixHours
5.8.24.21 precipitationSensorPrecipitationTwelveHours
5.8.24.22 precipitationSensorPrecipitation24Hours

3.5.2.5.9 : Retrieve Precipitation Totals - User Specified

ISO 26048-1 : Get tabular data

5.8.24.7 precipitationSensorPeriod

5.8.24.23 precipitationSensorPrecipitationUserDefined
3.5.2.5.10 : Retrieve Precipitation Type ISO 26048-1 : Get elemental data

5.8.24.14 precipitationSensorPrecipSituation
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Requirement Object Reference Object Dialogue Notes
5.9.8 radiationSensorTableNumSensors

3.5.2.6.2 : Retrieve Solar Radiation Sensor Location ISO 26048-1 : Get tabular data
5.9.10.5 radiationSensorLocation
5.9.10.11 radiationSensorXOffset
5.9.10.12 radiationSensorYOffset
5.9.10.13 radiationSensorZOffset

3.5.2.6.3 : Retrieve Solar Radiation Sensor Identity ISO 26048-1 : Get tabular data
5.9.10.14 radiationSensorEntitylD

3.5.2.6.4 : Configure Solar Radiation Sensor Location ISO 26048-1 : Set tabular data
5.9.10.5 radiationSensorLocation
5.9.10.11 radiationSensorXOffset
5.9.10.12 radiationSensorYOffset
5.9.10.13 radiationSensorZOffset

3.5.2.6.5 : Retrieve Solar Radiation 4.2.9 : Retrieve Solar Radiation
5.9.7 essTotalRadiationPeriod
5.9.8 radiationSensorTableNumSensors
5.9.10.7 essTotalSunv4
5.9.10.8 essinstantaneousTerrestrialRadiationV4
5.9.10.9 esslInstantaneousSolarRadiationV4
5.9.10.10 essTotalRadiationV4

3.5.2.7.1 : Determine Number of Visibility Sensors ISO 26048-1 : Get elemental data
5.10.2 essNumVisibilitySensors

3.5.2.7.2 : Retrieve Visibility Sensor Location ISO 26048-1 : Get elemental data
5.10.10.2 essVisibilitySensorLocation
5.10.10.3 essVisibilitySensorXOffset
5.10.10.4 essVisibilitySensorY Offset
5.10.10.5 essVisibilitySensorzZOffset
5.10.10.6 essVisibilitySensorDirection
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Requirement Object Reference Object Dialogue Notes

3.5.2.7.3 : Retrieve Visibility Sensor Identity ISO 26048-1 : Get elemental data
5.10.10.7 essVisibilitySensorEntitylD

3.5.2.7.4 : Configure Visibility Sensor Location ISO 26048-1 : Set elemental data
5.10.10.2 essVisibilitySensorLocation
5.10.10.3 essVisibilitySensorXOffset
5.10.10.4 essVisibilitySensorY Offset
5.10.10.5 essVisibilitySensorzZOffset
5.10.10.6 essVisibilitySensorDirection

3.5.2.7.5 : Retrieve Visibility ISO 26048-1 : Get tabular data
5.10.10.8 |essVisibiIitySensorCurrentReading

3.5.2.8.1 : Determine Number of Pavement Sensors ISO 26048-1 : Get elemental data
5.11.1 |numEssPavementSensors

3.5.2.8.2 : Retrieve Pavement Sensor Location ISO 26048-1 : Get tabular data
5.11.3.2 essPavementSensorLocation
5.11.3.28 essPavementMonitorXOffset
5.11.3.29 essPavementMonitorY Offset
5.11.3.30 essPavementMonitorZOffset
5.11.3.31 essPavementSensorXOffset
5.11.3.32 essPavementSensorY Offset

3.5.2.8.3 : Retrieve Pavement Sensor ldentity ISO 26048-1 : Get tabular data
5.11.3.33 essPavementSensorEntitylD

3.5.2.8.4 : Configure Pavement Sensor Location ISO 26048-1 : Set tabular data
5.11.3.2 essPavementSensorLocation
5.11.3.28 essPavementMonitorXOffset
5.11.3.29 essPavementMonitorY Offset
5.11.3.30 essPavementMonitorZOffset
5.11.3.31 essPavementSensorXOffset
5.11.3.32 essPavementSensorY Offset

Copy Per RTM Distribution Permission

e —

© 2018 AASHTO / ITE / NEMA



NTCIP 1204 v04.26
Page 261

Requirement Object Reference

Object Dialogue

Notes

3.5.2.8.5 : Retrieve Pavement Sensor Metadata

ISO 26048-1 : Get tabular data

5.11.3.2 essPavementSensorLocation
5.11.3.3 essPavementType
5.11.35 essPavementExposure
5.11.3.6 essPavementSensorType
3.5.2.8.6 : Configure Pavement Sensor Metadata ISO 26048-1 : Set tabular data
5.11.3.2 essPavementSensorLocation
5.11.3.3 essPavementType
5.11.3.5 essPavementExposure
3.5.2.8.7 : Configure Passive Ice Detection Logic 4.2.7 : Configure Passive Ice Detection Logic
5.13.1 numEssTreatments
5.13.3.2 essPaveTreatProductType
5.13.3.3 essPaveTreatProductForm
5.13.3.4 essPercentProductMix

3.5.2.8.8 : Retrieve Conditions for Freezing Algorithms - Active

ISO 26048-1 : Get tabular data

5.11.3.8 essSurfaceTemperature

5.11.3.9 essPavementTemperature
5.11.3.13 essSurfaceFreezePoint

5.11.3.14 essSurfaceBlacklceSignal
5.11.3.15 essPavementSensorError

5.11.3.16 essSurfacelceOrWaterDepth
5.11.3.19 pavementSensorTemperatureDepth

3.5.2.8.9 : Retrieve Conditions for Freezing Algorithms - Passive

4.2.5 : Retrieve Icing Conditions—Passive
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Requirement Object Reference Object Dialogue Notes
5.11.3.15 essPavementSensorError
5.11.3.16 essSurfacelceOrWaterDepth
5.11.3.17 essSurfaceConductivityV2
5.11.3.19 pavementSensorTemperatureDepth
5.13.1 numEssTreatments
5.13.3.2 essPaveTreatProductType
5.13.3.3 essPaveTreatProductForm
5.13.3.4 essPercentProductMix
3.5.2.8.10 : Retrieve Pavement Surface Temperature ISO 26048-1 : Get tabular data
5.11.3.8 essSurfaceTemperature
5.11.3.15 essPavementSensorError
3.5.2.8.11 : Retrieve Pavement Surface Condition ISO 26048-1 : Get tabular data
5.11.3.15 essPavementSensorError
5.11.3.22 pavementSensorSurfaceCondition
3.5.2.8.12 : Retrieve Forecasted Pavement Surface Condition ISO 26048-1 : Get tabular data
5.11.3.23 |pavementSensorForecastCondition |
3.5.2.8.13 : Retrieve Roadway Friction Coefficient ISO 26048-1 : Get tabular data
5.11.3.24 |pavementSensorFrictionCoefficient |
3.5.2.8.14 : Retrieve Ice Percentage ISO 26048-1 : Get tabular data
5.11.3.27 |pavement|cePercentage |
3.5.2.8.15 : Retrieve Adjacent Snow Depth ISO 26048-1 : Get tabular data
5.8.24.8 |precipitationSensorAdjacentSnowDepth |
3.5.2.8.16 : Retrieve Roadway Snow Depth ISO 26048-1 : Get tabular data
5.8.24.9 precipitationSensorRoadwaySnowDepth
5.8.24.10 precipitationSensorRoadwaySnowPackDepth
3.5.2.8.17 : Retrieve Roadway Ice Thickness ISO 26048-1 : Get tabular data
5.11.3.16 essSurfacelceOrWaterDepth
3.5.2.9.1 : Determine Number of Subsurface Sensors ISO 26048-1 : Get elemental data
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Requirement

Object Reference

Object Dialogue

Notes

5114 numEssSubSurfaceSensors

3.5.2.9.2 : Retrieve Subsurface Sensor Location ISO 26048-1 : Get tabular data
5.11.6.2 essSubSurfaceSensorLocation
5.11.6.12 essSubSurfaceSensorXOffset
5.11.6.13 essSubSurfaceSensorYOffset

3.5.2.9.3 : Retrieve Subsurface Sensor Identity ISO 26048-1 : Get tabular data
5.11.6.6 essSubSurfaceSensorEntitylD

3.5.2.9.4 : Configure Subsurface Sensor Location ISO 26048-1 : Set tabular data
5.11.6.2 essSubSurfaceSensorLocation
5.11.6.12 essSubSurfaceSensorXOffset
5.11.6.13 essSubSurfaceSensorYOffset

3.5.2.9.5 : Retrieve Subsurface Sensor Metadata ISO 26048-1 : Get tabular data
5.11.6.2 essSubSurfaceSensorLocation
5.11.6.3 essSubSurfaceType
5.11.6.4 essSubSurfaceSensorDepth

3.5.2.9.6 : Configure Subsurface Sensor Metadata ISO 26048-1 : Set tabular data
5.11.6.2 essSubSurfaceSensorLocation
5.11.6.3 essSubSurfaceType
5.11.6.4 essSubSurfaceSensorDepth

3.5.2.9.7 : Retrieve Subsurface Temperature ISO 26048-1 : Get tabular data
5.11.6.5 essSubSurfaceTemperature
5.11.6.8 essSubSurfaceSensorError

3.5.2.9.8 : Retrieve Subsurface Moisture ISO 26048-1 : Get tabular data
5.11.6.7 |essSubSurfaceMoisture |

3.5.2.10.1 : Determine Number of Air Quality Sensors

ISO 26048-1 : Get elemental data

5.14.10

|airQuaIitySensorTabIeNumSensors

3.5.2.10.2 : Retrieve Air Quality Sensor Location

ISO 26048-1 : Get tabular data

5.14.12.5
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Requirement Object Reference Object Dialogue Notes

5.14.12.7 airQualitySensorXOffset

5.14.12.8 airQualitySensorY Offset

5.14.12.9 airQualitySensorZOffset
3.5.2.10.3 : Retrieve Air Quality Sensor Identity ISO 26048-1 : Get tabular data

5.14.12.10 |airQuaIitySensorEntityID
3.5.2.10.4 : Configure Air Quality Sensor Location ISO 26048-1 : Set tabular data

5.14.12.5 airQualitySensorLocation

5.14.12.7 airQualitySensorXOffset

5.14.12.8 airQualitySensorYOffset

5.14.12.9 airQualitySensorZOffset
3.5.2.10.5 : Retrieve Carbon Monoxide Reading ISO 26048-1 : Get elemental data

514.1 lessco |
3.5.2.10.6 : Retrieve Nitrogen Dioxide Reading ISO 26048-1 : Get elemental data

5.14.4 lessNO2 |
3.5.2.10.7 : Retrieve Sulfur Dioxide Reading ISO 26048-1 : Get elemental data

5.14.5 lessso2 |
3.5.2.10.8 : Retrieve Small Particulate Matter Reading ISO 26048-1 : Get elemental data

5.14.7 lessPM10 |
3.5.2.10.9 : Retrieve Particulate Matter 2.5 Reading ISO 26048-1 : Get elemental data

5.14.9 lessPM25 |
3.5.2.10.10 : Retrieve Particulate Matter 1.0 Reading ISO 26048-1 : Get elemental data

5.14.16 lessPm1 |
3.5.2.10.11 : Retrieve Carbon Dioxide Reading ISO 26048-1 : Get elemental data

5.14.13 lessco2v4 |
3.5.2.10.12 : Retrieve Nitric Oxide Reading ISO 26048-1 : Get elemental data

5.14.14 lessNOv4 |
3.5.2.10.13 : Retrieve Ozone Reading ISO 26048-1 : Get elemental data

5.14.15 essO3V4
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Dialogue

Notes

3.5.2.11.1 : Determine Number of Water Level Sensors

ISO 26048-1 : Get elemental data

5.8.19 waterLevelSensorTableNumSensors

3.5.2.11.2 : Retrieve Water Level Sensor Location

ISO 26048-1 : Get tabular data

5.8.21.7 waterLevelSensorLocation

5.8.21.9 waterLevelSensorReferencePoint

5.8.21.10 waterLevelSensorXOffset

5.8.21.11 waterLevelSensorYOffset

5.8.21.12 waterLevelSensorZOffset
3.5.2.11.3 : Retrieve Water Level Sensor Identity ISO 26048-1 : Get tabular data

5.8.21.13 |WaterLeveISensorEntityID |
3.5.2.11.4 : Retrieve Water Level Sensor Warning Level ISO 26048-1 : Get tabular data

5.8.21.3 |waterLeveISensorWarningLeveI |
3.5.2.11.5 : Configure Water Level Sensor Location ISO 26048-1 : Set tabular data

5.8.21.7 waterLevelSensorLocation

5.8.21.9 waterLevelSensorReferencePoint

5.8.21.10 waterLevelSensorXOffset

5.8.21.11 waterLevelSensorYOffset

5.8.21.12 waterLevelSensorZOffset
3.5.2.11.6 : Configure Water Level Sensor Warning Level ISO 26048-1 : Set tabular data

5.8.21.3 waterLevelSensorWarningLevel
3.5.2.11.7 : Retrieve Water Level ISO 26048-1 : Get tabular data

5.8.19 waterlLevelSensorTableNumSensors

5.8.21.2 waterLevelSensorReading

3.5.2.12.1 : Retrieve Wind Situation

ISO 26048-1 : Get tabular data

5.6.5 |essWindSituation

3.5.2.12.2 : Retrieve Precipitation Situation

ISO 26048-1 : Get elemental data

5.8.9 |essPrecipSituation

3.5.2.12.3 : Retrieve Visibility Situation

ISO 26048-1 : Get elemental data
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5.10.3 |essVisibilitySituation |
3.5.2.12.4 : Retrieve Cloud Situation ISO 26048-1 : Get elemental data
59.11 |essCIoudSituationV4 |
3.5.2.12.5 : Retrieve Ground State ISO 26048-1 : Get elemental data
5.12.4 |essMobiIeObservationGroundStateV4 |
3.5.2.12.6 : Retrieve Pavement State ISO 26048-1 : Get elemental data
5.12.5 |essMobiIeObservationPavementV4 |
3.5.2.13.1 : Determine Number of Snapshot Cameras ISO 26048-1 : Get elemental data
5.16.1 |essSnapshotNumberOfCameras |
3.5.2.13.2 : Retrieve Snapshot Camera Identity ISO 26048-1 : Get elemental data
5.16.3.10 |essSnapshotCameraEntitylD |
3.5.2.13.3 : Determine Supported Image Storage Formats ISO 26048-1 : Get elemental data
5.16.3.7 |essSnapshotCameraSupportedFormats |
3.5.2.13.4 : Configure Snapshot Camera ISO 26048-1 : Set tabular data
5.16.3.2 essSnapshotCameraDescription
5.16.3.8 essSnapshotCameraFileFormat
5.16.3.9 essSnapshotCameraFilenameV5
3.5.2.13.5 : Retrieve Snapshot Camera Configuration ISO 26048-1 : Get tabular data
5.16.3.2 essSnapshotCameraDescription
5.16.3.3 essSnapshotCameraStoragePath
5.16.3.8 essSnapshotCameraFileFormat
5.16.3.9 essSnapshotCameraFilenameV5
3.5.2.13.6 : Capture Snapshot Image 4.2.1 : Capture Snapshot Image
5.16.3.4 essSnapshotCameraCommand
5.16.3.5 essSnapshotCameraError
3.5.2.13.7 : Retrieve Snapshot 4.2.2 : Retrieve Snapshot
3.5.2.13.8 : Delete Snapshot 4.2.3 : Delete Snapshot
3.5.3.1.1 : Retrieve Pavement Treatment System Location ISO 26048-1 : Get elemental data
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Requirement Object Reference Object Dialogue Notes
5.13.23 essPavementTreatmentLocation
5.13.31 ptsXOffset
5.13.32 ptsYOffset

3.5.3.1.2 : Retrieve Pavement Treatment System Identity

ISO 26048-1 : Get elemental data

5.13.33

ptsEntitylD

3.5.3.1.3 : Configure Pavement Treatment System Location

ISO 26048-1 : Set elemental data

5.13.23 essPavementTreatmentLocation
5.13.31 ptsXOffset
5.13.32 ptsYOffset
3.5.3.1.4 : Retrieve Stationary Pavement Treatment Configuration 4.2.4 : Retrieve Stationary Pavement Treatment Configuration
5.13.1 numEssTreatments
5.13.3.2 essPaveTreatProductType
5.13.3.3 essPaveTreatProductForm
5.13.3.4 essPercentProductMix
5.13.10 ptsSignalDuration
5.13.18 ptsMonitoringDetectors

3.5.3.1.5 : Configure Stationary Pavement Treatment System

4.2.6 : Configure Stationary Pavement Treatment System

© 2018 AASHTO / ITE / NEMA

5.13.1 numEssTreatments
5.13.3.2 essPaveTreatProductType
5.13.3.3 essPaveTreatProductForm
5.13.3.4 essPercentProductMix
5.13.10 ptsSignalDuration
5.13.18 ptsMonitoringDetectors
3.5.3.1.6 : Configure Mobile Pavement Treatment System 4.2.8 : Configure Mobile Pavement Treatment System
5.13.1 numEssTreatments
5.13.3.2 essPaveTreatProductType
5.13.3.3 essPaveTreatProductForm
5.13.3.4 essPercentProductMix
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5134 essPaveTreatmentAmount
5.13.5 essPaveTreatmentWidth
5.13.10 ptsSignalDuration

3.5.3.1.7 : Retrieve Mobile Pavement Treatment Configuration 4.2.10 : Retrieve Mobile Pavement Treatment System
5.13.1 numEssTreatments
5.13.3.2 essPaveTreatProductType
5.13.3.3 essPaveTreatProductForm
5.13.34 essPercentProductMix
5134 essPaveTreatmentAmount
5.13.5 essPaveTreatmentWidth
5.13.10 ptsSignalDuration

3.5.3.2.1 : Retrieve Pavement Treatment Status ISO 26048-1 : Get elemental data
5.13.9 ptsSprayerState
5.13.11 ptsSignalEventCount
5.13.13 ptsActiveEventCount
5.13.14 ptsinactiveEventCount
5.13.17 ptsError
5.13.25 ptsLastSignalEventDate
5.13.26 ptsLastSignalEventTime
5.13.27 ptsLastActiveEventDate
5.13.28 ptsLastActiveEventTime
5.13.29 ptsLastlnactiveEventDate
5.13.30 ptsLastlnactiveEventTime

3.5.3.2.2 : Retrieve PTS Operational Mode ISO 26048-1 : Get elemental data
5.13.19 |ptsOperationaIModeV3

3.5.3.4.1 : Set PTS Operational Mode ISO 26048-1 : Set elemental data
5.13.19 |ptsOperationaIModeV3

3.5.3.4.2 : Manually Activate PTS Sprayer ISO 26048-1 : Set elemental data
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5.13.20 ptsCommandStateV3
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A.4 Versions and Object Refinements

Per RFC 2580, MIB modules can include MODULE-COMPLIANCE macros to define:

e When each object-group must be supported.
When object-types can be sub-ranged within an AGENT-CAPABILITIES statement,
To what extent access to objects can be restricted within implementations,
Which object types were introduced and deprecated within each version of the standard,
When refinements were made to the valid syntax of objects (e.g., new or deprecated
enumerations),

IETF MIB modules typically contain one MODULE-COMPLIANCE statement for each revision of the
module.

NTCIP standards define when each object-type must be supported using the PRL and RTM traceability
tables. These tables allow the reader to better understand the user needs behind each object-type. Some
of the other details mentioned above are often discussed within object descriptions, requirements, or
other locations within the standard. However, some issues, such as when objects were added or ranges
changed are seldom discussed in other portions of the document.

Rather than using MODULE-COMPLIANCE macros within each MIB module, the NTCIP standards
include a version conformance table and an object refinement table to provide identical information in a
more concise manner that does not complicate the MIB modules. These tables are provided to ensure
that these implementation issues are documented within the standard and to provide a single summary
area for this information. It is recognized that these tables duplicate and extend requirements contained
within object-type descriptions, the PRL, and the RTM. In case of any conflict between these sources the
object-type descriptions, PRL, and RTM take precedence over the version conformance table and object
refinement table.

A.4.1 Version Conformance

Table 9 indicates which object groups and capabilities are required for each version of NTCIP 1204 for
the objects contained within this MIB, starting with NTCIP 1204 v05, the first version of this document to
include object group definitions.

The MIB version compliance table supplements the conformance symbols for the PRL and RTM by
identifying the following additional symbols:
a) a hyphen (-) indicates that the object group was not defined in that version of the document,

b) the letter 'd' indicates that the object group was "deprecated" for that version of the document and
is not required, and

c) the letter 'o' indicates that the object group was "obsolete" for that version of the document and is
not required.

Table 9: Version Conformance for NTCIP1203-Dms MIB

Group v05 (current)
fdActionAdminGroupV1 CondTrigger OR
DayPlan OR
SchedTrigger: M
fdActionGroupV1 CondTrigger OR
DayPlan OR
SchedTrigger: M
fdCabinetLocationGroupV1 M
fdPowerSourceGroupV1 M
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fdUtcClockGroupV1 UTC:M
fdLocalClockGroupV1 LocalClock:M
fdDstClockGroupV1 LocalClock:O
fdCommandAdminGroupV1 Command:M
fdCommandGroupV1 Command:M
fdCondTriggerAdminGroupV1 CondTrigger:-M
fdCondTriggerGroupV1 CondTrigger:-M
fdControllerGroupV1 M
fdDayPlanSchedulerGroupV1 DayPlan:M
fdDynObjAdminGroupV1 DynObj:M
fdDynObjBasicGroupV1 DynObj:M
fdDynObjRefreshGroupV1 DynObj:O
fdDynObjNewValueGroupV1 DynObj:O
fdLogAdminGroupV1 Log:M
fdLogConfigGroupV1 Log:M
fdLogRetrievalGroupV1 Log:M
fdNotifyAdminGroupV1 Notify:M
fdNotifyFactoryGroupV1 Notify:M
fdNotifyChannelGroupV1 Notify:M
fdNotifyDataGroupV1 Notify:M
fdNotifyGroupV1 Notify:M
fdOwnerGroupV1 SchedTrigger OR Log

OR Notify OR Command
OR Recording: M

fdRecordingGroupV1

Recording:M

fdSchedTriggerAdministrativeGroup

SchedTrigger:M

fdSchedTriggerBasicGroup

SchedTrigger:M

fdSrsaBasicGroupV1 Srsa:M
fdSrsaOutputGroupV1 SrsaOutput:M
fdSrsalnputGroupV1 Srsalnput:M
essCharacteristicsGroupV5 M
essPressureSensorDataGroupV4 Press:M
essPressureSensorLocationGroupVs Press:O
essPressureSensorinformationGroupV5s Press:O
essWindSensorDataGroupV?2 Wind:M
essWindSensorLocationGroupV5 Wind:O
essWindSensorinformationGroupV5 Wind:O
essTempSensorDataGroupV1 Temp:M
essTempSensorLocationGroupV5 Temp:O
essTempSensorinformationGroupV5 Temp:O
essHumiditySensorDataGroupV4 Humidity:M
essHumiditySensorLocationGroupV5 Humidity:O
essHumiditySensorinformationGroupV5 Humidity:O
essPrecipPresenceGroupV4 Precip:M
essPrecipRateGroupV4 Precip:O
essPrecipTimesGroupV5 Precip:O
essPrecipSensorLocationGroupV5 Precip:O
essPrecipSensorinformationGroupV5 Precip:O
essPrecipTotalGroupV4 Precip:O
essPrecipUserTotalGroupV4 Precip:O
esslceThicknessGroupV4 Precip:O
essAdjacentSnowGroupV4 Precip:O
essRoadwaySnowGroupV4 Precip:O
essSolarRadiationSensorDataGroupV4 Rad:M
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essSolarRadiationSensorLocationGroupV5 Rad:O
essSolarRadiationSensorinformationGroupVs Rad:O
essVisibilitySensorDataGroupV1 Visibility:M
essVisibilitySensorLocationGroupV5 Visibility:O
essVisibilitySensorinformationGroupV5 Visibility:O
essPavementBlacklceGroupV1 Pave:O
essPavementTemperatureGroupV1 Pave:O
essPavementSurfaceFreezePointGroupV1l Pave:O
essPavementSurfaceSalinityGroupV1l Pave:O
essPavementSurfaceConductivityGroupV?2 Pave:O
essPavementSurfacelceOrWaterDepthGroupV2 Pave:O
essPavementSensorDepthGroupV2 Pave:O
essPavementSurfaceTemperatureGroupV4 Pave:O
essPavementSurfaceConditionGroupV4 Pave:O
essPavementForecastGroupV4 Pave:O
essPavementFrictionGroupV4 Pave:O
essPavementSensorMetadataGroupV5 Pave:O
essPavementSensorLocationGroupV5s Pave:O
essPavementSensorinformationGroupVs Pave:O
essSubsurfaceSensorDataGroupV1 Subsurf:M
essSubsurfaceMoistureGroupV1 Subsurf:O
essSubsurfaceSensorLocationGroupV5 Subsurf:O
essSubsurfaceSensorinformationGroupV5 Subsurf:O
essSnapshotCameraGroupV1l Camera:M
essSnapshotCameraFilenameGroupV5 Camera:M
essWaterLevelSensorDataGroupV4 Water:M
essWaterLevelSensorConfigurationGroupV4 Water:O
essWaterLevelSensorLocationGroupV5 Water:O
essWaterLevelSensorinformationGroupV5 Water:O
essAirQualityCOGroupV2 CO:M
essAirQualityNO2GroupV?2 NO2:M
essAirQualitySO2GroupV?2 SO2:M
essAirQualityPM10GroupV2 PM10:M
essAirQualityCO2GroupV4 co2:M
essAirQualityNOGroupV4 NO:M
essAirQualityO3GroupV4 0o3:M
essAirQualityPM25GroupV4 PM25:M
essAirQualitySensorLocationGroupVs Air:0
essAirQualitySensorinformationGroupV5 Air:0
ptsTreatmentGroupV1 PTS:M
ptsMobileTreatmentGroupV1 PTS:O
ptsSignalDurationGroupV2 PTS:O
ptsMonitoringDetectorsGroupV2 PTS:.O
ptsStatusGroupV?2 PTS:O
ptsOperationGroupV3 PTS:.O
ptsTimeGroupV5

ptsLocationGroupV5 PTS:.O
ptsinformationGroupV5 PTS:.O
essPrecipSituationGroupV1 @)
essVisibilitySituationGroupV1 @)
essWindSituationGroupV?2 @)
essCloudSituationGroupV4 @)
essPrecipSituationGroupV4 @)
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essGroundStateGroupV4
essPavementObservationGroupV4

O|0

A5 Object Refinements

The syntax of the refinement column of the table follows the formats defined in RFC 2580, Section 5.4.3.
However, rather than repeating text for each version, the table allows a concise representation of the
restrictions when no change is made and a clearer indication when revisions are made.

To conform to this MIB, implementations shall:

» support the defined MAX-ACCESS of each supported object, unless the object refinement table
indicates a different minimum access;

* support at least the access defined when the object refinement table indicates a refined access
for the object type;

» support the full range of values defined by the SYNTAX for each supported object, unless the
object refinement table indicates a different SYNTAX;

* support at least the range of values defined when the object refinement table indicates a refined
syntax for the object type.

NOTE 1— The refined access or syntax includes any text in the DESCRIPTION field.

NOTE 2— Information in the table regarding versions prior to v04 are informative interpretations of the
previous versions and not normative.

Table 10 indicates the object refinements for the object types used by NTCIP 1204.

Table 10: Object Refinements for NTCIP1204-Ess MIB

Obj Versions Refinement
essPressureSensorHeight
v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPressureSensorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPressureSensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPressureSensorLocation

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

essPressureSensorXOffset
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v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
essPressureSensorYOffset
v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
essPressureSensorZOffset
v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
windSensorHeight
v02-v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is

optional."

windSensorLocation

v02-v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only

DESCRIPTION "Support for setting this object is

optional.
characters;

Implementations shall support all NVT ASCII
support for other characters is optional."

windSensorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
windSensorLongitude
v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
windSensorXOffset
v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
windSensorYOffset
v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
windSensorZOffset
v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
essTemperatureSensorHeight
v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is

optional."

essTemperatureSensorLatitude
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Refinement

v04

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essTemperatureSensorLongitude

v04

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essTemperatureSensorLocation

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only

DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

essTemperatureSensorXOffset

v05

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essTemperatureSensorYOffset

v05

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essTemperatureSensorzOffset

v05

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

waterLevelSensorWarningLevel

v04-v05

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

waterLevelSensorHeight

v04

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

waterLevelSensorLatitude

v04

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

waterLevelSensorLongitude

v04

MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

waterLevelSensorLocation

v04

MIN-ACCESS read-only

DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."
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v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

waterLevelSensorReferencePoint

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCIT
characters; support for other characters is optional."

waterLevelSensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

waterLevelSensorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

waterLevelSensorzOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

precipitationSensorHeight

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

precipitationSensorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

precipitationSensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

precipitationSensorLocation

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

precipitationSensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
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precipitationSensorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

precipitationSensorZOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

humiditySensorHeight

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

humiditySensorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

humiditySensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

humiditySensorLocation

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

humiditySensorTemperatureInformation
v04-v05 DESCRIPTION "The value must reference an active
temperature sensor."

humiditySensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

humiditySensorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

humiditySensorZOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

radiationSensorHeight

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
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radiationSensorLatitude
v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

radiationSensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

radiationSensorLocation

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

radiationSensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

radiationSensorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

radiationSensorzOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

visibilitySensorHeight

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

visibilitySensorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

visibilitySensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

visibilitySensorLocation
v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."
v05 MIN-ACCESS read-only
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DESCRIPTION "Support
optional.
characters;

for setting this object is

Implementations shall support all NVT ASCII
support for other characters is optional."

visibilitySensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support
optional."

for setting this object is

visibilitySensorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support
optional."

for setting this object is

visibilitySensorzZOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support
optional."

for setting this object is

essPavementSensorLocation

v01-04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

essPavementType
v01l-vO05 MIN-ACCESS read-only

DESCRIPTION "Support
optional."

for setting this object is

essPavementElevation

v0l-v04 MIN-ACCESS read-only
DESCRIPTION "Support
optional."

for setting this object is

essPavementExposure

v01l-v05 MIN-ACCESS read-only
DESCRIPTION "Support

optional."

for setting this object is

essPavementSensorType

v01l
contactPassive
contactActive
infrared (4),
radar (5),
vibrating (6),
microwave (7) 1}
DESCRIPTION "Version
values."

(2),
(3),

SYNTAX INTEGER { other

(1),

1 only supported the first seven

v02-v04
contactPassive
contactActive
infrared (4),

(2),
(3),

SYNTAX INTEGER { other

(1),
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radar (5),

vibrating (6),

microwave (7),

laser (8) }

DESCRIPTION "Version 2 added the value for laser."
v05 SYNTAX INTEGER { other (1),

contactPassive (2),

contactActive (3),

infrared (4),

radar (5),

vibrating (6),

microwave (7),

laser (8),

audio (9) }

DESCRIPTION "Version 5 added the value for audio."

essPavementSensorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementSensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementMonitorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementMonitorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementMonitorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementMonitorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementMonitorzOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementSensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementSensorYOffset
v05 MIN-ACCESS read-only
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DESCRIPTION "Support for setting this object is
optional."

essSubSurfaceSensorLocation

v01-04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

essSubSurfaceType
v01l-v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essSubSurfaceSensorDepth
v01l-vO05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essSubSurfaceSensorLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essSubSurfaceSensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essSubSurfaceSensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essSubSurfaceSensorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPaveTreatProductType
v01l-v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is optional
for mobile pavement treatment systems."

essPaveTreatProductForm
v01l-v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is optional
for mobile pavement treatment systems."

essPaveTreatProductMix
v01l-vO05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is optional
for mobile pavement treatment systems."

essPaveTreatmentAmount
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v01l-v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is optional
for mobile pavement treatment systems."

essPaveTreatmentWidth
v01l-v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is optional
for mobile pavement treatment systems."

ptsCommandState
v02 WRITE-SYNTX INTEGER { activate (3) }
DESCRIPTION "The values other and inactive are read-only
values."

ptsSignalDuration
v02-v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is optional
for mobile pavement treatment systems."

ptsCommandStateV3
v03-v05 WRITE-SYNTX INTEGER { activate (3) }
DESCRIPTION "The values other and inactive are read-only
values."

essPavementTreatmentLatitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementTreatmentLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essPavementTreatmentLocation

04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

ptsXOffset
v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."
ptsYOffset
v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

airQualitySensorHeight

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

airQualitySensorLatitude
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v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

airQualitySensorLongitude

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

airQualitySensorLocation

v04 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations only support NVT ASCII as the
object was defined as a DisplayString."

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional. Implementations shall support all NVT ASCII
characters; support for other characters is optional."

airQualitySensorXOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

airQualitySensorYOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

airQualitySensorzZOffset

v05 MIN-ACCESS read-only
DESCRIPTION "Support for setting this object is
optional."

essSnapshotCameraDescription

v02-v04 DESCRIPTION "Implementations only support NVT ASCII as
the object was defined as a DisplayString."
v05 DESCRIPTION "Implementations shall support all NVT ASCII

characters; support for other characters is optional."

essSnapshotCameraStoragePath

v02-v04 DESCRIPTION "Implementations only support NVT ASCII as
the object was defined as a DisplayString."
v05 DESCRIPTION "Implementations shall support all NVT ASCII

characters; support for other characters is optional."

essSnapshotCameraFilename
v03-v04 DESCRIPTION "Implementations may limit the range of
valid characters to NVT ASCII."

essSnapshotCameraFileFormat
v05 DESCRIPTION "Implementations are only required to
support text strings corresponding to the supported
formats as defined in
essSnapshotCameraSupportedFormats."

essSnapshotCameraFilenameV5
v05 DESCRIPTION "Implementations shall support all NVT ASCII
characters; support for other characters is optional."
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Annex B
Object Tree [Informative]

The following listing provides the Environmental Sensor Station Object Tree Structure as provided by
smidump. The tree structure identifies how the object definitions are combined under specific nodes.
Each row in the tree starts with a five field code. The first field indicates the status of the item as follows:

+ = the item is current
x = the item is deprecated
o = the item is obsolete

The next two fields are not used in this listing. The fourth field indicates "r" if the item allows read
operations and "-" otherwise. The fifth field indicates "w" if the item allows write operations and "-"

otherwise.

---- €55(1.3.6.1.4.1.1206.4.2.5)
+---- essBufr(1)
| +---- essBufrinstrumentation(2)
| | +--r- essTypeofStation(1)
| x---- essBufrLocationVertical(7)
| | x--r- essAtmosphericPressure(4)
| +---- essBufrwind(11)
| x--r- essAvgWindDirection(1)
| x--r- essAvgWindSpeed(2)
| x--r- essMaxWindGustSpeed(41)
| x--r- essMaxWindGustDir(43)
+---- essBufrPrecip(13)
| x--r- essRelativeHumidity(3)
| x--r- essPrecipRate(14)
| x--r- essSnowfallAccumRate(15)
| x--r- essPrecipitationOneHour(19)
| x--r- essPrecipitationThreeHours(20)
| x--r- essPrecipitationSixHours(21)
| x--r- essPrecipitationTwelveHours(22)
| x--r- essPrecipitation24Hours(23)
+---- essBufrRadiation(14)
x--r- essInstantaneousTerrestrialRadiation(17)
X--r- esslnstantaneousSolarRadiation(18)
x--r- essSolarRadiation(24)
x--r- essTotalRadiation(25)
X--r- essTotalSun(31)
+---- essNtcip(2)
| +---- essNtcipldentification(1)
| | x--r- essNtcipCategory(1)
| | x--rw essNtcipSiteDescription(2)
| +---- essNtcipLocation(2)
| x--r- essLatitude(1)
| x--r- essLongitude(2)
| x--r- essVehicleSpeed(3)
| x--r- essVehicleBearing(4)
| x--r- essOdometer(5)
x---- essNtcipHeight(3)
|
|

x--r- essReferenceHeight(1)
X--r- essPressureHeight(2)

I
I
I
I
I
I
I
I
| | x--r- essWindSensorHeight(3)
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+---- essNtcipWind(4)

| x--r- essSpotWindDirection(1)
| x--r- essSpotWindSpeed(2)

| +--r- essWindSituation(3)

| +--r- windSensorTableNumSensors(7)

| +---- windSensorTable(8)

| +---- windSensorEntry(1) [windSensorindex]
| +--r- windSensorindex(1)

| x--rw windSensorHeight(2)

| +--rw windSensorLocation(3)

| +--r- windSensorAvgSpeed(4)

| +--r- windSensorAvgDirection(5)

| +--r- windSensorSpotSpeed(6)

| +--r- windSensorSpotDirection(7)

| +--r- windSensorGustSpeed(8)

| +--r- windSensorGustDirection(9)

| +--r- windSensorSituation(10)

| X--rw windSensorLatitude(11)

| X--rw windSensorLongitude(12)

| x--r- windSensorModellnformation(13)
| +--rw windSensorXOffset(14)

| +--rw windSensorY Offset(15)

| +--rw windSensorZOffset(16)

| +--r- windSensorEntityID(17)

+---- essNtcipTemperature(5)

| +--r- essNumTemperatureSensors(1)

| +---- essTemperatureSensorTable(2)

| +--r- essTemperatureSensorindex(1)
X--rw essTemperatureSensorHeight(2)
+--r- essAirTemperature(3)
X--rw essTemperatureSensorLatitude(4)
X--rw essTemperatureSensorLongitude(5)
+--rw essTemperatureSensorLocation(6)
X--rw essTemperatureSensorModellnformation(7)
+--rw essTemperatureSensorXOffset(8)
+--rw essTemperatureSensorY Offset(9)
+--rw essTemperatureSensorZOffset(10)
+--r- essTemperatureSensorEntitylD(11)

|

|1

|1

|1

|1

|1

|1

|1

|1

|1

|1

| x--r- essWetbulbTemp(3)
| x--r- essDewpointTemp(4)
| +--r- essMaxTemp(5)

| +--r- essMinTemp(6)
+---- essNtcipPrecip(6)

| x--r- essWaterDepth(1)

| x--r- essAdjacentSnowDepth(2)

| x--r- essRoadwaySnowDepth(3)

| x--r- essRoadwaySnowPackDepth(4)

| x--r- essPrecipYesNo(5)

| +--r- essPrecipSituation(6)

| x--r- esslceThickness(7)

| x--r- essPrecipitationStartTime(8)

| x--r- essPrecipitationEndTime(9)

| x--rw precipitationSensorModellnformation(10)
| +--r- waterLevelSensorTableNumSensors(11)
| +---- waterLevelSensorTable(12)
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+---- waterLevelSensorEntry(1) [waterLevelSensorindex]

+--r- waterLevelSensorindex(1)

+--r- waterLevelSensorReading(2)

+--rw waterLevelSensorWarningLevel(3)

X--rw waterLevelSensorHeight(4)

X--rw waterLevelSensorLatitude(5)

X--rw waterLevelSensorLongitude(6)

+--rw waterLevelSensorLocation(7)

X--rw waterLevelSensorModellnformation(8)

+--rw waterLevelSensorReferencePoint(9)

+--rw waterLevelSensorXOffset(10)

+--rw waterLevelSensorYOffset(11)

+--rw waterLevelSensorZOffset(12)

+--r- waterLevelSensorEntitylD(13)
+--r- precipitationSensorTableNumSensors(13)
+---- precipitationSensorTable(14)
| +---- precipitationSensorEntry(1) [precipitationSensorindex]
| +--r- precipitationSensorindex(1)
X--rw precipitationSensorHeight(2)
X--rw precipitationSensorLatitude(3)
X--rw precipitationSensorLongitude(4)
+--rw precipitationSensorLocation(5)
X--rw precipitationSensorModellnformationV4(6)
+--rw precipitationSensorPeriod(7)
+--r- precipitationSensorAdjacentSnowDepth(8)
+--r- precipitationSensorRoadwaySnowDepth(9)
precipitationSensorRoadwaySnowPackDepth(10)
precipitationSensorPrecipYesNo(11)
precipitationSensorPrecipRate(12)
precipitationSensorSnowfallAccumRate(13)
precipitationSensorPrecipSituation(14)
precipitationSensorlceThickness(15)
precipitationSensorPrecipitationStartTime(16)
precipitationSensorPrecipitationEndTime(17)
precipitationSensorPrecipitationOneHour(18)
precipitationSensorPrecipitationThreeHours(19)
p
p
p
p
p
p
p
p

recipitationSensorPrecipitationSixHours(20)
recipitationSensorPrecipitationTwelveHours(21)
recipitationSensorPrecipitation24Hours(22)
recipitationSensorPrecipitationUserDefined(23)
recipitationSensorPrecipStartDate(24)
recipitationSensorPrecipStartTimeV5(25)
recipitationSensorPrecipEndDate(26)
recipitationSensorPrecipEndTimeV5(27)
+--rw precipitationSensorXOffset(28)
+--rw precipitationSensorY Offset(29)
+--rw precipitationSensorZOffset(30)
+--r- precipitationSensorEntitylD(31)
+--r- humiditySensorTableNumSensors(15)
+---- humiditySensorTable(16)
+---- humiditySensorEntry(1) [humiditySensorindex]

+--r- humiditySensorindex(1)

x--rw humiditySensorHeight(2)

x--rw humiditySensorLatitude(3)

x--rw humiditySensorLongitude(4)

+--rw humiditySensorLocation(5)

+--r-
+--r-
+--r-
+--r-
+--r-
X--r-
X--r-
X--r-
+--I-
+--I-
+--I-
+--r-
+--r-
+--r-
+--r-
+--r-
+--I-
+--I-
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| x--rw humiditySensorModellnformation(6)
| +--r- humiditySensorRelativeHumidity(7)
| +--rw humiditySensorTemperaturelnformation(8)
| +--r- humiditySensorWetbulbTemp(9)
| +--r- humiditySensorDewpointTemp(10)
| +--rw humiditySensorXOffset(11)

| +--rw humiditySensorYOffset(12)

| +--rw humiditySensorZOffset(13)

| +--r- humiditySensorEntitylD(14)

+---- essNtcipRadiation(7)

| x--r- essCloudSituation(1)

| +--r- essTotalRadiationPeriod(2)

| +--r- radiationSensorTableNumSensors(3)

| +---- radiationSensorTable(4)

| | +---- radiationSensorEntry(1) [radiationSensorindex]
| | +--r- radiationSensorindex(1)

| | x--rw radiationSensorHeight(2)
| | x--rw radiationSensorLatitude(3)
| | x--rw radiationSensorLongitude(4)
| | +--rwradiationSensorLocation(5)
| | x--rw radiationSensorModellnformation(6)

| | +--r- essTotalSunVv4(7)

| | +--r- essinstantaneousTerrestrialRadiationV4(8)
| | +--r- essinstantaneousSolarRadiationV4(9)

| | +--r- essTotalRadiationV4(10)

| | +--rw radiationSensorXOffset(11)

| | +--rw radiationSensorYOffset(12)

| | +--rw radiationSensorZOffset(13)

| | +--r- radiationSensorEntitylD(14)

| +--r- essCloudSituationV4(5)

+---- essNtcipVisibility(8)

| x--r- essVisibility(1)

| +--r- essNumVisibilitySensors(2)

| +--r- essVisibilitySituation(3)

| x--rw visibilitySensorHeight(4)

| x--rw visibilitySensorLatitude(5)

| x--rw visibilitySensorLongitude(6)

| x--rw visibilitySensorLocation(7)

| x--rw visibilitySensorModellinformation(8)

| +---- essVisibilitySensorTable(9)

|
|
|
|
|
|
|
|

+---- essVisibilitySensorindex(1)
+--rw essVisibilitySensorLocation(2)
+--rw essVisibilitySensorXOffset(3)
+--rw essVisibilitySensorY Offset(4)
+--rw essVisibilitySensorZOffset(5)
+--r- essVisibilitySensorDirection(6)
+--r- essVisibilitySensorEntityID(7)
+--r- essVisibilitySensorCurrentReading(8)

---- essNtcipPavement(9)

+--r- numEssPavementSensors(1)

---- essPavementSensorTable(2)

+--r- essPavementSensorindex(1)
+--rw essPavementSensorLocation(2)
+--rw essPavementType(3)
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+
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|
I
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| | x--rwessPavementElevation(4)
| | +--rw essPavementExposure(5)
| | +--r- essPavementSensorType(6)
| | x--r- essSurfaceStatus(7)

| | +--r- essSurfaceTemperature(8)
| | +--r- essPavementTemperature(9)
| | x--r- essSurfaceWaterDepth(10)
| | +--r- essSurfaceSalinity(11)

| | x--r- essSurfaceConductivity(12)

| | +--r- essSurfaceFreezePoint(13)

| | +--r- essSurfaceBlacklceSignal(14)

| | +--r- essPavementSensorError(15)

| | +--r- essSurfacelceOrWaterDepth(16)

| | +--r- essSurfaceConductivityV2(17)

| | x--rw pavementSensorModellnformation(18)

| | +--r- pavementSensorTemperatureDepth(19)

| | x--rw pavementSensorLatitude(20)

| | x--rw pavementSensorLongitude(21)

| | +--r- pavementSensorSurfaceCondition(22)

| | +--r- pavementSensorForecastCondition(23)

| | +--r- pavementSensorFrictionCoefficient(24)

| | x--rw pavementMonitorLatitude(25)

| | x--rw pavementMonitorLongitude(26)

| | +--r- pavementicePercentage(27)

| | +--rw essPavementMonitorXOffset(28)

| | +--rw essPavementMonitorY Offset(29)

| | +--rw essPavementMonitorZOffset(30)

| | +--rw essPavementSensorXOffset(31)

| | +--rw essPavementSensorYOffset(32)

| | +--r- essPavementSensorEntitylD(33)

| +--r- numEssSubSurfaceSensors(3)

| +---- essSubSurfaceSensorTable(4)

| | +---- essSubSurfaceSensorEntry(1) [essSubSurfaceSensorindex]
| | +--r- essSubSurfaceSensorindex(1)

| | +--rw essSubSurfaceSensorLocation(2)

| | +--rw essSubSurfaceType(3)

| | +--rw essSubSurfaceSensorDepth(4)

| | +--r- essSubSurfaceTemperature(5)

| | +--r- essSubSurfaceSensorEntitylD(6)

| | +--r- essSubSurfaceMoisture(7)

| | +--r- essSubSurfaceSensorError(8)

| | x--rw essSubSurfaceSensorLatitude(9)

| | x--rw essSubSurfaceSensorLongitude(10)

| | x--rw essSubSurfaceSensorModellnformation(11)

| | +--rw essSubSurfaceSensorXOffset(12)

| | +--rw essSubSurfaceSensorYOffset(13)

| - essPavementBlock(5)

| - essSubSurfaceBlock(6)

| x--r- essPavementV3Block(7)

+---- essNtcipMobile(10)

| x--r- essMobileFriction(1)

| x--r- essMobileObservationGroundState(2)

| x--r- essMobileObservationPavement(3)

| +--r- essMobileObservationGroundStateV4(4)

| +--r- essMobileObservationPavementV4(5)

+---- essNtcipTreatment(11)
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I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
+
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

+--r- numEssTreatments(1)
+---- essPavementTreatmentTable(2)

| +---- essPavementTreatmentEntry(1) [essPavementTreatmentindex]

| +--r- essPavementTreatmentindex(1)
| +--rw essPaveTreatProductType(2)

| +--rw essPaveTreatProductForm(3)

| +--rw essPercentProductMix(4)

+--rw essPaveTreatmentAmount(3)

+--rw essPaveTreatmentWidth(4)

x--r- pavementTreatmentBlock(5)

o--rw ptsOperationalMode(6)

o--rw ptsCommandState(7)

+--r- ptsSprayerState(8)

+--rw ptsSignalDuration(9)

+--r- ptsSignalEventCount(10)

X--r- ptsLastSignalEvent(11)

+--r- ptsActiveEventCount(12)

+--r- ptsinactiveEventCount(13)

X--r- ptsLastActiveEvent(14)

X--r- ptsLastlnactiveEvent(15)

+--r- ptsError(16)

+--rw ptsMonitoringDetectors(17)

+--rw ptsOperationalModeV3(18)

+--rw ptsCommandStateVV3(19)

X--rw essPavementTreatmentLatitude(20)
X--rw essPavementTreatmentLongitude(21)
+--rw essPavementTreatmentLocation(22)
X--rw essPavementTreatmentModellnformation(23)
+--r- ptsLastSignalEventDate(24)

+--r- ptsLastSignalEventTime(25)

+--r- ptsLastActiveEventDate(26)

+--r- ptsLastActiveEventTime(27)

+--r- ptsLastInactiveEventDate(28)

+--r- ptsLastInactiveEventTime(29)

+--rw ptsXOffset(30)

+--rw ptsYOffset(31)

+--r- ptsEntitylD(32)

---- essNtcipAirQuality(12)

+--r- essCO(1)

X--r- essC02(2)

X--r- essNO(3)

+--r- essNO2(4)

+--r- essS02(5)

X--r- essO3(6)

+--r- essPM10(7)

X--r- essAirQualityBlock(8)

+--r- essPM25(9)

+--r- airQualitySensorTableNumSensors(10)
+---- airQualitySensorTable(11)

| +---- airQualitySensorEntry(1) [airQualitySensorindex]
| +--r- airQualitySensorindex(1)

| x--rw airQualitySensorHeight(2)

| x--rw airQualitySensorLatitude(3)

| x--rw airQualitySensorLongitude(4)

| +--rw airQualitySensorLocation(5)

|  x--rw airQualitySensorModellnformation(6)
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+--rw airQualitySensorXOffset(7)
+--rw airQualitySensorY Offset(8)
+--rw airQualitySensorZOffset(9)
+--r- airQualitySensorEntitylD(10)

-r- essCO2V4(13)

-r- essNOV4(14)

-r- essO3V4(15)

| +--r- essPM1(16)

+---- essNtcipWaterQuality(13)

+---- essNtcipSnapshot(14)

| +--r- essSnapshotNumberOfCameras(1)

| +---- essSnapshotCameraTable(2)

I
I
I
I
+-
+-
+-

| +---- essSnapshotCameraEntry(1) [essSnapshotCameralndex]

| +--r- essSnapshotCameralndex(1)

| +--rw essSnapshotCameraDescription(2)

| +--r- essSnapshotCameraStoragePath(3)

| +--rw essSnapshotCameraCommand(4)

| +--r- essSnapshotCameraError(5)

| X--rw essSnapshotCameraFilename(6)

| +--r- essSnapshotCameraSupportedFormats(7)
| +--rw essSnapshotCameraFileFormat(8)

| +--rw essSnapshotCameraFilenameV5(9)

| +--r- essSnapshotCameraEntity|D(10)

+---- essNtciplnstrumentation(15)
| x--r- essDoorStatus(1)

| x--r- essBatteryStatus(2)
| x--r- essLineVolts(3)

| x--r- essStationMetaDataBlock(4)
| x--r- essWeatherBlock(5)
| x--r- essMobileBlock(6)

| x--r- essStationMetaDataV3Block(7)
| x--r- essWeatherV3Block(8)

| x--r- essStatus(9)

+---- essNtcipPressure(16)

+--r- essNumPressureSensors(1)
+---- essPressureSensorTable(2)

+---- essPressureSensorEntry(1) [essPressureSensorindex]

+--r- essPressureSensorindex(1)

X--rw essPressureSensorHeight(2)

X--rw essPressureSensorLatitude(3)

X--rw essPressureSensorLongitude(4)

+--rw essPressureSensorLocation(5)

x--rw essPressureSensorModellnformation(6)
+--r- essPressureSensorAtmosphericPressure(7)
+--rw essPressureSensorXOffset(8)

+--rw essPressureSensorYOffset(9)

+--rw essPressureSensorZOffset(10)

+--r- essPressureSensorEntitylD(11)

+---- essConformance(127)

+---- essCompliances(1)

+---- essGroups(2)
+---- essControllerGroups(1)
| x---- essCharacteristicsGroupV1(1)
| x---- essMobileGroupV1(2)
| x---- essMobileFrictionGroupV1(3)
| x---- essDoorStatusGroupV2(4)
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x---- essBatteryGroupV2(5)

X---- essLineVoltsGroupV2(6)

x---- essMetaDataBlockGroupV2(7)
x---- essMobileBlockGroupV2(8)
x---- essWeatherBlockGroupV2(9)
x---- essMetaDataBlockGroupV3(10)
x---- essWeatherBlockGroupV3(11)
X---- essStatusGroupV3(12)

+---- essCharacteristicsGroupV5(13)

---- essPressureGroups(2)

X---- essPressureGroupV1(1)

x---- essPressureSensorLocationGroupV4(2)
x---- essPressureSensorinfoGroupV4(3)
+---- essPressureDataGroupV4(4)

+---- essPressureSensorLocationGroupV5(5)
+---- essPressureSensorinfoGroupV5(6)

---- essWindGroups(3)

X---- essWindGroupV1(1)

X---- essMobileWindGroupV1(2)

+---- essWindDataGroupV2(3)

x---- essWindSensorLocationGroupV2(4)
x---- essWindSensorLocationGroupV4(5)
x---- essWindSensorinfoGroupV4(6)
+---- essWindSensorLocationGroupV5(7)
+---- essWindSensorinfoGroupV5(8)

---- essTemperatureGroups(4)

+---- essTemperatureGroupV1(1)

x---- essTemperatureSensorLocationGroupV1(2)
x---- essTemperatureSensorLocationGroupV4(3)
x---- essTemperatureSensorinfoGroupV4(4)
+---- essTemperatureSensorLocationGroupV5(5)
+---- essTemperatureSensorinfoGroupV5(6)

---- essHumidityGroups(5)

X---- essHumidityGroupV1(1)

x---- essHumiditySensorLocationGroupV4(2)
x---- essHumiditySensorinfoGroupV4(3)
+---- essHumidityDataGroupV4(4)

+---- essHumiditySensorLocationGroupV5(5)
+---- essHumiditySensorinfoGroupV5(6)

---- essPrecipitationGroups(6)

x---- essPrecipPresenceGroupV1(1)

x---- essPrecipRateGroupV1(2)

x---- essPrecipTotalsGroupV1(3)

x---- essPrecipEmergingGroupV1(4)

x---- essPrecipSensorinfoGroupV2(5)

+---- essPrecipPresenceGroupV4(6)

x---- essPrecipDataGroupV4(7)

+---- essPrecipSituationGroupV4(8)

x---- essPreciplceThicknessGroupV4(9)
+---- essPrecipTotalsGroupV4(10)

+---- essPrecipUserTotalGroupV4(11)

x---- essPrecipSensorLocationGroupV4(12)
x---- essPrecipSensorinfoGroupV4(13)
+---- essPrecipDataGroupV5(14)

+---- essPrecipSensorLocationGroupV5(15)
+---- essPrecipSensorinfoGroupV5(16)
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| +---- essPrecipAdjacentSnowGroupV5(17)

| +---- essPrecipRoadwaySnowGroupV5(18)
+---- essRadiationGroups(7)

x---- essRadiationGroupV1(1)

x---- essRadiationGroupV2(2)

+---- essRadiationDataGroupV4(3)

x---- essRadiationSensorLocationGroupV4(4)
x---- essRadiationSensorinfoGroupV4(5)

+---- essRadiationSensorLocationGroupV5(6)
+---- essRadiationSensorinfoGroupV5(7)

---- essVisibilityGroups(8)

x---- essVisibilityGroupV1(1)

+---- essVisibilitySituationGroupV1(2)

x---- essVisibilitySensorLocationGroupV4(3)
x---- essVisibilitySensorinfoGroupV4(4)

+---- essVisibilityDataGroupV5(5)

+---- essCloudSituationGroupV5(6)

+---- essVisibilitySensorLocationGroupV5(7)
+---- essVisibilitySensorinfoGroupV5(8)

---- essPavementGroups(9)

+---- essPavementSensorCountGroupV1(1)
+---- essPavementSensorMetaDataGroupV1(2)
x---- essPavementSensorSurfaceStatusGroupV1(3)
x---- essPavementSensorElevationGroupV1(4)
+---- essPavementSurfaceTempGroupV1(5)
x---- essPavementEnhancedGroupV1(6)

x---- essSurfaceConductivityGroupV1(7)

+---- essSurfaceSalinityGroupV1(8)

+---- essPavementFreezeGroupV1(9)

+---- essSurfaceConductivityGroupV2(10)

+---- essPavementTemperatureGroupV2(11)
x---- essPavementBlockGroupV2(12)

+---- essPavementSensorDepthGroupV2(13)
x---- essPavementSensorinfoGroupV2(14)

x---- essPavementBlockGroupV3(15)

+---- essPavementSurfaceCondGroupV4(16)
+---- essPavementFrictionGroupV4(17)

+---- essPavementicePercentGroupV4(18)

x---- essPavementSensorLocationGroupV4(19)
+---- essPavementForecastGroupV5(20)

+---- essPavementSensorLocationGroupV5(21)
+---- essPavementSensorinfoGroupV5(22)

---- essSubSurfaceGroups(10)

+---- essSubSurfaceSensorCountGroupGroupV1(1)
+---- essSubSurfaceMoistureGroupV1(2)

x---- essSubSurfaceBlockGroupV2(3)

x---- essSubSurfaceSensorLocationGroupV4(4)
x---- essSubSurfaceSensorinfoGroupV4(5)
+---- essSubSurfaceDataGroupV5(6)

+---- essSubSurfaceSensorMetaDataGroupV5(7)
+---- essSubSurfaceSensorLocationGroupV5(8)
+---- essSubSurfaceSensorinfoGroupV5(9)
+---- essSnapshotGroups(11)

| +---- essSnapshotCameraGroupV2(1)

| x---- essSnapshotFilenameGroupV3(2)

| +---- essSnapshotFilenameGroupV5(3)

- t----- 0+ -+ -
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| +---- essSnapshotCameralnfoGroupV5(4)

+---- essObservedGroups(12)

| x---- essObservedReadingGroupV1(1)

| x---- essMobileObservationGroupV1(2)

| +---- essObservedReadingGroupV4(3)

| +---- essObservedGroundStateGroupV4(4)

| +---- essObservedPavementStateGroupV4(5)

+---- essWaterLevelGroups(13)

| x---- essWaterDepthGroupV1(1)

| +---- essWaterLevelDataGroupV2(2)

| +---- essWaterLevelSensorConfigurationGroupV4(3)
| x---- essWaterLevelSensorLocationGroupV4(4)

| x---- essWaterLevelSensorinfoGroupV4(5)

| +---- essWaterlLevelSensorLocationGroupV5(6)

| +---- essWaterLevelSensorinfoGroupV5(7)

+---- essAirQualityGroups(14)

| +---- essAirQualityCOGroupV1(1)

| x---- essAirQualityCO2GroupV1(2)

| x---- essAirQualityNOGroupV1(3)

| +---- essAirQualityNO2GroupV1(4)
| +---- essAirQualitySO2GroupV1(5)

| x---- essAirQualityO3GroupV1(6)

| +---- essAirQualityPM10GroupV1(7)
| x---- essAQBIlockGroupV2(8)

| +---- essAirQualityCO2GroupV4(9)
| +---- essAirQualityNOGroupV4(10)
| +---- essAirQualityO3GroupV4(11)

| +---- essAirQualityPM25GroupV4(12)
| x---- essAirQualitySensorLocationGroupV4(13)
| x---- essAirQualitySensorinfoGroupV4(14)

| +---- essAirQualityPM1GroupV5(15)

| +---- essAirQualitySensorLocationGroupV5(16)
| +---- essAirQualitySensorinfoGroupV5(17)
+---- essPavementTreatmentGroups(15)

+---- ptsProductGroupV1(1)

+---- ptsSpreadConfigGroupV1(2)

X---- ptsStatusGroupV2(3)

+---- ptsConfigurationGroupV2(4)

0---- ptsCommandGroupV2(5)

x---- essPtsBlockGroupV2(6)

+---- ptsOperationGroupV3(7)

+---- ptsCommandGroupV3(8)

x---- ptsLocationGroupV4(9)

x---- ptsinfoGroupV4(10)

+---- ptsStatusGroupV5(11)

+---- ptsLocationGroupV5(12)

+---- ptsinfoGroupV5(13
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Annex C
Test Procedures [Normative]

CA1 Purpose

Test procedures for testing an implementation of this document are available at https://github.com/ite-
org/NTCIP1204.
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Annex D
Documentation of Revisions [Informative]

Annex D identifies the changes that have been made to this document. The NTCIP effort makes
reasonable efforts to ensure that standards are as backward compatible as possible, but the primary
purpose of this document is to provide interoperability by developing standards in a consensus
environment. When changes are required to meet these objectives, the problematic objects are refined (if
the issue is primarily editorial) or deprecated and, in most cases, replaced with new objects. Annex D
identifies why each of these changes has been made. New implementations should support the
new/replacement objects; they may also support deprecated objects.

D.1 NTCIP 1204 v04 to NTCIP 1204 v05

The motivation behind the vO5 update was to enhance the security of NTCIP devices. This entailed
revising the MIB to conform to SMIv2 conventions, as normally used with SNMPV3, and ensuring that the
structure of object-types allow for easy management of access control. The references in the document
were also updated to reference ISO 26048-1 and ISO 15784-2 rather than NTCIP 1201 and NTCIP 1103
to leverage work already developed by others and to reflect a more international design (e.g., by revising
text fields to support UTF-8 character encodings rather than just ASCII). Specific changes are listed
below.

D.1.1 Update MIB from SMiv1 to SMiv2 format

In order to enhance the security of NTCIP, the protocol migrated from SNMPv1 to SNMPv3. SNMPv1 is
designed to exchange objects defined in a MIB conforming to the Structure and Management of
Information version 1 (i.e., SMlvl), as defined in RFC 1155, RFC 1212, and RFC 1213. SNMPV3 is
designed to exchange objects defined in a MIB conforming to SMIv3, as defined in RFC 2578, RFC 2579,
and RFC 2580. While the MIB formats are similar, There were several changes required as described
below.

D.1.1.1 Removal of Header

The header that preceded the MIB was removed from the standard. The filename was not needed and
the description was moved into the MODULE-IDENTITY macro within the body of the MIB.

D.1.1.2 Change to Imports Clause

The IMPORTS clause was updated to replace the import of foundational concepts from RFC 1155, 1212,
1213 with the import of similar concepts from RFC 2578, 2579, 2580, and 3411.

D.1.1.3 Declaration of Module Identity
A module identity was added to formally declare the module's intent and to provide a revision history.
D.1.1.4 Declaration of Object Identities

Object nodes, which used to be defined as simple OBJECT IDENTIFERS, were replaced with OBJECT-
IDENTITY macros so that a description and status would be formally associated with these nodes.

D.1.1.5 Revisions to Syntax

The SYNTAX clause of each OBJECT-TYPE was reviewed and updated as needed to conform to SMiv2
rules. Ranged integers were generally converted to "Integer32", to minimize backwards compatibility
issues; however, integers that provided a 4-octet unsigned range (e.g., "0.. 4294967295") were generally

Do Not Copy Without Written Permission © 2022 AASHTO / ITE / NEMA



NTCIP 1204 v04.26
Page 297

converted to "Unsigned32". DisplayStrings were generally converted to SnmpAdminStrings to allow for
non-English (i.e., UTF-8) characters. Counters were reviewed to ensure that the semantics conformed to
teh requirements of a counter.

D.1.1.6 Revision of Units

The units of an object type, which had previously been captured within a "<Units>" subclause of the
DESCRIPTION clause, were moved to the UNITS clause defined by SMIv2.

D.1.1.7 Revision of Access

The ACCESS clause of SMIv1 was revised to become the MAX-ACCESS clause defined by SMIv2. The
object refinement table in Annex A identifies any instances where implementations are allowed to support
a lower level of access, as defined by the MIN-ACCESS clause.

D.1.1.8 Revision of Status

The status clause was revised from a poorly-defined indication of conformance to a simple indication of
whether the item is "current", "deprecated", or "obsolete". Conformance within NTCIP is still defined by

the PRL and RTM.
D.1.1.9 Addition of Object Groups

Within SNMPv3, an implementation's support of capabilities is indicated through an AGENT-
CAPABILITIES macro provided in a separate file. This statement relies upon the definition of OBJECT-
GROUPs. As such, OBJECT-GROUPs were added to the MIB to allow use of this feature rather than the
less descriptive historically used NTCIP format that only indicated the standard versions that the
implementation supported.

D.1.1.10 Version History of Object Groups

Within SMIv2, conformance requirements for a MIB are usually defined by a MODULE-COMPLIANCE
macro. Within NTCIP, the PRL and RTM provide a more robust solution to defining conformance. As a
result, NTCIP MIBs do not contain MODULE-COMPLIANCE statements but this results in losing details
about when object groups were added and deprecated from design. Within NTCIP, this information is
captured within the name and description field of object groups. The version in which an object group was
added is reflected by the "V" number at the end of the object group's name. The version in which it was
made obsolete is either indicated by the "V" number of the group's superseding object, or shown within
the "<Withdrawn>" subclause, if the group is not superseded.

D.1.1.11 Addition of Object Refinement Table

Within SMIv2, object definitions can be refined within the MODULE-COMPLIANCE macro. For example,
object ranges can be refined to allow implementations to support a defined minimum subrange of the full
range defined for the object in the MIB. This is particularly useful for showing the evolution of enumerated
lists and showing which versions of a MIB support which enumerated values. Because NTCIP standards
do not include the MODULE-COMPLIANCE macro, this information is provided in the object refinement
table provided in Annex A. The "Refinements" column of this table conforms to the format defined in RFC
2580 for defining these types of refinements.

D.1.1.12 Object Ranges

The text at the top of Section 5 was revised to follow standard SNMP conventions and to require the
support for the full range of an object, unless explicitly stated in the object refinement table.

D.1.2 Revisions for SNMPv3

In addition to the general refinements to support SMIv2, SNMPv3 required an update to error codes.

In some locations, Section 4 and 5 refer to specific SNMP error codes to be used. The error codes
provided in SNMPv3 are more extensive than those provided in SNMPvV1; as a result, this text has been
updated to reflect the correct SNMPv3 error codes to be used.
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D.1.3 Replace NTCIP 1201 and NTCIP 1103 with ISO 26048-1

Most of the objects defined within NTCIP 1201 and NTCIP 1103 had to be deprecated due to a variety of
reasons, but the most common reason was that the tables were not defined to easily allow different
management systems to manage their own rows within tables. Rather than reproducing these tables from
scratch, the NTCIP community decided to adopt the objects defined in ISO 26048-1 since these were
largely based on the NTCIP design but updated to implement the desired changes. Adopting ISO 26048-
1 resulted in the following specific changes.

D.1.3.1 Replacement of User Needs

Many of the generic user needs previously contained in NTCIP 1204 (and which had been planned to
migrate to NTCIP 1201) were deleted and replaced with references to specific user needs defined in ISO
26048-1. This effected the following user needs:

a) Architectural Needs

b) Retrieve ESS Characteristics simplified to Retrieve ESS Type of Station
¢) Generic Features

d) Monitor Door Status

e) Monitor Power

f)  Monitor the Status of the ESS

D.1.3.2 Adopting ISO 26048-1 Traceability Tables

Rather than repeating the traceability defined in ISO 26048-1, the PRL in this document references the
traceability tables defined for ISO 26048-1.

D.1.3.3 Adopting Textual Conventions

This document imports the following textual conventions from 1SO 26048-1:
a) ITSDailyTimeStamp and ITSDateStamp: Used to replace references to time, which was

previously based on a 4-octet unsigned integer that createed problems in implementations. The
new approach allows for a time range without rollover issues and provides a resolution down to
milliseconds.

b) ITSIntegerl6: This is a textual convention for a 2-octet integer.

c) ITSOerString: This is a textual convention to represent an OER string in a manner that will allow
management stations to automatically display the value appropriately.

Changing the way time was handled was required due to the invalid use of an unsigned 4-octet integer in
the previous version. To overcome this problem, the ITSDailyTimeStamp and ITSDateStamp textual
conventions were used to replace the following objects:

a) precipitationSensorPrecipitationStartTime superseded by precipitationSensorPrecipStartDate and

precipitationSensorPrecipStartTimeV5

b) precipitationSensorPrecipitationEndTime superseded by precipitationSensorPrecipEndDate and
precipitationSensorPrecipEndTimeV5

c) ptsLastSignalEvent superseded by ptsLastSignalEventDate and ptsLastSignalEventTime

d) ptsLastActiveEvent superseded by ptsLastActiveEventDate and ptsLastActiveEventTime

e) ptsLastinactiveEvent superseded by ptsLastinactiveEventDate and ptsLastlnactiveEventTime

D.1.3.4 Reference to Physical Index

In addition, this document imports PhysicallndexOrZero from RFC 6933 so that the sensors can point to
their entry in the entity table, which is used by ISO 26048-1 rather than the previously defined NTCIP
module table. This resulted in the following changes:

e essPressureSensorModellnformation supplanted by essPressureSensorEntitylD

¢ windSensorModellnformation supplanted by windSensorEntitylD
e essTemperatureSensorModellnformation supplanted by essTemperatureSensorEntitylD
e waterLevelSensorModellnformation supplanted by waterLevelSensorEntitylD
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e precipitationSensorModellnformationV4 supplanted by precipitationSensorEntitylD

¢ humiditySensorModellinformation supplanted by humiditySensorEntity|D

¢ radiationSensorModellnformation supplanted by radiationSensorEntityID

¢ visibilitySensorModellnformation superseded by essVisibilitySensorEntitylD

e pavementSensorModellnformation supplanted by pavementSensorEntitylD

e essSubSurfaceSensorModelinformation supplanted by essSubSurfaceSensorEntitylD
o essPavementTreatmentModellnformation superseded by ptsEntitylD

e airQualitySensorModelinformation supplanted by airQualitySensorEntitylD

D.1.3.5 Replacement of General Object Types
The following objects were replaced with objects defined or referenced by ISO 26048-1:
o essNtcipCategory superseded by 1ISO26048-1-FieldDevice.fdMobility
o essNtcipSiteDescription supplanted by SNMPv2-MIB.sysLocation (RFC 3418)
e essDoorStatus superseded by 1SO26048-1-Srsa.fdSrsaTypeWarning.FDO
e essBatteryStatus superseded by 1ISO26048-1-Srsa.fdSrsaPortValue.FBC
e essLineVolts superseded by 1ISO26048-1-Srsa.fdSrsaPortValue.FLV
e essStatus superseded by 1ISO26048-1-Controller.fdControllerStatus
e esslLatitude superseded by 1ISO26048-1-FieldDevice.fdConfiguredLatitude
e esslLongitude superseded by 1ISO26048-1-FieldDevice.fdConfiguredLongitude
o essVehicleSpeed superseded by 1SO26048-1-FieldDevice.fdSpeed
e essVehicleBearing superseded by 1SO26048-1-FieldDevice.fdBearing
o essOdometer superseded by 1ISO26048-1-FieldDevice.fdOdometer
o essReferenceHeight superseded by 1ISO26048-1-FieldDevice.fdConfiguredElevation

D.1.3.6 Replaced Annex F and G with References to ISO 26048-1

The dialogs and processes defined in Annex F and G in the prior version of this document were intended
to migrate to NTCIP 1201. However, this information is already defined in ISO 26048-1 and has replaced
the material previously in Annex F and G.

D.1.4 Other Security Enhancements
In addition to the above, the following security enhancements were also made.
D.1.4.1 Added Security User Needs and Requirements

User needs and requirements were added to require conforming implementations to not support
SNMPv1. The support of unsecured protocols is itself a vulnerability. However, it is recognized that
deployment of SNMPv3 will require time; as such, the document implementations to support SNMPv1 but
classifies such devices as consistent rather than conformant.

D.1.4.2 Updated Security of Supporting Protocols

Prior versions of this document allowed snapshot camera images to be retrieved via FTP. This version
prohibits all unsecured protocols within conformant devices and instead relies upon the following
protocols:

a) HTTPS

b) SSH
c) SFTP

D.1.5 Updates to Conform to NTCIP 8004

The following changes were made to conform with NTCIP 8004.

© 2022 AASHTO / ITE / NEMA Do Not Copy Without Written Permission



NTCIP 1204 v04.26
Page 300

D.1.5.1 Deleted Tags

The following subclauses were deleted from the DESCRIPTION clause as they are not defined in NTCIP
8004 and were deemed to be unnecessary:
a) Descriptive Name

b) Data Concept Type

D.1.5.2 Added Tags

The following subclauses were added to the DESCRIPTION clause to conform to NTCIP 8004:
a) Superseded by
b) Supplanted by
¢) Withdrawn

D.1.5.3 Ensured Consistent Use of Tags

Other tags were applied more consistently by using a requirements management tool that allowed quick
analysis of which tags were used for each object type.

D.1.5.4 Updated Module Name

The name of the MIB module was updated to the format defined by NTCIP 8004. The new naming
convention conforms to broader MIB standards that do not change the module nhame with each new
version.

D.1.6 Conforming to Industry Resolution Standards

Objects related to latitude, longitude, and elevation did not conform to industry standards for centimeter-
level accuracy for latitude and longitude and decimeter accuracy for elevation. The objects were updated
to support this resolution. In addition, the position of sensors was changed to relative offsets from the
ESS reference location rather than their own latitude and longitude positions. This allows a mobile station
to have a constant offset for each sensor rather than requiring the RPU to constantly calculate the
respective latitude and longitude of each sensor.

o essPressureSensorHeight superseded by essPressureSensorZOffset

e essPressureSensorLatitude superseded by essPressureSensorY Offset

e essPressureSensorLongitude superseded by essPressureSensorXOffset

e windSensorHeight superseded by windSensorZOffset

e windSensorLatitude superseded by windSensorY Offset

¢ windSensorLongitude superseded by windSensorXOffset

e essTemperatureSensorHeight superseded by essTemperatureSensorZOffset
e essTemperatureSensorlLatitude superseded by essTemperatureSensorY Offset
e essTemperatureSensorLongitude superseded by essTemperatureSensorXOffset
o waterLevelSensorHeight superseded by waterLevelSensorZOffset

e waterLevelSensorlLatitude superseded by waterLevelSensorYOffset

o waterLevelSensorLongitude superseded by waterLevelSensorYOffset

e precipitationSensorHeight superseded by precipitationSensorZOffset

e precipitationSensorLatitude superseded by precipitationSensorY Offset

e precipitationSensorLongitude superseded by precipitationSensorXOffset

e humiditySensorHeight superseded by humiditySensorZOffset

e humiditySensorLatitude superseded by humiditySensorY Offset

e humiditySensorLongitude superseded by humiditySensorXOffset

o radiationSensorHeight superseded by radiationSensorZOffset

o radiationSensorLatitude superseded by radiationSensorY Offset

o radiationSensorLongitude superseded by radiationSensorXOffset

o visibilitySensorHeight superseded by essVisibilitySensorZOffset
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¢ visibilitySensorLatitude superseded by essVisibilitySensorY Offset

¢ visibilitySensorLongitude superseded by essVisibilitySensorXOffset

e essPavementElevation superseded by essPavementZOffset

e pavementSensorLatitude superseded by pavementSensorY Offset

e pavementSensorLongitude superseded by pavementSensorXOffset

e pavementMonitorLatitude superseded by essPavementMonitorYOffset

e pavementMonitorLongitude superseded by essPavementMonitorXOffset

e essSubSurfaceSensorlLatitude superseded by essSubSurfaceSensorY Offset

e essSubSurfaceSensorLongitude superseded by essSubSurfaceSensorXOffset
e essPavementTreatmentLatitude superseded by essPavementTreatmentYOffset
e essPavementTreatmentLongitude superseded by essPavementTreatmentXOffset
e airQualitySensorHeight superseded by airQualitySensorZOffset

e airQualitySensorLatitude superseded by airQualitySensorY Offset

e airQualitySensorLongitude superseded by airQualitySensorXOffset

D.1.7 Renumbering Requirements and Dialogs

The clause numbering of user needs and objects were retained compared to prior versions of this
document to facilitate traceability. However, the clause numbers for dialogs and requirements were
reordered to remove unnecessary clauses and provide a more organized listing.

D.1.8 Updated Reference Physical Architecture

The reference physical architecture was updated to conform with ARC-IT modelling conventions. The
architecture is consistent with the content of ARC-IT but is more detailed.

D.1.9 Updated References to ARC-IT Content

Prior versions of this document explained how its contents related to the National ITS Architecture. The
latest version of the National ITS Architecture is known as ARC-IT and the relationships to its content
have been updated to reflect the current version.

D.1.10 Other Revisions
Several other edits have been made as follows:
D.1.10.1 Removed Backward Compatibility Needs

SNMPV3 is not backwards compatible with SNMPv1. As such, there was little benefit in including user
needs and requirements for backwards compatibility in this version. It is expected that future versions will
re-introduce backward compatibility requirements with this version.

D.1.10.2 Updated Boilerplate

The upgrade to SNMPv3 is requiring an update to all NTCIP standards. As a part of this process, the
boilerplate text throughout the document is being made more consistent to minimize any unintended
interpretations.

D.1.10.3 Updated all references

All normative and other references in the document were reviewed to ensure that the latest versions of
those documents uwere referenced. In addition, the references only cite a specific version in Section 1.2.
References within the text only cite the main document number as defined in these sections. This allows
for easier maintenance of this document so that each reference in the text does not have to be updated in
each subsequent version.

D.1.10.4 New Reference for OER

OER was originally defined in NTCIP 1102. When the developers of ASN.1 learned of this new encoding
standard, they determined that it would be a useful international standard. As such, they developed
ISO/IEC 8824-7, which is also known as ITU-T X.696. The ISO/IEC/ITU-T version of OER is fully
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consistent with NTCIP 1102 and extends it to support additional ASN.1 concepts. Rather than maintaining
a parallel standard, the NTCIP community has agreed to adopt the ISO/IEC/ITU-T version.

D.1.10.5 Added Support for Multiple Visibility Sensors

In v04, the object for essVisibility had been marked deprecated but the traceability tables still referenced

it. When reviewing this anomaly, the WG decided that the singular object should be replaced with a table

of visibility sensors. In addition to the edits noted in other locations, this resulted in the following changes:
a) essVisibility superseded by essVisibilitySensorCurrentReading

b) visibilitySensorLocation superseded by essVisibilitySensorLocation

D.1.10.6 Added Support for Monitoring PM 1.0

The WG expressed a need to add support for monitoring levels of small particulate matter with a size of
1.0 micrometer or smaller.

D.1.10.7 Clarified Requirements for Response Times

Requirements were refined to clarify the response times and notification timeliness, as shown in 3.6.29
and 3.6.30.

D.1.10.8 Refined Definition of Snapshot Camera Filenames

Previous versions of the MIB noted that there was no requirement for the filename assigned to a
shapshot camera image to reflect the encoding format for the image (e.g., a jpg image could be saved to
a file with a .bmp extension). This version of the standard made the following changes:
a) added essSnapshotCameraSupportedFormats,
b) essSnapshotCameraFilename was superseded by essSnapshotCameraFilenameV5 and
essSnapshotCameraFileFormat

D.1.10.9 Revised Dialogs for Mobile Profiles

The dialogs for capturing mobile profiles were changed to rely upon the use of dynamic objects. Prior to
v04, this requirement relied upon the use of block objects; however, anytime any object type in this
standard was updated, these block objects had to be deprecated and replaced. In v04, this process was
replaced with a dialog; however, the dialog disassociated the time stamp and location data from the data
being retrieved. As a result, this version replaces both of these designs with the use of dynamic objects
as defined in ISO 26048-1 so that the timestamp and location data can all be collected in a single request
using a process that is flexible enough to handle version updates without replacing its design.

D.1.10.10 Ice Thickness

A review of the precipitation ice thickness object resulted in its deprcation and replacement with the
existing surface ice or water depth object.
a) precipitationSensoriceThickness superseded by essSurfacelceOrWaterDepth

D.1.10.11 Udpated Class Diagrams

The class diagrams contained in Section 4 were updated to show the "current”" data used in this
document.

D.1.10.12 Generated Key Content from Requirements Management Tool

The key content of this standard was imported into a requirements management tool so that traces could
be properly managed rules could be enforced in an automated fashion. The key content included:
a) user needs,

b) requirements,
c) dialogs, and
d) MIB content.

Once this content was finalized, it was exported to an HTML file and reintegrated into the draft. This
approach:
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a) Improves consistency of cross-references in tables,

b) Allows automated error checking, and

¢) Allows single source for MIB in either Word or ASCII text file
D.1.10.13 Updated Object Tree in Annex B

The graphic in Annex B was replaced with a listing of the object tree as automatically generated from teh
MIB using smidump.

D.1.10.14 Moved Test Procedures to GitHub

The test procedures formerly contained in Annex C are being moved to GitHub and reformatted according
to the rules being developed by the NTCIP community.
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Annex E
User Requests [Informative]

Annex E identifies features that were suggested for this document, but are either supported by
mechanisms that may not be readily obvious, or are not supported by this document.

E.A Features Indirectly Supported

The following identifies how certain features are supported by this document.

E.1.1 Archiving Data on a Periodic Basis for Dial-up Operations

Some users wish to configure their ESS to archive data into memory on a periodic basis so that multiple
readings may be retrieved in bulk at a later time (e.g., because of a long polling cycle over a dial-up link).
To operate in a meaningful manner, each entry into the archive needs to have a timestamp that identifies
when the measurement was taken.

This capability is provided through the "Provide Off-Line Log Data" Architectural Need defined in Annex
Error! Reference source not found.. This architectural need can be used in conjunction with any data s
upported by the device.

E.1.2 Precision and Accuracy Information

Some users need to know precision and accuracy information for each sensor, in addition to the type of
sensor. Some users need this information to calibrate their weather models. The ESS WG discussed this
feature and concluded direct support of this feature would result in a standard that is roughly two times
the size and complexity of this document. To support this capability indirectly, this document added
support to provide metadata about the sensor. The metadata includes the make and model of each
sensor. A user needing precision, accuracy, and type information about the sensor can then look up that
information based on the sensor make and model.

Note: At the time this document was developed, USDOT's Weather Data Environment (WxDE)
was maintaining a list of all known sensor types used in the United States for environmental
sensor stations. Each known sensor type is assigned a unique identifier in the WxDE. USDOT
has suggested using the unigue identifier, or using the sensor make and model name in the list,
in describing the sensor make and model for naming consistency.

E.1.3 Retrieve Sensor Profile with Mobile Sources

One of the user needs identified was to collect sensor data from a mobile platform at regular intervals or
on a conditional exception-based reporting (e.g., if an ice patch is detected). This feature requires that
each sensor data record be either time-stamped or location-stamped or both. One method to collect this
data with a time-stamp is to log the sensor data in an event log along with a time stamp, and optionally
with the location of the mobile platform, then retrieve the event logs. NTCIP 1204 v03 also added block
objects that supported this feature, but these block objects were removed in this document (See Annex
Error! Reference source not found.).

Requirement Error! Reference source not found. supports recovering the sensor data from a mobile p
latform, including the time the sensor data is retrieved, but that is not a timestamp.
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Another possibility is the development of an XML mobile block for communication between mobile
platforms (e.g., snow plows) and a center (e.g., maintenance management or traffic management center).
This requires a translation of the MIB/ASN.1 definition contained in the this document to an XML Schema
definition. The XML Schema defines XML content (i.e., messages). NTCIP 2306 v01, provides guidance
on the transport and compression of XML based on web services. NTCIP 2306 v01 also includes a
method for describing message exchange combinations called dialogs, written in Web Services
Description Language (WSDL). NTCIP 2306 v01 defines the following dialogs: Request-Response,
Subscription-Publication, and One-way.

The Internet Engineering Task Force has developed RFC 5935, which defines the expression of
Management Information Base (MIB) datatypes into XML Schema Definition (XSD) language. The
primary objective of RFC 5935 is to enable the production of XML documents that are as faithful to the
MIB as possible, using XSD as the validation mechanism.

The following example is taken from NTCIP 1204 v03. The example is NOT an endorsement by the ESS
WG that the proposed example is an official interpretation of this document in XML format, but is for
provided for informational purposes only. The MIB definition of the Mobile Block follows. The XML
translation of a SEQUENCE is not included in the RFC 5935, but XML has a corresponding concept,
which is follows the MIB definition.

E.1.3.1 Example Mobile Block MIB
essMobileBlock OBJECT-TYPE

SYNTAX OerString
MAX-ACCESS read-only
STATUS current

DESCRIPTION "<Definition>An OER encoded string of the EssMobileData structure
as defined below. This object is used for uploading current mobile station
data from the ESS in a bandwidth efficient manner.

The OPTIONAL fields shall be present if the data is supported by the
implementation and is valid. The OPTIONAL fields shall be omitted for any
data that is invalid or not supported by the implementation.

EssMobileData ::= SEQUENCE {
essLatitude.O OPTIONAL, -- @NTCIP1204-v03
essLongitude.O OPTIONAL, —-- @NTCIP1204-v03
essReferenceHeight.0 OPTIONAL, —-- @NTCIP1204-v03
essVehicleSpeed. O OPTIONAL, -- @NTCIP1204-v03
essVehicleBearing.0 OPTIONAL, -- @NTCIP1204-v03
essVehicleOdemeter.O OPTIONAL, -- @NTCIP1204-v03
essMobileFriction.0 OPTIONAL, -- @NTCIP1204-v03
essMobileObservationGroundState.0 OPTIONAL, -- @NTCIP1204-v03
essMobileObservationPavement.0 OPTIONAL, -- @NTCIP1204-v03
essPaveTreatmentAmount.0 OPTIONAL, -- @NTCIP1204-v03
essPaveTreatmentWidth.O OPTIONAL -- @NTCIP1204-v03

}
<SetConstraint>read-only
<DescriptiveName>MobilePlatform.mobileBlock: frame
<Data Concept Type>Data Element"
HEES { essNtcipInstrumentation 6 }

E.1.3.2 Example Mobile Block XML Schema

The XML Schema representation follows
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<xs:complexType name="EssMobileData">
<xs:sequence>
<xs:element name="essLatitude" type="EssLatitude"/>
<xs:element name="essLongitude" type="EssLongitude"/>
<xs:element name="essReferenceHeight" type="EssReferenceHeight"/>
<xs:element name="essVehicleSpeed" type="EssVehicleSpeed"/>
<xs:element name="essVehicleBearing" type="EssVehicleBearing"/>
<xs:element name="essVehicleOdometer" type="EssVehicleOdometer"/>
<xs:element name="essMobileFriction" type="xs:integer"/>
<xs:element name="essMobileObservationGroundState" type="xs:integer"/>
<xs:element name="essMobileObservationPavement" type="xs:integer"/>
<xs:element name="essPaveTreatmentAmount" type="xs:integer"/>
<xs:element name="essPaveTreatmentWidth" type="xs:integer"/>
</xs:sequence>
<I-- This is from vO3 -->
</xs:complexType>

E.1.3.3 Example Latitude MIB and XML Schema

An example of the translation of a MIB definition for essLatitude follows, with its XML schema counter-
part.

Latitude

essLatitude OBJECT-TYPE

SYNTAX INTEGER (-90000000..90000001)
MAX-ACCESS read-only

STATUS current

DESCRIPTION "<Definition>The latitude in 107-6 degrees of the ESS station,
per WGS-84 datum.

<SetConstraint>read-only

<DescriptiveName>ESS.latitude:quantity

<Valid Value Rule>

The essLatitude at the North Pole is 90,000,000. The essLatitude at the South
Pole is -90,000,000. The wvalue 90,000,001 shall indicate a missing value.
<Data Concept Type>Data Element

<Unit>latitude"

REFERENCE "Resolution based on on-going location referencing activities;
the WMO Binary Code Form FM 94 BUFR Table B item 0 05 001 can be obtained by
dividing this value by 10."

= { essNtcipLocation 1}

<xs:simpleType name="EssLatitude">
<xs:annotation>
<xs:documentation>
<objectClass>ESS</objectClass>
<valueDomainTerm>qty</valueDomainTerm>
<units>latitude</units>
<l-- <Unit> -->
</xs:documentation>
</xs:annotation>
<xs:restriction base="xs:integer">
<xs:mininclusive value="-90000000"/>
<xs:maxInclusive value="90000001"/>
<I-- INTEGER translates to xs:integer -->
</xs:restriction>
</xs:simpleType>
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E.2 Features Not Supported by This Version
E.2.1 User Defined Sampling Periods

Some users have requested the ability to configure the details about how a device calculates the current
reading. For example, some have requested the ability to configure an overall sampling period that is
used to archive data and then, for each entry into the archive, a second sampling period over which
measurements are actually taken and averaged.

ESS WG discussed this feature and concluded that it would:

a) resultin a standard that was not backward compatible with NTCIP 1204 vO1.
b) resultin a standard that was roughly three times the size and complexity of NTCIP 1204 v03
c) be difficult to implement and test

Instead, ESS WG has followed an approach that allows all data to be monitored, measured, and archived
continuously using averaging periods that are appropriate and in wide use for each parameter. This data
can be uploaded to a central system for further statistical analysis, if needed.

E.3 File Transfer Protocol (FTP)

Some agencies do not allow the use of FTP to transfer files, such as camera snapshots, across their
agency's network. To conform to this document, the implementation is still required to support the use of
FTP as specified by this document, but those implementations are allowed to use other protocols, such
as HTTPS:, FTPS: or SFTP:, to transfer camera snapshots.
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